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Ylym yurdumyzda umumyhalk gyzyklanylmasyna,
ykbalyna dwriilmelidir.
MUKADDES RUHNAMADAN.

Giris
Tiirkmenistanyn altyn asyry bolan 21-nji asyrda bizin Tiirkmenistan dowletimizde diinya biliminin
we ylymynyn in soiiky gazananlary bolan tize maglumat tilsimaty ykdysadyyetde, dolandyrysda we
beyleki ugurlaryn &hlisinde kopgiiliikleyin ornasdyrylyp we giiiden ulanylyp baslandy. Hézir her bir
mekdep okuwgysyndan edara-kdrhanada isleyédn hiindrmene ¢enli dhlisi hdzirki zaman c¢aklanja Sahsy
kompyuterlerde 1islap bilydrler. Sahsy kompyuterlerde 6z zerur islerini ol kompyuterlerddki MS
WINDOWS gursawyn 6ziinin we ondaky kompyuter maksatnamalary bilen amal edip bilerler. Sahsy
kompyuterde islap bilmek ti¢in hem her bir ony ulanyjy MS WINDOWS gursawyn miimkingiliklerini doly
owrenmelidir. Edara, kdrhanalalaryn maglumat we resminama dolanysygyny MS WINDOWS gursaw
bilen bilelikde tize maglumat tilsimatyn bolegi bolan MS OFFICE kompyuter maksatnamalar
ulgamynyn maksatnamalary bolan MS WORD, MS EXCEL, MS ACCESS we s.m. amaly maksatnamalar
bilen baangy¢ yagdayda kanagatlanarly doredip bolar. Maglumat we resminama dolanysygynyn has
cylsyrymlagmagy, ol yerlerde komyuter torlarynyn doredilmegi, 6z maglumat ulgamyny goramakini
guramak we elektron resminamalary doretmek hem-de olaryn alys calysygyny guramak ii¢in, olaryn
gizlinligini iipjiin etmek yokarky sanawy getirilen maksatnamalarda ¢ylsyrymlydyr ya-da has kyn isdir.
Her bir edara-kdrhana {igin 6z maglumat, resminama dolanysygyny guramak isi hdzirki wagtda tize
maglumat tilsimaty doretmegin kuwwatly serisdesi bola kompyuter maksatnamalary doretmegin
serisdeleri Microsoft Visual Basic, Delphi, Visual Fox Pro, Java we s.m. kompyuter maksatnamalary
doretmegin MS WINDOWS gursawa niyetlenilen dilleri ulanmak zerurdyr. Bu sanalan dillerin Microsoft
Visual Basic dili tutus MS WINDOWS gursawda, MS OFFICE ulgamyn her bir maksatnamasynda
ayratyn taslamalary isldp tayyarlamaga niyetlenilendir.

Microsoft Visual Basic kompyuterde maksatnamalar doretmegin dili gegen XX asyrda ginden
ulanylan adaty Basic dilinini 6sdiirilip MS WINDOWS gursawa uygunlagdyrylan has kédmillesdirilen,
islendik dolandyrys, ykdysady meseleleri ¢6zmek ligin goniikdirilen dildir. Visual Basic algoritmik dilde
hézirki zaman kompyuter torlaryna, sol sanda INTERNET torynda goldanyan ActiveX tilsimaty gifiden
peydalanylyar. Bu yerde amal edilyén islerin ¢dgi her bir maksatnama diiziijinin islere ¢emelesisi bilen
we bilim derejesi bilen kesgitlenip biler.

Kitapda Microsoft Visual Basic kompyuterde maksatnamalaryn diiziilisinin nazaryyet we
tehnologiyasy anyk mysallarda beyan edildi. Hizirki zaman programmirlemegin algoritmik dillerinin MS
WINDOWS gursaw esasyndaky kompyuter maksatnama diiziilisi birmefizesdir. Sonun {igin hem
hiindrmen Visual Basic algoritmik dilni we onun gursawyny Harplyk hokiinde dwrense beyleki hézirki
zaman programmirlemegifi ulgamlary bolan Delphi, Java we s. m. dillerde, seyle hem maglumat
gorlarynyn dolandyrys ulgamlary bolan Visual Fox Pro we s.m. islemegi 6zbasdak ele alyp bilerler.

Mazmuna gecmek.
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1.Visual Basic ulgama girmek we onun bilen tanysmak

Visual Basic girip islemek {i¢in ol ulgam kompyuterde goyulan bolmaly. Eger yok bolsa ol CD
ROM ykjam diskden ya-da basga seyle maglumat goterijiden goyumaly. Visual Basic maksatnama
WINDOWS-y1 is stolyndan seyle yzygiderlikde girip bolar

| Gl Microsoft Visual Basic 6,0

b MHTEpHET B ) Microsoft Visusl Basic 6,0 Tools  »
Intarnat Explorer -
T ABTOzarpysKa 4 ghe 6,0
4 ANeKTPOHNAA NouTa @ i N
}I Outlook Expre: Pisl
) CpeacTra Microsoft Office ’
ﬂ Microsoft Waord ) CravaapTHe »
A Intornet Explorer
Microsoft Visual Basic P
E 6.0 Microsoft Access
w IS] Microsoft Excel
Faint
) Microsoft Outiook
g Bt [E] Microsoft PowarPoint
W Microsoft word
MPoOKrPLIRATR My 2
-2 Windows Medla N vi=0l EAplor)
) Outlook Expross
" MEN Explorer B Windows Messenger

E MNpourpeearens Windows Madia

Boe nporpammbi »| Y ASNEHHIA NOMOLLLHIAK

[;:] -Fu-&.&-=.’.:_‘_a"- &

AR NAFACKIAG

WINDOWSxp-i -
G _Microsoft A VEIEEERTETENEEANN  yzygiderligi basyp ya-da is stolynyn islendik

yerinde yerlesen belgili yazgyny basybam seyle hem
DiiProgram Files\Microsaoft visual SUJ'TJ'DWE'QE -su yoly gorkezibem Visual Basic maksatnama glrlp bolar.
WINDOWS- i be'lekl 98, 2000 gorniislerine | nycijiinporpamms: B I

: yzygiderlikde hem girip bolar. Seyle yzygiderligi basanynyzdan son kompyuterln
ekranyna Visual Basic-ifl is ekrany we gurallary asakdaky gorniisde bolar

] Exristing ] Fecent ]

» 2N > B N

Standard EXE  Ackivel EXE aActivex DLL Ackiver WE Applicakion
Control ‘izard

>

5 < < < <
NS A= =
&

WE Wizard  Data Project 1IS Application Addin Arkiver
Manager Document Dl
P 4 Pes 4 Pea 4

Otkpems

OTmeHa

i)

Crpaeka

[ Don't show this dialog in the future

1.1-nji surat.Proyekt Wizard ussadyn geplesik penjiresi

Bu yerde programmirlemeisini baslamak iicin, onufl isini yenillesdirmek boyunca birnédge
taslamalaryn iiliiisini saylap bolar. Penjranin menyuwy ii¢ gatdan ybarat: New yazgy tdze taslamalar
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doretmek iicin; Existing vyazgy bar bolan taslamalaryn iistiinde islemek ii¢in; Resent yazgy oOniirdk
ulanylan taslamalarda islemek ii¢in niyetlenilendir.

Taslamanyn su iiliiileriniil birini saylap almak bilen is maksada ugrukdyrylyp guralyar. Mysal ii¢in,
su penjrianin New gatyny saylamak bilen Visual Baisic ulgama amal etjek isimiz ii¢in zerur toplumlary
doretmegi buyrarys, ol bolsa is wagtyny ep-esli tygsytlap biler.

New gatda asakdaky taslamalaryn nusgalary bardyr:

Standart EXE (kompyuterde isleri amal edyin standart EXE-fayldyr);
ActiveX EXE (ActiveX ulgamyit EXE-fayly);

ActiveX DLL (ActiveX ulgamdaky DLL-fayl toplumy, kitaphanasy);
ActiveX Control (ActiveX-da dolandyryan element);

VW Appilication Wizard(Wisual Beysik-de is edyén ussat);

Data Project( taslamanyn maglumat bazasy);

1S Appilication(l1S-in is toplumy);

Addin(yokarsy);

ActiveX Document DLL(ActiveX-yn DLL-toplumyndaky resminama);
ActiveX Document EXE(ActiveX-daki resminamanyn EXE-fayly);
DHTML Appilication(DHTML-yn gosundysy).

Existing gatda bar bolan taslamalary saylap bolar, olar Wisual Beysik toplumyn diiziimine giryan
ya-da ontirdk islenilen taslamalar bolup biler.

Resent gatda bolsa oniirdk islenilen taslamalar yerlesyér, ol 6iiki gat bilen menzesdir, yone islenilip
duran taslamany gorkezyar.

Wisual Beysik-de su ti¢ gatyn islendiginden taslama isi baslanyp bilner.

Su penjrinin in asaky etegindidki Don’t Show This Dialog in the Future yazgynyn oniindéki yere
bellik etseiiz taslamalaryn yokarky gorniislerini saylamak gerek bolmaz, ol yagdayda iiliiilerden
peydalanmagyn zerurlygy yokdyr.

Mazmuna ge¢cmek.
1.2.Visual Basic-de iglap tayyarlamagyn jemlenen gursawy IDE-ni 6wrenmek

Project Wizard penjire bilen bilelikde isldp tayyarlamagyn jemlenen gursaw-IDE, goriinyandir, ol
Visual Basic-de esasy mohiim bolek bolup duryar. Su yerde Visual Basic-de taslamany amal edijiler,
meseldni programmirleyjiler esasy wagtlaryny geciryirler.

Menyu getri Forma  Gurallar paneli Taslama apisgesi
Proje 0SO al Ha desig -
Fle Edit View Project Format Deltug Run Query Disgiem Tools Add-Ins Window Help
M-a-BEH @B o | N HERBERA
General OB &
[N : : = B Project1 (Project1)
r =13 Forfns
A [abl 0 = 3 |Form1 (Form1)
Nl | 22znsaesy esserecoeeeeapsen:
p (‘ .....................................
=] iEaE e e Properties forml b3
1”-‘;’ e Y G Sl (b fs e STy e . |Form1 Form _;]
O O O L Gl O : sbhabetic | catsgried |
B By
R . : ¥ 7 % % y v h (Name) Farm1 ~
J® eSS S SR e popearace __[1-3 »
& ~ e e e s Caption
S A A O o Returns/sets the text displayed in an
g I - L object’s title bar or below an object's
- i
Ll

Elementler paneli Formalary doretmek Hasiyetler apisgesi Formanyii
maketiniii dpiggesi
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1.2.-nji surat. Visual Basic-de islip tayyarlamagyrn jemlenen gursawyny(IDE)

IDE adalga programmirlemekde gursawy we ondaky aragatnasygy beyan edip, ol yerde adatca
taslamalar islenip tayyarlanylyar. Gursaw jemlenen bolanda onda islendik zerur guraly is ekrana cagyryp
bolar.

IDE asakdaky birndce boleklerden duryar:

Bas menyudan- suratda menyu setri;
Gurallaryn panelinden;
Taslamanyn penjiresinden;
Asiyetleriii penjiresinden;
Formanyn maketinin penjiresinden;
Elementlerin panelinden;
Formalaryn konstrukturyndan-formalary déretmekden;
Taslananlara seretmek penjiresinden ybaratdyr.
Mazmuna gecmek.

1.3. Visual Basic-de Bas menyu

Bas menyu Visual Basic-gin penjiresinin  yokarysynda yerlesendir, ony 1.2.-nji suratda menyu setri
diyip atladyrdyk. Visual Basic-de bas menyu edil WINDOWS-yi maksatnamalaryndaky bag menyularyn
amal edyén isleri yalydyr.

Bas menyuyi birinji ¢cepki yazgysy File bolup, ol fayllar bilen islewmek iicin niyetlenilendir, ony
bassan fayllar bilen yerine yetirip boljak isleriit sanawy ¢ykar. File baryp sycanyn sag gulagyny bassai
taslamana degisli buyruklaryn sanawy c¢ykar, sycanyn ¢ep gulagyny bassan fayla degisli buyruklaryn
sanawy cykar.

Bas menyuda File yazgydan soni Edit yazgysy bardyr, ofla sycanyn peykamyny eltip sycanyn sag
gulagyny bassan edil yokardaky taslama degisli buyruklaryn sanawy ¢ykar, ¢cep gulagyny bassan kesmek,
nusgalamak, goymak yaly standart amallary yerine yetirydn sanaw ¢ykar. Bu yerdiki Find buyrugy tutus
IDE-de gozlegi amal edyir. Yazgynyn bolegini proseduradan, moduldan ya-da tutus taslamadan gozlap
bolar.

Bas menyudaky View yazgyny bassaii her hili diiziimleri we gurallary gérmek diizgiini ise girizmek
licin sanaw ¢ykar.

Bas menyuda Project bu ulgamda taslama isinifi esasydyr. Ony basmak bilen ¢ykan sanawdaky
buyruklary basyp formalary, maksatnama modullary, ulanyjynyn dolandyryjy elementleri, basga
taslamalardky ActiveX hasiyetleriii sahypalaryny we diiziimlerini ayryp we gosup bolar. Onun komegi
bilen standart bolmadyk elementleri we OLE salgylanmany hem ayryp we gosup bolar.

Bas menyudaky Format yazgysyny basmak bilen ¢ykan sanawdan elementlerin we formalaryn
mocberini we yerlesisini berip bolare.

Bas menyudaky Debug yazgyny basmak bilen ¢ykan sanawdaky sozler bilen maksatnamadaky
diizedis isleri amal edilyar.

Bas menyudaky Run yazgyny basmak bilen tayyarlan taslamanyn maksatnamasyny ise girizmeli,
isleyérki saklamaly, arasyny tizmeli we tdzeden ise girizmeli buyruklary yerine yetiryér.

Bas menyudaky Tools yazgyny basmak bilen maksatnama proseduralary gosup, olaryn
atributlarynyil baalaryny berip bolar. Bu yerdédki Options bilen IDE-nifi parametrleriniii bahalaryny berip
bolar.

Bas menyudaky Add-Ins gosmaca utilitleri 6ziinde saklayar.

Mazmuna ge¢mek.

1.4.Gurallar paneli

Visual Basic-gin bas menyunyn asagyndaky setirde gurallar paneli yerlesyir, ol yok bolsa bas
menyua girip View Toolbars *Standart ony ol yere goyup bolar. Ahli WINDOWS gursawda bolsy yaly
Visual Basic-de hem islendik isi bas menyu arkaly dolandyryp bolar. Yone gurallar paneli bolsa zerur
buyruklary tapmak yeiiil bolyar.
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Standart EXE gorniigli taslamany doretmek
Project Wizard ussady —Goymak
Bdlegj gogmak
Taglamany agmak

Programmany saklamak
Taslamanyfi dpiggesi
Formanyii maketinifi dpiggesi
Elementlerifi paneli

Ayyrmak

rojecti - Microsoft Visual Basic [design]
Eile Edit Wiew Prpject Fgrmat Oebug Rtin Query Diggram Jools Add-Ins Window Help

=2 = B B (i1 o0 1 4800 x 3600
Formaj Nu galaJLak ‘ Magll:matlara seretmek dpiggesi
gogmak Tapmak Obyektlere seretmek dpiggesi
Menyu redaktory Y za gayt Hisiyetler dpiggesi

Taslamany yatda saklamak Programmany tamamlamak

Programmany ige goybermek
1.3.-nji surat.Visual Basic-de gurallar paneli
Mazmuna ge¢cmek.

1.5.Gurallar panelinde yazgylaryn yerine tiytgetmek

Islemek ti¢in yeiiil bolar yaly Visual Basic-de gurallar panelindéki yazgylary iiytgetmek gerek

bolsa, onda asakdaky yzygiderlikde amallary yerine yetirmeli:

1.Sycanyn peykamyny ekranyn yokarysyndaky bas menyua ya-da gurallar panelinin istiine eltip,
sycanyn sag gulagyny basmaly.

2.Cykan penjiredédki sanawdan Customize...buyrugy saylap basmaly.

3. Customize penjirede ii¢ gatly penjireler: Toolbars, Commands we Options bardyr. Penjranin
Toolbars gatynda haysy paneli iiytgetjek bolsaiiyz onun 6niinde bellijik-baydak goyiin, sonda ol
ekrana geler.

4.Gerek yazgynyzyn listiine peykamy eltip, sycanyn ¢ep gulagyny basyp durup, ony goybermén, ol
yazgynyn ekrandaky tdze yere sliyremeli.

5. Stuiyreyérkaniz «I» harp belgisi gerek yerifie baranson sycanyi gulagyny goybermeli.Panelin
guraly ol yerde bolar.

Bellik: Gurallar paneline gerek yazgyny, paneliil basyna, atlandyrylysyna eltip zynsaiiam bolar.

Eger goyan guralyiyz, liytgesmaniz sizi kanagatlandyrmasa ekrandaky Reset yazgynyn basyn,

sonda adaty standart panel dikeldilyar, yogsamam ekrandaky Close yazgynyn basyn, sonda &hli eden
tiytgesmeleriniz yatda saklanar.
Mazmuna ge¢cmek.

1.6.Buyruk menyuny ayyrmak we goymak

Eger gurallar panelinde gerek yazgyn-buyrugyn bolmasa, ony ofla gosasynyz gelse, su asakdaky

yzygiderlikde isleri amal etsefl ony ol yere goyup bolar:

1.Sy¢anyn peykamyny ekranyn yokarysyndaky bas menyua ya-da gurallar panelin lstiine eltip,
sycanyn sag gulagyny basmaly.

2.Cykan buyruklaryn sanawy yazylan penjireden Customize...yazgynyn saylap basmaly.

3.Agylan Customize penjireden Commands gata gegmeli.

4.Categories sanawy barlap, onun asaky bolegindéki setirden Built-in Menus yazgynyn tapmaly.

5. Visual Basic menyu setrinden Help menyuy Commands sanawa siiyremeli. Haganda ol sanawyn
yokarysynda bolanda syganyn gulagyny goybermeli, sonda Help Visual Basic-in menyu setrinden
ayrylar.

6. Commands sanawdan Help setir saylamaly, ony menyu setirdédki onki yerine siiyremeli.

7.Ekrandaky Save yazgynyn basmaly.

Bellik: Yokarky usul edil WINDOWS-daky siiyremek yalydyr, ol IDE-de has kop dus gelyir.

Mazmuna gecmek.

1.7.Taslamanyn penjiresi

Is ekranyndaky gurallar panelinin asagynyn sagynda taslamanyn penjiresi bardyr. Ol taslamanyn
forma, toparlat we modullar yaly taslamanyn her hili diiziijileri barada maglumatlary calt almak ii¢in
niyetlenilendir, onun gorniisi 1.4. suratda getirilendir.
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Obyekte seretmek

Pro __I.:{; - Projectl [
Programma | ] c P.apkalfny
seretmek . birlegdirmek
= E} Projectl (Projectl) (agyrmak)
- 8 Forms

B9 Formil (Form1)

1.4.-nji surat.Taslamanyii penjiresi

Taslamanyn penjiresinin gorniisi we isleyisi WINDOWS-yn TlpoBoaauk penjiresininki yalydyr. Bu
yerde taslama degisli &hli diiziimler taslama birikdirilydr. Edilen isler peydalanylanda barlanylanda,
diizedilende we isti yetirilende Visual Basic taslamanyn beyanyna .VBP girneldilme gosyar, ol Visual
Basic Project yazgynyn gysgaldylmasydyr.

Yonekeyje taslama bir formadan duryar, ondan basgada taslamanyfi penjiresinde modullaryi we
toparlarynl sanawy getirilyar.

Forma seretmek tigin ony penjirede belgilemeli, menyudaky View Object yazgyny basmaly(forma
bilen baglanysykly programma yazgysyny gormek {igin menyudaky View Code yazgyny basmaly).

Taslama penjiresine peykamy eltip, sycanyn sag gulagyny bassanyz , bu dpisgd degisli edip bolyan
islerin sanawy ¢ykar. Ol buyruklaryn komegi bilen forma we modullara degisli gosmak, ayyrmak ya-da
cap etmek islerini amal edip bolar.

Eger taslamadan bir obyekti ayyrjak bolsailyz, ofia peykamy eltip sy¢anyn sag gulagyny basyn,
sonda ¢ykan sanawdan Remove... basyn. Obyektin gorniini sol Remove-den son gorkezmeli.

Mazmuna ge¢cmek.

1.8.Hasiyetler penjiresi

Ekranda taslama penjiresininn asagynda hésiyetler penjiresi yerlesyar, onda belgilenen obyekte
degisli her hili atributlar(hésiyetler) gorkezilydr. Taslamada her bir forma obyekt hasap edilyir.Su
formadaky her bir dolandyryjy element(Mysal tigin, yazgy(knopka)) hem obyekt hasaplanylyar. Visual
Basic-de dhli obyektlerini atributlary bardyr, Mysal ii¢in, renki we mocberi. Kébir atributlar obyektin
dagky gorniisini tiytgetmek bilen ¢éklenmén, onufl 6ziini alyp barysyny hem iiytgedydr. Bu atrubutlaryn
hemmesine Adsiyetler diyilyar.Bu yerde her bir forma hésiyetlerin toplumyna, ol formadaky her bir
dolandyryjy element hem hisiyetleriti toplumyna eyedir. Ahli hisiyetler hdsiyetler penjiresinde
gorkezilendir(1.5.-nji surat).

Properties - Form1 »
|F|:|rm1 Farm had
Alphabetic ]Categnrized ]
{Mame) Form1 -~
Appearance 1-30
AutoRedraw False
BackColar [ sHs000000F
BorderStyle 2 - Sizable
ClipConktrols True
ControlBox True
DrawviMode 13 - Copy Pen
Drawskyle 0 - Solid
D ave'Width 1 ~
Capktion
Returnsfsets the text displayved in an
object's title bar or below an object's

1.5.-nji surat.Hasiyetler penjiresi
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Bu penjirede obyekte degisli hasiyetlerin sanawy getirilyar, olaryn atlandytylysy inlisgedir, Mysal
ticin, Caption -yazgy, Height - dikligi, Width - ini we s.m. Eger siz bu yerdaki sanaw setirinde yazylan
yazgynyn mazmunyny belesiniz gelse ol, sanawyn asagyndaky bolekde inlisce yazylandyr ya-da ol setirin
tistiine peykamy eltip F1 basmaly. Sanawy elipbiy(Alphabetic) ya-da kategoriyalar(Categorized) tertipde
yerlesdirip bolar. Eger forma-da dolandyryjy element goysafiyz, onda ofia baran wagtyilyz onui
hisiyetleri bu yerde bolar. Hésiyetler konstruirlemek diizgiininde berilyér, kd halatlarda programma
yerine yetirilydrkd hem iiytgedilydr. Bu yagdayda programmalayyn liytgediji kody yazmaly, tiytgetmek

programma amal edilende bolar.
Mazmuna ge¢cmek.

1.8.1.Logiki hdsiyetler

Visual Basicde logiki hasiyetlerin bahalary seyle liytgedilyar:

1.Formal-i agmaly. Eger hdsiyet True ya-da False birini alyp bilse, olar loguki bahalardyr, Adsiyetler
penjrdnin birinji siitiininin tistiine peykamy eltip iki sapar basyp ol bahanyn birini saylamaly. Mysal
ticin, Formal-in MaxButton hésiyetine False bahasyny berip goriin:

Propetrties - Form1 p

Form1 Farm T

Alphabetic lCategDrized ]

MinButbton

Determines whether a Form has a
Minimize button,

2.Bas menyua baryp Run™Start yazgylary bassanyz ekranyi yokarky sag bur¢yndaky belgiler ayrylar:

-
Ede Edit Vew Propct Format Detug Bun Query Dwagram locks sdd-Ins Window Help

Wom B

~ Form1 mT o

B4 Projectt {Project1)
- \ Foros

@

3 romi {romi)

‘ »

Bu isi tamamlamak ticin Run™End basmaly ya-da gurallar panelinddki End yazgyny basmaly, ya-da
Formal-formanyn yokarky burcundaky X belgini basmaly, sonda ekran 6nki konstruirlemek diizgiinine
geler.

Mazmuna ge¢cmek.

1.8.2.Uytgedilmeyin bahalaryn toplymynyt bahalary

On bellip gecisimiz yaly hisiyetler penjiresine baryp sanawdaky yazga iki sapar basybersek hemme
ulylyklaryn bahalary tiytgép giden yagdaya doner, eger olaryn sanawy kop bolsa is hasam kynlasar. Seyle
yvagdayda kabir hdsiyetlerin bahasyny belgilép tiytgedilmez yaly edilse gowy bolar. Ony Form1l {icin
BorderStyle hisiyetinin mysalynda seredelin:
1.Forml-e peykamy eltip bas maly, sonda ol isjeni yagdayada bolar.
2.Hasiyetler penjiresinde baryp BorderStyle yazgyny tapyp, onuf sagyny bassan ¢ykan penjirejikde

sanaw ¢ykar:
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Properties - Formmd e
IFDrrnl Form ~ |

Alphabetic ]Categorized ]

Eorderstywile 1 - Mone

O - MNons

-~
Zapkion —
—lirn— okl 1 - Fixed Single :
2 - Sizable —
BordersSktyle 3 - Fixed Dialog
Returnsisets the H4 - Fied ToolwWhn
obijeck. S - Sizable Tool

onun bahalary we amal edyén isleri sulardyr:
0-None baha, forma-nyn dasynyn ¢arguwasyny ayyryar.
1-Fixed Single baha, forma-nyn dasynda ingejik ¢arcuwa doredyér, penjranin mogberinin erkin
tiytgedilmegini gadagan edydr.
2-Sizable, ol hig hili hisiyet berilmese kabul edilyan hasiyetdir, onda ulanyjy penjirelerin méiiytegip
bilyar.
3- Fixed Dialog bolanda BorderStyle ulanyy penjréni tiytgedip bilmez, ol kopleng WINDOWS-yn habar
beriji penjirelerinde ulanylyandyr.
4- Fixed Toll ya-da 5- Sizable Window bolanda ekranda ziytgedip bolyan gurallar paneli déredilip
bilner.
3. BorderStyle yazga 3- Fixed Dialog hésiyet bermeli sonda ulanyjy formanyin mdcgberini tiytgedip
bilmez.
4. Run™Start buyrugy amal edin, sonda formany ulaldyp kiceldip bolyan belgi ekranda bolmaz, formanyn
mogberini liytgedip hem bilmersiniz.
5.Ekranyn yokarysyndaky sagda Close yazgyny basmaly.
Mazmuna ge¢cmek.

1.8.3.Setirler hasiyeti

Kaébir héasiyetlet yazgy hasiyetlidir, olar harp gatysykly bolany iigin setir diyilyar.Hasiyetler
penjiresindéki sanawda difie Name we Caption setir hésiyetlidirler. Eger olaryn bahalary klawiaturadan
girizilmeli bolsa, ol hisiyetlerinn adynyn iistiine baryp iki sapar bassan sagda almaly bahalary ¢ykar.
Mysal {i¢in, formanyn ady seyle liytgedilyar:

1.Formal baryp ony isjenlesdirmeli:

2.hasiyetler penjiresine baryp Name yazgyny iki sapar basmal, sonda seyle setir bolar

.
3.Formal yazylan yere FrmResminama girizmeli [0 Frrresrinand 4

4.Enter diiwméni basmaly.

5.1ki sapar Caption setri basmaly sonda cykar.
6. Caption meydancan sagyna Formal tize at bemeli, Mysal iigin, Yaz1: [ 1|

Visual Basic is ekrany seyle gorniise geler:

~ Project1 - Microsoft Visual Basic [design]

Flla Edit Wiew Project Format Debug Bun Query Dlagram Tools Add-Ins Window Halp

= R = = 3 L T |
= Froject - Projecti ——— F1
Ganeral | __ il =
3 = Project1 - FrmResminama (Form)['__HEHZ] [< | e
-
A IE[ r_lral[lm = Piopeirties - FrimResminama |9
7 — [FrmResminam, Farm =1
¥ @ Alphabitic ]thugurlzud]
(Mame) FrmBesminama |
=R E=m Appesrance  |1- 3D
e AutoRedran False
=l BackColor || &H&ODO000F
2 - Sizahle
@ = £y
= w |Caption
[ Raturrsfmka Lhe el cisplayed inoan
[ e Form Layout x|
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Hasiyetlewrin su ikisi has kop ulanylyanlarydyr.
Mazmuna gecmek.

1.8.4.0n altylyk hésiyeti

Bu diisiinje renk bilen baglanysyklydyr. Renklerin toplumy ekranda hemise bolar yaly etjek
bolsanyz View™Color Palette basmaly. Bu yagdayda hisiyetlerdéki atlaryn iistiine baryp bir sapar bassan
gerek renkini saylap alyp bolar.

Mysal tigin BackColor formanyn diisegini tiytgedyar:

1.1ki sapar héasiyetler penjiresindédki BackColor, sonda refiklari saylamak tigin penjire agylar

Paletke  System l

B Active Tidle Bar S
B 1nactive Title Bar

[1 Menu Bar

[ window Backaground

M wvindow Frame

M renu Text

W window Text

[ active Title Bar Text

[ Active Border w

2.Su Palette gyzyl reiik ¢ykar yaly ol s6zi basmaly.
3.Cykan reniklerden gyzyly saylamaly sonda Formanyn diisegi gyzyl bolar

- FrmResminama (Form)[= |34 [Properties = FrmResminama B4

. [FemBesminam. Form |
Alphabetic | categorized |

~ Project1

Netijesi bize yaramsyz bolsa BackColor yzyna standart yagdaya seyle getirmeli
1. BackColor tizedaen basmaly, ¢ykan penjirede System yazgyny basmaly
2.Cykan su penjireden island renkifi basmaly

Backcolor  [EIRDODORE:
Bl Palette Swstem |

B application workspace w
:a |l Highlight
+ [ Highlight Tesxt

[ Button Shadow
[ Disabled Text
Ml Eutton Text
| e B .- -

Button Face bassan 6nki yagdaya gelersiniz. Window Background bassanyz Forma ak renkli diisekde

bolar.
Mazmuna gecmek.

1.8.5.Fayllar hisiyeti

Doreden formanyzyn fayl yagdayy , ony saylamak hisiyetlere baryp Icon barsan ona belgijik berip
bolar, ony su yzygiderlikde berip bolar.
1.Hésiyetlerdéki Icon baryp Yazl formany agmaly, sondas su Load Icon atly penjire agylar
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Load lcon

2.Apigediki sanawdan FACEOQ2 saylap, Omxpwims Vazgyny bassaii formanyi yokarsy
seyle gorniise geler.

Mazmuna gecmek.

1.8.6.0l¢gegit hisiyeti

Left, Top, Width we Height su dort hédsiyetler gurallar panelinde we hésiyetler penjiresinde
bolyarlar. Olaryn bahalaryny hésiyetler penjiresiniin degisli setirinin sagyndaky ikinji siitiinde girizip
bolar. Formany sycanyn peykamy bilen siliyrdp maket dpisgd eltsen Left we Top bahalary héasiyetler
penjirede we gurallar panelinde iidr. Eger formanyn haysam bolsa bir bur¢yny seyle etsen Width we
Height bahalary tiytgér.

Mazmuna gecmek.

1.9.Formanyn maketinin penjiresi

Formanyn maketinifi penjiresini ulaldyp, kigeldip bolar, ol gaerekli gurallaryn biridir, ol amal
edilydn igin ekranyi haysy yerinde boljagyny gorkezyar.

Form Layout

Penjire bilen bolayjak is seylerdkdir:
1.Maketin penjiresinddki formanyn sekiline baryp basmaly, ony monitoryn merkezine siiyremeli.
2.Run™Start buyruk bilen programmany ise girizmeli, sonda a igjent yagdayda bolar.

Mazmuna gecmek.

1.10.Elementler paneli

Elementler paneli adyndan gorniisi yaly amal etjek isimize gerekdir. Ahli belgiler we yazgylar
degisli obyektlerde, formalarda yerlesdirip bolar, olar Visual Basic-in i¢inddki ya-da standart elementler
diyilyar.
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x|
Gerneral |

Mazmuna gecmek.

1.10.1.Elementler panelini tertiplesdirmek

Visual Basic-in gorniiglerinii element panelleri mefizesirdkdir.

Onun bilen elementleri toplap tdze penjire doredip bolar. Mysal iicin, Internet at bilen tidze penjire
seyle yzygiderlikde doredilyar:

1.Elementler panelin bos yerine sycanyn peykamyny eltip basmaly.

2.Sycanyn sag gulagyny basanyida ¢ykan penjireden Add Tab yazgyny saylamaly.

3.Visual Basic téize dpisgd at bermegi talap etse Internet yazgyny girizmeli

MAicr sy Tl Winesaal Boanic:

4.0k basmaly.
5.Téaze doreden penjire gatyiyza islendik elementi stiyrdp gegirip yerlesdirip bilersiniz.
6. Taze doreden &dpisgéinize standart bolmadyk elementleri gecirmek iicin, sycanyi sag gulagyny
basmaly ¢ykan sanawdan Components buyrugy basmaly(ya-da Project™Components basmaly).
7.Gerek elemenleriiiizin 6ntinde bellik etmeli.
8.Elementleri panele yerlesdirmek iicin OK basmaly.
Mazmuna ge¢cmek.

1.10.2.Panelden elementi ayyrmak

Onun tigin Custom Controls penjirede degisli elementin 6niindédki belligini ayyrmak yeterlidir.
Panelden dolandyryjy elementleri i¢inde Visual Basic doredilende goyylan bolsa ol elementleri ayyrmak
bolmaz. Panelden asakdaky yzygiderlikde elementi ayyryp bolar:

1.Panelinl i¢ine peykamy eltip sycanyi sag gulagyny basmaly.

2.Cykan sanawdan Components buyrugy basmaly.
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Components

Controls | Dmsigners | Insertable Sbjects |

Microsatt DOS -
Microsoft DirsctAnimation Media Contrals
Mictosoft Flemcrid Control &0
Microsaft Forms 2,0 Object Library
Microsoft Hisrarchical FlexGrid Control &,0 (OLE
Micrasaft HTML Shject Lilbrarys

| Microsoft Internet Controls
Microsolt Internet Transfer Control 6.0
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Browse. .
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3.Ayryljak elementin 6niindéki belgini ayyrmaly.
4. OK basmaly.

1.11.Formanyn konstruktory

Ekranyn ortasynda formanyn konstruktorynyn sgesi yerlesendir.

Visual Basic-de bu yerde formanyn sekili ya-da programmanyn penjiresi ¢ykyar.

~ Project1 - Microsoft Visual Basic [design)

Ee Gt Yww Dromet Formed Debasy B Query Opegam Dmk adcbime (o Lk

B-u- 5 M ’ s NEFARFRA
X X

Gy | ol o
" = Project! - Form1 (Form) = B Prowectd dhrapentt) |
é r“l > | - ‘;_::"

= frometies fami B
Fo= Faemt fare -
5§ ]
2y 3
(o B=]
4 ®
Q - P e s T 2l idbered 6 o
= AT N X
) -‘
Yoerrat

Mazmuna gecmek.

Formanyn ya-da programmanyn dagyndaky garaja inedordiillere markerler diyilyér, ona peykamy
eltip gerek tarapyna sycanyn ¢ep gulagyny basyp siiyreseil ol penjranint mo ulalar ya-da kigeler.

1.12.0beyektlere seretmek penjiresi

Mazmuna gecmek.

Obeyektlere seretmek penjiresi View™Objekt Browser buyruk bilen ya-da klawiaturadan F2

diwméni basyp ekrana c¢agyryp bolar, ol
ulanyljakdyr.Onun is penjiresi asakaky yalydyr:

= Object Browser
|-=AII Librarics=

l ~| #al x|

= N e o

Classas Marmbars of '=globalas"
T A
& AR

=M Allgnmentionstants = S ppactivate

B AmbientMroperties o A

B AP ]

= Applcationstaricon s U

B ssyncProperty e | | AR

(=T

=All Librarics s

1.13. Visual Basic - redaktoryny 6wrenmek

penjire obyekte-goniikdirilen  programmirlemede
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Visual Basic-in 6z kuwwatly yazgy redaktory bardyr, ona girizilen serisdeler is Ondiirijiligini has
artdyryar. Bu penjirede esasy isler amal edilyér. Visual Basic yazgy redaktorynyn penjiresini agmak tigin
Forma ya-da formanyn maketinin apisgsinin elementinin tistiine peykamy eltip basmaly.
Eger iki sapar forma bassain onda su formanyn prosedurasy yiiklener. Programmanyi penjiresini
taslama penjiresinddki View Code yazgyny basybam agyp bolar. Programma penjiresiniii gorniisi
asakdaky yalydyr

= Project1 - Form1 (Code)

|(General] -| |(Declarntlon-:l -
Option Explis=t| =
Frivate Dub Form Lo=ad()
Frnd Sub
FPriwvate ZIub Form Unload(Cancel s 1
End Sub
-
il E JER N |

Elemente baryp agsan elementinn prosedurasy yiklener. Programma penjiresi ag¢ylandan son
belgilenen formadaky islendik obyektdéki islendik prosedura gecip bolar.

Prosedura -munun 6zi 6zara baglanysykly yumugy yerine yetiryan programma bolegidir.

Visual Basic yazgy redaktoryny gowy oOwrenmeseniz meseldni programmirlip bolmaz, onda
klawiaturadaky diiwmelerin utgasdyrylysyny, sriftlerit we reiklerin berlisini 6wrenmeli. Visual Basic
yazgy redaktorynyn IDE-sinin diiziilisine gord programma penjirede birbada birndge prosedura bolmagy
miimkindir. Programma penjirede 6z programman yagdayy barada anyk maglumatlar girizilende we
¢ykarylanda obyektin hasiyeti gorkezilyar.

Mazmuna ge¢cmek.

1.14.Visual Basic -de birndce taslama bilen islemek

Visual Basic-de birbada birndge taslama bilen isldp bolar. Bu taslamalaryn we olaryn diiziimi
tasalama penjiresinde biri-birine yzygiderli baglanysykly aga¢ gorniisli sekillendirilydr. Visual Basic-i
tazerdk Owrenyénler bir taslama bilen ¢éklenselerem bolar. Adatca ActiveX -iii elementleri doredilende
obyektin {istiinde islemek {igin bir taslama a¢mak amatlydyr, galanlary ony barlamak iigin
niyetlenilmelidir.

Visual Basic-in diiziimine giryén islerin mysaly seyle yzygiderlikde goyulyar:

1.WINDOWS-yi dolandyrys panelindiiki FaYerancera u manere nporpar (Add/Remove Program) bilen MSDN
Library-Visual Basic 6 Setup programmany ise girizmeli.

2.Goymak isini baglamak {i¢in /Jo6asumvlyoarums(Add/Remove) yazgyny basmaly.

3. MSDN Library-Visual Studio 6.0 penjiresi agylanda Add/Remove yazgyny basmaly.

4. MSDN Library-Visual Studio 6.0 penjiredéki VB Product Samples yazylan setirde bellik etmeli. Eger
bellik agyrak bolsa Select All yazgyny basmaly.

Visual Basic mysal hékmiinde getirililen taslamalaryny goyanynyzdan sof, birndce taslamada isldp

gérménin miimkiin¢iligini asakdaky mysalda gorelin:

1.File™Add Project buyrugy amal etmeli.

2. Add Project penjranin Existing gatyna gegmeli.

3.\MSDN98\98vs\1033\Samples\VB98\FirsApp katalogdan FirsApp.vbp fayly saylamaly.

4.0pen yazgyny basmaly, sonda FirsApp taslama IDE giriziler.

5. Yene bir taslamany gosmak iigin File™Add Project buyrugy basmaly.

6. Tazeden Add Project penjranin Existing gatyna ge¢cmeli.

7. \MSDN98\98vs\1033\Samples\VB98\Controls katalogdan Controls.vbp fayly saylamaly, sonda
Controls IDE-4 giriziler.

Birndge taslama bilen islemeklik gowy is, ol is tejribesi bilen miimkindir.

Mazmuna ge¢cmek.
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1.15. IDE-ni diizmek

Visual Basic 6 gurallar jemlenen gursawy has kdmillesdirilen hem bolsa ony 6z islegine gora diiziip
bolar. Mysal ii¢in, Tab diiwmw ulanylanda bolmaly belgilerin sany, programma penjranifi refkini
tytgetmek we s.m. IDE-nifi parametrlerini iiytgetmek bas menyudaky Tools™Options basmak bilen
baslanylmalydyr. Options penjrénin gatynda IDE-nin dhli parametrleri bardyr.

Mazmuna gecmek.

1.15.1. IDE-de Editor gaty

IDE-ni diizmekde Editor gatyndan birgiden parametrleri berip bolar, onun gorniisi

Editer | Editar Format | General | Docking | Envirenment | Advanced |
Code Sebrings
I |Pien Synkai Chack) ¥ ko Indsnt
I Rmmuirs Yarishls Declarstion
I pubo List Members
I suko Solck Info
I+ Auto Data Tipg

tab width: |4

o Sl g

I Gorengand-Drop Texl Editiong
W Default to Full Module Wicw
v Procedurs Smparstoe

Bu yerddki Code Setting toparda redaktoryn isine goniiden-goni tédsir edydn parametrler
yygnalandyr, olaryn oniinde bellik goyup 6z IDE-ni diizldp bolar. Tools™Options buyrugy amal
edeninizden soil ol parametrleri berip barlap gorelini:

o Auto Syntax Check yazgynyn oniine bellik etsek redaktor, konstruirlemek diizgiinde, programmadaky
sintaktik yalfiyslary tapar. Ol mydama belgilenen bolsa programma diiziilenda kabir sintaktik
yaliiyslyklary aradan ayyrmaga yardam eder.

oRequire Variable Declaration yazga bellik etsek programmadaky islendik tiytgeydn ulylyklar
ontinden méalim edilip ulanylmalydyr. Ol mydam belgilenen yagdayda bolsa gowy bolar. Ol General
Options bolekdéki her bir forma, modula we topara yeke tik setri Option Explicit birikdiryér.
awtomatiki ¢ykarar. Programma girizilende kursoryn duran yerinde hésiyetler we usullar awtomatiki
anladylar.

o Auto Quick Info yazga bellik etsek funksiya we onun parametrleri baradaky maglumatlary ¢ykarmaga
rugsat ya-da gadagancgylayk beryir.

o Auto Data Tips bellik etsek sycanyn peykamy duran yerdéki tiytgeyanin bahasy ekranda gorkeziler, ol
programma barlananda zerurdyr.

o Auto Indent yazga bellik etsek programmada kesgitli bos yerlerden duran awtomatiki yza ¢ekilmeleri
goyar. Ol programma yazgylaryny tertipli okar yaly dip yazmaga yardam eder.

oTab yazga bellik etsek klawiaturadaky Tab diiwméni basanymyzda bolmaly bos yerin mukdaryny
beryir, hi¢ hili gorkezme bermeseniz 4 boyer berer, ony ulaldybam, kigeldibem bolar.

Gatyn Window Setting toparynda berilydn parametrler:

o Drag-and-Drop Text Editing yazga bellik etseniz yazgy boéleklerini programma penjiresine siiyremége
rugsat berersiiiz.

o Default to Full Module View Yazga bellik etseniiz bar obyekt baradaky dhli proseduralary redaktor
gorkezmelidir.

o Procedure Separator yazga bellik etsek Default to Full Module View yazgyda bellik bar bolsa, onda
prosedura yazgylarynyi arasy boliinen bolmalydyr.

Mazmuna gecmek.
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1.15.2. IDE-de Editor Format gaty

Bu gatyn penjiresi asakdaky yalydyr

Option= [E|

[==1[=10 Edikc Farrnsk ]Gl-nll'l.l | Dizzking | Ervirarmant | advanced |

imods Zolors

-
Elorm Foinke Tack
Broalymoink Toxk

i leul

Coommnen (5]
Voot o Tk e Tar Ploarigins i ot Hor

Furcgroo nds Eochoarooned:s 3dieator AT Y e R
[ auka = T ~ | IAaute =1

s simena || <iwessa |

Bu gat redaktorda peydalanylyan refikleri we sriftleri saylanylyar, ol edil WINDOWS-daky yalydyr.
Mazmuna gecmek.

1.15.3. IDE-de General gaty

General gaty IDE-de her hili Yagdaylary diizmek ii¢in niyetlenilendir, Mysal ti¢in, formalarda tor
¢cyzygyny bermek, yaliiyslary islemek we s.m. General gatyn penjiresinin gorniisi seyledir

Qptions X
Cdikor ] Cdikar Format  Gensrsl ] Docking ] Crvironmment ] Advanced ]
Form Grid Scttings Error Trapping
e G € Brsakon Al Erars
taried Liniks: Teips = Dpeskin Class Moduls
wldthi | 1200 ° prask on Unhandlsd Errors
usight: | 120 Sampaile

v Compls on Dermand

¥ Align Controls ko Grid
I+ Background Cormpls

v Show ToolTips

I Crillapsm Prog. Hides Windows

Bu yerdéki penjireddki parametrlerin niyetlenilisi seyledir:

o Form Grid Settings toparda toryn birikmelerinin aralary berilyar. Tor formada elementlerini gyraden
bolmagy ii¢in ulanylyar. One bermeseniem bolar.

a Error Trappihg topar yalfiyslar islenilende tésirliligi beryar

Compile toparda asakdaky parametrlerin bahalary berilyér:

oCompile on Demand yazga bellik etseniz Visual Basic yazan programmanyzy, yazysynyza goré
kompilyasiya eder, bu bolsa Run »Start buyruk bilen programmany ise girizmegi tizlesdirer.

o Enable Background Compile yazga bellik etseiiiz, programmanyz kompilyasiya edyarkéniz he isinizi
dowam etdirip bilersifiz.

General gatdaky penjireden asakdaky parametrler hem berilyar:

oShow Tool Tips yazgyny bassanyz Visual Basic-de peykamy dolandyryjy elementin istiine eltseniz
maslahat beriler.

o Collapse Proj.Hides Windows yazgyda bellik etseniz taslama penjiresindiki taslamany yygnasanyz
onui bilen baglanysykly dpiyygnalar.

Mazmuna gecmek.

1.15.4. IDE-de Docking gaty

Docking gatda IDE-de haysy penjireler ekranyn kesgitli yerinde bolmalmalydygy gorkeziler,
penjiresi asakdadyr
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Mazmuna gecmek.

1.15.5. IDE-de Environment gaty

Environment gatda IDE-nin diizmegifi mohiim parametrleri yerlesyar, penjiresinin gérniisi

Options B
Fdikar ] Fdikar Farmak ] Erar s ] Docking  Frvironmsntb |I\HvAn.-AH ]
When visual Basic starks! Show Templates For!
{= Prompt bor prodect W Eorms
O Zreats dafaulk projeck e ML Forms
[ podules
whmn & pranram skarks; W Clazs Modules
07 wave ChannEs % Llm@r Cankrals

v Eroperty Pages

I Llsmr Docurnesnk

Lmrriplabems Lirscbor:
| i Pranram FilesiPaicensaft Yisosl Stodind Y ESE Tamplakes

(=108 LITMEHS | (S TRETETE] |

Islaninde Project Wizard penjiresi gerek bolmasa When Visual Basic starts topardan Prompt for
project yazgydan belligi ayyrmaly.

Eger Project Wizard penjiresini ayyrmak islemeseniz, yone onuni penjiresinden kébir tlniileri
ayyrmak isleseniz Show Templates For topardan degigisli belgileri ayyryn.

When a Program Starts topardaky parametrler bilen taslamalaryn yatda saklanylysy guralyar. Mysal
ticin, Prompt To Save Changes yazgyda bellik etseniz Visual Basic taslamanyzy yatda saklamagy teklip
eder.

Mazmuna ge¢cmek.

1.15.6. IDE-de Advanced gaty
Advanced gatynyn gorniisi asakdaky yalydyr

COpticns |.E|

Folirow | Folivow Fovmar | esmneeal | eockinn | eoseonmeane . Sudeon oo |

(S = R B P S R e
= raarify whmn chanoing shaad peageer ifame
I miad el L by e el

Cockmrmal |ITHL Cdlkar:
| s LR s sy i | e

& 3k & ET S | TR TrEs |

o Background Project Load yazgyda bellik etsek Visual Basic taslamany isldp duran wagtyn hem
yuklar.
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o Notify when changing shared project items yazgyda bellik hokman etmeli, ol Visual Basic-de birndge
obyektleri bilelikde peydalanmak ii¢in niyetlenendir.

o SDI Development Environment yazgyda bellik etsek IDE-nin arabaglanysygyny bir resminama(SDI)
ya-da kép resminama(MDI) bolmalydygyny saylamaga miimkingilik berer.

o External HTML Editor yazgyda bellik etsek Visual Basic-iri 6ziinde Web sahypa doéredip bilersiniz,
onun tigin HTML dili bilmeli.

Mazmuna gecmek.

1.16. Visual Basic-de birinji taslamany doretmek

Visual Basic-in jemlenen gursawy IDE bilen tanysanyfiyzdan sofi 6z birinji taslamanyzy déretmek
bilen, ol dilde programmirleméni baglarsynyz. Ol programma "Hemmelere salam" diyip atlandyralyn.
"Hemmelere salam" taslama seyle yzygiderlikde doredilyér:
1.Visual Basic girmeli, bas menyudan File™New Project buyrugy amal etmeli. Oiiki yerine yetiren
isleriniz gerek bolsa ¢ykan penjirede Yes yazgyny basmaly, gerek bolmasa No yazgyny basmaly.
2.Ekranda formanyn maketinin penjiresi yok bolsa ony View™Form Layout Window buyruk bilen
acmaly.
3.Peykamy maketin penjiresinddki formanyn {istiine eltip sycanyn sag gulagyny basyn. Cykan
penjiredédki sanawdan Startup Position™Center Screen buyrugy basyn, sonda forma ekranyn ortasyna
geler.
4.Formanyn dasky ¢ékletine baryp, onunt mogberini inine we boyuna ulaldyn.
5.Elementler panelinddki Command Button yazgynyn belgijigine baryp sycanyn ¢ep diiwmesini iki
sapar basyn, sonda formanyn ortasynda basylyan yazgy dorediler. Ony formanyn asaky etegine
stiyran.
6. Elementler panelinddki yazgy elemente(Label belgijigi-A)baryp ony iki sapar basmaly, sonda
formada yazgy dorediler. Ol yazgyny ortarak siiysiirmeli, onun gorniisi seyledir

= Form1

7.Forma peykamy eltip, ony belgilemeli, sycanyn ¢ep diiwmesini basmaly. Seyle edileneni hésiyetler
penjiresinddki mazmundan hem bilip bolar, ol yok bolsa F4 basmaly.
8.Formanyn su iki hasiyetini Hasiyetler penjiresinin siitiininde seyle bermeli

Hiisiyet Bahasy
Caption Birinji taslamam
Name frmHemmeleresalam

Caption berlen hisiyet formanyn adyna geger.
9.Lebell -yazgy elementine baryp belgildp, asakdaky hasiyetleri berin

Hiisiyet Bahasy
Name frmHemmeleresalam
Text Hemmelere salam

K4 halatlarda Text-inn ornuna Caption yazmak zerurdyr.
10.Command1 baryp ony belgilemeli we ona dsakdaky hasiyetleri bermeli

Hidsiyet Bahasy
Name cmdOK
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Caption &OK

Bu yerde Caption basylmaly yazgyny kesgitleyar.
11.cmdOK yazgyny iki sapar basyn, sonda forma degisli programma penjiresi agylar

™ Project1 - frmHemmel... [T |[8]5]
[orrior | ek |

Fraswmte Sab Porem Liosdd () —
End S
Fraswmte Suabr o omedfskl 0l aesk ()

End Shas

== 4| k|

Ekranyn penjiresindiki yazgylar proseduranyn yazgylarydyr ony soit wreneris.
12.Private Sub we End Sub setirlerini aralygyna programmanyn su bolegini girizmeli

Unload Me
Set frmHemmeleresalam=Nothing
Penjire seyle bolar

M PFroject1 - femmHemmel . [— =3 ==

| -~ | [onek ~ |
FPriwrsaca Tulz sasbID Zldisl=i) -
hJ'nJ.l:ll:L:l M= -

i CrroHororoes Lo oo oo o i Fad racy
E A =k

— = i1 .

Haganda ulanyjy cmdOK bassa cmdOK_Click yagday bolar.

13.File™Save Project buyrugy amal etmeli. Formanyn adyny .frm-gineldilmede we taslamanyn adyny
.vbp gineldilmede girizmeli. Olar yatda saklanar.

14.Run™Start buyrugy amal etmali, dhli amallary dogry yerine yetiren bolsaflyz ekranda seyle forma
bolar

= Birinji taslamam [?][E][ls_‘]

Hemmelers salam

15.Formadaky OK yazgyny basyp isi tamamlamaly. Eger sizde seyene bir sapar isi basyndan baslap
gorun.
Hemme amallaryniyz dogry bolsa sizi Visual Basic 6-da ilkinji doreden programmanyz bilen gutlasa

bolar.
Mazmuna gecmek.

2.Visual Basic-de formalar bilen islemek

2.1.Visual Basic-de formalar, olaryn gorniisleri

Visual Basic-de formalar in esasy islenyén yerlerdir, olar bilen is salynyar. Forma iydn ekrandaky
penjire bolup, onda taslama isine degisli her hili dolandyrys elementler yerlesdirilydr. Tdze formany
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doretmek iicin Visual Basic-1 ise girizmeli, menyudaky File—New Project yazgyly buyruklara gecmeli,
sonda ekrana ici bos forma geler

¢

&, Forml Yapmak belgisi

Menyu apiggesi

Formati ady '~ Jtoti il Siietste et st il Sl B Apiggani ulaltmal: ,

......................... —— lkigeltmek belgisi

Aplgganiti gag e S s A S RS BRI

R N S L Apiggani etege
Apigeanifi ady —mms——— —— yygnamak belgisi

Bu yerde penjranin ¢égi liytgemeyédn, Olcegli ya-da ayrylan bolup biler, ol hésiyetler formanyn
hésiyetlerindéki BorderStyle yazgydan seyle berilyar

sarderSkvle
—apktion

lim bl

orderstyle
eturnsfseks the

3 - Fixed Dialog
B - Fized ToolWindows
5 - Sizable Toolwindows

Penjrianin ady, ol formanyn yokarky renkli zolagydyr, sycanyn peykamyny onufi iistiine eltip,
sycanyi ¢ep gulagyny basyp formany ekranyin islendik yerine eltip bolar, ondan basgada sycanyi ¢ep
gulagyny yzly-yzyna iki sapar basyp formany gineldip ya-da onki 6lgegine eltip bolar.

Formanyn ady, ol dpisgé taslayjy tarapyndan berlen yazgy, onyn hisiyetini BorderStyle bilen
berip bolar, adyny Caption bilen bermeli.

Menyu penjiresinde formany dikeltmek, yerini iytgetmek, mdogberini liytgetmek, yygnamak,
yygnalany agmak we yapmak ti¢cin buyruklar bolyar.

Apisgini etege yygnamak belgisi formany wagtlayyn etege yygnayar, ony formada goymak ii¢in
hasiyetler penjireddki MinButton hésiyeti True bolmaly.

Penjrini ulaltmak we kiceltmek belgisi, ony basmak bilen forma adatdaky yagdayda bolsa ekranyn
mocberine ¢enli ulalyar, ona MDI-de konteyner diyilyar. Eger forma ulaldylan bolsa, ony bassan forma
adaty yagdaya dolanyar. Bu belgininn formada bolmagy iigin hasiyetler penjirede MaxButton hasiyet
True bolmaly.

Formany yapmak belgisi X bolup, onyn formada bolmagy ticin ControlBox hisiyet bolmaly. Ger ol
belgi bolmasa penjrani yapmagyn basga serisdesi géz 6niinde tutylan bolmaly, Mysal tigin, Esc basmak.

Mazmuna ge¢cmek.

2.2.Visual Basic-de formalaryn hésiyetleri bilen islemek

Formany dolandyrmak, onunl dasky we icki yagdayyny kesgitlemek hasiyetler bilen berilyér. Forma
in bolmanda bir hésiyet berilmeli. Formanyn &hli alyp biljek hésiyetleri sulardyr.

ActiveControl DrawWidth HelpContextID NegotiateMenus
ActiveForm Enabled hwnd Pikture
Appearanke FillColor Icon ScaleHeight
AutoRedraw FillStyle Image Scaleleft
BackColor Fond KeyPreview ScaleMode
BorderStyle FontBold Lift ScaleTop
Caption Fontltalic LinkMode ScaleWidth
ClipControls FontName LinkTopik ShowlInTaskbar
ControlBox FontSize MaxButton Tag

Controls FontStrikeThru MDIChild Top

Count FontTransparent  MinButton Visible

CurrentX FontUnderline Mouselcon WhatsThisButton
Currenty ForeColor MousePointer WhatsThisHelp
DrawMode hDC Moveable Width

DrawStyle Height Name WindowState

Su yokarky formanyn hésiyetleri birbada kop bolup goériinydn bolmagy miimkindir, emma olardan
kébirleri has kop ulanylyandyr, beylekileri ki halatlarda ulanylyar, sonuni iicin hem olaryn atlary
hésiyetler penjiresinde hem getirilen déldir.

Indi bolsa kébir kdp ulanylyan hésiyetlere seredip gegelin:
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BackColor —-onuii bilen formanyn diiseginin refiki berilydr, ony iki sapar bassai miimin bolan
saylamaly renkler ¢ykar.

BorderStyle —hidsiyet bilen formanyn dasynyn cigi kesgitlenyir, ol alty gorniisde berilip bilner: 0-
None bolsa, formanyn mdgberi, yerlesyéin yeri tiytgemeli déldir, formanyn atlandyrylysy bolmaly daldir;
1-Fixed Signle bolsa, gyralaryndan tutyp formanyn mdogberini liytgedip bolmayar, formany agyp, yygnap
goymak belgisinden peydalanyp bolar; 2-Sizable bolsa, gyralaryndan(ya-da at berilydn belgiler arkaly)
tutyp formanyn mogberini tiytgedip bolyar, WINDOWS-yn kop penjireleri seyledir; 3-Fixed Dialog bolsa
esasanam isleyéanler bilen geplesik su baha bilen amala agyrylyar; 4- Fixed TollWindow bolsa edil 6iiki yaly,
yone yapys belligi gosulyar. A seyle bolanda meseleler paneled gorkezilmeyér; 5- Sizable TollWindow
bolsa edil 2 diki yaly, yone yygnamak we agmak belgisi-[J bolmayar.

Caption - hidsiyet bilen formanyn ady c¢ykarylyan yazgy kesgitleyiar. Eger BorderStyle hésiyetde None
bolsa, onda formanyi ady yiter.

ControlBox — hésiyetin bahasy True ya-da False bahalar bolup biler. BorderStyle, ControlBox, MaxButton We
MinButton hésiyetler 6zara baglanyklydyrlar.Birini ayyrsain beylekisi formada bolmaz. Mysal
ticin, taslamadaky formada ControlBox-hdsiyetde False Dbersek formany yygnamak- ,
ulaltmak-kiceltmek, yapmak X belgiler bolmaz.

ForeColor — hisiyet bilen formada yerleirilydn obyektlere-yazgylara capa ¢ykarylanda reiik berilyar.
Formanyn 6ziiniii refiki BackColor bilen berilydr. Height — hésiyet bilen formanyn dikliginin
mogberi berilydar. Ony formanyn ¢etini ¢gekmek bilen konstuktirlemek diizgiinde berip bolar.
Height — hisiyet-de ayratyn gorkezilmese(Width, Left, Top hisiyetlerde hem ) dikligi
bermegin birligi twips — de berilyar. Width — bilen formanyn keseliginii mogberi berilyér.

Icon — hisiyet bilen forma ii¢in belgijik berip bolar ony Visual Basic goyulanda \Graphics\lcons
bukjalardan tapyp islénini saylap formanyn adynyn 6niine goyup bolar.

Left — hasiyet edil Height, width yalydyr, ol forma bilen ekranyn g¢epinii aralalygy berilyar. Bu hésiyet
kopleng Top hisiyet( ol ekranyin yokarsy bilen forma c¢enli aralygy kesgitleyir) bilen

utgasdyrylyp berilyir.

MaxButton — hésiyet bilen formany ulaldyp kigeldip bolyan belgi - (3, True bolsa berilyir, False bolsa ol
islemez.

MinButton - hésiyet bilen formany etege yygnap bolyan belgi - — , True bolsa berilyir, False bolsa forma

etege yygnalmaz.

Name — hésiyet bilen doéreden formana at berip bolar, ol isde yeke tdk bolmaly, onun oniinden frm.
Gosundy gosulyandyr, Mysal {igin, frmSalam  yazylys formanyn ady Salam-dyr.

ScaleMode — hésiyet bilen formada bar bolan elementlere her hili(ol sekiz sany gorniisli) 6l¢eg birlik berip
bolar, Left, Height, Width we Top hésiyetler bilen élgegler twips —de berilyér, ony pikselde berjek
bolsan 3-Pixel bermeli.

ShowInTaskbar - hésiyet bilen meseleler panelinden formany ayryp bolar. Eger sizin formanyzy
bagga birinift gormegini islemesefiiz, onun sag tarapyndaky setrde False goyun. Ony
programma yerine yetirilydrkd hem goyup bolar.

WindowState - hisiyet bilen forma ise girizilydrkd onunl yagdayyny kesgitleyir. Ol yagday {i¢ gorniisde
bolup biler: 0-Normal —forma adatdaky yagdayda agylyar, 1-Minimized-forma yygnalan
yagdayda agylyar, 2-Maximized - forma doly ekrandaky yagdayda agylyar.

Mazmuna gecmek.

2.3.Formalaryn hasiyetlerininl diiziilisi

Visual Basic-de formalaryn kop hésiyetlerini yerine yetirilydn wagty, seyle hem konstruirlenyérka
hem berip bolar. Kabir hésiyetler difie konstruirlenyérkd berip bolyar, ony dinie yerne yetirilyarka okap
bolyar.

Isleri yerine yetirmegin yzygiderligine mysal:

1. Visual Basic-e girmeli.

2. Visual Basic-ii menyuyna baryp tdze taslama agmaly: File [INew Project. Hasiyetler penjirede

Name setirin sagynda frmForm1 yazmaly. Caption —yn sagynda hem Salam diyip yazmaly.
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3. Cepdiki elementler panelindédki bos bellige iki sapar basmaly, sonda ol bellik formada yerleser.
Hisiyetlerddki Name yazgynyn sagynda cmdSalam diyip, Caption yazgynyil sagyna &Salam
yazmaly.
4. Formadaly bellige iki sapar bassak cmdHello_Click proseduraly programmaly penjire agylar. Ona
proseduranyn su bolegini yazalyn

If frmForm1.Caption = "Salam" Then
frmForm1.Caption = "Aleykim"

Else
frmForm1.Caption = "Salam"
End If
Onun ekrandaky gorniisi
M Project] - fimForm1 [Code] =B
|cmdHelio | [cliek |
Frivate Zub cmdHello Clicki) =
If frwForml.Caption = "3alam™ Then |
frwForml.Caption = "hleykim®™
Else
frwForml.Caption = "3alam®™
End If
End Sub
|
== b

. Salam

Indiki mysalda programmadaky prosedurany seyle liytgedelin

Private Sub cmdHello_Click()

If frmForm1.Caption = "Salam" Then
frmForm1.Caption = "Aleykim"
cmdHello.Caption = "&Salam”

Else

frmForm1.Caption = "Salam”
cmdHello.Caption = "&Aleykim"

End If

End Sub

Seyle yazsak belgiddki Salamy bassak formanyn ady Aleyk bolar ya-da tersine, onun programma
yazgysynyi gorniisi



M Project] - frmFaorml [Code]

Form j |Luad j

Priwvate Zub cmdHello Clicki() Il
If frwForml.Caption = "ZJalaun™ Then
frwmForml.Caption = "Alevykim"
cidHello.Caption = "&3alam™

El=e

frwForml.Caption = "ZJalsm™
cidHello.Caption = "&dleyvkim™

End If

End Sub

Priwvate Zub Form Losdi() —
cidHello.Caption = "&dleyvkim™

il i

Her sapar su yokarky programma yazynyi netijesini bilmek iicin Run[IStart isi amal edip gérmeli
sonda forma we ondaky belgi ekrana geler. Eger Start yazgy isjen bolmasa, onuil asagyndaky su yazgyly
setirlerin Break, End, Restart haysam bolsa birini basybam netijéni goriip bolar.

Mazmuna ge¢cmek.

2.4 Formadaky isler

Windowsda amallar ulgamynda programmalar isler bilen dolandyrylyar. Is maglumat almak bilen
yiize ¢ykyar. Forma bilen baglanysykly islerin atlary asakdaky sanawda getirilendir

Activate KeyDown LostFocus OLESetData
Click KeyPress MouseDown OLEStartDrag
DblIClick KeyUp MouseMove Paint
Deactivate LinkClose MouseUp QueryUnload
DragDrop LinkError OLECompleteDrag Resize
DragOver LinkExecute OLEDragDrop Terminate
GotFocus LinkOpen OLEDragOver Unload
Initialize Load OLEGiveFeedback

Su atlandyrylyan islerin dine garaldylany has kop ulanylyar, galanlary has c¢ylsyrymly
programmalar yazylanda peydalanylyar.
Forma bilen baglanysykly islerin sanawy asakdaky penjirede getirilendir

M Project] - frmForm [Code]

|Furm ﬂ |Luad
frmForml . Caption I
P . LostFocus ﬂ
ciwdHello.Caption FhaLseDnwn
Else oL etdoe
frmForml . Caption Arlouszellp
cidHello . Caption JOLECampletelbrag
End If CLEDragDrop
End Suhb CLEDragwer
L EGiveFeedback
CLESetDiat —
Priwarte ZJub Form I OLEStar‘tDraag
cmdHello. Caption Spgint -
End Sub
=
== 4« »

Sagdaky cykan sanawdaky isler boyunc¢a programma yazgysyny yazmak iicin anyklama
maglumatyny, onu yazylys diizgiinini bilmek ii¢in, ol setirin listiine ge¢ip F1 basmak yeterlikdir.
Indi bolsa su yokarky islerin kdbirlerine seredip gegelii
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Activate isi, ol Forma ise girizilenden son bolyar, seylelikde Forma Load is bilen okalmaly. Eger
Formadan bagga Forma gecilende, soni yene 6nki Forma gecilende Load i3 bolmaz.
Deactivate isi Activate igin tersidir, ol Forma isjent bolmagyny bes etse bolyar, ony Formanyn adynyn
diitie beren renkinden bilip bolyar.
DragDrop isi Forma elementi siiyrdp “zynanynda’ bolyar. Ol is ligin hokmany suratda zynylmaly element
bolmaly.
Load isi Initialize isden son bolyar, Activate isden 6n bolyar. Onyn bilen Formanyn atriburyna degisli
maglumatlary kesgirldp bolar, Mysal {i¢in, Formany ekranyn ortasynda yerlesdirmek yaly.
Resize isi ulanyjy Formanyn mogberini iiytgedende bolup gegydr. Ol kdpleng su iki maksat {icin
peydalanylyar:
o Formada yerlesdirilen dolandyrys elementlerine 6lgeg bermekde.
o Formanyn deslapky 6lgegini dikeltmekde.
Unload isi Load ise tersdir, ol kopleng agylan Formany yapjakmy diyip sorayar. Ol isin adynyil yzyndan
mydama Cansel As Integer argument gelyar. Bu igin amal edilisine seredelin:
1. Visual Basic-e girmeli.
2. Visual Basic-iit menyuyna baryp tdze taslama agmaly: File [INew Project.
3. Formal baryp iki sapar bassan programma yazylyan penjire ¢ykar, onia Unload degisli amal

edilmeli su yazgyny yazmaly

Private Sub Form_Unload(Cancel As Integer)
If MsgBox("dogrymy", vbYesNo, _

"chykmaly") = vbYes Then

Unload Me
Set Form1 = Nothing

Else

Cancel =1

End If
End Sub
4. Programmany yapmaly, menyudaky Run[IStart bassain su bos Formal ekrana geler.

Formal-in yokarsyndaky X belgini bassaii ekrana sorag-jogap Unload isifi yerine
yetirilisi geler

i =[o]x]
|Furm j |Unluad j
Priwvate 3ub Form Unload(Cancel As Integé, |
If MsgBox ("dogrymy", wvhb¥VesMNo, Il
"ochyknaly™) = wh¥es Then
Tnload He
Set Forml = Nothing
Elzse: Cancel = 1
End If
End 3Sub
E.

chukrnaly

dogrymy

Mazmuna gecmek.

2.5.Formalalar usuly

Visual Basic-de usul munyn 6zi obyekte berilyyan buyrukdyr. Usulyn komegi bilen obyekte ol ya-
da beyleki hereketi etmegi buyrmak miimkindir. Forma bilen baglanysykly usullaryin sanawy asakda
getirilendir.
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Circle Move PSet TextHeight
Cls PaintPicture  Refresh TextWidth
Hide Point Scale Unload
ltem Print SetFocus ZOrder
Line PrintForm Show

Hide, Show we Unload usullar Formalar bilen has k&p ulanylyanlar bolup duryar.
Mazmuna gecmek.

2.6.K6p resminamaly Forma-lar bilen islemek

Kop resminamaly Formalara MDI-formalar diyilydr. MDI-nini interfeysi esasy konteyner-penjrdinin
icinde birbada birnd¢e penjire acmaga miimkingilik beryar. Ona mysal edip MS Word yazgy redaktoryn
icinde birnice resminama agyp, biri-birinden gegip islip bolyar. Ahli agylan resminamalar MS Word-da
birigyérlar. Visual Basic-de seyle kopresminamaly isleri doretmek isi yonekeydir.

Mazmuna gecmek.

2.7.MDI-gosundynyn doredilisi

MDI-gosundynyn doretmek ticin it azyndan iki Forma, yagny konteyner we onun igine degisli
Forma bolmaly. Doredilisininl yzygiderligi seylerdkdir:

1.Visual Basic-e girmeli.

2.Visual Basic-iii menyuyna baryp tdze taslama agmaly, 61 File[INew Project gecmeli ya-da agylan
faylly penjire bar bolsa Standart EXE taslamany saylamaly,.

3.Déredilen taslamada ilkibada bir Forma bolyar. Hésiyetlerde Name frmChild, Caption hésiyete Ichki
Forma MDI hidsiyet bermeli.

4.MDI-den esasy Forma doretmek tii¢in taslama dpisgd baryp Forms yazga baryp sy¢anyi sag gulagyny
basmaly, ¢ykan yazgyly penjirede AddTIMDI Form buyrugy yerine yetirmeli, ekranda Form Wizard
penjire geler

5.0ndan NewIIMDI Form ge¢meli, Caption hisiyete Ichki Forma MDI yazgy bermeli.

6.Taslama &piggd baryp Projectl setire baryp sycanyn sag gulagyny basmaly, ¢ykan menyudan
Projectl Properties yazgyny saylamaly. Onun netijesinde agylan penjiredaki Startup Objekt —
daki penjirejikdéki sanawdan frmMDI saylamaly, OK basmaly.

7.Taslama penjirede frmChild setire gegmeli. Asakdaky hésiyetler penjirede MDI Child setiri tapyp ona
True baha bermeli. Peykamy Formalaryi iistiine gecirmeli.

8.Umumy menyudan Tools[IMenu Editor setiri ise girizmeli, sonda agsakdaky menyu redaktory ekrana
geler.

ke Editar

E
Zapkion; || Ik
Marme: | Cancel
Index: I— Shiorteut: ||{N|:une]| ﬂ
HelponkextID; llji MeqgotiabePosition: Im

[ Checked [v Enabled [v Wisible [ windowdList

ﬂ ﬂ ﬂ ﬂ ek | Inserk | Delete |

Menyu redaktory.
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Menyu redaktory bilen gosundynyn doredilisinin yzygiderligi:
1. Caption penjirejige &File yazgy yazmaly.
2. Name penjirejige mnuFile yazmaly.
3. Next yazgyly belligi basmaly.
4. =>» -seyle peykamy basmaly, buyruk menyu setirde kopnokatly aralyk yiize ¢ykar.
5. Caption penjirejige &New Form yazgy yazmaly.
6. Name penjirejige mnuFileNew yazmaly.
7. Redaktory OK basyp yapmaly.
8. frmMDI Forma-da File menyu ¢ykar.

ki “Talx]

Yokarky ekrandaky File>New Form

E -[al x|
ol Project] - frmbkdD1 [MODIForm]
] ]

-8 Ezasp Forma MDl  MIETEA 1

Hew Form

yerine yetirseni ekranda programma penjiresi yiize ¢ykar.
9.0na seyle yazgy yazalyi

Private Sub mnuFileNew_Click()
Dim frm As New frmChild
frm.Show

End Sub

10.Taslamany yatda saklamaly we ise girizmeli, sonda seyle penjireler ekrana geler

‘8 Ezazy FomaMDl HEEBR
Filz

g REE| N
¥ |chkiF.. MEHE

=

Her sapar Esasy Forma MDI -déky File>»New Form agsak tdze Ichki Forma agylar.
Yokarky isimizin has onayly tize gorniisini, yagny agylan tize formalaryn ekranda her hili
yerlesisini gorkezelin:
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Onki frmMDI baryp menyu redaktoryny ise girizmeli(Tools[IMenu Editor). FrmMDI-diki
menyularyn {stiine Caption &Window yazmaly, Name mnuWindow yazmaly, WindowList-ifi 6niitinde
bellik etmeli, Next basmaly.
Menyua tidze Tile we Cascade buyruklary gosmaly(Caption &Tile yazmaly, Name mnuWindowTile
yazmaly, Next basmaly, Caption &Cascade yazmaly, Name mnuWindowCascade yazmaly).
Menyu redaktoryny OK basyp ¢cykmaly.
mnuWindowTile-déki Click ise su yazgyny gosmaly

frmMDI.Arrange vbTileHorizontal
mnuWindowCascade-déki Click ise su yazgyny gosmaly

frmMDI.Arrange vbCascade

Bu yerde vbTileHorizontal, voCascade hemiselikler Visual Basic-ifi i¢ki hemiselikleridir.

6.mnuFileNew buyruk {i¢in programma yazgysyny seyle tiytgetmeli

Private Sub mnuFileNew_Click()
Static Counter As Integer
Dim frm As New frmChild
Counter = Counter + 1
frm.Caption = "Ichki Forma MDI" & Counter
frm.Show
End Sub

7.Yazan programmaiy we taslamany yatda saklamaly
8.Run[]Start bassak seyle is penjiresi ekrana geler

‘@ Ezazy Forma MD|
File Windmw Tile LCazcade

Formadaky File baryp New File girip, birndge Ichki Forma agalyn, goy ol 4 sany bolsun. Menyudaky
Window agsak sol agylan icki formalaryn sany we onyn haysysynyn igjenligi gorkeziler, mysal {igin

‘@ Ezasy Forma MDI
File | wWindow Tile Cazcade
£ 1 lchki Forma kDI

2 lchki Forma kDI2
2 lchki Forma kDI
v 4 |chki Forma MDI4

Menyudaky Tile gecip ony agsak is ekrany seyle gorniise geler, yagny dhli agylan Formalar ekranda
goriiner yaly yerlesdiriler



‘& Ezaszy Forma MDI
File “Window Tile Cazcade

‘¥ |chki Forma MD14 M= E ] =1

& —lolx|| & =o]]

Menyudaky Tile gegip ony agsak is ekrany seyle gorniise geler, yagny &hli agylan Formalar ekranda
yzly-yzyna ady goriiner yaly yerlesdiriler

¥ |chki Forma D14

Mazmuna gecmek

2.8.Wizard(ussat) Formanyn peydalanylysy

Visual Basic-e Forma doretmek isi, ony taslama gosmak yenillesdirilendir. Onun {igin taslama
dpisgé baryp sycanyn sag gulagyny basmaly, ekrana ¢ykan menyudan Add>Form agsak Wizard Formanyn
Add Forma is penjiresi agylar



Add Farm

Mew l Esizting ]

o
s\ [ N

il BN

YEB Daka Form Abouk Dialog WWeb Browser
Wizard

Dialog Log in Dialog Splash Screen Tip of the Day =

Otepeme

OTreHa

i,

Crnpaera

[ Dan't show thiz dialog in the fubure

Wizard Forma-nyi penjiresi

Yokarky penjireden gorniisi yaly by yerde her hili doredilmeli tayyar penjirelerini tayyar iliiileri

toparlandyrylyp getirilendir, olaryn gereklisini saylamak yeterlikdir, sonda onun programma iipjiin¢iligi
sol Forma ti¢in awtomatiki Visual Basic tarapyndan dorediler.

Su isin amal edilisini asakdaky taslamada gorkezeliii:

1. Taslama dpisgéd baryp baryp sycanyn sag gulagyny basmaly, ekrana ¢ykan menyudan Add>Form

agsak Wizard Formanyn Add Forma is penjiresi agylar.

2. Taslama Add Forma is penjiresindéki About Dialog belgili Formany saylalyn. Tédze forma frmAbout at

3.
4.

o

9.

10.

11.
12.

beriler.

Taslama penjiresindédki frmMDI baryp, ona iki sapar basyp ony isjenlesdirelin.

Menyu redaktoryny cagyrmaly, &New Form yazgynyn yanyndaky bos yere baryp sycanyn
gulagyny basmaly, sonda ... nokatly yazgy bolmaly dél, bar bolsa menyudaky peykam bilen
ayyrmaly. Caption hésiyete &Help, Name bolsa mnuHelp yazgy bermeli.

Téze buyrugy gosmak licin Next yazgyny basmaly.

mnuHelp yazga tdze buyruk gosmak iicin menyudaky sag peykamy basmaly. Caption hasiyete
&About, Name bolsa mnuHelpAbout yazgy bermeli. Menyu redaktory OK basyp yapmaly.

Taslama penjiresine baryp sycanyn sag gulagyny basyp ¢ykan sanawdan Projectl Properties
buyrugy basmaly.

Cykan penjireden Make gata gecmeli.

Title meydan¢a MDI-goshunda mysal yazgy yazmaly.

Version Information topardaky Type sanawdan Company Name edaranyzyn adyny Value meydanga
girizmeli.

Type sanawdan Product Name setri tapyp MDI goshundy yazgyny yazmaly, OK basyp yapmaly.
Programma penjréni agmak ticin MDI Forma-nyn menyundan Help> About buyrugy yerine yetirmeli.

13.mnuAbout_Click() ise asakdaky setri gosmaly frmAbout.Show vbModal
14.Menyudaky Run] [Start bassai About geplesik penjiresi ekrana geler



w. About MD| goshundy

| % kD gozhundy

Werzion 1.0.0
App Description

Wwharning: ..

System [nfo...

Mazmuna gecmek.

3.Visual Basic-de dolandyrys elementlerini saylamak we peydalanmak

Visual Basic-de dolandyrys elementlerinin paneli, kopleng ekranyn ¢ep taraynda yerlesyar,
asakdaky gorniise eyedir

Grrafik mesrdarsy
Y azgy meydany
Carenara u JA R Enopkahelgi
Bardajyk W & —— Gering
Utgagdytylan EE EE 1 S atiaw
mewdan -
Eese dolatys 48 5 1 Dik dolatiys zolagy
1 o
oty ) & —4— Disklerifi sanawy
Wagt gitkeniji
i —1— Fayllaryfi sanawy
Bulijalat satnawy
qekil —1— Cyzyk
Surat —1— DMlaglumatlar elementi
OLE elementi

OVisual Basic-de elementler paneli

Visual Basic-de "= -su belgi(knopka) ifi bir umumy element bolup, onuii kémegi bilen Formada
her hili isleri amal edyén yazgyly belgi goyulyar.
Mazmuna gecmek.

3.1.Knopkalar
Knopkalarynl hésiyetleri

Forma degisli knopkalaryn hésiyetlerinin sanawy asakda getirilendir, bir knopkany beyleki
knopkadan tapawutlandyryan méhiim hésiyet Name we Caption bolup duryar.

Appearanke Enabled hwnd Style
BackColor Font Indeh TablIndex
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Cancel FontBold Left TabStop
Caption Fontltalic MaskColor Tag
CausesValidation ~ FontName Mouselcon ToolTipText
Container FontSize MousePointer ~ Top

Dafault FontStrikethru Name UseMaskColor
DisabledPicture FontUnderline OLEDropMode Value
DownPicture ForeColor Parent Visible

Draglcon Height Picture WhatsThisHelpID
DragMode HelpContextID RightToLeft Width

Bu yerde has kop ulanylyan Name hisiyet bilen at berilydr, Caption bilen ona yazgy berilyir, ol
yazgynyn oOnilinden &«ampersand» belgini goysak sycanyin peykamynyn ornuna klawiaturadaky
diiwméiniulanyp bolyar.

Knopkanyn Cancel we Dafault hésiyetleri hem has kép ulanylyandyr. Eger Dafault—yn bahasy True
bolsa, onda Enter(+' ) diwmaéni basmak, knopkany basmakdyr. Eger Cancel -bahasy True bolsa, onda Esc
diiwmaéni basmak, ol Forma yapylar.

Formadaky knopkada Style hésiyet bersek, onda ona hi¢ zat yazman ya-da ona surat yerlesdirip
bolar.Knopkany basmadyk yagdayymyzda surat bolmagy ii¢in Picture hésiyet bermeli.Knopka basga
yagdaylarda suratlary bermek {i¢in DisabledPicture we DownPicture hisiyetler bermeli.

Enabled, Visible hésiyetler bilen knopka girmekligi ¢édklendirip bolar. Onun {igin olara False baha
bermeli.

Tabindex hisiyet bilen klawiaturadaky Tab diiwmaénin igini dolandyryp bolar.

Mazmuna ge¢cmek.

Knopkalardaky isler

Kopleng knopkalar bilen baglanysykly islerde Click ulanylyar. Bu isler knopkalara degisli
programma prosedurany yazmaga degislidir. Knopkalar bilen baglanysykly isleriii sanawy asakakylardyr.

Click KeyPress MouseUp OLESetData
DragDrop KeyUp OLECompleteDrag OLEStartDrag
DragOver LostFocus OLEDragDrop
GotFocus MouseDown OLEDragOver
KeyDown MouseMove OLEGiveFeedback
Mazmuna ge¢mek.
Knopkalar usulyeti

Knopkalar usulyeti bilen baglanysykly adalgalar hokmiinde ulanylyan sozler asakdakylardyr

Drag OLEDrag SetFocus ZOrder
Move ORefresh ShowWhatsThis
Bu sanawdan has kop ulanylyany SetFocus  sozdiir. Onuil kdmegi bilen anyk knopka {insi

bermek {i¢in peydalanylyar.
Mazmuna ge¢cmek.

3.2.Yazgy meydany

Visual Basic-in islendik taslamasynda in bolmanda bir yazgy meydany berilydr. Ol elementler
panelindéki [abl-su belgi bilen berilyir. Ol yerde maglumatlar girizilyyir ya-da ulanyjydan maglumat
almakda peydalanylyar. Onun {icin yazgy meydanynyn hésiyeti saylanyp alynmalydyr. Maglumatlary
yonekeyje gorniisde girizmek isleseniiz InputBox bilen ¢éklensent hem bolar. Seyle etseiliz programma ise
girizilende maglumaty girizmegi talap edip, ondan son programma gaydyp geler.

Mazmuna ge¢cmek.

Yazgy meydanynyn hisiyeti

Yazgy meydanynyn hisiyetleri asakdaky sanawda getirilendir, olardan has kop ulanylyanlary
garaldyp gorkezilendir.
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Alignment Font Linkltem RightToLeft
Appearanke FontBold LinkMode ScrollBars
BackColor Fontltalic LinkTimeout SelLength
BorderStyle FontName LinkTopic SelStart
CausesValidation Font Size Locked SelText
Container FontStrikethru  MaxLength Tablndex
DataChanged FontUnderline  Mouselcon TabStop
DataField ForeColor MousePointer  Tag
DataFormat Height MultiLine Text
DataMember HelpContextID Name ToolTipText
DataSource HideSelection = OLEDragMode Top
Draglcon hwnd OLEDropMode Visible
DragMode Index Parent WhatsThisHelpID
Enabled Left PasswordChar  Width

Yazgy meydanlary Name hisiyet bermek bilen baslanyar, bu hisiyetli yazgylar txt. Gineltme bilen
baslanyar. Olarda Caption hésiyet bolyan déldir, ol Text hdsiyet bilen kesgitlenyér.

MaxLength hisiyet bilen yazgy meydana girizilmeli sekillerin uzynlygy kesgitlenyér, ol adatca
PasswordChar hésiyet bilen bilelikde utgasdyrylyp peydalanylyar. Bu yerde onuil uzynlugy parolda *-
bilen berilydr. MaxLength we PasswordChar hésiyetler formalarynl yazgy meydanynda ulanyjylary
bellige almak {i¢in niyetlenilendir.

MultiLine  hédsiyet birndce setirden ybarat bolan yazgylary girizmige miimkingilik beryér. Eger ol
ScrollBars  hisiyet bilen utgasdyrylyp ulanylsa , onda meydan hi¢ hili kodlanmazdan yonekey yazgy
redaktoryna owriilyér.

SelLength,SelStart we SelText hisiyetler belgilenen yazgylar bilen islemek ii¢in niyetlenilendir.

Mazmuna ge¢cmek.

Yazgy meydanlaryndaky isler

Yazgy meydanlary asakdaky sanawdaky isleri amal edip bolar

Change  KeyDown LinkOpen OLEDragOver
Click KeyPress LostFocus OLEGiveFeedback
DbIClick  KeyUp MouseDown OLESetData
DragDrop  LinkClose = MouseMove OLEStartDrag

DragOver  LinkError ~ OLECompleteDrag Validate
GotFocus  LinkNotify OLEDragDrop

Bu yerde Change is yazgy meydanyndan sekili goyjak ya-da ayyrjak bolsail her sapar yiize
¢cykyar.
Mazmuna ge¢cmek.

Yazgy meydanlar usulyeti

Yazgy meydanlar usulyetine degisli adalgalar asakda getirilendir

Drag LinkReguest ~ OLEDrag ShowWhatsThis
LinkExecute LinkSend Refresh Zorder
LinkPoke Move SetFocus

Bularyn kopiisi ki halatlarda ulanylyar. Yoéne Link...usulyet yazgy meydany DDE(Dynamic Data
Exchange) protokoly arkaly maglumat alys ¢alysylygynyil dinamikasyna gatnasyarlar. SetFocus
usulyet bolsa gosundylarda has kop ulanylyar.

Mazmuna gecmek.
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3.3.Yazgylar

A -yazgy, ol yazgy meydanyna menzesdir, ol hem yazgyny ¢ykarmakda peydalanylyar. Ulanyjy bu
yerde 0z islegine gord yazgyny iiytgedip bilmez. Yazgyda esasy hdsiyet Caption bolup duryar(Text
bilen garysdyrmaly dél). Mysal ti¢in, onunl yazylysy seylerdk bolar

A

Tabshyryp ady

I.-’-'-.sh_l,lr

Mazmuna gecmek.

Yazgylaryii hisiyeti

Yazgylara degisli ahli hisiyetler asakdaky sanawdan berilyar

Alignment DataSource Height Parent
Appearance  Draglcon Index RightToLeft
AutoSize DragMode Left Tablndex
BackColor Enabled Linkltem Tag

BackStyle Font LinkMode ToolTipText
BorderStyle  FontBold LinkNotify Top

Caption Fontltalic LinkTimeout UseMnemonic
Container FontName LinkTopic Visible
DataChanged  FontSize Mouselcon WhatsThisHelplD
DataField FontStrikethru MousePointer Width
DataFormat  FontUnderline Name WordWrap
DataMember  ForeColor OLEDropMode

Bu sanawdaky hisiyetlerden ift mohiimi Name bolup duryar. Yazgy atlary iicin Ibl. Ofiunden
gosundy ulanylyar. Ger yazgyda & belgi ulanylsa ona ylizlenmek caltlagdyrylyar.
Mazmuna ge¢cmek.

Yazgylarda isler
Yazgylardaky isler asakdaky standart sanaw bilen berilyar

Change  LinkClose MouseMove OLEGiveFeedback
Click LinkError MouseUp OLESetData
DbIClick  LinkNotify = OLECompleteDrag OLEStartDrag
DragDrop  LinkOpen OLEDragDrop
DragOver MouseDown OLEDragOver
Mazmuna ge¢mek.

Yazgylar usulyeti

Yazgylaryii hem 6z usulyeti bardyr, olar asakdaky sanaw bilen amal edilyr

Drag LinkRequest  OLEDrag ZOrder
LinkExecute LinkSend Refresh
LinkPoke Move ShowWhatsThis

Mazmuna gecmek.
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3.4.Geciris
Gegirislerin hésiyetleti

@ _gecirisler bilen bar bolan miimkingiliklerden difie birini saylap ofia ge¢mekligi amala
asyryar. Adatca olaryn topary ¢arguwa alynyar.

Alignment FontSize Picture
Appearance FontStrikethru  RightToLeft
BackColor FontUnderline  Style

Caption ForeColor TablIndex
CausesValidation  Height TabStop
Container HelpContexID  Tag
DisabledPicture hwnd ToolTipText
DownPicture Index Top

Draglcon Left UseMaskColor
DragMode MaskColor Value

Enabled Mouselcon Visible

Font MousePointer ~ WhatsThisHelpID
FontBold Name Widht

Fontltalic OLEDropMode

FontName Parent

Bu yerde esasy hiésiyet, gegirijinifi ady - Name bilen berilyir, ada opt. Hem gosulmaly. Caption

Mazmuna gecmek.

Gecirisler isi

Asakda gecirisler bilen isde ulanylyan adalgalaryn yazgylarydyr.

Click KeyDown MouseMove OLEGveFeedback
DbiClick  KeyPress MouseUp OLESetData
DragDrop  KeyUp OLECompleteDrag OLEStartDrag
DragOver | ostFocus OLEDragDrop Validate

GotFocus  MouseDown OLEDragOver
Bu yerde has kop ulanylyan is Click yazgydyr. Degisli
gecirijini bassan Click prosedurasy bolar, onda sertli gegme If ... End ya-da Select Case ... End Select
diizumler girizilendir.
Mazmuna ge¢cmek.

Gegirisler usuly

Visual Basic-de ulanylayjak gecirijiler usuly asakdaky sozler bilen berilip bilner.

Drag OLEDrag SetFocus ZOrder
Move Refresh ShowWhatsThis
Mazmuna gecmek.
3.5.Baydajyklar

Baydajyklar gurallar panelindiki ‘W!-belgijik bilen berilydr. Ol edil gecirijiler yalydyr, olaryn 6zara
tapawudy baydajyk ayratyn element hokmiinde peydalanylyar. Baydajyklarbiri-birine garassyz isleyérler.
Gegirijiler goyulandyr ya-da ayrylandyr. Baydajyklar bolsa ii¢ yagdayda goyulan, ayrylan we kesgitsiz
yagdayda bolup bilerler.

Baydajyklaryn dhli hisiyetleri agakdaky sozler bilen berilyér
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Alignment DownPicture Height RightToLeft
Appearance Draglcon HelpContextID  Style
BackColor DragMode hwnd Tablndex
Caption Enabled Index TabStop
CausesValidation Font Left Tag

Container FontBold MaskColor ToolTipText
DataChanged Fontltalic Mouselcon Top

DataField FontName MousePointer  UseMaskColor
DataFormat FontSize Name Value
DataMember FontStrikethru OLEDropMode Visible
DataSource FontUnderline Parent WhatsThisHelpID
DisabledPicture ForeColor Picture Width

Gegirislerdédki yaly bu yerde hem Name, Caption We Value esasy kop ulanylyan sozlerdir. Mysal
ticin, baydajyklar MS OFFICE-déki programmalar goyulandaky we ayrylandaky penjirede seyle gorniise
eyedir:

B FHonkM | Manend uHetpyrertos | Hactpoika |

Danene: [EilEs AobasHre dafin, |

OTIDpEKaTE KHOMKK;

W Micrusnft Ward
v %Micrusnrt Exocel

w Mil.ru:,I.lI'L Fumszr Pui il T |

AoEaEmTE Nanky.. .
|

Micrasoft Sutlzalk: ¥ 1 ANHT>

v EMicrusnFt Arcess

i JC:::3,a,aTb AokemeHt Office ﬂ
%OTKPI:ITI: AokymerT Office

v|!3KpaHHaq 3an_—re||En<a Jﬂ
P 9

Mozagor

MepeHMeEHOEATE, o

o |

Baydajyklaryn isi hem edil gecirijilerinn isine menzesdir, olar asakdaky sanawdaky sozler bilen
berilyér

JiraeHa |

Click KeyPress MoseUp OLESetData
DragDrop KeyUp OLECompleteDrag OLEStartDrag
DragOver LostFocs OLEDragDrop Validate
GotFocus MouseDown OLEDragOver

KeyDown MouseMove OLEGiveFeedback

Sycanyn peykamy bilen peydalanjak bolsan Click isden peydalanmaly.
Baydajyklar usuly hem edil gegirijiler usuly yaly sular bilen berilyar

Drag
Move

OLEDrag
Refresh

SetFocus ZOrder

ShowWhatsThis

3.6. Carcuwalar

Mazmuna gecmek.

Carguwalar bagga elementler bilen utgasdyrylyp, bilelikde ulanylyar, onun gurallar panelindéiki

belgilenisi - u Carcuwanyn i¢inde adatca gecirijiler ya-da baydajyklar yerlesdirilyér. Olar ol ¢arguwa
bilen bilelikde eylak-beyldk siiysirilydr. Gegirijini ya-da baydajygy ¢arcuwanyi i¢inde yerlesdirmek ii¢in,
onyn elementler panelindéki belgisine baryp bellik edip, peykamy bir sapar basyp ondan soni ony siiyrdp
carcuwanyn i¢ine eltmeli.Carguwanyn adynyn adatga gineldilmesi fra belgilemesidir.

Carcuwanyn hisiyetlerini asakdaky adalgalar bilen berip bolar.



Appearance
BackColor
BorderStyle
Caption
ClipControls
Container
Draglcon
DragMode
Enabled

Font

FontBold
Fontltalic
FontName
FontSize
FontStrikethru
FontUnderline
ForeColor
Height
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HelpContexID  RihhtToLeft

hwnd TablIndex

Index Tag

Left ToolTipText
Mouselcon Top
MousePointer Visible

Name WhatsThisHelpID
OLEDropMode Width

Parent

Carguwanyi esasy hisiyetlerinifi biri Name we Caption bolup duryar. Olar garguwa diunikli at
bermegi amal eder. Carguwanyr igindéki gegirijilerin ya-da baydajyklaryn ayratyn hasiyetlerini Caption bilen
berilyéar. Mysal {i¢in, Eltmeli garguwanyii icinde Adatca We Gyssagly gegirijileri goymak yerliklidir.

Carcuwalar asakdak getirilen birnige isleri goldayarlar

Click MouseMove OLEGiveFeedback
DblClick MouseUp OLESetData
DragDrop OLECompleteDrag OLEStartDrag
DragOver OLEDragDrop

MouseDown OLEDragOver

Carcuwadaky isler orin seyrek ulanylyar. Olar difie obyektleri siiyridp ge¢irmekde ulanylyar.
Carcuwalar birnice usulyeti goldayar, olaryn adalga sozleri sulardyr

Drag
Move

OLEDrag
Refresh

ShowWhatsThis
ZOrder

Mazmuna gecmek.

3.7. Sanawlar

WINDOWS ulgamda sanawlar has kop ulanylyan guraldyr. Ol birndge wariantly sanaw bilen
islemegiii gowy serisdesidir. Sanawyii gurallar panelindiki belgisi -EH. Ulanyjy sanawdan bir ya-da
birndge geregini onun sagyndaky asaky ya-da yokarky peykamy basyp saylap alyp biler.

Sanawlaryn kop hésiyetleri utgasdyrylan meydanlarda bolyarlar, olarsyz asaky elementleriii
miimkingiligi durmusa gecirilip bilinmez.

Appearance
BackOColor
CausesValidation
Columns
Container
DataChanged
DataField
DataFormat
DataM00ember
DataSource
Draglcon
DragMode
Enabled

Font

FontBold
Fontltalic
FondName
FontSize
FontStrikethru
FontUnderline
ForeColor
Height
HelpContextlD
hwnd

Index
IntegralHeight
ItemData

Left

List
ListCount
ListIndex
Mouselcon
MousePointer
MultiSelect
Name
NewIndex
OLEDragMode
Parent
RightToLeft
SelCount
Selecdet
Sorted

Style
Tablndex
TabStop
Tag

Text
ToolTipText
Top
Toplndex
Visible
WhatsThishelplD
Width

Sanawlaryn Columns hésiyeti birndge siitiinden ybarat tablisa gérniisde sanawlar doretmége
miimkingilikler beryér. List -hdsiyet sanawa giryén setirit mazmunyny berydr ya-da yzyna gaytaryar.
Setirleri tertiplemek 0-dan baslanyp 1 san gosulyp artyar. List -hésiyet bilen islendik setiriii mazmunyny
kesgitldp bolar. Mysal {i¢in, ii¢ilinji setiriiit mazmunny su afilatma bilen kesgitldp bolar

LstlListl.List(2)

Boliinen setirin hizirki mazmuny Text hidsiyetde saklanylyar. Listindex

hisiyet belgilenen setirin

tertibini beryér. Eger belgilenen setir bolmasa Listindex bahasy 1-e dendir.
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LstListl.List(IstList1.Listindex)- afilatma bilen IstList1.Text yazgynyn sol bir bahalary bardyr.
Sanawa girizilenlerinn sofiky setirinini tertibi Newlindex hésiyetde saklanyar. ListCount hésiyet
sanawdaky setirlerin umumy mukdaryny beryar.
MultiSelect hdsiyet birbada birnége setiri ulanyjy belgildp bilmegini gorkezyir.
Selected hdsiyet logiki baha eyedir, onunn bahasy programma amal edilyiarkd belli bolyar. Onun
bahasy True ya-da False bolup biler.Mysal ii¢in, sanawdaky {igiinji setiri belgilemek seyle yazylyar

LstListl.Selecd(2) = True

2 san ti¢linji setire degislidir.
Sorted hisiyet difie konstruktirlemek diizglinde berilip bilner.
Sanawlar bilen is asakdaky adalgalar bilen berilyir ya-da olar bilen goldanyar.

Click KeyDown MouseUp OLEStartDrag
DblClick KeyPress OLECompleteDrag Scroll
DragDrop KeyUp OLEDragDrop Validate

DragOver LostFocus OLEDragOver
GotFocus MouseDown OLEGiveFeedback
ItemCheck MouseMove OLESetData

Kopleng sanawlar bilen is ligin DbiClick ulanylmagy dhtimaldyr.
Sanawlar bilen usulyetde asakdaky adalgalar ulanylyp bilner

Addltem Move SetFocus
Clear Refresh ShowWhatsThis
Drag Removeltem ZOrder

Bu yerde Additem, Clear we Removeltem yaly ii¢ usulyet koprik ulanylyar. Birinjisi setiri sanawa
gosmak ticindir, Removeltem bolsa setiri sanawdan ayyrmak ticindir. Tutus sanawy ayyrmak ugin bolsa
Clear ulanylyar.

Mysal {igin, AddItem usulynyil yazylysy seyledir

LstList.AddItem “Salam”
Bu bélek “Salam” setirini sanawa gosyar. Eger seyle yazsak

LstList.AddItem “Salam”, 3
“Salam” setri sanawyn 4-nji yerinde yerlesdiriler. Eger tertibi berilmese ol sanawyil soiflunda
yerlesdiriler.
Mazmuna ge¢cmek.

Sanawlar bilen islemeklige mysal

Sanawlar bilen islemekligi asakdaky mysalda gorkezelin.

1.Visual Basic maksatnama girmeli. File » New Project buyrugy amal edip tdze taslama doretmeli.
Agylan Project Wizard penjirede Standard.EXE belgijigi saylamaly.

2.Gurallar panelindiki EB-belgini basyp Formal penjirede iki sany sanaw doretmeli.

3.Birinji sanawy penjranini yokarysynda ikinjisini penjrinin asaky eteginde siiysirip yerlesdirmeli,
onun gorniisi seyledir



_3 w. Project] - Formd [Form]

General |

w. Form
N BB |

ATl o

S R (T L

IF'F ............................

EEEE v|
4|r|=! I'I I Ll

4.Formal —e baryp iki sapar sycanyn c¢ep gulagyny bassi programma penjiresi agylar. Load is

prosedurasyna asakdaky programma bolegini gosmaly
Private Sub Form_Load()
Listl.Addltem "Ashyr"
Listl.AddIltem "Chary"
Listl.Addltem "Muhammet"
Listl.AddItem "Ayna"
End Sub
5.List1 degisli sanawa DblClick is prosedurasy bilen su bdlegi gosmaly
Private Sub List1_DbIClick()
‘Setri bashga sanawa goshmaly
List2.AddItem Listl.Text

'‘Sanawdan setri ayyrmaly
Listl.Removeltem Listl.Listindex
End Sub
6.List2 degisli sanawa DblClick is prosedurasy bilen su bolegi gogmaly
Private Sub List2_DbIClick()
'Setri bashga sanawa goshmaly
Listl.Addltem List2.Text

‘Sanawdan setri ayyrmaly
List2.Removeltem List2.ListIndex
End Sub

7.Run » Start basyp programmany ise girizmeli. Sonda ekranda sanawly seyle penjire bolar

w. Form - [Of x|

Ashyr yazylan yazgynyn iistiine peykamy eltip iki sapar bassak, ol setirdiki yazgy asakdaky sanawa
gecer, asakdaky sanawa gecen setirinl Uistline peykamy eltip iki sapar bassak ol yazgy yokarky sanawa
gecer, onun gorniisi seyledir
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. Forml

Mazmuna gecmek.

3.8. Utgasdyrylan meydanlar

Gurallar panalinde utgasdyrylan meydanlar yazgy meydanlar bilen sanawlaryn mimkingiliklerini

=R EB
utgasdyryar. Onun gurallar panelinddki belgisi we yazgysy - | {ComboBoxl, Utgasdyrylan meydan sanaw
bilen denesdirilende ondaky sanawly setirler ag¢ylyar. Konstruirlemek diizgiininde utgasdyrylan
meydanlaryn ti¢ gorniigine girip bolar:
a Agylyan utgasdyrylan meydan;
a Yonekey utgasdyrylan meydan;
a Agylyan sanawlar.
Meydanyn gorniisi Style hdsiyet bilen kesgitlenilydr. Ol standartlagsdyrylan utgasdyrylan meydan
barada bolup onunn DBCombo-maglumat gory bilen islemek ti¢in niyetlenileni hem bardyr.
Utgasdyrylan meydanlaryn hésiyeti asakdaky adalgalar-sozler bilen berilyér

Appearanke Fontltalic ListCount Style
BackColor FontName Listindex Tablndex
CausesValidation FontSize Locked TabStop
Container FontStrikethru  Mouselcon Tag
DataChanged FontUnderline  MousePointer  Text
DataField ForeColor Name ToolTipText
DataFormat Height NewlIndex Top
DataMember HelpContextiD OLEDragMode Toplndex
DataSource hwnd Parent Visible
Draglkon Index RigxtToLeft WhatsThisHelplD
DragMode IntegralHeight  SelLenght Width
Enabled Itemdata SelStart

Font Left Seltext

FontBold List Sorted

List, ListCount, Listindex, Newindex we Sorted hasiyetler edil sanawdaky hisiyetler yalydyr. Style
hésiyetin, onun tertibi 0,1,2 bolup degisli agylmalary gorkezyir.

aAcylyan birinji utgasdyrylan meydan adat¢a standart yazgy meydanyna menzesdir, onuni sagynda
peykamly diiwme bardyr, ulanyjy ony bassa ¢ykan sanawdan birini saylap biler ya-da meydana 6z
yazgysyny girizip biler.

oIkinji utgasdyrma yonekey utgasdyrylan meydan bolup, yokarkydan tapawydy, ol meydan mydam
acgylan yagdayda bolyar. Ol formada artykmac yer bar bolsa saylanyp alynyar.

o Sonky agylyan utgagdyrma adatga utgasdyrma bolman agylyan sanawa degisli.

Mazmuna gecmek.

Utgasdyrylan meydanlardaky isler

Utgasdyrylan meydanlary goldayan isleri goldayan adalgalar-sozler asakda getirilendir

Change DropDown  LostFocus OLESetData
Click GotFocus OlecompleteDrag OLEStartDrag
DbiClick KeyDown OLEDragDrop Scroli
DragDrop keyPrass OLEDragOver Validate
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DragOver KeyUp OLEGiveFeedback

Bu Verdiki kop isler basga elementlerde kop dusulyar. Yéne DropDown adalga difie su utgasdyrylan
meydana degislidir.
Change is bolsa ikinjide bolmayar, sebdbi yazgy meydanynda redaktirlemek bolmayar. DbiClick bolsa
yonekey sanawda bolyar.
Mazmuna gecmek.

Utgasdyrylan meydanlaryn usulyeti

Utgasdyrylan meydanlaryn usulyeti sanawlaryn usulyeti bilen gabat gelyér, onun adalgalary-sozleri

asakda getirilendir.
Addltem Move Removeltem ZOrder
Clear OLEDrag SetFocus
Drag Refresh ShowWhatsThis

Mazmuna gecmek.

3.9. Suratlar

Surat grafik meydanyn yonekeylesdirilen wariantydyr, onun faylynyn gineldilmesiniii gysgaltmasy

img  belgilenme bolup duryar. Gurallar panelinde belgileniligi - k&l Suratyn i¢inde basga sekil
yerlesdirilip bilinmez. Grafik meydan bilen denesdirilende surat husda az meydan eyeleyar.
Visual Basic topluma giryan surat-element asakdaky fayllardan ybarat bolup biler:

.BMP-rastr fayllardan;
.WMF-metafayllardan;
.co-belgijiklerden;
JPG- JPEG formatda;
.GIF — GIF formarda;
Mazmuna gecmek.

Suratlaryn hisiyeti

Suratlaryn hésiyeti asaky adalgalar bilen berilyér

Appearance Draglcon MousePointer Tag

BorderStyle DragMode  Name Top

Container Enabled OLEDragMode  Visible

DataField Height OLEDropMode  WhatsThisHelpID
DataFormat Index Parent Width
DataMember Left Picture

Datasource Mouselcon  Stretch

Kopleng surat fayllary ti¢in hésiyetler Picture bilen berilydr. Stretch hésiyet logiki bolup, onun
bahasy False bolsa onufi mdgberi sekilifi mogberine awtomatiki dogurlanyar. True bolsa gerek mogbere
gogurlanyar.

Mazmuna gecmek.

Suratlardaky isler

Suratlardaky isler programma prosedurasynda asakdaky adalgalar bilen berilyér.

Click MouseDown OLEDragDrop OLEStartDrag
DblClick MouseMove OLEDragOver
DragDrop MouesUp OLEGiveFeedback

DragOver OLECompleteDrag OLESetData
Mazmuna ge¢cmek.




Suratlardaky usulyet
Suratlardaky usulyet agakdaky usulyetlere eyedir
Drag OLEDrag ShowWhatsThis
Move Refresh ZOrder

3.10. Grafiki meydanlar
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Mazmuna gecmek.

Gurallar panelindiki grafiki meydanlary seyle belgi bilen #8 berip bolar.Gragik meydana islendik
sekili yerlesdirip, ona gurallar panelindéki diiwdni ya-da basga elementlerem yerlesdirip bolar, sonui
ticinem ofla formanyi i¢indéki forma diyilyér.

Grafiki meydanlaryn hisiyeti.

Grafiki meydanlaryn hisiyeti asakdaki adalgalarda berilyar

Align CausesValidation DataField
Appearance ClipControls dataFormat
AutoRedraw Container DataMember
AutoSize CurrentX DataSource
BackColor CurrentY Draglcon
BorderStyle dataChanged DragMode
DrawMode Hieght RightToLeft
DrawStyle HelpContextID ScaleHeight
DrawWidth hwnd ScaleLeft
Enabled Image ScaleMode
FillColor Index ScaleTop
FillStyle Left SaleWidth
Font Linkltem Tablndex
FontBold LinkMode ThbStop
Fontltalic LinkTimeout Tag
FontName LinkTopic ToolTipText
FontSize Mouselcon Top
FontStrikethru MousePointer Visible
FontTransparent Name WhatsThisHeipID
FountUnderLine OLEDragMode Widht
ForeColor OLEDropMode

HasDC Parent

hDC Picture

Grafiki meydanlarda is

Mazmuna gecmek.

Grafiki meydanlardaky isi asakdaky adalgalar-sozler bilen programma yazgysynda amal edip

bolar
Change KeyPress MouseDown OLESetData
Click KeyUp MouseMove OLEStartDrag
DbiClick LinkClose MouseUp Paint
DragDrop LinkError OLECompleteDrag Resize
DragOver LinkNotify OLEDragDrop Validate
GodFokus LincOpen OLEDragOver
KeyDown LostFocus OLEGiveFeedback

Bu yerde has kop ulanylyany Click we DragDrop buyruklardyr.
Mazmuna ge¢cmek.

Grafik meydanlaryn usulyeti

Grafik meydanlaryn usulyeti bilen baglanysykly usulyetler koptirdkdir, olaryn has kop
ulanylyanlarynyn atlary asakdaky sanawda getirilendir
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Circle LinkReguest PSet TextHeight
Cls LinkSend Refresh TextWidth
Drag Move ScaleX ZOrder
Line OLEDrag ScaleY

LinkExecute PaintPicture SetFocus

LinkPoke Point ShowWhatsThis

Circle, Cls, Line, PaintPicture, Print we Pset usulyetler grafiki meydanlardaky grafikleri we yazgylary
programma yerine yetirilyarka ¢gykarmak ti¢in niyetlenilendir.
Mazmuna ge¢cmek.

3.11. Taymerler

Gurallar panelinde taymeri su belgi - beryar. Onun {igin formada yorite yer bollinip berilmeyir,
ol formanyn islendik yerinin iistiinde bolup kompyuterin ulgam wagty gorkezyar.

Taymerlerin hisiyeti

Taymerlerin hésiyeti azyrak bolup olar asakdaky tablisalardaky adalgalarda berilyar

Enabled Left Tag
Index Name Top
Interval Parent

Taymerin adynyn ginieldilmesi .tmr gysgaltmadyr. Interval hésiyetini bahasy millisekund-da berilyér,
sekunda gegmek ti¢in ol 1000-¢ kopeldilyar.
Taymerlerin isi difie Timer bilen berilyir. Taymerlerde usulyet bolmayar.
Mazmuna gecmek.

Taymer bilen islemek

Diistinikli bolar yaly formanyn adynda sagady dorederis, ol isin yzygiderligi asakdaky yalydyr:

1.Visual Basic maksatnama girmeli. File » New Project buyrugy amal edip tdze taslama doéretmeli.
Agylan Project Wizard penjirede Standard.EXE belgijigi saylamaly.

2.Formal-iii Name hisiyetine frmMain yazmaly, Caption hésiyete goshundy sagat yazmaly.

3.frmMain formada gurallar panelinden alyp sagady yerlesdirmeli. Onuii Name hésiyetine tmrTime
yazmaly.

4.Interval hisiyete 500 baha yazmaly.Ulgam sagady her yarym sekundtdan barlanyp durlar.

5.frmMain baryp programma yazylyan yere baryp (General) (Declaration) bolege girip su programma
bolegini yazmaly:

Option Explicit
Private OldCaption As String

6.Form.Load is prosedurasyna su programma bolegi gosmaly

Private Sub Form_Load()
OldCaption = Me.Caption
End Sub

7.Formadaky sagadyn iistiine baryp programma yazmaga ge¢meli, ol yerde Timer is prosedurasyna su
programma bolegini gosmaly

Private Sub tmrTime_Timer()
Dim msg As String

msg = OldCaption & ":" & Time$
Caption = msg
End Sub
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8.Run » Start basyp su programmany ise girizsek real wagty sekunt-da gorkezyan, isldp duran su forma
cykar

. goshundy-zagat 16:25:47 M= E

Bu yerde sagadyn isleyisi azajyk yylpyldar, ony ayyrmak ii¢in Timer is prosedurasyna si programma
bolegini gosalyn

Private Sub tmrTime_Timer()
Dim msg As String

msg = OldCaption & ":" & Time$
If msg <> Caption Then

Caption = msg

End If

End Sub

Mazmuna gecmek.

3.12. Dolanys zolaklary

-
Gurallar panelinde dolanys zolaklary su belgi ﬂ = bilen berilydr. Bu gurallar formalardaky
awtomatiki goyulyan adatdaky dolanys zolaklary déldir. Olar 6zbasdak elementlerdir.Olar kibir bahalary
ulaltmak ya-da kigeltmek ti¢in niyetlenilendir. Ysal {i¢in sesi, refiki we s.m.
Dolanys zolaklaryn hisiyetleri
Dolanys zolaklaryn hésiyetleri su adalgalarda-sézlerde berilyar

CausesValidation hwnd MousePointer Tag

Container Index Name Top

Draglcon LargeChange Parent Value

DragMode Left RightToLeft Visible

Enabled Max SmallChange WhatsThisHelpID
Height Min Tablndex Widtx

HelpContextID Mouselcon TabStop

Bu yerde dolanys zolaklary igcin Max, Min, LargeChange We SmallChange hisiyetler berilyér.
Mysal ti¢in, programmadaky prosedurada minimal we maksimal ses seyle yazylyp bilner

Private Sub Form_Load()
hscVolume.Min=0 ‘Minimal ses
hscVolume.Max=255 ‘Maksimal ses

End Sub

Mazmuna gecmek.

Dolanys zolaklary isi

Dik we Kese dolanys zolaklary isi programmadaky prosedurada asakdaky adalgalar we sozler bilen
berilyar

Change GotFocus KeyUp Validate
DragDrop KeyDown LostFocus
DragOver KeyPress Scroll

Bu yerde i1l esaslary Change, Scroll islerdir.
Mazmuna ge¢cmek.
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Dolanys zolaklary usulyeti

Dolanyn usulyeti su sozler bilen berilyir
Drag Refresh ShowWhatsThis

Move SetFocus ZOrder
Mazmuna gecmek.

Dolanys zolaklary bilen islenilisine mysal

Kese dolanys zolagynyn isleyisini mysalda gorkezelii:

1. Visual Basic maksatnama girmeli. File » New Project buyrugy amal edip tidze taslama doretmeli.
Agylan Project Wizard penjirede Standard.EXE belgijigi saylamaly.

2. Gurallar panelinden Formal-e kese- 42| dolanys zolagyny ékelip goymaly. Onuii Name hisiyetine

hscVolume yazmaly.

Sol yerdédki Min hasiyete 0 baha, Max hdsiyete 100 bermeli. Volume hésiyete 50 baha bermeli.

SmallChange hisiyete 1 baha bermeli, LargeCange hisiyete 10 baha bermeli.

Gurallar panelinddki A harpa baryp Formada yazgyny zolagyn yokarysyndan goymaly.Onun

Name hésiyetine IblVolume yazmaly, Caption hdsiyetine 50 yazmaly.

6. Sol yerddki Font setirdédki dpisgd baryp peykamy basmaly, ¢ykan gosmaga penjirede FontSize —den
24 sany saylap almaly.

7. Sol penjireddki AutoSize hisiyete True baha bermeli.

8. Dolanys zolagynyn iistiine baryp iki sapar peykamy basmaly, sonda programma penjiresi agylar.

9. Change ise su programma bdlegini gosmaly:

ok w

Private Sub hscVolume_Change()
IbIVolume.Caption = Trim$(Str$(hscVolume.Value))
End Sub

10. Run » Start basyp su programmany ise girizsek yokarky isleriii netijesinde ekranda seyle forma
bolar
11.

w. Form H= E

Zolakdaky <« ,» diiwmeleri basyp ya-da peykam bilen siiysiirilydni sliyrdp sany ulaldyp ya-da
kiceldip bolar.

Yokarky mysaldaky programmada Str$ funksiya sany setire owiirydr. Sebdbi Caption hisiyet
IblVolume yazgy setir liytgeyénleri alyp bilyar ya-da Variant gorniisli iiytgeyan ululygy kabul edip biler.
Value hésiyet dolanys zolagy ii¢in bitin gorniise degisli. Sonun {icin hem Str$(hscVolume.Value) -su
ozgerdilydn ululyk c¢aption hésiyete degislidir.  Trim$ -funksiya setirifi basyndaky we sofiundaky bos
yerleri ayyryar, seyle is 6zgerdilisde ylize ¢ykyp biler. Cykarylyan baha gowy goriiner yaly su utgasmany
ulandyk

Trim$(Str$(hscVolume.Value))
Mazmuna gecmek.

3.13. Disklerin sanawy

Gurallar panelindéki diskleriii sanawy adatca beyleki elementler bilen bilelikde ulanylyar, onuil
belgisi -I=4. Islenyérki disklerin sanawyndan ondaky kataloglara gecip fayllary agmak ya-da yatda
saklamak isini tizlesdirip bolar.
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Disklerin sanawynyn hésiyetleri asakdaky adalgalarda-sozlerde berilip bilner.

Appearance Draglcon Font FontSize
BackColor DragMode FontBold FontUnderline
CausesValidation  Drive Fontltalic ForeColor
Container Enabled FontName Height
HelpContextID Listindex Tablndex Visible

hwnd Mouselcon TabStop WhatsThisHelpID
Index MousePointer Tag Width

Left Name ToolTipText

List OLEDropMode Top

ListCount Parent Toplndex

Disklerinn sanawynyn adynyn gineldilmesi drv bilen berilyér.
Bu yerde kop ulanylyan hasietler Drive bilen Name bolup duryarlar.

Mazmuna gecmek.

Disklerin sanawynyn isi

Disklerin sanawynyi isleri programma prosedurasynda su adalgalar-sozler bilen berilyar.

Change KeyDown OLECompleteDrag OLESetData
DragDrop KeyPress OLEDragDrop OLEStartDrag
DragOver KeyUp OLEDragOver Scroll
GotFocus LostFokus OLEGiveFeedback Validate

Bu yerde has kop ulanylyany Change isdir, ol ulanylsa ulanyjy téze disk gurlusyny saylap alyar.
Mazmuna ge¢cmek.

Diskleriit sanawynyin usulyetleri

Asakdaky tablisada disklerin sanawynyin metodyna degisli usulyetler getirilendir, olar ki halatlarda

ulanylyandyrlar
Drag OLEDrag SetFokus ZOrder
Move Refresh ShowWhatsThis

Mazmuna gecmek.

3.14. Kataloglaryn sanawy

Gurallar panelinddki kataloglaryn sanawy adatga disklerin sanawy bilen bilelikde ulanylyar,
belgilenilisi -L1.
Mazmuna ge¢cmek.

Kataloglaryn sanawynyn hésiyetleri

Kataglaryn sanawynyn hésiyetleri asakdaky adalgalarda-sozlerde berilyir

Appearance FontName List Tablndex
BackColor FontSize ListCount TabStop
CausesValidation FontStrikethru Listindex Tag

Container FontUnderline Mouselcon ToolTipText
Draglcon ForeColor MousePointer Top

DragMode Height Name Toplndex
Enabled HelpContextID OLEDragMode Visible

Font hwnd OLEDropMode WhatsThisHelpID
FontBold Index Parent Width

Fontltalic Left Path

Kataloglaryn sanawynyn adynyn giiieldilmesi (Name-hésiyet) dir gysgaltmadyr. Path hésiyete bilen
difie programma isleyarka baryp bolar.
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Mazmuna gecmek.

Kataloglaryn sanawynyn isi

Su adalgalar bilen programma prosedurasynda berilyér

Change
Click
DragDrop
DragOver
KeyPress

GotFocus LostFocus OLECompleteDrag
KeyDown MouseDown OLEDragDrop
KeyUp OLEDragOver OLEStartDrag
MouseMove  OLEGiveFeedback Scroll

MouseUp OLESetData Validate

Mazmuna gecmek.

Kataloglaryn sanawynyn usulyeti

Kataloglaryi sanawynyn usulyeti su adalgalar bilen berilyér

Drag
Move

Gurallar panelinde fayllaryn sanawynyn belgisi SE)

OLEDrag
Refresh

SetFocus
ShowWhatsThis

ZOrder

Mazmuna gecmek.

3.15. Fayllaryn sanawy

Mazmuna gecmek.

Fayllar sanawynyn hésiyetleri

Fayllaryn sanawy birgiden hésiyetlere eyedir, olaryn has kop ulanylyanlary garaldylyp

gorkezilendir.

Appearance FontName ListCount
Archive FontSize Listindex
BackColor FontStrikethru Mouselcon
CausesValidation FontUnderline MousePointer
Container ForeColor MultiSelect
Draglcon Height Name
DragMode HelpContextID Normal
Enabled Hidden OLEDragMode
FileName hwnd OLEDropMode
Font Index Parent
FontBold Left Path

Fontltalic List Pattern

ReadOnly
Selected
System
Tablndex
TabStop
Tag
ToolTipText
Top
Toplndex
Visible
WhatsThisHelpID
Width

Bu hisiyetlerden it moiimi Path hésiyetdir, onuil bilen fayla bolan yol gorkezilyar. Path hdsiyet tize
disk saylanylanda berilmelidir.

Mazmuna gecmek.

Fayllaryn sanawy boyunca is

Fayllaryn sanawy boyunga is programmadaky prosedurada su adalgalar-sézler bilen yazylyar

Click
DbIClick
DragDrop
DragOver
GotFocus
KeyDown

KeyPress
KeyUp
LostFocus
MouseDown
MouseMove
MouseUp

OLECompleteDrag PathChange
OLEDragDrop PatternChange
OLEDragOver Scroll
OLEGiveFeedback Validate
OLESetData

OLEStartDrag

Mazmuna gecmek.

Fayllar sanawy usulyeti

Fayllar sanawy usulyeti asakdaky usulyetler bilen goldanyar
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Drag OLEDrag SetFocus ZOrder
Move Refresh ShowWhatsThis

Mazmuna gecmek.

3.16. Panele basga elementleri gosmak

Panele basga elementleri gosulanda asakdaky in yzygiderligini amal etmeli:
o Elementler paneline gosjak gatyn gowy goriinmeli.
o Gerek elementinii saylamaly.
o Olary gerek gatyia yerlesdirmeli.
Mazmuna ge¢cmek.

Panele basga elementleri gosmaga mysal

1.  Agylan Visual Basic is ekranyndaky Elementler panelinini penjiresinin iistiine peykamy eltip
sycanyn sag gulagyny basmaly, sonda gapdal menyu ¢ykar.
2. Ykan gapdal menyudaky sanawdan Add Tab... yazgyny saylamaly, sonda su penjire ¢ykar

Microzoft Yisual Basic

X
Mew Tab Marme:

Cancel

3. Cykan asaky zolaga Goshmacha yazyp OK basmaly.

Microzoft Yisual Basic

X]
Mew Tab Mame:

Cancel

|Enshmacha

4.Elementler panelinde déreden Goshmacha gatymyz seyle ¢ykar

= ~ A
Goshmacha |

Goshmacha yazgyly gaty basyp ony isjen yagdaya getirmeli, sonda su penjire gykar
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x|

General

Goshmacha

k

5.0l dpisgé baryp, sycanyn sag gulagyny basanyiida ¢ykan gapdal menyudaky sanawdan Components
s0zi saylamaly.

6.Cykan penjranin Controls gatyndaky sanawdan Microsoft Common Controls 6.0 yazgyly setirin 6niindéaki
dortburglykda bellik goymaly.

Components x|

Controls lDesigners ] Insertable Ohjects ]

Microsoft PickureClip Control 6.0
Microsoft Remotelata Control 6.0
Microsoft Rich Textbox Conkral 6.0 [ L=
Microsoft Script Contral 1.0 — | oos
Microsoft SysInfo Contral 6,0 I
Microsoft Tabbed Dialog Control 6.0 =5 - EIEI.
Microsoft Windows Common Conkrals 5.0 (SP2)

Padblicrosaft \Windows Common Cantrals 6.0 i E
Microsoft Windows Common Conkrols-2 5,0 (5P

Microsoft Windows Common Conkrals-2 6.0
Microsoft Windows Common Conkrols-3 6.0
Microsoft \Winsock Conkral 6.0 |

MSFlesiGrid Wizard - Browse. .
1] | ' [ selected Items Only

Microsoft Windows Common Conkrols 6.0

Locakion:  CYWIMDOWS,SYSTEMIMSCOMITL, OOy

0,4 | OTHMEHA MPHMEHHTE

7.Bu yerde OK bassak saylanan boyunca elementler Goshmacha gatda yerleser, eger olar ol yerde
bolmasalar, General gatda bolar, ondan ol gurallary siiyrdp Goshmacha ge¢irip bolar.

» =10l

Gaenetal

Goshmacha

e
il

E, i!
[[=1]=]
oo

Bu yerde General sdze bassail esasy Elementler paneli ¢ykar.
Elementler panelinde agan gatymyzyi adyny Goshulan diyip tiytgetmek seyle yzygiderlikde amal edilyar:
1.Goshmacha peykamy eltip sycanyi sag gulagyny basmaly.
2.Cykan gapdal menyudan Rename Tab basmaly.
3.Cykan penjirediki at berilmeli zolakda téze at yazmaly, OK basmaly.
Mazmuna gecmek.
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3.17. Interfeyslerin guralysy

Windiwsda meseleler ¢oziilende we adatca islenilende olar esasanam asakdaky bds element bilen
iipjlin edilyér:

o Daragt ona Tree View diyilyér.

a Tablisa sanawlary, ona List View diyilyar.

o Sekillerin sanawlary, ofla Image List diyilyér.

0 Yagday setiri, ofia Status Bar diyilyar.

a Gurallar panelleri.

Mysal ii¢in, ITpoBoaauk Windows penjirede bular seyle yerlesendirler

Guyallar peneli llablis,.? anewrlay
_gum-umzmawm ! =10/ X
Faiin  [pasca Ra  MNepeyxor U e Cgpewc  Croascs “
' N = = Y »
@ @ = , B /3| =
Hasm Brepx Bopesars  Komposars [ Berame | Dmvessas
&apzc I__l CvUT 2003 1eyoelkler / E]
Nan x * - :
— - MUT2003 tejribelikler
<=3 St 4
3011 s | Hszaep] Tom
") Deechd Mutdan Dy ten 78K Howyreae Nicrcsoft
') Deweb for Wirdows Mut-dan “1-rg tejr 89k6  HokyrasHr Nicrcsoft
3 ] Game: Mt -dan " 209 lejt 127 kE  Dovytaasr Nicrcsof
1 jeen Mut-dan " 4rg tep SOKE  Ooryrssser Nacrezaft,
Da.:ﬁgt__y. —J meodi ) nwi-can 15 bein 145 K6 Joryrazd Nicresoft
4 o ‘?_]: L -can 16-rg tep D3KE Dorutassr Ncresof!
nu-can 1y lerh 26k Jowyree Nicresoft.
- ) MLT dan 2y tepr 33kb  HokyrasHr Nicresoft
i _j F:I gram Fies Mit-dan Frd et I7KE Horyras Nazicsoft
. .—J ;1_-_::31 Mut-dan 4-rg ot A6 KD Noryras Nocrczobt.
&f Reydec 24 |7 itz S vsint KA Mowimaasr Micrrent
1| | ‘]
. o = Gt
Vaglas setisi - 106ME Ceotoano Haw Sl Mol kereerorep

Islendik Windows isde gurallar paneli Bas menyuyn asaky eteginde yerlesyér, olar bilen kesmek,
nusgalamak, yerine goymak we ayrmak isi, ondaky diiwmleler bilen tizlesdirilyér.
Mazmuna ge¢cmek.

3.18. Daragt

Elementler panelinde daragt seyle belgilenyar - [ , 0l papkalar yokardan asak biri-birine
baglylykda ¢ykaryp gorkezydr, onuil iigcin papkanyn o6ndki + belgijigi basmak yeterlikdir.
Mazmuna gecmek.

Daragtlaryn hisiyetleri

Daragtlar birgiden hisiyetlere eyedirler, olaryn adalgalary-sozleri sulardyr

Appearance Height Mouselcon SingleSel
BorderStyle HelpContextID MousePointer Sorted
CausesValidation HideSelection Name Style
CheckBoxes HotTracing Nodes Tablndex
Container hwnd Object TabStop
Darglcon ImageList OLEDragMode Tag
DragMode Indentation OLEDropMode  ToolTipText
Drophighlight Index Parent Top
Enabled LabelEdit Pathseparator ~ Visible

Font Left Scroll WhatsThisHelpID
FullRowSelect LineStyle Selectedltems  Width

Bu yerde hem adatca element bilen i Name hésiyetden baslanyar. Daragtyn gineldilmesi tvw
yazgydyr.Mysal ii¢in, daragt diskin katalogyndaky diiziimi tvwDirectories diyip atlandyrylyar.
Mazmuna gecmek.
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General gat

Styl hdsiyet elementin dasky gorniisyny kesgitleydr. Ol asakdaky bahalara eye bolup biler

Bahasy Beyany

O-tvwTextOnly Yazgynyn birlesmesi gorkezilyar

1-tvwPictureText Yazgy birlesmesi we belgisi gorkezilyér

2-tvwPlusMinusText Yygnalyan/agylyan sekil(+ we -) we yazgy
birlesmesi gorkezilyar

3-tvwPlusPictireText Yygnalyan/agylyan sekil, yazgynyi
cepinden beligi we yazgyn 6zi gorkezilyar

4- tvwTreeLinesText Eger biri-birine bagly birlesmeler birikmeli
bolsa her bir birlesmgyzyk we yazgy
cykarylyar

5-tvwTreeLinesPictureText Yazgydan ¢epde belgi gorkezilyir, 6zara

bagly birlesmeler ¢yzyk bilen birikdirilyér
6-tvwTreeLinesPlusMinusText ngna]}'/an/agyl}'/an sekil, baglasdyryjy

cyzyklar we yazgy birlesmeleri gorkezilyar
7- vwTreeLinesPlusMinus Her bir birlesme ti¢in dhli miimkingilikler
Picture Text gorkezilyar

LineStyle hisiyet birleslmelerin arasyndaky birikdiriji ¢yzyklarin gérniisini kesgitleyar, onui
bahalar sulardyr

Bahasy Beyany
0-TreeLines Daragtyn esasy ¢yzyklary
1-RootLines Esasy birlesmelerin arasyndaky ¢yzyklar

LabelEdit lagoki hdsiyet elementinl yazgylaryny awtomatiki diizetmegi ya-da diizetmédge gadaganlyga
miimkingilik beryér. Eger onun bahasy True bolsa elementinl yazgylary redaktirlenyér, False bolsa
elementlerin yazgysyny redaktiplemek gadagandyr.

BorderStyle We Appearance hdsiyetler elementiil carguwasynyn gorniiyar.

OLEDragMode hésiyet siiyremek diizgilinini beryér, onun bahalary

0 - OLEDragManual
1 - OLEDragAutomatic

OLE- bilen siiysirilende OLEDragMode hésiyet daragt ii¢in siiysirydniii zynmak isine rugsat beryar
ya-da ol isi gadagan edydr.

0 — OLEDropNone Zynmak bolanok
1 — OLEDropManual Zynmak bolyar

Indentation hdsiyet daragtda gonisy derejiniil birlesmesiniii keseligindéki aralygy kesgitleyér.Onun
bahasy nége kigi bolsa, birlesmeler 6zara yakyn yerlesyérler.
Birlesmede FullPath hdsiyet bilen gaytagylyan Pathseparator hasiyet yol licin boliiji sekili bilmegi ya-
da bermegi kesgitleyir, onunl yazylysy

Private Sub TreeViewl NodeClick(ByVal Node As Node)
Dim rc as String
Rc = Node.Fullpath
MsgBox rc

End Sub

Mysal tgin, gaty diskde boliji hokmiinde \(6nie gapdal ¢yzyk) ulanylyar, INTERNET-in IP —
salgylry yerli torynda daragt-da .(nokat) ulanylyar.
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Scroll hésiyetin bahasy True bolsa daragt dolanys zolagy bilen {ipjiin edilydr, onui bahasy False

bolsa dolanys zolagy bolmaz.
HotTracing hdsiyet True bolsa birlesmn doly ady setire sygmaz, ofia barsann gapdaldan doly ady
¢ykar, Mysal tigin, su penjire

_5‘,%] O6zop - Temporary Internet Files —|O ﬂ
Pain  [paska Bua [lepegoa  Msdpadnoe Cepewc Cnpaeka n
N = == »
=, 14 4 S e
Ha=ag Becp= Breipesarte Konupoeate Boraeure
Aopec |J CWMDONS ST emporany Intemet Files j
Marku b =
g 5 Temporary Internet File:
yshokup -
-] System A | Aapec 5 MHTepHeTS | T
+-_ ] System32
] Taszks
w7 Temp
+ _\J| Temporam lnternet Files|
1 vem J
+-_ ] web
—-[_] MnasHoe MeHn
= AR A0 N N7
1 | » 1] Ji3

8 MHreoHeT

Mazmuna gecmek.

Daragtlarda is

Daragtlarda is agakdaky tablisalardaky adalgalar-sézler bilen programma yazgysynda berilyér

AfterLabelEdit Expand MouseMove OLEGiveFeedback
BeforeLabelEdit GotFocus MouseUp OLESetData

Click KeyDown NodeCheck OLEStaraDrag
Collapse KeyPress NodeClick Validate

DblClick KeyUp OLECompleteDrag

DragDrop LostFokus OLEDragDrop

DragOver MouseDown  OLEDragOver

AfterLabelEdit() 1 birlesmedéki yazgylar redaktirlenilenden sofi bolmaly. Onuii bilen birlesmn adyny
barlap dogrylygyna goz yetirip bolar. BeforeLabelEdit i bolsa redaktirlemége bagslamazdan 611 bolar.

Collapse is daragtyn sahalary yygnalanda bolar.Onuil ii¢in ulanyjy daragtyn kokiine peykamy eltip
iki sapar basmaly ya-da kokdaki “-* basmaly. “+” bassanl onuni yerine “-” bolar, yagny sanaw
yygnalar.”+” {i¢in Expand() i$ ulanylyar.

NodecClick() i bilen birlesme barada maglumat alyp bolar.

OLECompleteDrag i OLE —siiyremek bilen zyfimak bolyarka amal bolyar.

OLEDragDrop() is bilen OLEDropMode hédsiyetde 1 — Manual gorkezilende, elemente OLE maglumat
zyiylyar.

OLEDragOver is elementin iistiinden OLE maglumatlar siiyrelip gecilende bolar.

OLEGiveFeedback() i her bir OLEDragOver() hidsiyet yerine yetirilende amal bolyar.

OLESetData() 13 DataObject obyekt ¢esmeden GetData obyekt kabul ediji usulyet cagyrylanda yerine
yetyar.

OLEStaraDrag() i$ hacanda ulanyjy elementden maglumatlary siiyrdp baslanda yerine yetyir.
OLEDropMode hisiyetde 1 — Automatic gorkezilen bolsa element awtomatiki siiyrelip ugralyar.

Mazmuna ge¢cmek.

Daragtlar usulyeti

Daragt-elementler asakdaky usulyetlere eyedirler

Drag Move SetFocus StartLabelEdit
GetVisibleCount OLEDrag ShowWhatsThis  ZOrder
HitTest Refresh
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GetVisibleCount usulyet daragtda birbada seredilyédn birlesmeleriit mukdaryny kesgirleyar.
HitTest usulyet birlesme siiyreméni kabul ediji bolup peydalanyp bilinjekdigini kesgitleyér.
OLEDrag usulyet OLE siiyreme amalyny baglayar.Ondan sofi OLEStaraDrag is ¢agyrylyar.
StartLabelEdit usulyet birlesméni yazgylary redaktirlemek diizglinine h6kmany ge¢irmekde
peydalanylyar.
Mazmuna gecmek.

3.19. Tablisa sanawlary

{[=1r]
[=§]-]
=3

Kopleng tablisa sanawlary Daragt bilen bile utgasdyrylyp islenyér belgisi -
Tablisa sanawlaryn hisiyetleri

Tablisa sanawlaryn hdsiyetleri agsakdaky adalgalarda-sozlerde berilyér, bu kop ulanylyanlary
garaldylyp gorkezilendir

AllowColumnReorder Height Parent
Appearance HelpContextID Picture

Arrange HideColumnHeaders PictureAlignment
BackColor HideSelection Selectedltem
BorderStyle HotTracking Smalllcons
CausesValidation HoverSelection Sorted
CheckBoxes hwnd SortKey
ColumnHeadericons | Icons SortOrder
ColumnHeaders Index Tablndex
Container LabelEdit TabStop
Draglcon LabelWrap Tag

DragMode Left TextBackground
DropHighlight Listltems ToolTipText
Enabled Mouselcon Top
FlatScrollBar MousePointer Visible

Font MultiSelect WhatsThisHelpID
ForeColor Name Width

FontName Object View
FullRowSelect OLEDragMode

GridLines OLEDropMode
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Elementler paneline tize goyulan 22 belligi basyp forma goyup, peykamy onufi iistiine eltip

sycanyn sag gulagyny basanymyzda ¢ykan gapdal menyudan Properties setiri bassak, ol elementin
geplesik penjiresi gykar

Property Pages ﬁl

General IImage Lisks I Saorking I Column Headers I Color I Faont I Picture I

MouzePainter:

Yiew: I':I - vl con j [ HideColumnHeaders
Arrange; ||:| - lvwtone j ¥ HideS election
LB T . J ¥ Labehafrap
. - k k -
e I nLiamEe [ MultiSelect
BarderStyle: I'I - coFivedSingle =l F|Enabled
Appearance: I‘I -cedD j [ AllowColumnF eorder

[T Checkboxes
ocOLEDragManual x| ™ FlatScrollbar

OLEDropMode: [n. collEDopione  ¥| T~ FulRowSelect

[T Giridlines
[~ HotTracking
[T HoverSelection

| R I OTHEHS | ﬂpHﬂEHHTbl CNpaeka

OLEDraghd ode: ID .

Bu penjire birndge gatdan ybaratdyr, olara seredip gegelin.
Mazmuna gecmek

General gat

Yokarky agylan General gatdyr, onda tablisa sanawa degisli birgiden hésiyetler berip bolar.
View hisiyet element barada maglumatlary gorkezyian diizglindir, onuii sagyndaky w bassan su

|EI - Iywilzon j

0 - vwlcon
1 - lywSmallcon
2 - Lzt

sanaw ¢ykar 3 - lwheport

, onun alyp bilyan bahalary

Bahasy Beyany

0 - lvwicon Sanawyn obyekti uly belgi
gorniisinde gorkezilyar

1 - lvwList Obyekt adaty sanaw gorniisinde
gorkezilyar

2 - lvwReport Edil lvwList yaly, yone her bir
obyekt ligin gogmaca maglumat
cykarylyar

3 - lvwSmallicon Edil lvwicon yaly, yone obyekt

kici belgilerde gorkezilyar

Arrange hiésiyet okamak we yazmak fiicin elyeterdir, onuit sagyndaky w bassan, alyp bilyin
0 - vwhone i

bahalarnyn su sanaw ¢ykar - kawéitnTnn , onuil alyp bilyin bahalary

Bahasy Beyany
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0 - lvwNone Belgiler tertiplesdirilmeyér

1 - lvwAutoLeft Elementin ¢epinden baslap
obyektler awtomatiki
tertiplesdirilyar

2 - lvwAutoTop Elementin yokarky boleginden
baslap obyektler awtomatiki
tertiplesdirilyar

LabelEdit logiki hésiyet elementddki yazgyny awtomatiki redaktirlemegie rugsat(0 — lvwAutomatic)
ya-da gadagancylygy(2 — lvwManual) girizyar.

OLEDragMode hisiyet peykam bilen siiyremek diizgiinini beryér: 0-OLEDragManual -el bilen, 1
OLEDragAutomatic -awtomatiki.

OLEDropMode hisiyet, tablisa sanaw ligin OLE siiyrelende obyektleri zyimaga rugsat ya-da
gadagancgylyk edyir: 0-OLEDropNone-zynmak bolanok, 1 - OLEDrop Manual —zyiimak bolyar.

ColumnHeaders hisiyetdéki Hide Column Headrs yazgyda bellik goyulan bolsa False goyulyar, onda

siitlinin  ady gizlenyar.

LabelWrap , hisiyet yazgylary okamak we yazmak iigin elyeterdir, hdsiyetde True baha goyulan bolsa
belgiler gorkezilen diizgiinde yazgynyn gecirilisini dolandyryar

MultiSelect hasiyetde True goyulan bolsa birbada birnige obyekti belgildr bolar, biri belgilenyin
bolsa False goyulandyr.

FullRowSelect hisiyetde True goyulan bolsa, elektron tablisa yaly bolup element obyekt ticin dhli
setiri belgileyar.

GridLines hisiyetde True goyulan bolsa, elektron tablisa menzeslik hasam artar, element tory emele
getiryin dik we kese ¢yzyklara boliisdirer.

FullRowSelect We GridLines hdsiyetlerde True goyulan bolsa, tablisa sanawda tablisa diizgiini
goyulyar. Mysal {li¢in, IvwSheet tablisa sanawy li¢in programma bolegi seyledir:

With lvwSheet

.View = lvwReport
.GridLines = True

.FullRowSelect = True
End With

HotTracking hdsiyetde True goysak, onda birlesme yazgysa elementin setirine yerlesmese, gizlenip
yerlesdiriler, peykamy eltsenl gizlenen yazgy bolegi ¢ykar.
HoverSelection hidsiyet okamak yazmak ii¢in elyeterdir, onda True goysak, onda peykamyn ol
obyektde saklanmagy onun belgilenmegine getirer.
Mazmuna ge¢mek

Image Lists gat

Image Lists gat-da tablisa sanawda ulanylyan grafiklere degisli hisiyetler toplanandyr. Grafigi
tablisa sanawa gosmak ii¢in ImageList hisiyetde bar elementiii adyny bermeli. Small meydanda
gorkezilen sekiliit sanawynyn adyna Smalllcons hésiyet berilyir.

ColumnHeader meydanda sekillerii sanawy berilyér, olar tablisa sanawyn siitiinlerinin ady bolup
peydalanylar.

Mazmuna ge¢mek

Sorting gat

Sorting gatda tablisa sanawdaky teriplesdirilmeli maglumatlara degisli parametrler toplanandyr.

Sorted baydajyk sol bir atly hésiyetin bahasyny kesgitleyar. Ol goyulan bolsa tablisa sanawy 0z
maglumatyny tertiplesdiryér. Baydajyk yok bolsa onuil bahasy False bolar.

Sortkey hésiyet tablisa sanawda maglumatlary tertiplesdirmegiii usulyny dolandyryar. Hésiyet O
bolsa obyektler Text hdsiyet boyunga tertiplesdirilydr. Bahasy basga bolsa tertiplesdirme Subltems
yazgy héasiyeti boyunca tertiplesdirilyar.

SortOrder hisiyet tertiplesdirménin gorniisini kesgitleydr, dsydn ya-da kemelyén boyunga. 0 —
Osyén, 1- kemelyéin boyunga tertiplesdirilyar.
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Mazmuna gecmek

Column Headers gat

Index meydan tablisa sanawa her sapar ColumnHeader obyekt gosulanda ulalyar.

Su gatdaky Text meydan doldurylanda Visual Basic ColumnHfader obyekte indeksi bilen Text
hdsiyetin bahasyny beryar.

Alignment meydanda su un birini gérkezip bolar:

0 - IvwColumnLeft

1 - IvwColumnRight

2 — lvwColumnCenter

Obyektde ColumnHfader yazgyny giradenlesdiryar (degislilikde sag gyra, ¢cep gyra we orta gord).

Width meydana girizilen baha ColumnHfader obyekte gérd Width hisiyetin bahasyny kesgitleyar.Ol
Index meydanda gorkezilen indeksli siitiiniii adynyi inini beryar.

Key hésiyety siitiinlerin atlaryndan esasy ayratynyny kesgitleyér, ol hem yazsy, hem san bolup
biler. Onun haysy gorniini tapawudy yok, esasy ol beylekilerden tapawutly, ayratyn bolmaly.

Tag meydanda siitliniii adynyn Tag hdsiyetini beryar.

IconIndex meydanda sekillerin element-sanawynda gerek belgijiginn indeksini kesgitldp sanyny
beryar.Mysal {i¢in, sanaw ii¢ belgijikden ybarat bolsa, berlen atda iiclinji belgijik goérkezilmeli
bolsa bu meydanda 3 baha bolmaly.

Mazmuna ge¢cmek

Tablisa sanawlarda is

Tablisa sanawlarda goldanyan isler asakdaky sanawda getirilendir, olaryi has kop ulanylyany
garaldylyp gorkezilendir.

AfterLabelEdit DragOver KeyUp OLEDragDrop
BeforeLabelEdit GotFocus LostFocus OLEDragOver
Click ItemCheck MouseDown OLEGiveFeedback
ColumnClick ItemClick MouseMove OLESetData
DblClick KeyDown MouseUp OLEStartDrag
DragDrop KeyPress OLECompleteDrag Validate

Bu yerdaiki islerin kopiisi Daragtdaky isler bilen gabat gelyér. AfterLabelEdit is tablisa sanawdaky
haysam bolsa bir obyektin yazgysyny redakirldnimizden son ¢agyrylyar. Onuil komegi bilen téze
yazgynyn dogrylygy barlanyar. BeforeLabelEdit is obyekt redaktirlemek diizgiinine gegen halatynyn
ontinden bolar.

ColumnClick is ulanyjy siitiiniii adyna peykamy eltip bassa bolar.

ItemClick 15 tablisa sanaw {i¢gin mohiimlerin biridir, onun bilen baran obyektin barada maglumat alyp
bolar.

OLECompleteDrag 1, haganda OLE maglumatlar elemente zyiiylanda ya-da OLE siiyremek amaly
bes edilende bolyar.

OLEDragDrop() 15, OLEDropMode hisiyetde 1 — Manual goyulan bolsa elemente OLE maglumat
zynylsa bolar.

OLEDragOver iselementlerin iistiinden OLE maglumatlar siiyrelyédn bolsa yerine yetyar.

OLEGiveFeedback() is, her sapar OLEDragOver() isden son bolyar.

OLESetData() i3, ¢cesme DataObject obyekt {i¢in GetData kabul edis usul obyekt cagyrylanda amal
bolyar.

OLEStartDrag()  is, ulanyjy elementden maglumatlary siiyrdp baslanda yerine yetyar.Eger
OLEDragMode —de 1 — Automatic goyulan bolsa element awtomatik siiysiirilip baslanyar.

Mazmuna gecmek

Tablisa sanaw usulyeti

Tablisa sanaw usulyeti asakdaky tablisada getirilen usulyetleri goldayar, olaryn has wajyplary
garaldylyp gorkezilendir

Drag HitTest RefResh StartLabelEdit
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Findltem Move SetFocus ZOrder
GetFirstVisible OLEDrag ShowWhatsThis

FindItem usulyet elementde obyekti gézleyar.Gozleg doly ya-da kem-kés gabat gelmek bilen
miimkindir.

Tablisa sanawda birbada iki obyekt gorkezilip bilner, sonda GetFirstVisible usulyet haysy obyektin
sanaw ya-da tablisa diizgiinde birinji bolmalydygyny kesgitleyar.

HidTest usulyet obyekt siiysirilende kabul edip peydalanyp bilinjekdigini kesgitleyar.

OLEDrag usulyet OLE siiysiirme amalyny baslayar.Ondan son OLEStartDrag i ¢agyrylar.

StartLabelEdit usulyet obyektleri hokmany yazgylary redaktirlemek diizgline gecirmek gerek bolsa
peydalanylyar.

Mazmuna gecmek

3.20. Sekillerin sanawy

Sekillerin sanawlary programma yerine yetirilyarkd formada gorkezilmeyén elementlere degislidir
belligi - 2 . Sunuti bilen birlikde ol beyleki elementlerde peydalanylyan belgijikler ii¢in konteyner bolup
bolup bilerler.

Mazmuna gecmek

Sekiller sanawynyn hisiyetleri

Sekiller sanawynyn hasiyetleri asakdaky adalgalarda berilyér

BackColor ImageWidth MaskColor  Prent
HimageList Index Name Tag
ImageHeight Listimages Object UseMaskColor

Sekil sanawy bilen is adatca Name hisiyet bilen baslanyar. Bu elementlerinn gorniisi iigin gineldilme
iml peydalanyar. Mysal ii¢in, sekilleriii sanawy gurallar paneli bilen baglasdyrylsa imIToolbar at berilyér.
ImageHeight hésiyet sanawdaky sekilinl dikligini kesgitleyér, imagewidth hésiyet &hli sekillerin inini
kesgitleyar.
MaskColor hidsiyet elemente degisli sekilin diisegine renki anrysy gornlip duran diisekde sekli
kesgitlap ¢ykaryar.
Mazmuna gecmek

Sekiller sanawy usulyeti

Sekiller sanawy usulyeti difie Overlay usulyeti bardyr. Ol bir sanawda iki sekili biri-birinifi iistiine
goymak ligin peydalanylyar. Mysal ii¢in, bir sekili beyleki sekilin iistiine goymagyi programma bolegi
“1-nji sekili 2-nji sekile goymaly
Set Picturel.Picture = imToolbar.Overlay(1,2)
Mazmuna gecmek

3.21. Setirin yagdayy

Setirinl yagdayy Windowsda dolandyrys elementlerin mohiimidir. Onun belgilenisi -— . Setiriii
yvagdayy kop islerde goyulandyr, onda ulgam wagt, sene, her hili belgijikler we ststistiki maglumatlar,
Mysal ii¢in, tablisa sanawda bar fayllarynn mukdary yaly maglumatlar yerlesdirilip bilner.

Mazmuna ge¢mek

Setir yagdayynyn hisiyetleri

Setir yagdayynyn hésiyetleri asakdaky adalgalarda-sézlerde berilydr.Olaryn kop ulanylyany
garaldylyp gorkezilendir

Align hwnd OLEDropMode Tag
Container Index Panels ToolTipText
Draglcon Left Parent Top

DragMode  Mouselcon ShowTips Visible
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Enabled MousePointer SimpleText WhatsThisHelplD
Font Name Style Width
Height Object Tablndex

Bu yerde esasy hisiyet Name bolup duryar. Setir yagdayynyn ginieldilmesi sts gyggaltmadyr. Mysal
ligin, stsStatus.

Panels hdsiyet setir yagdayyna degisli elemente paneldédki obyektlerin toplumyna salgyny gaytaryar.

Style hédsiyet setir yagdayyny gorkezmek diizgiinini kesgitleyér, onun bahalary 0 — sbrNormal
bolanda Setir yagdayynda birnige panel ¢ykarylyar, 1 - sbrSimple Setir yagday bir panelden duryar, tutus
setiri eyeleyar.

SimpleText hésiyet, Style hdsiyetde 1 — sbrSimple bolsa panelde yazgyny berip ya-da okap bolar.

Mazmuna ge¢cmek

Setir yagdayyndaky is

Setir yagdayyndaky isler asakdaky adalgalar bilen prosedurada goldanyar

Click MouseDown OLEDragDrop OLEStartDrag
DbIClick MouseMove OLEDragOver PanelClick
DragDrop MouseUp OLEGiveFeedback PanelDblClick

DragOver OLECompleteDrag OLESetData

PanelClick is panele peykamy eltip bir sapar basanynda yerine yetirilip baslanyar. PanelDbIClick is
panele peykamy eltip iki sapar basanynda yerine yetirilip baslanyar.
Mazmuna ge¢mek

Setir yagdayyndaky usulyet

Setir yagdayyndaky usulyet asakdaky usulyetler bilen goldanyar.

Drag OLEDrag SetFocus ZOrder
Move Refresh ShowWhatsThis

Mazmuna gecmek

4.Modullar we toparlar bilen islemek

4.1.Programmahanany doretmek

Visual Basicde doredilen programma modullaryny bir yerde saklamaly bolyar, onuf {igin yorite
katalogy gaty diskde doredelin.
Programmahananyn doredilis yzygiderligi:
1.Myck-dan ya-da bagga yerden NpoBoaHuk Windows-y ise girizmeli.
2.Codelib atly papka doretmeli.
3. NMpoeoaHuk Windows-y yapmaly.
Visual Basic- de yazylan moduly Codelib papka-da yerlesdirmek ii¢in asakdaky tertipde amal etmeli:
1. Visual Basic taslamanyn penjiresine peykamy eltip sycanyn sag gulagyny bir sapar basmaly.
2. ya-daProject » Add File agmaly.
3. Cykan penjireden Codelib papkany tapyp gerek modulyiy saylamaly.
Mazmuna ge¢mek

4.2.Modullary doretmek

Modullary déretmek {igin Visual Basic- de taslama isindéki programma yazylyan dpisgé girmeli.
Sonra Visual Basic- déki Bas menyudaky Tools Add » Prosedure basyp ¢ykan penjirede ol
programma modulyna at bermeli. Bu i difie programma penjire agylanda miimkindir.
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Add Procedure

Type

X

Zancel
+ Sub " Property
" Funckion " Event
Scope
+ Public " Private

[ all Local variables as Statics

Moduly doretmegin yzygiderligi:
1.File » New Project buyruk bilen tdze taslama doretmeli.
2. Taslama penjiresine peykamy eltip sycanyn sag gulagyny bir sapar basmaly, Add » Module

yerine yetirmeli

= 3Projectl {Project1} |

=l Farms Set as Start Up
B Formi (F

Projectl Properties. ..

Save Project

.}@ Rermove Project

7 Eormn
1 MO Farm
&P Print...

Edvodie

3.Agylan Add Module penjirede Module yazgyly belgijigi saylap Otkpsits basmaly.
4.Cykan hésiyetler penjirede Name hésiyetinn sagyna MyLibrary yazmaly

Froperties - Mylbrary x|
[Mylbrary Module -]
Alphabetic Categnrized]

[Mame)
Returns the name used in code ko
identify a Form, control, or data

5.Déreden modulymyzy-faylymyzy bas menydaky File » Save MyLibrary yazyp ya-da klawuaturadan
Ctrls+S diiwmeleri bilelikde basyp, ¢ykan Save File As penjirede, Codelib papkany tapyp, ol

moduly yatda saklamaly.
Mazmuna gecmek

4.3.Proseduralar

Proseduralar programma yazgysynda bir sapar, argumenti bilen yazylyp, sofira olaryil programma
yazgysynyn basga yerinde difie atlary yazylyar. Sonda olar bilen i amal bolyar. Onun isleyisini
mysallarda gorkezelin.

Adatga programma yerine yetirilyarkd peykamyn ¢dge sagadyna dwriilisi, sofira yene peykama
Owriilisinin prosedurasyny yazalyn. Sebdbi uly hasaplamalar yerine yetirilende ol zerurdyr.

1.011ki agylan taslamany agmaly, agylmadyk bolsa tizeden acmaly.
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2.Taslamada MyLibraryl bar bolsa ony tapyp a¢gmaly. Onun {igin pekamy taslama penjiresine eltip
sycanyn sag gulagyny basmaly, ¢ykan gapdal menyudan Add » Module agmaly. Cykan Add Module
penjranin Existing gatyna gecmeli, ondan MyLibraryl.Bas fayly tapyp OTkpbiTe(Open) basyp ony
taslama gosmaly.
3.Taslama penjiresinddki MyLibraryl.Bas fayly agsan programma penjiresi agylar.
4.Programma su yazgylary yazmaly

Public Sub ShowHourglass()
Screen.MousePointer = 11
End Sub

Bu prosedura sycanyn peykamyny c¢dge sagada Owiirydr. Ondan son, onun adaty yagdaya
dolanmasynyn prosedurasy hem bolmalydyr.
5.0nun iigin programma su bolegi gosmaly

Private Sub ShowMousePointer()
Screen.MousePointer = 0
End Sub

6. File » Save MyLibrary basmaly.

Programma yazgysynyi basga yerinde ShowHourglass yazgyny 6iilinden ShowMousePointer yazgyny
softundan ¢agyrmaly, mysal {i¢in:
ShowHourglass
IndexLargeDatabase
ShowMousePointer

IndexLargeDatabase yazgy garasylyarka amal edilmeli is.
Mazmuna gecmek

4.4.Funksiyalar

Funksiyalar kopleng proseduralar menizesdir, tapawudy olar cagyrylanda bahalaryny gaytayar.
Kub koki hasaplamagyil mysalynda funksiyanyn yazylysyna seredeliii:
1.File » New Project buyruk bilen tdze taslama doretmeli.
2.Taslamada MyLibraryl bar bolsa ony tapyp agmaly. Onun {icin pekamy taslama penjiresine eltip
sycanyn sag gulagyny basmaly, ¢ykan gapdal menyudan Add » Module agmaly. Cykan Add Module
penjranin EXxisting gatyna geg¢meli, ondan MyLibraryl.Bas fayly tapyp Otkpbite(Open) basyp ony
taslama gosmaly.
3.Taslama penjiresinde MyLibraryl.Bas fayly iki sapar basyp agmaly. Programma penjiresi agylar, ondan
(General)(Declarations) yazgyny bassaf, programma yazylyan yerde su yazgy peyda bolar:

Public Function Cuberoot()
End Function

4.0na su programma bolegini goyalyn

Public Function Cuberoot(x As Double) As Double
If x =0 Then
Cuberoot=0
Exit Function
End If
Cuberoot = 10 ~ ((Log(Abs(x)) / Log(10)) / 3)
If x <0 Then
Cuberoot = -Cuberoot
End If
End Function

6.File » Save MyLibary baryp programmany yatda saklamaly.
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Programma yazylan penjraniii gorniisi

«%% Project] - MyLibraryl [Code] =10] =]

I(General} j ICuheruut

Fublic Function Cuberoot (x iz Double] 4= Double
If = = 0 Then

Cuberoot = 0O

Exit Function

End If

Y

Cuberoct = 10 ¢ ((Log(ih=s(x)) / Log(ld)) / 3}

If x < 0 Then

Cuberoot = —-Cuberoot

End If

End Funetion -

== | 1w

Double -yazgy funksiyanyn gorniisini As adalgadan son gorkezyir.Yazgy End Function bilen
tamamlanyar. Exit Function bilen proseduradan ¢ykylyar. Ondan son hasaplama bes edilyér.
Indi bolsa funksiyanyn anyk mysalda ulanylysyny gorkezeli.
7.Taslama penjiresinde yazylan Formal yazga peykamy eltip iki sapar basmaly, sonda sol formanyn
konstruktor penjiresi ¢ykar.
8.0ndaky Caption hésiyete Programmahana bilen is yazgy yazmaly.
9.Gurallar elementi bilen formada diiwme doretmeli. Onun ii¢in onun belligini elementler panelinden
belgildp forma gegirmeli. Diiwméninn Name hésiyetine cmdCubeRoot yazgy yazmaly, Caption
hisiyetine Kub kok yazgy yazmaly.
10.Formadaky cmdCubeRoot diiwma peykamy eltip iki sapar basmaly, sonda programma yazylyan
cmdCubeRoot_Click() is proseduraly penjire agylar.
11.Proseduranynl i¢ine su bolegi goymaly
Dim Y As Double

Y = Cuberoot(27)
txtTextl. Text =Y

Programma penjranin umumy gorniisi seyledir

I: 1 Project1 - Form1 [Code] - O] =|
|(General} ﬂ |Cuheruut ﬂ

Fublic Function Cuberoot (x L= Double) Az Do)
If = = 0 Then ]
Cuberoot = O
Exit Function
End If

Cukbercot = 10 *~ ((Logiib=(x)1 / Logi(ldi) /

If = = O Then
Cuberoot = —Cuberoot
End If

End Functiuﬂ

FPriwvate Sub cmdCubeRoot Click()
Dim ¥ A= Double —
¥ = Cuberoot (27)

txtTextl.Text = ¥ -
=[= 4« 3|

12.Programmany ise girizmeli hem-de formada doreden diiwmédmizi basmaly, sonda seyle penjire
ekrana geler
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53 Programmahana bilen ishlemek - |0 ﬂ
3

13.Programmanyn isini [X] basyp duruzmaly ya-da Run » End basyp konstruktor diizgiinine gaydyp

gelmeli.
14.Taslama penjiresindéki Formal yazgyny agmaly.
15.Formada elementler paneli bilen yazgy meydancasyny doretmeli, onunn Name hésiyetine txtTextl

yazmaly, Text hasiyetddki yazgyny ayyrmaly.
16. cmdCubeRoot diiwménin prosedurasyndaky Click() isden in sonky setiri(Print Y) ayryp yerine
txtTextl. Text =Y

su yazgyny yazmaly. Programma penjrénin tdze gorniisi

I(General} j IcdeuheRnnt_Click j

Private 3ub cmdCubeRoot Click() -
Dim ¥ i=s Double
[f = Cuberoot(27)
LxtTextl.Text = ¥

End 3Sub

== | 3
Mazmuna gecmek

Programmany ise girizmegi testirlemek

Prosedurany we funksiyany barlap ise girizmek {i¢in barlamak penjréni ulanmaly. Onuil ii¢in
taslamany Run » Start bilen ise girizmeli, sofira Run » Break setiri ise girizmeli. Is ekrana “?” yazmaly,
sonra Cuberoot(27) yazmaly, Enter basmaly, netije asakda getirilrndir

Irirnediate x|

5 CubeRoot (27 i‘
3

il o

4.5.Programmahanany tizelemek

Mazmuna gecmek

Programmahanany téze funksiyalar bilen {istlini yetirmek isine seredip gecelinl.
1.0n taslama edilen bolsa ony agmaly, yogsamam File » New Project bilen téize taslama agmaly.
2.Isleydn modulymyz Mylbrary.Bas taslama gosulmadyk bolsa ony taslama &dpisgd peykamy eltip,
sycanyn sag gulagyny basyp ¢ykan gapdal menyudaky sanawdan Add » Module basmaly.
3.Cykan Add Module penjrinii Existing gatyna gegip Mylbrary.Bas fayly tapyp Open(OTkpbiTs) bassan ol
taslama gosular.
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4. Taslama penjiresinddki Mylbrary.Bas fayly agmaly. Agylan programma penjiresine General,
Declarations bolege su prosedura bolegini yazmaly:
Public Function IsFile(FileName As String) As Boolean
If Len(Dir(FileName)) > 0 Then
'Fayl bar
IsFile = True
Else
'Fayl yok
IsFile = False
End If
End Function
5.Programmahanada bu yazgyny File » Save Mylbrary amal edip yatda saklamaly.

Bu yerde esasy is proseduradaky

If Len(Dir(FileName)) > 0 Then

Su setirde yerine yetirilydr.Onda berlen sertlerde fayl gézlenilyér.
Mazmuna gecmek

4.6.Parametrleri bermek

Prosedura her hili deslapky maglumatlar, olara argumentler hem diyilyér, bilen islemegi guramak
mohiim isdir. Funksiyalarda, proseduralarda sol bir isi her hili maglumatlar bilen yerine yetirmek isi
parametr bermekdir.

Bu meseldnin guralysyny seylerdk amal edip bolar:

1.Standart EXE gorniisli tdze taslamany doretmeli.
2.Formal —de diiwme yerlesdirmeli. Onufi fiame hésiyetinifi bahasyna cmdCaption, Caption hisiyetine
Adyny uytgetmeli yazgy bermeli. Ona su programma boélegini gosalyn

Private Sub AlterCaption(X As String)
Caption = X
End Sub

Yerne yetirenimizde onuf gorniisi seyle bolar

5 Forml - 0] x|

Adury

Prosedurada bir sany X argument bardyr.
Prosedurany ¢agyrmak ii¢in formadaky diiwmaéni basyp programma dpisgé su bolegi yazalyn

[ 1Projectl - Form1 [Code) - 10| x|
|cdeaptiun j |C|ir.k j
rF
Private 3ub cmdCaption Clicki)
LlterCaption "Taze atlandyrma®™
End Sub

-
4| | 3

Programmany yerine yetirsek, hem-de Formal-déki yazgyly diiwméni bassak seyle forma ekrana
geler
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B9 Taze atlandprma _ O] |

Adyrg
uptgetrneli

Ony Y yaly edip hem berip bolar, onun iicin prosedurany seyle liytgedelin

[ 1Project] - Form1 [Code] -0 x|
|t:mdl:aptiun j |Click j

Fs
Private Zub cwdCaption Click()
Dim ¥ Az 3tring
¥ = "Taze atlandyrma’™
AlterCaption ﬂ
End Zub

- 0 Ry

Netije edil yokardaky yaly bolar.
Funksiyalar boyunga berilydn parametrler, yayyn iginde bolmaly. Proseduralar boyunga berilydn

parametrlerde beyle talap yokdyr. Mysal ii¢in, CreateUser prosedurada iki parametr, yagny isleyénin ady
we paroly berilmeli bolsa ony ¢cagyrmagyn yazylysy seyledir:

CreateUser “Ashyr”, “654321”
ya-da

Dim UserlID As String
Dim Password As String

UserlD = “Ashyr”,

Password = “654321”
CreateUser UserlD, Password

Birinji yazylysda parametrler goniiden goni berilyér. Ikinji yagdayda liytgeyan ululygy ulandyk. Bir

sapar prosedurany cagyrdyk.

Su proseduranyn esasynda yorite funksiyany doredibem bolar, at bilen paroly barlap yza gaytmak

isini amal etmek isi ticin

Dim UserID As String
Dim Password As String

UserlD = “Ashyr”,
Password = “654321”

If ValidUser(CreateUser UserID, Password)=True Then
‘Bahbitli ish etmek

Else

‘valitys barada habar

End If

Parametrler yayyn i¢inde yerlesip, aralarynda otur goyulandyr.
Mazmuna gecmek
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Parametrler berlende Optional adalga

Funksiyalar kesgitlenilende kébir parametrlerii hokman délligini goérkezmek zerur bolsa, sol
parametrin o6niinden Optional s6zi yazmalydyr, Mysal {i¢in,

Public Function CreateUser (UserID As String, _
Password As String, _
Optional Description As String) As Boolen

Bu yerde Description parametr hokman berilmeli parametr déldir, amal edilmeli funksiya ony
bermesenem iglir. Optional —dan son yazylan parametrlerit hemmesi hem su hisiyete eyedir.
Mazmuna gecmek

Parametrler berlende ByRef adalga

Funksiyada ya-da prosedurada ByRef bilen berlen parametr salgy boyung¢a berilydr. Yazylysynyn
gorniisi

Function FunctionName(ByRef AVariable As String) As Boolean

ya-da
Function FunctionName(AVariable As String) As Boolean

Sonky yagdayda ByRef ulanmak hokman hem déldir, sebébi onun salgysyny gérkezmek
yeterlikdir.

Parametrler berlende ByVal adalga
Bu yerde parametr bahasy boyunca berilyér, onun yazylysy

Function FunctionName(ByVal AVariable As String) As Boolean

Parametrler berlende ParamArray adalga
ParamArray adalga bilen funksiya kesgitsiz mukdarda parametrleri berip bolar, ona yeke-tdk talap
olam bolsa berilyin toplumyn gorniisi Variant bolmaly. Onun funksiyada yazylysy:

Function FunctionName(ParamArray AnArray() As Variant) As Boolean
Bu yagdaya seyle cagyrylyp bilner
Dim rc As Boolen
rc = FunctionName(“Ashyr”, “Maya”, “Ayhan”)

rc = FunctionName(“Berdi”)
rc = FunctionName(“Gurban”, “Hoja”)

Mazmuna gecmek

4.7.Public we Private adalgalar

Public we Private adalgalar proseduralaryn goriinydn yerini kesgitleyirler. Private adalga
prosedurany modul derejesinde elyeter edydr. Beyle diyildigi onun bilen formada ya-da modulda bar
bolan obyektler bilen isldp bolar. Public adalga bilen yglan edilen prosedura we funksiya taslamanyn &hli
derejesinde elyeterdir

Mazmuna ge¢mek

Yapyk prosedura(Private)

Kompyiiter maksatnamada modullar proseduralardan ybaratdyr. Prosedurada Sub adalgadan 6n
adalga Private gelyar.Hokmany bolmadyk Private adalga yglan edilen formalaryn ya-da modullaryn
proseduralary ii¢in elyeter bolan prosedurany beyan edyar.
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Her bir formanyn fayly, 6ziinde forma bilen baglanysykly islerin prosedurasynyn yazgysyny
saklayar, ona formanyn kody diyilyar(inlisgesi: code behind form — CBF). Formanyn kodyna formanyri
moduly hem diyilyar. Modul 6zbasdak proseduralaryii toplumy bolup, ol berlen formanyn ya-da 1 basga
prosedurasyndan is prosedurasy bilen ¢agyrylyp bilner.
Ahli proseduralar Private adalga bilen baslanmalydyr.Ol su proseduranyfi formanyfi modulynyi
ciklerinde cagyrylyp bilinydndigini anladyar.
Eger Public we Private adalgalar gorkezilmedik bolsa prosedura agyk hasap edilyar.
Mazmuna gecmek

Acyk prosedura(Public)

Agyk prosedura(Public) bolanda ona forma-dan dasardaky islendik yerden hem ol elyeter
bolyar.Mysal {i¢in, Test prosedura seyle yglan edilen bolsa ony amal etmek {i¢in

Test
gorniisde bir setir yazmak yeterlikdir. Bu isler Sub proseduralara degislidir. Funksiya baggarak

cagyrylyar.
Mazmuna gecmek

4.8. Toplumlaryn modullary bilen islemek

Topar Ozara arabaglanysykly amallary yerine yetirmek {i¢in hésiyetleri we usulyetleri 6ziinde
jemleydr. Topar programmanyn Ozbasdak bolegidir.Topary bir taslamadan basga taslama gecirip
bolar.Visual Basic obyektleri toparlar esasynda doredilydr. Mysal ii¢in, formadaky obyekt-diiwme yorite
topar esasynda doredildr. Toparlar standart modullar hokmiinde ayratyn fayllarda saklanylyarlar.
Toparlarda hokmany suratda su iki Class_Initialize() we Class_Terminate() proseduralary O6ziinde
jemleyar.

Class_lnitialize() - prosedura hisiyetin bahasyny beryar.

Class_Terminate() - prosedura tamamlayjy hereketi yerine yetirmek {i¢in kody 6ziinde saklayar.

Mazmuna ge¢mek

Toparlarda usulyet

Toparlarda usulyet modullardaky proseduralaryn iyerine yetiryar. Bu yerde usulyetin ady Public
we Private adalgalar bilen baglanyar. Public bilen agylan usulyet toparda programma arabaglanysygy
emele getiryar, onun bilen bilen programma ¢éklendirmesiz isldp biler. Private yapyk usulyetde toparyn
icinddki amallar yerine yetirilyar.

Topardaky yapyk usulyete mysal hokmiinde iggérlerin mglumat goryndan maglumatlary almak ugin
usulyete seredelin. Seyle maglumatlara elyeterlik ¢idklendirilen bolup, olardan maglumatlar yapyk usulyet
bilen alynyar. Banklardaky bankomatlaryn isleyisinifi usulyetinint yazylysynyn prosedurasy seylerdkdir:

Private Function GetBalance(AccountNo As String) As Double
GetBalance = 1000000
End Function
Public Function DisplayAccountinfo(AccountNo As String, PIN As _ String) As Double
If AccountNo = “654321” And PIN = “5551289” Then
DisplayAccountinfo = GetBalance(AccountNo)
End If
End Sub

Bu yerde GetBalance funksiya yapyk diyilip yglan edilen, sebibi hasaba galtasygy yoklara
ony bilmegin zerurlygy yokdyr. Hasaba elyeter bolmagy caklendirmek {i¢in hasaba giriji
DisplayAccountinfo proseduradan gegmelidir. Bu prosedurada hasapdaky yagdayy bilmek ii¢in hasabyn
nomeri we hasabyi eyesinin hususy identifikatory(kody, ofta PIN kod hem diyilyér) barlanyar.

Mazmuna gecmek
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Toparlarda hisiyet

Toparlarda hésiyet hem usulyetler yaly agyk we yapyk bolup bilerler. Agyk hésiyetler
proseduralarda ulanylyar hem-de toparyi interfeysiniii bolegini emele getiryér. Yapyk hésiyetler
interfeyse girmeydn maglumatlary saklamak ti¢in peydalanylyar. Olar toparyi isini {ipjlin edyén
maglumatlary tétdnden ya-da bilgeslinden ayrylmagynyi o6niiini alyar.

Toparlaryn hisiyetleri bilen is Property Get, Property Let we Property Set operatorlaryn komegi
bilen yerine yetirilyér.

Property Get operator programma goniiden-goni yiiz tutyp bilmejek iiytgeyan toparyn bahalaryny
almak iicin agyk interfeysi emele getiryar.

Property Let operator yokarka ters isi - ol liytgeyéin toparlaryn bahasyny beryar.

Property Set operator obyektleri salgy boyunca bermegi iipjiin edyar.

Property Get we Property Let operatorlar toparlaryi hésiyeti {icin yonekeyje gorag sekilini
doretmage miimkingilik beryér.

Bankomat mysalymyzda AccountNo we PIN ululyklaryn-hésiyetinin dhmiyetine seredelin. Su
toparda hisiyetin bahasyny gereginge berip usulyeti parametrlersiz cagyrmagyn prosedurasy seyle

yazylyar

Public AccountNo As String
Public PINNo As String

Private Function GetBalance() As Double
GetBalance = 1000000
End Function
Public Function DisplayAccountinfo() As Double
If AccountNo = “654321” And PINNo = “5551289” Then
DisplayAccountinfo = GetBalance()
End If
End Function

Su yokarky programma bdlegi Property Let we Property Get
Operatorlary peydalananmyzda seylerdk yazylyp bilner:

Public AccountNo As String
Public PINNo As String

Private Property Let AccountNo(x As String)
AccountNo = x
End Property

Public PropertyLet PIN(x As String)
PINNo = x
End Property

Private Function GetBalance() As Double
GetBalance = 1000000
End Function
Public Function DisplayAccountinfo() As Double
If AccountNo = “654321” And PINNo = “56551289” Then
DisplayAccountinfo = GetBalance()
End If
End Function

Mazmuna gecmek

Toparlarda is

Toparlarda is, sol toparlarda kesgitli sertleri kanagatlandyrmakda gosundylar bilen maglumat alys
calysygyny amal etmége miimkingilik beryar.Programma is bilen dolandyrylyar, programmada haysy sert
yerine yetse sonunam isi kesgitlenilyér.



78
Toparda isi kesgitlemek ti¢in programma yazylyan penjrdnin (General)(Declarations) modul
bolegindéki Public Event adalga bilen berilip bilner, onun yazylysy

Public Event EventName(parametrler)

Bu setirde anyk prosedura yazylman isin yglan edilmesi yazylandyr.Formada isi doretmek tigin
peydalanylyan yazylys seylerdkdir

Private WithEvents x As ClassName
Mysal {i¢in,
Private WithEvents p As Person

Yazgy Person toparyii esasynda doredilen p obyekti yapyk diyip yglan edyir.
Mazmuna ge¢cmek

SmartForm topary doretmek

SmartForm topary ekranyn yagdayy we gorniiginin mogberini yatda saklamak we almak {igin
peydalanylyar, onuii kdmegi bilen toparyn taslanylysyna seredip gecelin.
SmartForm topary peydalanyp formanyn mogberinini yagdayy barada maglumaty yat-da saklamak
we almak tigin ulanmagyn yzygiderligi seylerdk taslanyar:
1.Ctrl+N diiwmeleri utgasdyryp basyp ya-da File » Project buyruk bilen tdze taslama doretmeli.
2.A¢ylan New Project penjireden Standart EXE saylamaly.
3.Taslama &dpisgd baryp sycanyi sag gulagyny basyp ¢ykan gapdal menyudan Add» Class Module
saylamaly.
4.Agylan Add Class Module penjireden Class Module saylamaly.
5.Hasiyetler dpisgd baryp Name gapdalyna SmartForm yazmaly.
6.Taslama &dpisgd ¢ykan SmartForm yazgyny iki sapar agyp, onuil iigin programma yazylyan penjrini
acmaly.
7.Programma yazylyan penjranin (General)(Declarations) bolegini basyp topara su moduly yazmaly

Option Explicit

"Yapyk uytgeyanler
Private mForm As Object
Private mLeft As Long
Private mTop As Long
Private mWidth As Long
Private mHeight As Long
Private mWS As Integer

Public Event ErroMessage(Message As String)

8.Topara Tools » Add Procedure bilen tize hasiyet gosmaly.

9.Ekranda Add Procedure penjire bolanda Name meydandaky Form setiri ise girizmeli.
10.Property gegirijini goymaly, Scope gegcirijini Public yagdayda goymaly.

11.Sonira OK basmaly. Programma modula su iki prosedura gosular:

Public Property Get Form() we Public Property Let Form(ByVal vNewValue As Variant).
12.Property Let Form(ByVal vNewValue As Variant) Setirde Let soziini Set soziine ¢alysmaly. Ol seyle
yazylar
Property Set Form(ByVal vNewValue As Variant).
13 Property Get Form() prosedura seyle setir goymaly

Form = mForm
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14. Property Get Form... prosedura su setiri goymaly

Set mForm = vNewValue

15.Ctrl+H basyp gozleg, yazgyny calysmak penjiresini cagyrmaly.

16.Find What meydana Variant séz yazmaly.

17.Replace With meydana Object s6z yazmaly.

18.Current Module gegirijini goymaly.

19. Replace All diiwméni basmaly, modulda dhli Variant gorniisler Object gorniislere owriiler.
20.Cancel basyp penjrani yapmaly.

21.Programma yazylyan penjraniin (General)(Declarations) boélegini basyp topara su moduly yazmaly

Private Sub SaveSettings()
Dim mAppName As String

'‘UytgeyaneEXE -fayl atlandyrmaly
mAppName = App.EXEName

'‘Maglumaty Formanyn ady we goshundynyn
‘ady belli bolanda yatda saklap bolar
With mForm
If .Name <>"" Then
SaveSetting mAppName, .Name, _
"WindowState", Str$(.WindowState)

If .WindowState = vbNormal Then
SaveSetting mAppName, .Name, _
"Left", Str$(.Left)
SaveSetting mAppName, .Name, _
"Top", Str$(.Top)
SaveSetting mAppName, .Name, _
"Width", Str$(.Width)
SaveSetting mAppName, .Name, _
"Height", Str$(.Height)
End If
Else
‘ErrorMasssage ishi bashlamaly
RaiseEvent ErrorMessage("Bermeklik " —
"obyekt formany!")
End If
End With
End Sub

Bu yerde esasy is SaveSetting bilen amal edilyér.

22.Programma yazylyan penjranin (General)(Declarations) bdlegini basyp topara su prosedurany
yazmaly

Private Sub GetSettings()
Dim mAppName As String

‘UytgeyaneEXE -fayl atlandyrmaly
mAppName = App.EXEName

With mForm
If .Name <>"" Then

mLeft = Val(GetSetting(mAppName, _
Name, "Left", .Left))

mTop = Val(GetSetting(mAppName, _
.Name, "Top", .Left))

mWidth = Val(GetSetting(mAppName, _
.Name, "Width", .Left))
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mHeight = Val(GetSetting(mAppName, _
.Name, "Height", .Left))

Formanyn mochberini uytgetmeli
WindowState = mWS
.Move mLeft, mTop, mWidth, mHeight
Else
'ErrorMasssage ishi bashlamaly
RaiseEvent ErrorMessage("Bermeklik " _
"obyekt formany!")
End If
End With
End Sub

Toparda formanyn mdgberini iytgetmek {icin programma yazylyan penjrinin (General)(Declarations)
bolegine Resize usulyeti gosmaly

Public Sub Resize()
'Formanyn koordinatasyny
'vatda saklamaly
SaveSettings
End Sub

23. Programma yazylyan penjréanin (General)(Form [Property Set]) bdlegine su prosedurany gosmaly

Public Property Set Form(ByVal vNewValue As Object)
‘Formanyn haky mochberine salgy doretmeli
Set mForm = vNewValue

'Yatda saklanan koordinatany almaly
GetSettings

‘Mochberi birinji sapar uytgetmeli
Resize
End Property

24.Topara Formanyn obyekti yiklenyirkd parametrleri yatda saklamagy we salgylary ayyermagy
bermeli, onui iicin Class_Terminate is prosedurasynda su bdlegi yazmaly

Private Sub Class_Terminate()
'Formanyn parametrini yatda saklamaly
SaveSettings

'Obyekte yerli salgyny ayyrmaly
Set mForm = Nothing
End Sub

25. 1.ctrl+S ditwmeleri utgasdyryp basyp ya-da File » Save As buyruk bilen taslamany at berip, ony 6z
programmahananda Save basyp yatda saklamaly.
Su doredilen programma bdlegini islendik taslamada ulanylyp bolar. Ony taslama gosmagyn
yzygiderligi seyle amal edilyér:
1.Taslama penjiresindiki Formal basyp, onun ii¢in programma penjiresini agmaly.
2.Programma yazylyan penjréinin (General)(Declaration) bdlegine su prosedurany gogsmaly

Option Explicit
Private WithEvents sf As SmartForm
3. is prosedurasyna gegmeli,

Private Sub sf_ErrorMessage(Message As String)
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MsgBox Message
End Sub

Bu yerde MsgBox buyruk bilen Visual Basic maglumat ¢ykarmak tigin penjire agyar.

4.SmartForm(sf) toparynn obyktinden peydalanmak {i¢in ony doretmeli, onun iicin forma Formal
Form_Load() is prosedurasyny gosmaly

Private Sub Form_Load()
Set sf = New SmartForm
Set sf.Form = Me

End Sub

5 Formanyil mogberi liytgdnde . SmartForm obyekt formanyin mogberini we yagdayyny yatda saklamagy
icin Form_Resize is prosedurasyny gosalyn

Private Sub Form_Resize()
sf.Resize
End Sub

6.Forma yapylanda .sf obyekt ayrylmaly, onun ticin Form_Unload() is prosedurasyny gosmaly

Private Sub Form_Unload(Cancel As Integer)
Set sf = Nothing
End Sub

7.Taslama penjiresine girip Projectl setiri agyp Name hisiyete Barlag baha bermeli.
Mazmuna ge¢mek

5.Menyular we gurallar panellerini doretmek we peydalanmak

5.1.Visual Basic-de menyu we gurallar paneli

MS WINDOW gursawyn esasy islerinin kopiisi goni we gapdal menyulary hem-de gurallar paneli
bilen amal edilyir. Adatca MS WINDOWS-yn standartlasdyrylan menyuy we gurallar paneli bardyr.
Onun bilen islendik isi yenillesdirip, tizlesdirip olardaky yazgylary, bellikleri basmak bilen afisat yerine
yetirip bolar. Standart bolmadyk isleri yorite diiwme-bellik gérniisinde gurap bolar. Visual Basic-ii hem
isleri yenillesdirmek {i¢in agakdaky gorniisde menyuy we gurallar paneli bardyr.

File Edit Wew Project Formak Debug Run Query Diagram Tools add-Ins Window Help

H-h-BeE e > HE SHR A

Menyu bilen her hili islere girip isldp bolar. Amal edilydn obyekte baglylykda, ony saklabam, ise
girizibem, belgildbem, sekillendiribem bolar. Seyle hem formanyn icine girydn formalara girmek {igin
penjirede sanawam doredip bolar.

Gurallar paneli bolsa menyu boyunca buyruklary tiz ¢agyrmak ii¢in niyetlenilendir.Mysal ii¢in,
Edit » Copy basanyiidan Copy belgini ya-da yazgyny basmak isi tizlesdiryér.

Mazmuna ge¢mek

Menyuyn obyekti

Menyu ulanyja yaramly gornlisde islemek ucin niyetlenilen bolmaly.Visual Basic-de menyu
doretmek {licin menyu elementi peydalanylyar. Ol fomada bar beyleki elementlerden tapawutlanmayar. Ol
elementler panelinde hem yokdyr, ony gormek {igin Visual Basic-ddki gurallar panelindédki diiwme bilen
ya-da buyruk bilen menyu redaktoryny ise girizmeli.

Menyu elementi birndge hidsiyeti eyedir, bir isi hem goldayandyr, hi¢ hili usulyeti yokdyr. Menyu
elementi formada yerlesdirmek iicin ol forma isjent yagdayda bolmaly. Ony belgilédp
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Tolls » Menu Editor buyrugy amal etmeli ya-da ony gurallar panelinddki diiwmeden ise girizmeli, sonda su

penjire agylar:

Menu Editor |

Capkion: | ok
Mame: | Cancel

Index: Shorkcuk: |(Nnne} j
HelpContextID: |0 MegotiatePosition: 0-Mone -
[T Checked I+ Enabled v wisible [ windowlist

ﬂﬂﬂﬂ | [k I Insert | Deleke |
|

Su redaktorda menyu doretmek isi amal edilydr. Menyu bir ya-da birndge yokary derejeli
atlandyrmalardan ybarat bolyar, Mysal iicin, File. Her bir atlandyrma bir ya-da birndge buyruklardan
duryar, Mysal {i¢in, Exit. Meyua bdéliijileri hem girizip bolar, olar bilen 6zara arabaglanysykly buyruklary
toparlasdyryp bolar.Netijede menyuwyn bir elementinint ornuna birgidenini alyp bolar. Menyuyn her bir
atlandyrmasy we her bir buyrugy ayratyn toplum bilen ayratyn element bolup, Click ise eyedir.

Menyuyn héasiyeti

Mazmuna gecmek

Menyu hasiyetleri konstruirlemek diizgiininde elyeterdir, olar bilen hasiyetler penjiresinde
islenilmeydr, dinie menyu redaktorynyi iisti bilen islenilyar.

Appearance
Caption
Checked
Enabled
HelpContextlD

Index Tag

Name Visiable
NegotiatePosition WindowlList
Parent

ShortCut

Bu tablisada garaldylanan hisiyetler has mohiimleri bolup olar asakdaky yumuslary yerine

yetiryarelr:

Caption hidsiyet menyuda gorkezilydn yazgyny kesgitleydr. Ondaky &-ampersand belgi diiwménin
tizlesdirip ¢agyrylmak buyrugyny beryar.
Checked hdsiyet buyruk bilen bir hatarda markeri yerlesdirydr(ya-da ayyryar).Onuni bahasynyn
komemegi bilen programma yerine yetirilydrkd menyu buyrugyny ayrybam, gosubam bolyar.
Enabled hédsiyetin bahasy False bolsa gapdal menyuyn hézirki yagdayynyn manysy yokdyr.Mysal {i¢in,
Save buyruk boyunga haysam bolsa bir maglumat girizmesen manysy yokdyr. Hisiyetin
bahasyny programma yerine yetirilydrka tiytgedip hem bolar.
Visiable hésiyet bilen menyu buyrugyny amal etmén bolar.
Name hésiyet elementin ady bolup, ol deslap kesgitlenilmelidir. Onuni ady mnu bilen baglanmalydyr.
ShortCut hisiyet akseleratory kesgitleyér, ol buyrugy klawiaturanyn diiwmesi bilen hem c¢agyryp
bolmagy anladyar. Adatga seyle is licin Ctrl we Alt dliwmeler F1 bilen utgasdyrylyp akselerator
cagyrys amal edilyédr. Mysal {i¢in, Alt+H diiwmeleri bassan komek ekrana geler.
Redaktorda doredilen menyuy formada konstruirleme diizgiinde agyp bolar. Onuni prosedurasyna,
Click - seretmek ti¢in konstuirleme diizgiininde menyuyn buyrugyny basmaly.

Mazmuna gecmek
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Click is
Click isi menyuyn elementlerinint goldayan yeke tik isidir. Ol tizlesdirilydn cagyrma diiwméni we

akseleratory peydalanylanda ise girizilyar.
Mazmuna ge¢cmek

5.2.Menyu redaktorynda menyu doretmek

Menyu doretmek isi kopleng menyu redaktorynda doredilyér. Ol is Tolls » Menu Editor buyrugy bilen
baslanyar. Formada menyu doredilende asakdaky ayratynlyklary bilmeli:

1.Caption we Name hésiyetlerini bahalary deslapdan girizilmeli.

2.Menyuyn hézirki elementi {i¢in akseleratory saylap bilsefiem bolar.

3.Redaktoryn penjiresinddki Caption, Enabled, Visiable yazylardaky belgilemeler bolsy yaly durmaly.

4.Redaktordaky saga, ¢cepe goniikdirilen peykamly diiwmeler menyu elementlerinin 6niinden bos yeri
tiytgetmek {i¢in niyetlenilendir. Menyuyn ady ¢ep gapdal boca dogurlanyar. Menyuda bir sapar bos
yer bolup biler, iki bolsa ikinji derejeli yokarky menyua bagly menyu anladyar.

5.Redaktordaky yokary, asak goniikdirilen peykamly diiwmeler sanawdaky menyu buyruklarynyn we
atlandyrysynyn gelis tertibini liytgedyar.

6.Index meydanyna girizilen san menyuy elementlerin toparyna dwiiryar.

7.HelpContextlD meydanda anyklama kontekst girizilydr, onun bilen is amal edilydrkd anyklama
fayllaryna yiizlenilyér.

8.NegotiatePosition meydan bilen MDI formalar bolanda menyuyin verlesisiniit yokarky derejesini
kesgitleyér.

Ilki bilen formanyn ady Caption we Name bilen hokmany kesgitlenmeli, ondan son ofia buyruklary
gosmaly. Ahli buyruklarda oniinden yeke bos yer goyulmaly.Ondan son indiki at we ona degisli
buyruklar girizilydr.Indiki ona gosjak obyektiil iicin apisgedaki Next yazgyly diiwméni basmaly. Eger
kébir atlary girizmek yatda ¢ykan bolsa olary sonundan girizip, soiira penjireddki peykam bilen gerek
yerifie eltiymeli, yogsamam gerek yerifie kursory eltip Insert basyp girizmeli. Islendik obyekt penjiredaki
Delete diiwme bilen ayrylyar. Meyua boliiji(-) gosjak bolsan Caption meydana hem bdliiji(-) goymaly.Bu
yerde Name hem bahasyny bermeli.

Menyuyn adynyin we buyruklarynyn oiilinden mnu yazgyny yazyp baslamaly. Mysal i¢in, File
menyuyn ady mnuFile diyilip yazylmaly.Buyrugyn ady menyuyn adyna gosulyar. Mysal ii¢in, File
menyudaky Exit buyruk seyle mnuFileExit yazylyar.

Formada yonekeyje menyu doretmegin yzygiderligi asakdaky yalydyr:

1.File » New Project bilen tdze taslama doretmeli.

2.Taslamanyn Standart EXE gorniisiini saylamaly.

3.Formal forma baryp ony isjen yagdaya getirmeli.

4. Tolls » Menu Editor bilen ya-da Ctrl+E basyp menyu redaktory ise girizmeli.
5.Caption meydana &File we Name meydana mnuFile yazyp File menyu doretmeli.

Menu Editor

Zapkion; |&File

Mame: |mnuFiIe Cancel

Indes: Shorkout: |(N.:.ne]|
HelpContextID: |0 MeqgotiatePosition:  |0-pone -
[ Checked [+ Enabled [ Wisible [ WindowLisk

4-| +| fl +| ek | Insert | Delete |

6.Next basyp menyuyn indiki buyrugyna gegmeli.
7.Indiki buyruk File menyuda bolmaly, onun {i¢in penjireddki sag peykamy basmaly, sonda gerek
boslygyn bolar.

ek
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8. Caption meydana &Exit we Name meydana mnuFileExit yazmaly.

Menu Editor |

Caption: |aExit Ok,
Mame: |mnuFiIeExit| Cancel
Index; Shortout: ||{Nn:nne]| ﬂ

Helponke:xtID; ||:| MegotiatePosition:  |0-pMone =

[ Checked [+ Enabled [+ Wisible [ wWindowlList
ﬂ ﬂ ﬂ ﬂ (54 | Insert | Delete |
&File

9.Birinji menyymyz tayyar boldy. Edit we Help menyuy buyruklary bilen asakdaky hasiyetlerde
doretmeli.Her sapar Name hasiyetden son Next diiwmani basmaly.
Girizilisin yzygiderligi:

Edit menyuy
Caption Name
&Edit mnuEdit
Edit menyuyn buyruklary
Caption Name
&Cut mnuEditCut
&Copy mnuEditCopy
&Paste mnuEditPaste
Help menyuy
Caption Name
&Help mnuHelp
Help menyuyn buyruklary
Caption Name
&About mnuHelpAbout

Menyu redaktorynyn tayyar gérniisinini penjiresi seyledir

Menu Editor

Zapkion; |&.ﬁ.b|:|ut k.

Marme: |mnuHeIp.ﬁ.I:n:|ut Femm

Index: Shortout: ||:N|:|ne]|
HelpConkextID: ||:| MegaotiskePosition: |0 - Mone =

[ checked [+ Enabled [V wisible [ windowList

ek,
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Formada doreden menyuymyzyn gorniisi

55 Forml =10 x|
File MW Help
D Eut ..........................

I

Su doreden menyumyzdan File » Exit bassak mnuFileEXit_Click() prosedurasyna gecip bolar, ony agyp
ona End operator yazyp

Iz Project] - Form1 [Code] O] x|

|mnuFiIeExit ﬂ |Click ﬂ
x|

Frivate Zub mnuFileExit Click()

lEnd

End Sub

-

=J= iy

Run » Start basyp taslamamyzy ise girizelini, ahli menyular dogry agylyp dogry yapylar, Exit buyrugy
bassak taslama boyunca is tamamlanar.

MS Windows amallar ulgamy ulanyjynyn grafik interfeysini(inlisge gysgaltmasy - GUI) ulanylyar.
Onda grafikler, formalar we belijikler bilen is salysylyar, buyruklar yazgy bilen adat¢a girizilmeyar.
Windows ulgamda taslama isleri doredilende hem GUI satandarty saklanylmaly. Adatca menyu
taslanylanda Windowsa metizes taslajak bolup ¢alysmaly. Mysal ii¢in, File yazgy menyuda mydama ¢ep
yokarky bur¢da yerlesdirilydr, Help yazgy bolsa menyu setirin sagynda yerlesdirilydr. Seyle edilse
taslamany ulanyjy ii¢in amatly bolar. Sunyin yalyda menyu sozlerinde haysy harpyn asagy cyzykly
bolmalydygynyin hem GUI standartda g6z 6iilinde tutulandyr.

Mazmuna gecmek

5.3.Gurallar panelini doretmek

Taslamada gurallar paneli i menyuynyn isinin  yetirilydn peydaly gosundydyr, ol buyruklaryn
cagyrylysyny caltlandyryar. Gurallar paneli taslananda miimkin bolsa standart cozgiitlerden ugur
alynmalydyr. Diiwme ya-da belgijik bolsa onun standart mogberi bolmaly, ol seredilende ulanyja
diigtinikli bolmaly. Menyularynl beyleki taslamalardan alnysy yaly gurallar panelini hem ol yerlerden alyp
bolar.

Visual Basic-de gurallar panelinin adat¢a doredilisinin yzygiderligi seylerdkdir. Gurallar paneli
bilen islemezden 61, ony elementler paneline yerlesdirmeli:

1.Eger gerek elementin yok bolsa, onda elementler paneline baryp peykamyn sag gulagyny basmaly,
¢ykan gapdal menyudan Components buyrugy saylamaly. Ekranda onun penjiresi peyda bolar. Cykan
sanawdan Microsoft Windows Common Controls 6.0 setirii 6niiinde bellik goymaly. Ok basmaly.
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Components

Contrals | Designers ] Insertable Objecks ]

Microsoft Cutline Control

Microsoft PickureZlip Contral 6.0

Microsoft RemoteData Control 6.0

Microsoft Rich Textbox Contral 6.0

Microsoft Scripk Conkrol 1.0

Microsoft SysInfo Conktrol 6.0

Microsoft Tabbed Dialog Contral 6.0

Microsoft Windowes Cormmon Conkbrals 5, D (SPZ)
asoft YWindows O

i
il
o
[[=]]=}
=]

A

—amnan '_'_'rlrrl |I_ .0
Mlcrc\sc\Ft Windows Cormmon Conkrols- 2 S.00(5P:
Microsoft Windows Common Controls-2 6.0
Microsoft Windows Common Conkrols-3 6.0
. . Browse. .. |
Microsoft Winsock Control 6.0
4 | »

[ Selected Ikems Only

Microsoft Windows Cormmmon Conkraols 6.0

Location:  COAWINDOW S SYSTERMMICOMITL, O

o 1

OTMEHa | MNpHMEHHTE |

2.Gurallar paneliniii elementini Formada yerlesdirmeli. Name hésiyete tbrToolbar, Algin héasiyete 1-
vbAlginTop bahalary bermeli.

3.Hasiyetler penjirede Custom setire baryp iki sapar peykamy basmaly, sonda Property Pages penjire
agylar.

4.Ac¢ylan Property Pages penjirede Buttons gata gegmeli.

5.Birinji diwméni gurallar panelinde yerlesdirmek {i¢in gatdaky Insert Button diiwméni basmaly.

6.Style meydandan 3-tbrSeperator setiri saylamaly, netije asakda getirilendir.

x|| Properties - thiTookar x|
Caneral Buttons lPicture] [tbrToolbar Tookhar |
Alphabetic | Categorized ]
Index: 1 jj Inzert Buttan | Bemove Buthan |
LCaption: Drescription:
Mame) tbrToolbar
Kew: Walue: [p. - (
=y | = |D thrlinpressed J Align 1 - vbalignTap
Stule: 3 - thrSeparatar | width: [Flacehalder) AllowCustomize  True
. ) ) AppEarance 1-ecal
VeI | I | EorderStyle 0 - ccMone
Tag | EttonHeight 329,9528
Eithoniwidth 3452599
W isible W Enabled ™ MixedState !
Craglcon (Mone)
B emnE Craghlode 0 - vbManual
Enabled True
Indes: JJ Ingert Buttontenu | Height 420
. . . HelpContextID 0
Test: Kew Tag:
| | HelpFile ﬂ
[ =
(Custom)
Ok | OTHEHS | | Cnpaeka |

Gurallar panelinde diiwme doretmek
1.Forma tdze diiwme gomak li¢in Property Pages penjirede Insert Button diiwméni basmaly. Key hdsiyete
New yazgy yazmaly, Style hisiyete 0 — trbDefault baha bermeli.
2.Forma yene tdze diiwme gomak {igin Property Pages penjirede, tdzeden Insert Button diiwméni basmaly.
Key hisiyete Open yazgy yazmaly, Style hésiyete 0 — trbDefault baha bermeli.
3.Forma yene tdze diiwme gomak tigin Property Pages penjirede, tizeden Insert Button diiwméni basmaly.
Key hisiyete Help yazgy yazmaly, Style hdsiyete 0 — trbDefault baha bermeli.
4.Property Pages penjireddki OK diiwméani basmaly.
Tolls » Menu Editor bilen ya-da Ctr+E basyp menyu redaktory ise girizip o6n gorkezisimiz yaly File, Edit we
Help menyulary Forma ge¢irmeli. Amal eden islerimizin netijesinde Gurallar panalli su Forma - ny aldyk:
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59 Forml - 10| x|

File  Edit Help

Mazmuna gecmek

5.3.1.Gurallar panelini diiwmelerinde sekiljikler doretmek.

Gurallarda sekiller doretmek isi Visual Basic-de sekiller paneli bilen baglanysyklydyr, onufi amal
edilisinin yzygiderligi asakdaky yalydyr:
1.Elementler panelindédki sekiller sanawyny- belgijigini Forma gegirmeli, onun Name hisiyetine
imlToolbar baha bermeli. Degisli elementin elementler panelinde bolmagy ii¢in elementler panelinde
Components... basyp, ¢ykan penjireddki sanawdan Microsoft Common Controls setride bellik etmeli.
2.Hésiyetler 4psgede Custom Setiri basyp Property Pages dpsgéni agmaly.
3.Property Pages penjirediki Images gaty agyp belgijik gogsmaga girismeli.
4.Adatga sekil goymak bos sahypa gabat gelydn New buyrukdan baslanmaly. Onun {igin penjiredéki
Insert Picture basmaly.
5.Kompyuterdéki sekiller katalogyny agyp Tblr w95 papkadan c:\wisuaL
ULGAMLAR\COMMON\GRAPHICS\BITMAPS\TLBR_W95 sekiller fayllaryny agmaly.
6.Papkadaky sanawdan New fayly saylamaly, yerine baranda ony basmaly.
7. Penjirede Insert Picture basmaly, ¢ykan fayllardan Open fayly saylamaly, yerine baranda ony basmaly.
8.Yene bir sapar Insert Picture basmaly, ¢ykan fayllardan Save saylamaly. Property Pages penjréni OK
basyp yapmaly.
Bellik: windows Paint bilen gurallar paneli {i¢in 6z belgijiginizi doredip bilersiniz. Kigi belgijiklerin 6l¢egi
16x16 piksel, uly belgijigin 6lgegi 32x32 piksel bolmaly. Sekilin dl¢egini Image » Attributes ya-da
Ctrl+E diiwmeler bilen goyulyar.

Property Pages |

zereral  Images lCu:qu:ur ]

Current Image
Index: |3 Few |
Tag |
|mages:
u} = [
Clrsei Biciue,. || Bemove Fictwe | Image Count. [3

OF | OTHEHA | | CNpaeka |

9.Hasyetler penjiresindéki tbrToolbar hisiyete gegmeli, ondan son ol yerddki Custom Setire baryp, ony
a¢cmaly sonda Property Pages penjire agylar.
10. penjrénin General gaytyn ImageList hisiyetyine imlToolbar baha bermeli.
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Property Pages ﬂ

General lButtl:uns | picture |

MouzePointer: |IZI - ool efault

Lef Lo

OLEDropMode: |0 - ccOLEDiopMone

ImageList; | imlT oalbar ﬂ

Digabledimagelist: | nluar |

Hatlmagelizt: | <Manes j

HelpContextD: 0 HelpFile: |

ButtonH eight: W W AllowCustormize W \rappable
Buttariidth: 345,2533 W ShowTips W Enabled
Appearance: m BorderShyle: |I:| - ccMone ﬂ
T extdlignment: |IZI - tbrT extdlignB ottom ﬂ
Syl |IZI - tbr5tandard ﬂ

OF | OTHEHA | CMpaeka |

11. Buttons gata ge¢meli.

12.Penjirediki Index hésiyete 2, Image hésiyete 1 baha bermeli, onda New sekli yerleser.

13.Penjiredaki Index hésiyete 3, Image hésiyete 2 baha bermeli onda Open sekli yerleser.

12.Penjirediki Index hdsiyete 4, Image hésiyete 3 baha bermeli onda Save sekli yerleser.
Netije asakdaky yaly bolar:

3 Project] - Form1 [Form] i || ﬂ
O O S
9 Form1 Ol
File Edit Helip
[ | = | [E
R EERRRRERRES!
— . .............. . Tl

Sunun bilen paneli taslamak is1 tamamlandy, yone ol gurallaryn hyzmaty gorkezilmese ulanyjynyn
haysy diiwmaéni basanyny programma bilmez. Onun ii¢in Formadaky gurallar paneline baryp iki sapar
basyp, onun programmadaky prosedurasyny acalyil. Sonda tbrToolbar_ButtonClick() i prosedurasy agylar, ona

su programma yazgysyny gosalyn:

Private Sub tbrToolbar_ButtonClick(ByVal Button As MSComctlLib.Button)
Select Case Button.Key
Case Is = "New"
MsgBox "New duwme basylan"
Case Is = "Open"
MsgBox "Open duwme basylan"
Case Is ="Save"
MsgBox "Save duwme basylan”
End Select
End Sub
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Select Case operator basylan diiwmydr. Ol az-kem If...Then operatora menzesdir, emma ol sanaw
islenilende ceyelige eyedir. Yazylmaly ii¢ sany If...Then ornuna ii¢ sany Case Is ulanylyar.

Programmany Run » Start basyp amal etsek hem-de bir diiwmaini bassak, haysy diiwmaénin baslanyny
gorkezyan. seyle penjirejik ¢ykar:

5 =10l x|

Project] =]

Open duwme bazylan

Ondan OK basyp Forma ya-da programma &pid gaydyp gelip bolar.
Panel doredilende Key hisiyeti bermegi unutmaly déldir.
Mazmuna ge¢mek

5.4.Kéimillesdirilen paneli peydalanmak

Visula Basic girydn tidze elementler toplumy kémillesdirilen paneldir, ofia CoolBar diyilydr. Bu
element Microsoft firmanynn kompyuter maksatnanmalary bolan Office, Internet Explorer we IDE Visula
Basic-de bardyr. Onda gurallar paneliniii diiwmeleri toparlandyrylyp sycanyn peykamy bilen siiyrelip
gecirilip bilner, ona konteyner gorniiyilyir. Ona islendik diiwmeler toplanyp bilner. Seyle konteynerlere
kamillesdirilen panel diyilydr hem-de olar ekranda zolak gorniisinde yerlesdirilydr. Mysal {icin, MS
EXCEL kompyuter maksatnamanyn kadmillesdirilen panel bir ya-da birndce zolakdan(ona iilisge bands
diyilyér) ybarat bolup biler, seyle hem her bir zolakda bir elemen bolup biler.

D2l gy el B = £ 4l L il P w0 -
arial Cyr -0 - KK U EEEEY %, 4N EE _V&vév

Kémillesdirilen panel

Ofiki taslamamyzdaky déreden diiwmeler toplumymyzy-paneli kimillesdireliti:
1.0nki taslamamyzy agalyi.
2.Elementler paneline peykamy eltip, sycanyn sag gulagyny basanmyzda ¢ykan gapdal menyudan
Components buyrugy basalyn.
3.Cykan penjireddki sanawda Microsoft Windows Common Controls 6.0 We Microsoft Windows Common
Controls-3 6.0 setirleriii 6nitinde bellijik goymaly.
4.Panele element gosmak {igin OK basmaly.

5.Paneli kdmillesdirmek elementi- Forma-da yerlesdirmeli.
6.Forma-daky gurallar panelinifi elementini basyp, ony isjent yagdaya getirmeli.
7.Ctrl+X diiwmeleri utgasdyryp basyp Forma-dan elementi kesip almaly.

8. Forma-daky L -paneli kdmillesdirmek elementi basyp hem-de Ctrl+v diiwmeleri utgasdyryp basyp
ona kesileni goymaly.

9.Paneli igjen yagdayda ona hisiyetler bermeli, Name hésiyete cbrCoolBar, Algin hisiyete 1-Algin Top baha
bermeli.

10.Sol yerde Custom setri basyp, paneli kimillesdirmek hidsiyeti berilyan penjrini agarys
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Property Pages ﬂ

General l Bands ]

Imanelist:

Origntatiat |EI - e 30nentationH arizontal ﬂ

Picture: |[N ane) E’; |
[ EmbozsFicture

FEoreCalar: I
BackColor:

[V BandBorders

[ FigedOrder

[V % ariantH eight

OF | OTHEHA CNpaeka

11.Bu penjréanin General gatyndan Bands gatyna gegelin.
12.Index meydanda 1 goyulan bolmaly, Child Sanawdan tbrToolbar setri saylamaly.
13.0K basyp agylan su penjrini yapmaly.

Property Pages x|
General Bands]
Index: 1 3 Inzet Band | Rermowe Band |
Child:
Style: [0 ce3BandMomal |
¥ UseCoolbarPicture Caption: Ii
| Width: [2880
Firtafidth: il
r L
MinHeight: 420
Eey:
v UszeCoolbarColors Tag:
| | li
v “izible »
v Allowyertical W FizedB ackground
(o8 I OTMEHA | MpHHMEHNTE | Znpaeka |

14.Gurallar panelindédki diiwméni basyp, ony isjen yagdaya getirmeli.

15.Hésiyetler penjirediki Custom setiri iki sapar basmaly, sonda is penjiresi agylar.

16.Agylan penjranin General gatyndaky Appearance hidsiyetin hésiyetine 0-ccFlat baha bermeli. Apply
diiwméni basmaly.

17.Penjirediki Style hisiyete 1-tbrFlat baha bermeli. Apply diitwméni basmaly.

18.Agylan penjrini OK basyp yapmaly.

19. F5 diiwmaini basyp taslamany ise girizmeli netije asakdaky yaly bolar.
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B9 Forml - 0] x|
Fil=  Edit Helip
[ &

Taslamada kadmillesdirilen panel.
Mazmuna ge¢cmek

6. Kompyuter maksatnamalaryn yerine yetirilis mantygasy we yzygiderligi

6.1.Logiki operatorlar

Héazirki zaman kompyuterleri ikilik san ulgamyna esaslanyp 06z islerini yerine vyetiryarler.
Kompyuterlerinn pikir edip, mesele ¢oziip bilijilik derejesi, ol isler {igin kompyuter maksatnama-
programma diizen programmadiizijininn akyl payhasy bilen doly kesgitlenilyir. Programmasyz islendik
kompyuter hig¢ hili is edip bilmez. Kompyuterde mesele ¢6zmek ucin programma diiziiji nihlil pikir eden
bolsa, kompyuter hem mesele ¢dzende seyle pikir edydr. Kompyuterin mesele ¢oziip, pikir edisi edil
yalydyr. Mysal ii¢cin, bankda bankomat bilen pul aljak bolsaniyz kredit disketinizi pul berilydn yere
goyanyiiyzda pul beriji kompyuter sizinn kredit disketinizddki maglumatlarynyzy, Sizin bankdaky
hasabynyzdaky maglumatlar bilen denesdirip gorer, gabat gelse pul bermek barada kompyuter ¢6zgiidi
kabul eder we talap edyoéki pulyiiyzy berer, degisli maglumatlaryiiyz gabat gelmese pul bermez.

Kompyuterler difie ikilik san ulgamynyn sanlary 1 we O bilen &hli amallary yerine yetirydr. Ol
sanlara ikilik sanlar diyilydr. Olara inlis¢e bit diyilip at berilendir. Kompyuterin husynda, yadynda
maglumat yerlesdirip bolyjylygynyn Ol¢eg birligi bit-den baslanyar. Bit diymek onda 1 ya-da O
yerlesdirip bolyar diymekdir.

Eger bit-de 1 yerlesen bolsa kompyuter ony «hakykat», 0 yerlesen bolsa «yalan» diyip kompyuter
diisyandir.Su iki sanyn 6zara anlatmasynyn her hili utgagsmasyna hiazirki zaman algebrasy esaslanandyr.
Ol bolsa kompyuter ulgamynda has ¢ylsyrymly isler iicin esas bolup duryar. Mysal ii¢in, has yokary hili
grafikleri printere ¢ykarmak, yoritelesdirilen effektleri doretmek seyle hem yorite maksatlar tigin
kodlamak yaly islerde logiki operaorlar ulanylyar. Logiki operatorlarynn yonekeyleri ifilis sozleri AND.
EOV, OR, XOR we NOT bilen belgilenyir.

Mazmuna ge¢mek

6.2. AND logiki operator

AND logiki operatory iki afilatmany logiki birlesdirmek ii¢in peydalanylyar. Programma diiziilende
logiki birlesméd gatnasyan iki anlatma hem «hakykat» bolmaly. Mysal ii¢in bankomatda ayratyn yerlerde
yazylan sol bir maglumatlar defi gelmese pul alyp bolmayar. Pulyn bolsa diikana barsant dofidurma i1yrsii.

AND logiki operatoryn isleyisiniii gérkeziliginii tablisay

1-nji anlatma AND 2-nji anlatma Netije
Hakykat AND Hakykat Hakykat
Hakykat AND Yalan Yalan
Yalan AND Hakykat Yalan
Yalan AND Yalan Yalan

Su tablisanyn isleyisini 217 we 106 sanlarda AND logiki amalda birikdirelin. 128 den 1-e ¢enli bit
tiliisleri ikilik matmatikada 7-den 0-a ¢enlidir. Ikilik amal 2 modul boyuncga yerine yetirilyér, onda birinji
bit 2° ya-da 1 deii. Ikinji bit 2! ya-da 2 dei.Uginji bit 22 ya-da 4 deii. Seylelik bilen galan bitler
kesgitlenilyar.
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sagdan c¢epe sanalyar. Ikilik amallarda uly bit mydama ¢epde, ki¢i bit sagda bolyar. Ondan

basgada sagdaky bit mydama 0-njy hasap edilyér. Seyle sanalmak sanlary ikilik ulgamda sekillendirmegi
sadalasdyryar. Asakdaky tablisada, hasaplamalarda kop ulanylyan 8 bit iiliisli sanlaryn bahasy berlen
.Seyle sanlaryn bitleri 0-dan 7-4 ¢enli san berilyar.

Bitir Ne 7 6 5
Ikilik bahasy 27 26 25
Bitin bahasy 128 64 32
1-nji aflatma 1 1 0
2-nji anllatma 0 1 1
1-njianlatma AND 0O 1 0

2-nji anllatma

4 3 2 1 0

24 28 22 2t 20

16 8 4 2 1

1 1 0 0 1 217
0 1 0 1 0 106
0 1 0 0 0 72

Dordiinji setirddki 1-lik bilen berlen san bahalary gogsak 217 alnar = 27 + 26+ 24+ 23+20 . Bisinji
setirdaki bahalary gossak 106 alarys. Her bir degisli gosa bitleri AND amaly bilen birlesdirip tablisadaky
altynjy setiri alarys, onunl jemi 72-4 dendir. Diymek

217 AND 106 = 72

Bu hasaplamalary barlap gérmek ti¢in Visual Basic-e girelin, girip klawiaturadan Ctrl+G diiwmeleri
utgasdyryp basalyn, agylan penjirede ? belgisini yazyp degililikde 217 AND 106 yazyp Enter bassak netije
asaky setirde alynar. Su yokarky ikilik hasaplamalarymyzyn netijesi asakda getirilendir

x|

Immediate
? 217 AND 105
e
? 163 AND &
n}
P37 AND 12
4
? 72 AND ZEE
72

Kl

Y

i
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6.3. EQV logiki operator

Visual Basic-de EQV logiki operator iki afnlatmanyn biri-birine bap gelyanligini barlayar. Eger
olaryn logiki bahalary gabat gelse amalyn netijesi hakykat bolar.
EQV logiki operatoryn isleyisinin gorkezilisinin tablisay

1-nji anlatma EQV 2-nji afllatma Netije
Hakykat EQV Hakykat Hakykat
Hakykat EQV Yalan Yalan
Yalan EQV Hakykat Yalan
Yalan EQV Yalan Hakykat

Bu logiki operator has ¢ylsyrymly programmirlemekde ulanylyar.

Mazmuna gecmek

6.4. OR logiki operator

Amal gatnasyan iki anlatmanyn birinifi bahasy hakykat bolanda netije hakykat bolmaly bolsa OR
logiki operator ulanylyar. Onun tablisasy asakda getirilendir.
OR logiki operatoryi isleyisinin gorkezilisinin tablisay

1-nji anlatma OR 2-nji anlatma Netije
Hakykat OR Hakykat Hakykat
Hakykat OR Yalan Hakykat
Yalan OR Hakykat Hakyka
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Yalan OR Yalan tYalan

Bu yerde OR iicin hem edil AND-aki mysaly getirelin

Bitirt Ne 7 6 5 4 3 2 1 0

Ikilik bahasy 27 26 25 24 28 22 21 20

Bitin bahasy 128 64 32 16 8 4 2 1

1-nji anlatma 0 1 0 0 1 0 0 1 73
2-nji aflatma 1 1 1 0 1 0 0 0 232
1-nji arilatma OR 1 1 1 0 1 0 0 1 233

2-nji anlatma

Hasaplamalarymyzy barlap gérmek ii¢in yenede Visual Basic-e girelin, girip klawiaturadan Ctrl+G
diiwmeleri utgasdyryp basalyn, agylan penjirede ? belgisini yazyp degililikde 73 AND 232 yazyp Enter
bassak netije asaky setirde(233) alynar. Su yokarky ikilik hasaplamalarymyzyn netijesi asakda getirilendir

Irmrnediate x|
?OUI OB 232 -~
233
? 55 OR 12
63
? Ll1Z OR 22
534

-

] ;I_I
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6.5. XOR logiki operator

Iki anlatmanyn ikisinden biri hakykat bolup netije hakykat bomaly bolsa onda hasaplamada XOR
logiki operatory ulanylyar.
XOR logiki operatoryii isleyisinin gorkezilisinin tablisay

1-nji afllatma XOR 2-nji anlatma Netije
Hakykat XOR Hakykat Yalan
Hakykat XOR Yalan Hakykat
Yalan XOR Hakykat Hakykat
Yalan XOR Yalan Yalan

Bu yerde hem 61iki mysaly ulanyp XOR bilen hasaplamagy gorkezelin.

Bitifi Ne 7 6 5 4 3 2 1 0

Ikilik bahasy 27 26 25 24 28 22 21 20

Bitin bahasy 128 64 32 16 8 4 2 1

1-nji afnlatma 0 1 0 0 1 0 0 1 73
2-nji anlatma 1 1 1 0 1 0 0 0 232
1-nji arillatma OR 1 0 1 0 0 0 0 1 161

2-nji anlatma

Hasaplamalarymyzy barlap gormek ii¢in yenede Visual Basic-e girelin, girip klawiaturadan Ctrl+G
diitwmeleri utgasdyryp basalyn, agylan penjirede ? belgisini yazyp degililikde 73 XOR 232 yazyp Enter
bassak netije asaky setirde(161) alynar. Su yokarky ikilik hasaplamalarymyzyn netijesi asakda
getirilendir:
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Irmrnediate x|
? 73 ZOR Z23Z -~
161
? 55 ZOR 12
59
? Ll1Z EOR ZZ2
534
-
] ;I_I
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6.6. NOT logiki operator

NOT logiki operator logiki baha ters bolan baha gaytaryar. Ol operator aydylana ters baha gerek
bolanda ulanylyar. NOT operatoryil programma yazgysynda yazylysy

Dim Edilmeliamal As Boolean
Edilmeliamal = True

If Not Edilmeliamal Then
MsgBox "Edilmeli amal gowy tamamlanmady”
End If

Bu yerde Edilmeliamal iiytgeydn ululyga gogiki maglumatlar gorniisi diyip yglan etdik, ona
True(hakykat) baha berdik. Sofira serti barlap netijani alarys.
NOT logiki operatoryi isleyisinin gorkezilisinin tablisay

Anlatma NOT Netije
Hakykat NOT Yalan
Yalan NOT Hakykat

Hasaplamalarymyzy barlap gormek ii¢in yenede Visual Basic-e girelin, girip klawiaturadan Ctrl+G
ditwmeleri utgasdyryp basalyn, agylan penjirede ? belgisini yazyp degililikde NOT True yazyp Enter
bassak netije asaky setirde(False) alynar.

Immediate =

? NOT True -~
Fal=ze

? NOT Falzse
True -
4 3

6.7. Denesdirme

Programma yazylanda sertler barlanylanda logiki operatorlar bilen birlikde denesdirme operatorlary
peydalanylyar. Programmirlemede islendik yazgylar deniesdirilip bilner, Mysal {igin, sézler, sanlar, atlar
we §.m.

Mazmuna ge¢mek

6.7.1.«<Denn =» serti barlamak

Mesele ¢oziilende iki anlatmanyil bahasynyn gabat gelyénligini defiesdirmek talap edilyér, ol Visual
Basic-de “=" operatory bilen amal edilydr. Denligii barlagy programma yazgysynda seyle yazylyar:

If x =5 Then
MsgBox “x-yi bahasy 5-e def”
End If
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Bu programma yazgysy adatca iiilis dilinde yazylan s6zlem bolup duryar.
Senéni barlamak {i¢in Visual Basic-de mysala seredelin.
1.Visual Basic-e girmeli, File » New Project buyrugy basmaly.
2.Cykan penjireden Standart EXE belgijigi saylamaly, OK basmaly.
3.ls ekranyndaky Formal-in Name hisiyetine frmMain baha, Caption hisiyetine Sany saylamaly baha
bermeli.
4.Forma-da iki diwme doretmeli.
5.Birinji diwmaénin Name hésiyetine cmdGetSecretNumber baha, Caption hisiyetine Sany &saylamaly baha
bermeli.
6. Ikinji diiwménin Name hésiyetine cmdGuess baha, Caption hésiyetine &Bilmeli baha bermeli.
7.frmMain formany iki sapar basyp programma yazylyan penjréni agmaly.
8. frmMain formanyn Load is prosedurasyna su bolegi yazmaly:

Private Sub Form_Load()
‘Bilmeli san
SecretNumber = GetSecretNumber()
End Sub

9. frmMain formanyn (General)(Declarations) bolegine su yazgyny goymaly:
Option Explicit
Private SecretNumber As Integer

10. GetSecretNumber() funksiyany doretmige gegelinn , onun iicin (General)(Declarations) bdlegine su
yazgyny goymaly:

Private Function GetSecretNumber() As Integer
'1-de 10-a chenli sany bilmeli
Randomize

GetSecretNumber = Int(Rnd(1) * 10) + 1
End Function

11. GetSecretNumber diiwménin Click is proserdurasyna su bolegi goymaly:

Private Sub cmdGetSecretNumberCommandl_Click()
Bilmali san
SecretNumber = GetSecretNumber()
End Sub

12. cmdGuess diiwmainin Click is prosedurasyna su programma yazgysyny gosalyii:

Private Sub cmdGuess_Click()
Dim guess As Integer
Dim msg As String
Dim cap As String

'Habar doretmeli
msg = "1-de 10-a chenli sany girizmeli"

‘Ulanyjydan sany almaly
guess = Cint(InputBox(msg))

‘San dogry bilindi?

If guess = SecretNumber Then
' Hawwal! Siz bildiniz!

msg = "Siz bildiniz"
cap = "Dogry"
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'Habary chykarmaly
MsgBox msg, vbExclamation, cap

'‘Oyny gutarmaly
End
Else
'yok. Indiki synag...
msg = "Nadogry"
cap = "Tazeden bashla!"

MsgBox msg, vbExclamation, cap
End If
End Sub

Su yokarky prosedura bizin mysalymyzyn esasy bolegidir. =(deNlik belgisi) ilkinji sapar msg = "1-de 10-
a chenli sany girizmeli" yazylan, yone deniesdirmek If guess = SecretNumber Then setirde bolup
gecyar.

13.Doreden taslamamyzy we formamyzy yatda saklamaly.

14 Klawiaturadaky F5 diiwme bilen taslamany ise girizmeli.

5 =10l x|

Sany
zaylamaly

Bilrneli

Formadaky Sany saylamaly diiwméni bassan programma 1-den 10-a ¢enli totdn sanlary biler. Beyleki
Bilmeli diiwmaéni bassyp

yaz28 06.04 x|
1-de 10-a chenli zary girzmeli
Cancel
E

sol sany biljek bolun.
Her bir sany girizsenliz programma size girizen sanynyz dogry ya-da nddogry diyen yazgyny ekran
¢ykarar:

- =lalxl 5 =10 x|
Sany Sany
saylamaly zaylamaly
Bilrmehi Bilmeli
Tazeden bashlal | Dogry x|

1% Nadogw 1, Siebidiniz
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6.7.2.«Ulydyr >» serti barlamak

Adatga programmirlemekde, seyle hem algebrada «ulydyr» serti barlamak t¢in su > -belgi
ulanylyar. Mysal {igin, programma yazgysynyn seyle bolegine seredelin

If x>5 Then
MsgBox “x ulydyr 5 den”
End If

Programma yazgysynda bu sertin ulanylysyna asakdaky yzygiderlikde onki mysalda seredip
gecelin:
1.Visual Basic-e girmeli, 6nki taslamany agmaly, peykamy frmMain forma eltip iki sapar basmaly.
2.cmdGuess diiwmd degisli Click is prosedurasyna asakdaky yaly liytgesmeler girizmeli:

Private Sub cmdGuess_Click()
Dim guess As Integer
Dim msg As String
Dim cap As String
'Habar doretmeli
msg = "1-de 10-a chenli sany girizmeli"

‘Ulanyjydan sany almaly
guess = Cint(InputBox(msg))

‘San dogry bilindi?
Select Case guess

Case Is = SecretNumber

' Hawwal! Siz bildiniz!

msg = "Siz bildiniz"

cap = "Dogry"

'‘Habary chykarmaly
MsgBox msg, vbExclamation, cap

'‘Oyny gutarmaly
End
Case Is > SecretNumber
'yok. Indiki synag...
msg = "Nadogry Bilinmeli san kichi"
cap = "Tazeden bashla!"

MsgBox msg, vbExclamation, cap
End Select
End Sub

3. Taslamany yatda saklamaly we ise girizmeli.
Forma-da Bilmeli diwméni bassan san girizmegi talap eder, girizen sanyn ululygyna gord asakdaky
jogaplary alarsynyz:
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- _|o) x| 5 _|ol x|
Sany Sany
gaylaraly zaplamaly
Bilmneli Bilrnel

D
Tazeden bazhlal ogry J

Siz bildini
!‘_\ M adogry Bilinmeli zan kichi ! i e Btz
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6.7.3.«Kic¢idir <» serti barlamak

Adatga programmirlemekde, seyle hem algebrada «kigidir» serti barlamak ii¢in su < -belgi
ulanylyar. Mysal ii¢in, programma yazgysynyi seyle bolegine seredelin

Ifx <5 Then
MsgBox “x kichidir 5 den”
End If

Programma yazgysynda bu sertin ulanylysyna asakdaky yzygiderlikde yenede oiiki mysalda
seredip gecelini:
1.Visual Basic-e girmeli, yene onki taslamany agmaly, peykamy frmMain forma eltip iki sapar basmaly.
2.cmdGuess diiwmd degisli Click is prosedurasyna asakdaky yaly iiytgesmeler girizmeli:

Private Sub cmdGuess_Click()
Dim guess As Integer
Dim msg As String
Dim cap As String
'‘Habar doretmeli
msg = "1-de 10-a chenli sany girizmeli"

‘Ulanyjydan sany almaly
guess = Cint(InputBox(msg))

‘San dogry bilindi?
Select Case guess
Case Is = SecretNumber
' Hawwa! Siz bildiniz!
msg = "Siz bildiniz"
cap = "Dogry"

'Habary chykarmaly
MsgBox msg, vbExclamation, cap

'‘Oyny gutarmaly
End

Case Is > SecretNumber

'yok. Indiki synag...
msg = "Nadogry Bilinmeli san kichi"
cap = "Tazeden bashla!"

MsgBox msg, vbExclamation, cap
Case Is < SecretNumber
'yok. Indiki synag...

msg = "Nadogry Bilinmeli san uly"
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cap = "Tazeden bashla!"
MsgBox msg, vbExclamation, cap
End Select
End Sub

3.Taslamany yatda saklamaly we ise girizmeli. Kompyuterden bilmeli san ii¢in Bilmeli diiwméni basyp
girizen sanyn ol sandan ki¢i bolsa programma seyle penjirede habar berer

5 o x|

Sany
zaplamaly

Bilrmeli

Tazeden hashlal

! ‘_-. Madogry Bilinmel zan uly

Mazmuna gecmek

6.7.4.«Den didl <>» serti barlamak

Programmirlemekde den dél sert adatca it bolmanda bir baha tapawutly bolanda ulanylyar,
yazylysyna mysal

If x<>5 Then
MsgBox “x 5-e den daldir”
End If

Bu operator ulanyjynyn baha girizenini barlamakda ulanmak maksada layykdyr. Ony bilmek ti¢in
onki taslamany ise girizelin.
1.Formada Sany saylamaly diiwmaéni basmaly, sonda 1-den 10-a ¢enli t6tén sanlar programmada bolar.
2.Bilmeli diwmaini basmaly.
3.Agylan san girizilmeli penjirede OK ya-da Cancel diwmaini basmaly, sonda su penjire ¢ykar:

Microzoft Yizual Basic

Run-time errar '13"

Tywpe mismatch

End Help

Bu penjirede gorniisleriii gabat gelmeydnligi barada habar ¢ykdy. End diiwméni basyp
programmanyii isleyisini tamamlamaly. Yalilyslyk programma yazgysynyi su setirinde yiize ¢cykdy

guess = Cint(InputBox(msg))
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Bu yerde Cint() funksiya maglumat almalydy, alnan maglumaty ol funksiya bitin sana dwiirmelidi.
Ona bos setir berdik, ol hem yalnys diyip habar berdi. Seyle yaliiyl yiize ¢ykmazlygy tigin kdbir baha
bermegi ulanyp bolar, ol maksat {icin <> baha berse bolar. Barlagy seyle yazsa bolar

If rc <>“ Then

Bu yazgy «guess —iil bahasy bos bolmasa bir zatlar etmeli» diymekdir.
4. cmdGuess diiwma degisli Click is prosedurasyna asakdaky yaly liytgesmeler girizmeli:

Private Sub cmdGuess_Click()
Dim guess As Integer
Dim msg As String
Dim cap As String
Dim rc As String
'‘Habar doretmeli
msg = "1-de 10-a chenli sany girizmeli"

‘Ulanyjydan sany almaly
rc = InputBox(msg)

‘ulanyjy bahany girizdimi...
If rc <>"" Then

' Setri bitin sana owurmeli
guess = Clnt(rc)

'‘San dogry bilindimi?
Select Case guess
Case Is = SecretNumber
' Hawwal! Siz bildiniz!
msg = "Siz bildiniz"
cap = "Dogry"

'‘Habary chykarmaly
MsgBox msg, vbExclamation, cap

'‘Oyny gutarmaly
End

Case Is > SecretNumber

'yok. Indiki synag...

msg = "Nadogry Bilinmeli san kichi"
cap = "Tazeden bashla!"

MsgBox msg, vbinformation, cap
Case Is < SecretNumber
'yok. Indiki synag...
msg = "Nadogry Bilinmeli san uly"
cap = "Tazeden bashla!"
MsgBox msg, vbinformation, cap
End Select
Else
msg = "Siz sany girizmeli"
cap = "Sany giriz!"

MsgBox msg, vbinformation, cap
End If
End Sub

5.Taslamany yatda saklamaly we ise F5 basyp girizmeli. Formada Bilmeli diiwméni basmaly. Agylan
san girizilmeli penjirede OK ya-da Cancel diiwmaini bassak ekranda seyle duydurysly penjire ¢ykar.
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- _ (O] x|
Sany
zaylamaly
Bilrreli Sany ginzl B

-
\E) Siz sany ginizrmel
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6.7.5.« Uly ya-da dei >=» serti barlamak

K& halatlarda programmirlemekde, bir ululygyn beyleki ululykdan «ulydygy ya-da dendigini»
barlamak gerek bolyar, onun iicin >= operator ulanylyar. Mysal {i¢in, programma yazgysynyn seyle
bolegine seredelin

If x <=5 Then
MsgBox “x uludyr ya-da 5-e dendir”
End If

Bu programma bdleginin isleyisi yonekey, x —yn bahasy 5-den uly ya-da den bolsa habar beriji
penjire ¢ykyar. Mysal {igin, isde haysam bolsa bir ululyga gozeggilik etmeli bolsa, onuii bahasy berlen
ululykdan uly bolmaly dél bolsa su operator ulanylyp bilner. Kébir ulaglaryn inn yokarky tizligi gérkezilen
bolup ondan tizlik artsa dolandyrys sandan ¢ykmagy miimkin. Onufl programmasyny doredelin:

1.Visual Basic-e girmeli, File » New Project buyrugy basmaly.

2.Cykan penjireden Standart EXE belgijigi saylamaly, OK basmaly.

3.Is ekranyndaky Formal-in Name hésiyetine frmMain baha, Caption hésiyetine Tizligi gorkeziji baha
bermeli.

4.Formada dik dolanys zolagyny goymaly.Onuii Name hésiyetine vscThrottle baha bermeli. Dolanys
zolagyny formanyn sagynda, tutus dikligi eyeldr yaly yerlesdirmeli.

5. vscThrottle zolagyn Max hésiyetine 100 baha bermeli.

6.frmMain formada yazgy doretmeli. Onun Name hésiyetine IblAirspeed, Caption hisiyetine Hazirki tizlik:
baha bermeli.

7.frmMain forma baryp, ona programma yazar yaly penjiresini agmaly

8. (General)(Declaration) bdlege su yazgyny yazmaly:

Option Explicit

Private Throttle As Integer ' Gazyn hazirki bahasy
Private Const VNE =427 ' Tizligin chagi

9.Dik zolakdaky siiysliriji bilen gaz berméni guralyi, onun programma bdlegi
Private Sub Form_Load()

vscThrottle.Value = 100
End Sub

10. vscThrottle elementini Change is prosedurasyna su bolegi gosalyn

Private Sub vscThrottle_Change()
Dim ias As Integer 'Hazirki tizlik

' Dolanysh zolagynyn yokarysyna chenli aralyk
Throttle = 100 - vscThrottle.Value
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'‘Gaz boyuncha hazirki tizligi hasaplamak
ias = Throttle * 4.5

'Tizligi gorkezijini tazelemeli
IblAirspeed.Caption = "Hazirki tizlik: " & _
Trim$(Str$(ias))
' Hazirki tizligini barlamaly hem-de onun chakde
' yokarda daldigine goz yetirmel
If ias >= VNE Then
MsgBox "Gazy peselt", vbCritical, "Tizligi yokarlatdyn"
End If
End Sub

11.Taslamany yatda saklamaly, F5 basyp ise girizmeli, sonda su penjirejik ekrana geler

B3 Tizhai gorkeziji - |I:I ﬂ
Hazirki tizlik: 72
|

Sagdaky dolanys zolakdaky siiysiirijini yokary siiysiirsek, yokarky ¢édge bararys we “Gazy peselt”
duydurys alarys

5 =10| x|
Hazirki tizlik:
436

Tizligi yokarlatdyn J

0 Gazy pezelt

Mazmuna gecmek

6.7.6.« Kici ya-da deii <=» serti barlamak

Ké halatlarda programmirlemekde, bir ululygyin beyleki ululykdan «kigidigi ya-da dendigini»
barlamak gerek bolyar, onun iicin <= operator ulanylyar. Mysal {i¢in, programma yazgysynyn seyle
bolegine seredelin

Ifx <=5 Then
MsgBox “x kichidir ya-da 5-e dendir”
End If
Oniki mysalymyzda tizlik uly bolmaly dil bolsa, ki halatlarda tizligiii kicelmegi hem halanyan
yagday daldir. Seyle yagdayda duyrurys bermek zerurdyr. Onun programmirlenilisine seredelin:
1.01ki 6.7.5. bolekdiki mysalyi taslamasyny yatda saklanan bolsa agmaly.
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2.frmMain formanyn (General)(Declaration) bolegine asakdaky setri goymaly:

Private Const VSTALL =73 ‘ kichi tizlik

3.Hazirki tizlik, dwigatele gaz berlilis 77 goterime den diysek, Form Load is prosedurasyny seyle
yazalyn:

Private Sub Form_Load()
vscThrottle.Value = 23
vscThrottle_Change

End Sub

4. vscThrottle elementiii Change is prosedurasyny seyle yazalyn:

Private Sub vscThrottle_Change()
Dim ias As Integer 'Hazirki tizlik

' Dolanysh zolagynyn yokarysyna chenli aralyk
Throttle = 100 - vscThrottle.Value

‘Gaz boyuncha hazirki tizligi hasaplamak

ias = Throttle * 4.5

‘Tizligi gorkezijini tazelemeli

IblAirspeed.Caption = "Hazirki tizlik: " & _
Trim$(Str$(ias))

' yokarda daldigine goz yetirmeli
If ias >= VNE Then

MsgBox "Gazy peselt", vbCritical, "Tizligi yokarlatdyn"
End If

‘Tizligi peselemeginin onuni almaly
If ias <= VSTALL Then
MsgBox "Gazy ulalt!", vbCritical, "Tizlik peseldi, zyyanly!"
End If
End Sub

5.Taslamany yatda saklamaly we ise girizmeli. Sagdaky dolanys zolakdaky siiysiirijini asak stiiysiirsek,
“kichi tizlik” cdge bararys we “Gazy ulalt” duydurys alarys.

=10l x|

Hazirk. tizlik: 4

Tizlik peseldi, zyyaniyl El

Q 3azy ulalt!

Mazmuna gecmek




104
6.8.Programma yazgysynda cozgiidin kabul edilisi

Programma yazgysynda ¢ozgiidi kabul etmek boyunca meselede birnédge sertlerin talap edilmegi
zerurdyr. Ol sertlerin barlanylysy we degislilikde olaryn programma yazgysynda yazylysy 6.7 paragragda
gorkezipdik. Indi bolsa olaryn bilelikde ulanylysyna seredip gecelin.
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6.8.1. If...Tnen...Else operator

Visual Basic-de If...Tnen...Else operator serti barlamak tiigin it yonekey hem-de kop ulanylyan
gornligdir. Onun gysgaldylan gorniisinint programmada yazylys formaty:

If 1-nji arllatma Operator 2-nji afilatma Then
‘ Kabir hasaplamalary yerine yetirmek
End If

Bu yerde Operator bolup onki 6.7. paragrafdaky islendik AND, OR, =, <> we s.m. sertlerin
islendiginin biri bolup biler. 1-nji afilatma, 2-nji aiillatma berlen operator bilen deniesdirip bolyan islendik
tytgeyan ululyk ya-da hemiselikler bolup biler.Mysal ii¢in, bankomatdaky PIN kodyn bahasy seyle
denesdirilip bilner:

PIN = “123456”

If PIN = “123456" Then
MsgBox “PIN-ifi bahasy dogry”
End IF

Bu yerde girizilen PIN bahasy 61 bar bolan “123456” baha bilen denesdirilydr. Sert hakykat bolsa
ekranda habar bolar.

K4 halatlarda sert yerine yetmese ns etmeli yene barlamaly bolanda yokarky formata Else operator
gosulyar. Mysal ii¢in

If 1-nji arilatma Operator 2-nji afilatma Then

‘ Kébir hasaplamalary yerine yetirmek
Else

‘ Basga hasaplamalary yerine yetirmek
End If

Ofiki programma yazgymyzy Else gosup seyle yazyp bolar

PIN = “123456”

If PIN ="123456" Then

MsgBox “PIN-ifi bahasy dogry”
Else

MsgBox “PIN-ifi bahasy niadogry”
End IF

Sertinl i¢inde sert bolanda hem If...Tnen...Else operatorynl yazylys formaty seyledir, ony parol
barlanylandaky yazylysda gorkezelin
If ValidUserID(UserID) Then
If ValidPassword(UserID, Password) Then
MsgBox “Parol nadogry”
Else
MsgBox “Ulanyjy bellige alnan”
End If
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Else
MsgBox “Ulanyjynyi ady hadogry”
End If

Bu programma yazgyda ilki bilen ulanyjynyn adynyn dogry girizilenini barlayarys, ol ValidUserlD()
funksiya bile amal edilydr. Eger funksiyanyn bahasy True bolsa programma paroly barlamaga gec¢yr.
Yogsam hem ulanyja adyn niddogry diyip habar berer. Eger ValidPassword() funksiyanyn bahasy True
bolsa, programma ulanyja ulgama girmek rugsat beriler. Ol funksiyanyn bahasy False bolsa bellige
alynmak isi amal bolmaz.

Biri-birinin i¢ine giryén If...Then operatory basgarak Elself operator bilen hem seylerdk gurap bolar:

If x=4 Then

‘ Kabir hasaplamalary yerine yetirmek
Elself x = 6 Then

‘ Bagga hasaplamalary yerine yetirmek
End If

Mazmuna gecmek

6.8.2. IIf Funksiyasy

Oniki paragrafdaky If...Tnen...Else operatoryfi boleginii ornuna  goniiden géni If ya-da IIf
ulansanam bolar. Bu yerde yekeje tapawut ol hem bolsa IIF baryp hasaplanmaly iki anlatmanyn ikisini
hem hasaplayar we ¢6zgiidi kabul edyér. Su programma bolegine seredelin

Function Tastelt (Food As String) As String
Checklt = lif(Food = “Palaw”, “Sag bol”, “Tagamly”)
End Function

Bu yerde funksiyanynn  “Sag bol’, “Tagamly” parametrleri hem hasaplanylmaga degislidir. Eger
Tastelt() funksiyanyn isleyisi yonekeje. Food iiygeyan ululygyn bahasy “Palaw” bolsa “Sag bol” jogap
bolar.Yogsamam “Tagamly” setire gaydyp barar.

Iif funksiyanyn bahasy hemiselikler, seyle hem hasaplanylyan anlatmalar bolup biler.

Mazmuna ge¢mek

6.8.3. Select Case...End Select operator

Has ¢ylsyrymly birgiden sertleri barlamak bilen ¢ozgiitlerde Select Case...End Select operatory
ulanmak zerurdyr. Select Case...End Select operator bolegin yazylys formaty seyledir

Select Case x
Casels=5

‘ Kabir hasaplamalary yerine yetirmek
Case Is > 17

‘ Basga hasaplamalary yerine yetirmek
Case Else
* Oniki sertlerin hig biri yerine
‘ yetmedik yagdayda hasaplamalar
End Select

Programma yazgysynda her bir Select Case operatora degisli End Select operator bolmaly. Select
Case bilen End Select aralygyndaislendik sanda Case bdlegi bolup biler. Her bir barlanyan ii¢in 6z Case
bolegi bolmaly, hacanda hig bir sert yerine yetmese Case Else bolegi doredilmelidir.

Select Case operatorda setir ululyklary. Uytgeyin ululyklar we bahalaryf araciigi barlanyp bilner.
Mysal iicin, asakdaky programma bolegi sanyil 1 bilen 10 aralygynda yerlesyénini barlayar:

Select Case guess
Case 1to 10
* Aydyanyn dogry
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Case Else
‘Aydyanyn nadogry
End Select

Case 1 to 10 bolek guess li¢in yerine yetirilyar, ol 1 bilen 10 aralygyndadyr. Case Else bolek galan
yagdaylary barlayar.
Select Case ... End Select operatory setir ululyklary ti¢in hem ulanylyp bilner, mysal {i¢in

Select Case x

Casels =“5”

‘ Kabir hasaplamalary yerine yetirmek
Case Is > “27”

‘ Basga hasaplamalary yerine yetirmek
Case Else

“ Oriki sertlerin hig biri yerine

‘ yetmedik yagdayda hasaplamalar
End Select

Case bolegi birndce buyrukdan diiziilip bilner. Case boleginl sofly End bilen tamamlanmayar. Case
operator esasanam diiziimli programmirlemekde ulanylysy, onun artykmac tarapydyr. Mysal {i¢in, sol bir
setir maglumatlary uly ya-da kigi harplar, belgiler bilen, seyle hem 61, sony bos yerli girizilip bilner,
kompyter programma ona diisiinmelidir. Ol isler tigin Trim$() setir funksiyasy, UCase$() ya-da LCase$
funksiyalary ulanylyar. Olaryn ulanylysyna mysal:

If Trim$(UCase$(txtinput, Text)) = “DOLANDYRYJY” Then
‘ Kabir hasaplamalary yerine yetirmek

End If

If Trim$(LCase$(txtinput, Text)) = “dolandyryjy” Then
‘ Kabir hasaplamalary yerine yetirmek

End If

Bu yerdéki If...Then operatorlaryn ikisinde hem sol bir netije alynar.
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6.9.Programmada gaytalanyan amallaryn yerine yetirilisi

Ykdysady we dolandyrys meselelerinit kompyuterde ¢6zgiidi iicin programma yazgysy diiziilende
gaytalanyan amallar has kop ulanylmaly bolyar, ona sikller hem diyilyar. Visual Basic-de onun
yazylysynyn birndge gorniisi bardyr.

Mazmuna ge¢cmek

6.9.1. For...Next siklin guralysy

Visual Basic-de For...Next sikli, gaytalanyan amallar {i¢in sikl doretmegin esasy gorniigidir. Ol
operator bilen kesgitli gaytalanyan amallary yerine yetirip bolar. For...Next siklde gaytalanmanyn sany
oniinden berilydr we sanayjy ulanylyar. Onun programma yazgysynda yazylys formaty seyle yazylmaly:

For Sanayjy=Baslangy¢ baha To Ahyrky baha
‘ Gaytalanyan amallar
Next Sanayjy

Bu yerde

O Sanayjy san gorniisde(Integer ya-da Long) bolmaly, ol adatga programmirleji tarapyndan berilyér.

O Baslangyg baha iiytgeydninl sanap bislanyan yagdayny kesgitleyar.

O Ahyrky baha tiytgeyanin ahyrky yagdayny kesgitleyir, onda sanaw bes edilyir.

Mysal ii¢in, X-yi bahasy 5-den 8-e ¢enli bolmaly bolsa, onda X= Sanayjy , Baslangyg baha=5 , Ahyrky
baha=8 bilen calysylyar.
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Bu siklin birinji setirinde If...Then hokmany bolmadyk Step adalgasy ulanylyp bilner, ol adalga
bilen Sanayjynyn her sapar hasaplar gaytalananda artysy berilmeli. Mysal {igin,

For =15 To 105 Step 15
‘ Gaytalanyan amallar
Next
Bu yerde Next operatoryn soriunda tytgeyan ululygyri belligini goymak hokman hem déldir, yone

Sanayjy 6smén kemelibem biler, onun ii¢in Baslangyg baha we Ahyrky bahanyin  berilisi esas bolup
duryar. Bu yagdayda kemelme Step bilen gorkezilmelidir. Mysal ii¢in

For 1=15 To 3 Step -2
‘ Gaytalanyan amallar
Next

Soniky baha yetmdn siklden ¢ykjak bolsan Exit For buyruk ulanylmaly. Onuil mysalda yazylysy

For 1=1 To 105 Step 5
X =1*12
If X > 105 Then
Exit For
End If
Next
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6.9.2. Do...Loop siklin guralysy

Do...Loop sikl gaytalanyan amallarda, gaytalanmanyn sany oniinden ndbelli bolanda programma
vazgysynda ulanylyar. Do...Loop sikl kesgirsiz sapar yerine yetirilip bilner, mysal {i¢in:

Do
‘ Gaytalanyan amallar
Loop

Sikl sert bilenem tamamlanyp bilner, onunl yazylysy

Do While X <10
X=X+1
Loop

Bu sikl x-yn bahasy 10-da kigi bolsa dowam eder. Adatga sikl 10 sapar yerine yetiriler. While
adalganyn ornuna Until adalgany ulansailam bolar, onda yokarky yazgy seyle gorniise eye bolar

Do Until X =10
X=X+1
Loop

Visual Basic-de bu siklden ¢ykmak iigin islendik logiki serti ulanyp bolar. Adatga siklden ¢yklan
ticin Exit buyruk ulanylyar, ol kdpleng If ... Then bilen utgasdyrylyp ulanylyar.
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6.9.3. While...Wend siklini guralysy

While...Wend sikl Do...Loop siklin baggaga yazylysydyr. Onda kébir sert goyulyp ol yerine yetyarka
sikl 1sleyér, mysal tigin

While X <15
X=X+1
Wend
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6.9.4. For Each...Next siklin guralysy

Visual Basic-de saylantgylary saylamak isinde For Each...Next sikli  ulanylyar. Bu usulda
saylantgylarda bar bolan obyektlerii mukdary nébelli bolanda sikl guramak amatlydyr, olar yaly
meseleler maglumat goryndan maglumatlar gdzlenende 6rian zerurdyr.

Saylantgylary saylamak ii¢in sikl seyle yazylyp bilner

Dim cmd As CommandButton

For Each cmd In Form1
With cmd
If .Index <> Index Then
MsgBox “Duwme “ & Trim$(Str$(.Index)) & _
‘ basylmady
End If
End With
Next

Bu yazgyda
1-nji setirde CommandButton yglan edilyar.
2-nji setirde Formal-ddki CommandButton-ahli obyektler saylanyar. Sofira With cmd operator With...End
With bolege saylantgydaky cmd obyekt bilen amal edilydnini habar beryar.
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6.9.5. Siklleri peydalanmaklyga mysal
Siklleriit Visual Basic-de anyk mysalda yazylysyny we ulanylysyny gorkezelin:

1.Visual Basic-e girmeli, File » New Project buyrugy basyp tdze taslama doretmeli.

2.Cykan penjireden Standart EXE belgijigi saylamaly, OK basmaly.

3.Is ekranyndaky Formal-int Name hésiyetine frmMain baha, Caption hésiyetine Sikller baha bermeli.

4.Ctri+E diiwmeleri utgasdyryp basyp, menyu redaktoryny agmaly.

5. Caption meydana &Sikl baha berip, yokarky derejeddki menyu doretmeli. Name meydana mnuLoop
yazgy girizmeli.

6.Menyuda tdze obyekt doretmeli, ony Next diiwméni basyp amal etmeli.

7.Menyu sanawyn yokarysyndaky = peykamy basmaly, sonda ol yokary derejeli menyu buyrugy
bolyar.

8.Caption meydana &For...Next baha bermeli. Name meydana mnuLoop ForNext yazgy girizmeli.

9.Next basyp menywyn tize buyrugyny doretmeli. Indi peykamy basmak gerek bolmaz.

10.Caption meydana &Do...Loop baha bermeli. Name meydana mnuLoop DoLoop yazgy girizmeli.

11.Next basyp menywyn tize buyrugyny doretmeli. Caption meydana &While...Wend baha bermeli. Name
meydana mnuLoopWhileWend yazgy girizmeli.

12. Next basyp menywyn tdze buyrugyny doretmeli. Caption meydana «-» baha bermeli. Name meydana
mnuLoopSepl yazgy girizmeli.

13. caption meydana &Arassalamaly baha berip. Name meydana mnuLoopClearyazgy girizip indiki menyu
buyrugyny doretmeli.

14.0K diiwmaéni basyp menyu redaktopr yapmaly.
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Menu Editor x|
Capkion: lﬁ Ok
Mame: |mnuL|:u:||:| Cancel
Index; I— Shorkout: ||:Nn:-ne]|

HelpZontextID: |0

MegatiatePaosition: ||:| - Mone |

[

[ checked [+ Enabled v visible [ windowlisk
ﬂﬂﬂﬂ Rlek | Insert | Delete |

wolFor,, Mexk
wo@Da,, Loop
woliihile, , end

&Arassalamaly

15. File » Save Project buyrugy bilen taslamamyzy yatda saklamaly.
Y okrky islerin netijesinde asakdaky formany aldyk

5
m Arazzalamaly

| For...MNext
Do Loop
While..\Wiend

16.frmMain formada yazgy meydanyny doretmeli, ony ¢epden yokarky bur¢da yerlesdirmeli. Onun
Name hisiyetine txtTextBox baha bermeli, sol yerddki Text hésiyetin sagyndaky Textl Yyazgyny
ayyrmaly.

17. Formadaky txtTextBox elementi igjent yagdaya peykamy basyp eltmeli.

18.Klawiatutadan Ctrl+C diitwmeleri utgasdyryp basyp txtTextBox elementi alys-galys yere nusgalap
gecirmeli.

19. frmMain formany isjenlesdirmeli.

20.Klawiatutadan cCtrl+v diiwmeleri utgasdyryp basyp, alys-calysdan yazgy meydanyny formada
goymaly.Cykan duydurys penjirede size toplum doretmek teklip ediler, Aa(Yes) diwmaéni basmaly.

21.Téaze yazgy meydanyny 6nki yazgy meydanyn sagynda yerlesdirmeli.

22.Tézeden klawiatutadan Ctrl+V diiwmeleri utgasdyryp basyp yazgy meydanyny goymagy dowam
etdirmeli, ony her setirde ii¢ meydan jemi 5 setire ¢enli dowam etdirmeli.Onun gorniisi

B9 Sikller

Sikl  Arazsalamaly
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23.frmMain formadaky Sikl menyudan For...Next buyrugy saylamaly, agylan programma yazylyan
penjirede mnuLoopForNext_Click ig prosedurasy agylar.
24. mnuLoopForNext_Click ig prosedurasyna su programma bolegini yazmaly:

Private Sub mnuLoopForNext_Click()
Dimi As Integer
'For ... Next siklde yazgy meydanlaryny doldyrmaly
Fori=0To 14
txtTextBox(i). Text = "i=" & Trim$(Str$(i))
Next
End Sub

25. frmMain formadaky Sikl menyudan Do...Loop buyrugy saylamaly, agylan programma yazylyan
penjirede mnuLoopDoLoop _Click is prosedurasy agylar, ofia su yazgyny yazmaly:

Private Sub mnuLoopDoLoop_Click()
Dim i As Integer

'For ... Next siklde yazgy meydanlaryny doldyrmaly
i=0

Do While i <15

txtTextBox(i). Text = "i =" & Trim$(Str$(i))

i=i+1

Loop

End Sub

26.frmMain formadaky Sikl menyudan While...Wend buyrugy saylamaly, agylan programma yazylyan
penjirede mnuLoopWhilewend_Click() is prosedurasy agylar, ofia su yazgyny yazmaly:

Private Sub mnuLoopWhileWend_Click()
Dim i As Integer

'For ... Next siklde yazgy meydanlaryny doldyrmaly
i=0
While i < 15
txtTextBox(i). Text = "i =" & Trim$(Str$(i))
i=i+1
Wend
End Sub

27.frmMain formadaky Sikl menyudan Arassalamaly buyrugy saylamaly, agylan programma yazylyan
penjirede mnuLoopClear_Click() is prosedurasy agylar, ona su yazgyny yazmaly:

Private Sub mnuwWhileWend_Click()
Dim x As Control

'Formada ahli yazgy meydanlary gormeli
‘olardakylary supurip ayyrmaly
For Each x In frmMain.Controls
If UCase$(Left$(x.Name, 3)) = "TXT" Then
X.Text=""
End If
Next
End Sub

28.Taslamany yatda saklamaly we ise girizmeli.
Forma baryp Sikl menyua baryp islendik siklin gorniisini bassaflyz sol bir netije alarsyiyz, onun
gorniisi:
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i3 Sikller =101 =]
Sikl

i=0 i=1 =2

i=3 i=4 i=5

=5 |7 |8

=3 [i=10 fi=11

=12 |i=13 fi=14
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7. Kompyuter maksatnamalarynda maglumatlaryn gorniisleri

Kompyuter maksatnamalary islenip tayyarlanylanda her hili maglumatlar bilen is salysylyar. Ol

maglumatlary adatg
a Uytgeyanl

a li¢ topara boliisdirilyar:
er.

o Toplumlar(Massiwler).
o Hemiselikler(Konstantalar).

Maglumatlar belli bir dowiirde tiytgemeseler, olar hemiselikdirler. Berlen déwiirde maglumatlar
ara uytgeyanler diyilydr. Uytgeyinlerin we hemiseliklerin berlen tertipde toplumy

tytgdp dursalar, ol

emele getirse olara toplumlar(massiwler) diyse bolar.

Visual Basic-
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7.1. Uytgeyinlerin gorniisleri

hisiyetnamalaryna eyedirler:

Maglumatlaryn | Niyetlenilisi

gorniisi

Integer San tiytgeyén, ol —32768 - +32767 aralykdaky bitin sanlary alyp bilyirler.

Long San tiytgeyén, ol edil Integer yaly, yone iiytgeyén aralygy has ulydyr.

Single San {iytgeyén, onluk nokat bilen sany alyp bilyr.

Duble San iiytgeyén, ol edil Single yaly, yone iiytgeydn aralygy has ulydyr.

Currency Pul ululyklary yatda saklamak ii¢in liytgeyén.

String Yazgy ya-da setir bahalary yatda saklamak {igin tiytgeyin.

Byte 0 — 255 aralykdaky saniiytgeyan, Integer-denem Kkigi.

Boolean True ya-0a False bahalary yatda saklamak {igin iiytgeyan.

Data Senini yatda saklamak {i¢in tiytgeyén.

Object Visual Basic-dédki obyektlere salgylanmagy yatda saklamak {igin iiytgeyén.

Variant Umumy niyetlenilen iiytgeyén, ol beyleki gorniislerin kdpiisiniii bahasyny
yatda saklayar.

Visual Basic-de esasanam maglumatlaryn sy gorniisleri bilen programma diiziilende is salysylyar:
Byte — bayt maglumatlary.
String — setir maglumatlary.

Integer — b

Variant — U

0000 D D

itin maglumatlary.

Boolean — logiki maglumatlary.

mumy maglumatlary.

Object — obyekt maglumatlary.

Obyekt maglumatlary hem birndge gorniislere boliisdirilip bilner:

Q Formalar.
Q Elementler.

O Printerler we g.m.

de 7.1. uytgeyédnlerin gornilisleri birndge gorniisleri bardyr, olaryit her biri 6z
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7.2. Bayt iiytgeyanleri

Uytgeyinlerini yonekey gdrniisi bayt-gdrniisidir.
ulanylysyny gorkezelin:

1.visual Basic-e girmeli, File » New Project buyrugy basyp tdze taslama doretmeli.

2.Cykan penjireden Standart EXE belgijigi saylamaly, OK basmaly.
3.Taslama dpisgd girip Formal yazgyny ayyrmaly, onun {i¢in ol yazgynyn {iistiine baryp syganyn sag

gulagyny basafida ¢ykan gapdal menyudan Remove Formal buyrugy basmaly.
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4. Cykan penjirede Visual Basic Formal yatda saklamagy sorar sonda Het(No) diiwméni basmaly.
5.Taslama &pisgd peykamy eltip sy¢anyn sag gulagyny basmaly, ¢cykan gapdal menyudan Add » Module

buyrugy basmaly.

6. Add Module penjireden Module belgini saylamaly. sonda taslamada bos modul peyda bolar.
7.Eger modulyin programma penjiresi agylmasa, taslama penjiredaki Modulel setiri iki sapar basmaly.
8.Modulyn programma penjiresine su bolegi yazmaly:

Option Explicit

Private Sub Main()
Dim b As Byte
Dim text As String

Debug.Print "ASClII-tablisa"

Forb=0To 63

text = Str$(b) & ™ & Chr$(b)

text = text & Chr$(9) & Chr$(9)
text = Str$(b + 64) & "™ & Chr$(b + 64)
text = text & Chr$(9) & Chr$(9)
text = Str$(b + 128) & ™ & Chr$(b + 128)
text = text & Chr$(9) & Chr$(9)
text = Str$(b + 192) & ™ & Chr$(b + 192)
text = text & Chr$(9) & Chr$(9)

Debug.Print text
Next
End
End Sub

9.Yazan su programmamyzy Run » Start buyruk bilen ise girizmeli, netijede ASCII-tablisany alarys:

I(Generan

:J IMam

Option Explicitc

text
text
text
text
text
text
text
text

ext

Debug.Print
For b

End

o Private Sub Hain()
Dim b As Eyte
Iim text As 3tring

"ASCII-tablisa”

0 To &3

Str§(kh) & "" & Chrj(h)

text & Chr$(9) & Chr§(9)

3tr§(b + 64) & "" & Chri(bh + 64)
text & Chri(9) & Chr§(9)

stri(h + 128) & "" & Chri(b + 1z8)
text & Chr$(9) & Chr$(9)

3tr§(b 4+ 192) & "" & Chriib + 192)
text & Chri(9) & Chr§(9)

Debug.FPrint text

Imrmediate

2528
2533
Z54m
2553
LSCII-tahlisa
1924
193E
194E
195T
1967
197E

K1l

=
N
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7.3. Setir iiytgeyinler

Setir tliytgeydnler kompyuterit yadynda yzygiderli baytlary eyelemek bilen harplardan, sanlardan
ybarat bolup bilerler, olaryn atlandyrysynyn mnemoniki gysgaltmasy yerlikli bolmaly. Her bir ASCII-
sekil kod bir baytdan ybarat bolsa, setir ululykdaky iiytgeyéanlerde nége bellik bolsa songa bayt bardyr.

Visual Basic-de has kop ulanylyan Name we Caption hésiyetlerin bahalary elipbiy-san bahalara
eyedir. Setir tiytgeyénler bilen programma diiziilende iglemek {i¢in asakdaky isleri kesgitlemeli:

o Uytgeyinin adyny saylamaly.

o Uytgeyini setir(String gdrniis) hokmiinde yglan etmeli.

o Uytgeyine at bermeli.

Mysal {igin, strName - bu yerde str iiytgeyin setir gorniislidir.

Dim strName As String —liytgeyani- strName yglan etmek.

StrName = “Jahan”  -Setire at berdik.

Yokarky mysallary asakdaky taslamada gorkezelifi:
1.visual Basic-e girmeli, File » New Project buyrugy basyp tdze taslama doretmeli.
2.Formal peykamy eltip iki sapar basyp programma yazyldpisgcalyn.
3.Programma penjiredéki Events sanawdan formanyn Click igini saylamaly.
4. Click is prosedurasyna sujagaz programma bolegini yazmaly

Private Sub Form_Click()
Dim msg As String

msg = "Salam!"
Caption = msg
End Sub

5.Run » Start buyruk bilen taslamany ise girizmeli.
B9 Forml - 10| x|

6.Cykan  su forma peykamy eltip bassak onui  bu
5 Salam! O] x|

ady uytgér.

Uytgeyénleri yglan etmegi yatdan ¢ykarsaii hem olary Tools » Options bilen c¢ykan penjirediki
Require Variable Declaration yazylan yerde bellik etmek bilen programmanyn basynda Option Explist Setri
goyar.

O ptions = |
Editar ]Editur Format | General | Docking | Environment | advanced |

Zode Settings

Auko Swynkax Check v Aubo Indent

Require Variable Declarationd Ii
%utqn Lisk Members Iab width: |4

Auko Quick InFo

Oukba Daka Tips

EURRCUEY

Weindowe Setkings
v Drag-and-Cvop Text Editing
W Default to Full Module Yiews
[ Procedure Separakor

| L] o8 I DTHEHS Cnpaska
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7.4. Bitin liytgey:inleri

Bitin tytgeyanler maglumatlarynn gorniislerininn esaslarydyr. Olar —32768 den +32767-¢ cenli
aralykda bolup bilyarler we olaryn alamaty hem bardyr. Bitin sanlar yonekey hasaplamalarda amatlydyr,
seyle hem hasaplayjy islerde diiie olar ulanylyar. Ony mysalda gorkezelii:

1.Visual Basic-e girmeli, File » New Project buyrugy basyp tédze taslama déretmeli.

2..Is ekranyndaky Forma-da diiwme doretmeli. Diiwménin Name hisiyetine cmdPush baha, Caption
hésiyetine Bas! baha bermeli.

3.Forma-da doreden diiwméamize iki sapar basyp programma yazylyan penjriani agmaly.

4. Diiwmaénin Click is prosedurasyna su yazgyny yazmaly

Private Sub cmdPush_Click()
Dim A As Integer

Dim B As Integer

A=2

B=A+1

Print B

5.Programmany F5 basyp ise girizmeli, Forma-daky diiwméni basmaly.
Yazylan programmanyn gorniisi

[;1Project] - Formal [Code] i [m] B
IcmdPush | ICIick |
COption Explicit =

Private Sub cmdPush Click()
Dim A Az Integer

Dim B Az Integer

ho= 2

B =54+ 1

Print B

End Sub|

HEal o

:"’-..“\ 4

Diiwmini basanymyzda alynan netije:

03 yaz =10] x|
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7.5. Logiki iiytgeyinler

Logiki gorniigli iytgeyanlerin iki sany True We False bahalary bardyr. Berlen programma bdleginin
isi gowy tamamlansa baha True bolar, yaramaz tamamlansa baha False bolar. Indi bolsa disk-de berlen
at bilen faylyn bardygyny kesgitlein programma bolegini yazalyi:

1.visual Basic-e girmeli, File » New Project buyrugy basyp tdze taslama doretmeli.
2.Cykan penjireden Standart EXE belgijigi saylamaly, OK basmaly.
3.Form1 formada yazgy meydanyny doretmeli, onui Name hésiyetine txtFilename baha bermeli.
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4.Yazgy meydanynyii Caption meydanyny Textl ayyermely.
5.Formada diiwme doretmeli, onuni Name hésiyetine cmdSearch, Caption hidsiyetine &Search ~ baha
bermeli.
6.Form1 formanyn programma yazylyan penjiresini agmaly.
7.IsFile funksiya ti¢in su programma bdlegini yazalyn

Private Function IsFile(filename As String) As Boolean
If Len(Dir$(filename)) > 0 Then

IsFile = True
Else

IsFile = False
End If

End Function

8.Programma yazylyan penjranin ¢ep yokarsyndaky sanadan cmdSearch setri saylamaly, sonda Click is
ticin prosedura yazmaly bolar

Private Sub cmdSearch_Click()
Dim filename As String
Dim rs As Boolean

filename = txtFilename.Text
rc = IsFile(filename)
If rc = True Then
MsgBox "Fayl yok™
Else
MsgBox "Fayl tapylmady"
End If
End Sub

10. F5 basyp programmany ise girizmeli.

Formadaky yazgy yazylyan meydanga gozleydn faylyn adyny yazmaly, sonra Search diiwméini
basmaly, netije asakdaky yaly bolar

_|ol x|
Project] ot
= rojec Eq
Faul tapylmady
Search
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7.6. Umumy iiytgeyianler

Umumy uytgeyanler bitin, bayt, setir ya-da logiki bahalaryn islendigini alyp bilyérler. Visual Basic-
de Dim operatorsyz yglan edilen iiytgeyanler umumy gorniise degislidirler. Umumy iytgeyénleri Visual
Basic -de kop peydalanmak maslahat berilmeyir. Sebdbi kompyuter ol ululygy haysyna degisli etjek
bolup kop kompyuter wagty sarp edyar.

Mazmuna gecmek

7.7. Programmada iiytgeyinlerin berilis tertibi

Visual Basic-de tiytgeyanler iki hili berilip, yglan edilip bilner.

Eger liytgeyénler we proseduralar Private adalganyn ¢édklerinde berlen, yglan edilen bolsa, onda olar
dine su ona degisli Forma-nyn ¢éklerinde diyilip diisiinilyér.

Eger liytgeyanler we proseduralar Public adalganyn cédklerinde berlen, yglan edilen bolsa, onda olar
tutus programma modulynyn ¢éklerinde diyilip diisiinilyar.
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Kaébir tiytgeynler tutus taslamanyn ¢éklerinde elyeter bolsa olara a¢yk ya-da ummasyz tliytgeyanler
diyilip bilner. Ol iiytgeyénler
(General)(Declarations) bolekde yglan edilmeli hem-de Dim ya-da Private adalgalaryin ornyna Global
adalgasy ulanylmaly. Seyle yagdayda taslama .BAS gineldilen standart modul gosulyar we dhli ummasyz
tiytgeyanler onun boleginde yerlesdirilyar.
Indi bolsa ummasyz iiytgeyanlerini programmada berlisini mysalda gorkezelin:
1.visual Basic-e girmeli, File » New Project buyrugy basyp tdze taslama doretmeli.
2.Cykan Project Wizard penjireden Standart EXE belgijigi saylamaly, OK basmaly.
3..Taslama dpisgd peykamy eltip sycanyn sag gulagyny basmaly, ¢ykan gapdal menyudan Add » Module
buyrugy basmaly.
4. Add Module penjireden Module belgini saylamaly. sonda taslamada bos modul peyda bolar. Doredilen
Modulel programma penjirede agylar.
5.Programma dpiggé su bolegi gogmaly

Option Explicit

Global UserID As String
Global ACL As Integer

6.Modulel modula su prosedurany gosalyii

Public Sub InitApp()
UserID = "Ashyr"
ACL =255

End Sub

Bu yerde Global bilen yglan edilen UserID we ACL iiytgeyénlere taslamanyil modulynyn islendik
yerinden yuzlenip bolar. Onuit mysalyny ulanyjyny hasaba almak ii¢in forma déretmekde gorkezelii:
1.Taslama penjireddki Formal forma peykamy eltip iki sapar basmaly, sonda ol igjen bolar.
2. Formal-inn Name hésiyetine frmLogon, Caption hisiyetine Ulanyjyny hasaba almak baha bermeli.
3.Formada A-element bilen yazgy doretmeli. Onun Name bahasyna IblUserld, Caption hisioyetine
Ulanyjynyn ady baha bermeli.
4.Formada A-element bilen yene bir yazgy doretmeli. Onuni Name bahasyna IbiPassword, Caption
hésioyetine Parol baha bermeli.
5.Birinji yazgynyn sag tarapyndan yazgy meydancasyny doretmeli. Onui Name bahasyna txtUserlD
baha bermeli.
6.Ikinji yazgynyn sag tarapyndan yazgy meydancasyny doretmeli. Onui Name bahasyna txtPassword,
PasswordChar hésiyetine **** baha bermeli.
7.Formanynl il asaky eteginde diiwme yerlesdirmeli. Onuin filame hésiyetine cmdLogon, Caption
hésiyetine &Hasaba almak baha bermeli.
Yokarky isleri amal edenimizde forma seyle gorniise geler

5 Ulanyny hazaba almak - |I:I|5|

8.Formal-in programma penjiresini agmaly.
9.Programma yazylyan penjiredaki Option Explicit
yazan yerimizii oiline kursory eltmeli.

10.1ki sapar Enter basmaly, Option Explicit
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yokarysynda iki bos setir bolar.
11.0Option Explicit yokarysynda su setri yazmaly

Private Password As String
12.Formanyn Load isi {i¢in su prosedurany gosmaly

Private Sub Form_Load()
InitApp
xtUserID.Text = UserlD
txtPassword.Text ="
End Sub

13. cmdLogon diiwmaénii Click( isi licin programmada prosedura agyp ona su bolegi gosalyn:

Private Sub cmdLogon_Click()
Dim msg As String

UserID = txtUser.Text
Password = txtPassword.Text

msg = "Ulanyjynyn ady: " & UserID & Chr$(13)
msg = msg & "Parol: & Password & Chr$(13)"

msg = msg & "ACL: " & Str$(ACL)
End Sub

14.F5 basyp ya-da Run » Start bilen programmany ise goybermeli. Netije asakdaky yalydyr:

(59 Ulanyiyny hazaba almak 10| x|

lanypngn ady I"ﬁ"Sh-""r

Paral I xxxxx
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7.8. Uytgeyinleri yglan etmekde Static adalga

Prosedura derejesinde iiytgeyanleri yglan etmek {i¢in Dim —den basgada Visual Basic-de Static adalga
bilen hem liytgeyanleri yglan edip bolar. Onunl yazylysy

Static X As Integer

Seyle yazylanda iiytgeyn ifl sofiky bahasy prosedura boyunga iyatda saklanar. Seyle is ykdysady
hasaplardaky alnan jemlenydn jemi yatda saklamak iicin amatlydyr. Ol Static adalgany yazmasan
prosedura tdzeden ise goyberilende, liytgeyanin bahasy tiytgér.

Indiki mysalda kofehana girip nice kise kofe i¢genimizii hasabynyn yoredilisiniii programmasyny
diizelin

1.Standart EXE gorniisli tidze taslama doretmeli.

2.Formal formanyn Caption hésiyetine Kofehana baha bermeli.

3.Formanyn yokarky bdleginde yazgy doretmeli.Onun Name hésiyetine IblQuantity, caption hésiyetine
Buyrulan kofe:0 baha bermeli.

4. IblQuantity yazgynyn asaky setirinde yazgy doretmeli. Onuit Name hésiyetine cmdAdd, Caption
hésiyetine &Yene getir! baha bermeli.

5.cmdAdd diiwma iki sapar basyp, onun programma penjiresini agalyn.

6.cmdAdd diiwmn Click isine su prosedurany gosalyn
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Private Sub cmdAdd_Click()
Static count As Integer

count =count + 1
IblQuantity = "Buyrulan kofe:" & Str$(count)
End Sub

7.F5 basyp ya-0da Run » Start bilen programmany ise goybermeli. Netije asakdaky yalydyr:

™ =10/ %]
|emdadd ~| |ciick -]

Private 3ub cmdidd Click()

Static count Az Integer

F

count = count + 1
lhlouantity = "Buyrulan kofe:™ & 3triicount)
End 3Sub -
=J= 4| | Ny
5 kofehana ;@ﬂ

Buyrulan kofe: 2

Yene getir diwméni nige sapar bassak soncada yokarda i¢meli kofdmiz jemlener.
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7.9. Toplumlar(massiwler)

Toplumlar diyilip sol bir gorniisli iiytgeyanlerin alyan bahalarynyn tapawutlygyndan diiziilen
yzygiderlige aytsa bolar. Olar kopleng {iytgeyinlerin umumy belgisi we her bir tiytgeyédn indeks bilen

tapawutlanyar. Mysal {i¢in, olaryn adat¢a yazylysy seyledir:

Static X(2) As Integer

X(0) = 8
X(1) =86
X(2) = 128

Toplumlary isldp tayyarlamak iicin adatca For ... Next sikl ulanylyar, siklin artysyny hasaplayjy
tcin bitin Uytgeydan ulanylyar.Mysal iicin, yokarky programma bdlegini ekrana ¢ykarmak {igin

programmanyi bolegine seyle yazylyar gosulyar:

Dim Y As Integer

ForY=0To?2
Print X(Y)

Next Y

Yokarky mysalyi programma penjiresi we netije asakda getirilendir
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: -0 x|
Commandi j ICIick j

Frivate Zuh Commandl Clicki) =
Static X(2) As Integer

X0y = 8
(1) = 88
¥(z) = 128

Dim ¥ As Integer
For ¥ = 0 To 2

Print (7]
Mext ¥ L
- »
End Sub =;Efl,Fu:nrm1 |O] x|
=[= 4| BE A

Toplum modul derejesinde elyeter bolmagy iigin ony (General)(Declarations) bolekdédki Dim bilen
yglan etmeli. Tutus taslamada ol toplum elyeter bolmagy ti¢in Public adalga bilen yglan etmeli.
Toplum bilen islemegiin mysalyna seredelii:
1.Standart EXE gorniisli tédze taslama doéretmeli.
2. Téze taslamadan Formal formany ayyrmaly. Onun ii¢in taslama dpisgd baryp Formal yazga peykamy
eltip sycanyn sag gulagyny basmaly, ¢cykan gapdal menyudan Remove Formal yazgyny saylamaly.
3.Taslama tdze modul gogmaly, onui ii¢in taslama dpisgd baryp syganyn sag gulagyny basmaly, ¢ykan
penjireden Add » Module saylamaly.
4. Add Module penjireden Module saylamaly.
5. Modulel programma modulyna su prosedurany gosmaly:

Sub Main()
Dim x(7) As Integer
Dim i As Integer
Dim txt As String

' Toplumy bit baha bilen doldurmaly

Fori=0To7
x()=2"i
Next

"Toplumy chykarmaly
Fori=0To 7
txt = "Toplumyn elementi" & Str$(i) & " ="
txt = txt & x(i)
Next
End Sub

6.Programmany ise girizmeli, netijdni barlanyan penjirede gormeli.
Mazmuna gecmek

7.10. Dinamik toplumlar(massiwler)

Programma diiziilende kopleng toplumyn agzalarynyn sany 6niinden nébelli bolyar. Seyle yagdayda
agzasy bos toplum yglan edilyar. Isin basynda hi¢ bir elementi-agzasy bolmadyk topluma Dinamik
toplum diyilyar. Dinamik toplum hem adatdaky toplumlar yaly yglan edilyér, tapawudy prosedurada Dim
bilen Static adalga ulanylyar, mysal igin

Dim Y() As Integer
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Oniunden uly mocberli toplum doretmegint zerurlygy yokdyr. Programmada Veri gelende dinamiki
topluma gerek agzalaryny gosmak yeterlikdir. Onun {igin ReDim operatory ulanylyar, ol operator diie
prosedurada dus gelmelidir, mysal {i¢in,

ReDim Y(5)
Onki doreden dinamik Y() topluma 5 agza gosduk. Soiira toplumyn agzalaryny artdyrybam bolar:
ReDim Y(5)

Su operator yerine yetirilse toplumdaky &hli bahalat yiterler. Olaryn bahalaryny saklap galmak iigin
Preserve adalgasy ulanylmalydyr, mysal {i¢in

ReDim Preserve Y(5)
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7.11. Hemiselikler(Konstantalar)

Programma yazgysynda hemiselikler iliki basda yglan edilydr we sol bada hem olaryn bahalary
berilyar.Hemiselikleri yglan etmek ticin Const adalga ulanylyar, mysal ii¢in

Const conPi = 3.142

Hemigeligin programma yazgysynda ulanylysyny tegelegini meydanyny hasaplanylysyn
programmasy we formada diiwme doredip gorkezileni asakda getirilendir:

Const conPi = 3.142
Dim Radius As Integer
Dim Area As Double

Option Explicit

Private Sub Commandl1_Click()
Radius = 3
Area = conPi * (Radius * 2)
Print Area

End Sub

™ Project] - -0 x|
(General) =] I(I]et:laratinns} ~|

Fs

Const conPi = 3.142
Dim Badius L= Integer
Dim Area ALz Double

Option Explicit

Private Zub Commandl Clicki)
Badiu=s = 3

Ares = conPi * [(Radiuzs ~ 2)
Print Area

End Suhk

E%{II 53 Form1 -0l x| ﬁ
28,278 -
28,278
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Hemiselikleri programma yazgysynyn proseduralarynda, seyle hem programma modulynyn
béleklerinde yglan edip bolar. Hemiseligi tutus taslamada doretmek gerek bolsa ol yglan edilende Global
adalga ulanylmaly, mysal ii¢cin

Global Const Pi = 3.142
Mazmuna gecmek

8.Visual Basic-de maglumatlary yazmak we okamak (Faylar bilen islemek)

Kompyuterler maglumatlary igldp tayyarlamak iicin niyetlenilendir. Seyle yagdayda kompyuterin
maglumat goterijilerine yazmagyn we olardaky maglumatlary okamagyn ygtybarly usulyny ulanmak 6rén
zerurdyr. Kompyuterde maglumat yazylyan ¢eye, gaty, optik diskler bilen bir hatarda magnit lentalaram
ulanylyar we olardan maglumatlar okalyar. Bu isler fayllar bilen islemekdir.

Mazmuna ge¢cmek

8.1. ASCII fayllar bilen islemek

Adatca Visual Basic-de, diskde saklanyan iki goérniigli fayllar, yagny maglumat gorlarynyin we ASCII
fayllar bilen is salysylyar. Adatca ASCII fayllar Windowsda WordPad, Bloknot kompyuter maksatnamalar
bilen doredilyar.

Islendik fayl bilen islemek ony agmakdan baslanyar. Visual Basic-de fayly agmak, ony okamak ya-
da ona yazmak 1gin Open operatory ulanylyar. Open operator ii¢in ifi az parametrleriii toplumy faylyn
adyndan, girmegin diizglininden we faylyil tertibinden ybaratdyr. Open operatoryn yazylys formaty
seylerdkdir:

Open filename For mode As fileno

Bu yerde

llename - agylyan faylyn adyny kesgitleyir;

mode - girmegin diizgiini, onun gorniisleri:
Append(Gosmaga) - gosmaca girizmek diizgiini;
Input(Girizmek) — adat¢a girizmek;
Output(Cykarmak) — adatca ¢ykarmak;
Binary(lkilik) — aglyan fayl ikilik san ulgamynda;
Random(Erkin) — agylyan fayl erkin islendik diizgiinde.
fleno —programmada acylyan faylyn tertibi, ol bitin bolmaly. Faylyn tertibi programmada

fayllar bilen amallar
yerine yetirilydrka ulanylyar. Append, Output, Binary,

Random diizgiinlerde agyljak fayl bolmasa isual asic onun yerine bos fayl doredyir.

Eger mode parametr acyljak formatda bolmasa acyljak fayl erkin diizgiinde agylar. Fayllary
acmagyn yokarky diizgilinlerinini hi¢ birinifi biri-birinden tapawudy yokdyr, olaryn tapawudy fayldaky
maglumatlaryn formatyna baglydyr.

Programmada fayl bilen islenilip bolanyndan soni ony Close operator bilen faylyn agylys tertibini
gorkezip yapmaly:

Close fileno

Mazmuna ge¢mek

8.2.Fayllara yzgiderli girmek diizgiini

Visual Basic-de maglumatlar yatda saklanylanda ya-da okalanda k& halatlarda yzygiderli fayllar
ulanylyar. Yzygiderli fayl ASCII formatdaky yazgy setirlerden ybaratdyr.
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@ Config.sys - b noxHoT ;Iglil

FPain  [Npaeka [lNodck LCropaeka

[menu] -
menuitem=CD, Start computer with CD-ROM support.
menuitem=HOCD, Start computer without CD-ROHW support.
menuitem=HELP, Uiew the Help file.

menudefault=CD,38

menucolor=7,08

[cD] (.
device=himem.sys /testmem:off

deuice=uakcdrum.5y5 fD-mscdBa@l

device=btdosm.sys

device=fFlashpt.sys

deuice=htcdrum.595 fD:mscda|

device=aspiZdos.sys

device=aspiBdos.sys

device=aspildos.sys

device=aspiBu2._sys -

] AW
Yzygiderli faylyn nusgasy

Yzygiderli fayly maglumatlary yazmak ii¢in ony Output ya-da Append diizgiinlerde agmaklyk
zerurdyr. Eger fayl yok bolsa ony Visual Basic doreder. Eger ol bar bolsa, ony Output diizgiinde agsaiyz
ondaky 61 bar bolan maglumatlar ayrylyar. Eger ol bar fayly Append diizgiinde agsailyz, onda tize
yazgylar onki yazgylaryn yzyna yazylar. Adatga fayl téze maglumatlary 6iiki maglumatlaryn {istiine
gosmakda peydalanylyar. K& halatlarda fayllardaky maglumatlar fayl tdzeden acgylyanga yatda
saklanylyar, agylanda bolsa ayrylyar.

Yzygiderli fayldaky maglumatlary okamak ii¢cin ony Input diizgiinde agmaly. Fayly islendik Output,
Append ya-da Input diizgiinde programmada aganyniyzda ona agylys tertibini bermeli. Gerekmejek, agylan
fayly agylys tertibini gérkezmek bilen Close ulanyp yapmaly.

Fayla yazgy yazmak ti¢in Print #(ya-da Write #) operatorlary ulanylyp bilner.

Fayldaky yazgyny okamak ii¢in Line Input #(seyle hem Input # operatory ya-da Input funksiyasy)
operatory ulanylyp bilner.

Asakdaky programma bolegi C:\Yaz katalogda iki setir yazgy yazar:

Dim FileNo As Integer

FileNo = FreeFile

Open “C:\Yaz\test.txt” For Append As FileNo
Print #FileNo, “Nazar”
Print #FileNo, “Gurban”

Close FileNo

FreeFile funksiya erkin faylyn tertibine dolanar. Ol Open, Print # we Close operatorda ulanylar. Fayl
hig hili maglumat bilen isti yetirilmén tizeden yazylmaly bolsa Outpur adalgany Append bilen ¢alysmaly.

Yatda saklanan maglumatlar tizeden yuklenilende olaryi her bir setirini toplumyn(massiwiii) setri
hokmiinde okap bolar. Mysal iigin, C:\Yaz\test.txt faylyn toplumy seyle yiiklener:

Dim FileNo As Integer
Dim GetValues() As String
Dim Counter As Integer

‘ Hasaplayjyny atlandyrmaly
Counter=0
FileNo = FreeFile

‘ Fayly achmaly
Open “C:\Yaz\test.txt” For Input As FileNo
Do until EOF(FileNo)
Counter = Counter + 1
ReDim Preserve GetValues(Counter)
Loop
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Close FileNo

Bu yerde EOF funksiya fayl okalanda, onun sofiuna yetilendigini barlayar. Faylyin somy yorite
ASClII-sekil bilen belgilenydr, ol sekil, fayla maglumat gosulanda ya-da faylda maglumat doredilende
ekranda goriinmeydr. Fayldaky maglumatlar okalyp bolynanda GetValues toplumyi ululygyny saylap,

olaryn elementlerine at berip forma ¢ykaryp bolar:
Dim J As Integer

For J =0 To Ubound(GetValues)
Print(GetValues)
Next J

Bu programma bdleginin isini gowulandyrmak iicin formamyzdaky (General)(Declaration) bolekde
Option Base 1 setri gosmaly. Bu buyrugyn yerine yetirilmegi bilen toplumyn indeksi 0-dan baglanman 1
bilen baglanyar. For...Next Sikl 1-den baglanmaly.

Ubound funksiya toplumyn ifi uly bahasyna,
Lbound funksiya toplumyn ini ki¢i bahasyna sikli gaiitaryar.

Bu iki funksiyany ulansak toplumyn mdgberini kesgitldp bolar.

Programma yazgynyn asakdaky bdlegi bi Olgegli toplumyn #hli elementlerine seretmek {igin
niyetlenilendir:

Dim J As Integer
For J = Lbound To Ubound(arrayname)
6z programmamyz
Next J
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8.3.Fayllara erkin girmek diizgiini

Erkin girmek diizgiini hem ASCII fayllardan maglumatlary almak {igin peydalanylyar. Erkin
girmekde girilyédn faylyn islendik yerinden talap edilydn maglumatlary okamak ii¢in niyetlenilendir. Onun
isleyisi edil maglumat gorlarynynky yalydyr.

Erkin girmek diizgiini ti¢in faylyn acylysy Random parametri bermek bilen amal edilyar, onun
yazylys formaty:

Open “C:\Yaz\test.txt” For Random As FileNo Len=10

Bu yerde Len parametri bermezden 611 her bir maglumat setirii uzynlygyny sekillerde kesgitlemek
zerurdyr.

Setirddki maglumatlara yazgy diyilyir, ol edil maglumat goryndaky yaly.

Mysal {i¢in, her bir yazgy kébir adamyn familiyasy, ady we gysgaca beyany berilmeli bolsa, onda ol
parametrleri bir setire birlesdirsek, ony manyly okamak kynlasar:

Private Sub SaveFile()
Dim FileNo AS Integer
Dim RecNo AS Integer
Dim FName AS Integer
Dim Lname AS Integer
Dim Lineout AS Integer

Fname = "Jeren”

Lname ="Geldi"

Desc = “Geldinin mashgalasy”
LineOut = Lname & Fname & Desc

FileNo = FreeFile

RecNo =1

Open “C:\Yaz\test.txt” For Random As FileNo
Put #FileNo, RecNo, LineOut
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Close FileNo
End Sub

Okalan yazgy seylerdk bolar

Geldi Jeren Geldinin mashgalasy

Seyle yazylys bimanydyr. Onuil ornyna her bir iytgeyane 6z gorniisini Type...End Type adalga bilen
bermek yerliklidir. Operator Type {liytgeyénlerin standart bolmadyk gorniislerini kesgitlemek {i¢in
niyetlenilendir. Ol adalga taslamada in bolmanda bir programma modulynyil bolmagyny talap edyér. Ol
programma YVazylyan (General)(Declaration) bolekde yglan edilmeli. Yokarky peogramma su bolegi

gosalyn

Type UserinfoRecord
LName As String * 15
FName As String * 15
Desc As String * 50

End Type

Formanyn prosedurasy seyle gorniise geler:

Private Sub SaveFile()
Dim FileNo AS Integer
Dim RecNo AS Integer
Dim usr AS UserinfoRecord

usr.Fname = "Jeren”
usr.Lname ="Geldi"
usr.Desc = “Geldiniin mashgalasy”

FileNo = FreeFile
RecNo =1
Open “C:\Yaz\test.txt” For Random As FileNo Len = 80
Put #FileNo, RecNo, usr
Close FileNo
End Sub

Bu yerde Type...End diiziimde Fname, Lname, Desc yaly 3 sany 6zbasdak setir liytgeyénleri yglan
etdik. Bu yerde Fname, Lname iiytgeyénlerii uzynlygy 15-e yetip biler, Desc uytgeyéninki bolsa 50-4
yetip biler. Hemmesini gosgak setirddki diiziim 80 sekil bolar, ol yazgynyn uzynlygy bilen gabat gelyir,
fayla bolsa sol yazgy yazylar.

UserlinfoRecord gorniigli liytgeyédnlerden peydalanmak ii¢in ony Dim adalga bilen yglan etmeli.
Ondan son onui i¢indéki iiytgeyiidnlere nokat goyup(usr.) adyny yiiz tutup bolar.
Mazmuna ge¢gmek

8.4.Fayllara ikilik girmek diizgiini

Fayllar bilen islenilende olara girmek ikilik girmek diizgiini uly ¢eyelige eyedir. Onda yazgylary
okamak Get# buyruk bilen okalyar, Put# buyruk bilen yazmak amal edilyér. Ikilik girmede faylyn islendik
yerinden okamak bolanok. Onda maglumatlary okamak yzygiderlilikde bolek-bolek gorniisde bolup
gecydr. Fayldan okalan baytyn mukdary setirint baytdaky mdgberine dendir. Mysal {i¢in, su yazgy fayldan
10 bayt okar:

Yaz = String(10, “ )
Get #FileNo, , Yaz

Bu yerde RecNo yokdyr, sebibi fayl yzygiderlikde okalyar.
Indi bolsa yonekeyje sifrlamak programmasynyn diiiilisine seredelin.
Mazmuna ge¢mek
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8.4.1.Sifrlamak programmasynyn diiziilisi

Fayllary sifrlamak menyuyn Actions » Encrypt buyrugy bilen, sifrlary agmak Actions » Decrypt buyruk
bilen amal edilyar. Iki yagdayda hem iistiinde amallar edilmeli yazgy faylyny saylamak teklip ediler.
1.Standart EXE gorniisli téze taslama doretmeli.
2.Formal-ifi Name hésiyetine frmMain, Caption hésiyetine fayllary sifrlamak baha bermeli.
3.Forma standart geplesik penjiresini yerlesdirmeli. Onun Name hésiyetine digFile baha bermeli.
4 Menyu redaktoryny agmaly, onda su obyektleri doretmeli:

Menyu File:
Caption: Name:
&File mnuFile

File menyuyn buyruklary:

Caption: Name:

&EXit mnuFileExit

Actions menyu:

Caption: Name:

&Actions mnu Act
Actions menyuyn buyruklary:

Caption: Name:

&Encrypt mnu ActEncrypt

&Decrypt mnu ActDecrypt

Netijede asakdaky formany-resminamany alarys

(] ] C

53 Faypllary zhifrlamak |0 ﬂ

5.Programma penjiresine baryp Object Sanawdan mnuFileExit setri agmaly
6. mnuFileExit_Click() is prosedurasyna End operatory gosmaly:

Private Sub mnuFileExit_Click()
End
End Sub

7.Sifrlamagyn algoritmini programmirldlin, onun {igin (General)(Declarations) bdlegi acyp, ona su
setirleri yazalyn

Function Encrypt(infile As String) As Boolean
Dim filenol As Integer
Dim fileno2 As Integer
Dim outfile As String
Dim xpos As Long
Dim x As Byte
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'‘chage sagady gorkezyan belgini chykarmaly
MousePointer = vbHourglass
Xpos =4
outfile = "c:\temp.enc”
filenol = FreeFile
Open infile For Binary As filenol
fileno2 = FreeFile
Open outfile For Binary As fileno2
Put #fileno2, 1, 0
Put #fileno2, 2, 128
Put #fileno2, 3, 0
Put #fileno2, 4, 128
Do While Not EOF(fileno1)
Xpos = xpos + 1
Get #filenol, xpos, x
Get #fileno2, xpos, x + 128
Loop
Close fileno2
Close filenol

'deslapky fayly ayyrmaly, ony shifrlanan fayl bilen chalyshmaly
Kill infile

FileCopy outfile, infile

Kill outfile

Encrypt = True

'sychanyng gorkezijisini dikeltmeli
MousePointer = vbNormal
End Function

Bu yerde sifrlamak isinde Sub ulanman funksiya ulanylmaly, sebébi ol ¢agyrylyan prosedura yza
gaytmak kodyny beryir. Sifrlamak gowy gecen bolsa Encrypt = True bolar, gowy gecmese onun bahasy
False bolar. Funksiya infile parametr berilydr, onda sifrlanyan faylyn doly ady bolmaly. infile bahasy
GetFile() funksiyany ¢agyrmak bilen kesgitlenilydr.Programma belli bir iyerine yetirydrkd duryp galdy
diyilmezligi iicin onun peykamyny ¢dge sagadyna dwiirmeli, onun buyrugy: MousePointer = vbHourglass.

1.Yokarda esasy programma(sifrlamak funksiyasy) tayyar yagdayda. Indi bolsa ony cagyrmak iicin
prosedura doretmeklik zerurdyr.Onun iigin mnuEncrypt_Click() i prosedurasyny peydalanarys:

Private Sub mnuActEncrypt_Click()
Dim filename As String

filename = GetFile()
If flename <> "™ Then
If Encrypt(filename) = False Then
MsgBox "fayl shifrlanylanda yalnyshlyk!"
End If
End If
End Sub

2. Encrypt funksiyany ¢agyrmazdan ozal menyu buyrygy faylynl adyny GetFile() funksiyanyn komegi
bilen almalydyr:

Function GetFile() As String
digFile.CancelError = True
On Error GoTo filerr

digFile.DialogTitle = "Fayly sayla..."

digFile.DefaultExt = "*.txt"

digFile.Filter = "Yazgy fayly(*.txt)[*.txt* _ ahli fayllar(*.*)|*.*"
digFile.Filterindex = 1

digFile.MaxFileSize = 32767

digFile.ShowOpen
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GetFile = digFile.filename
Exit Function

filerr:
GetFile=""
End Function

Féayl sifrlanylandan son ony deslapy yagdayyna getirmek ii¢in desifrlamak zerurdyr, onun
algoritminiii programmasynyn bolekleri:

Algoritmin programma boleginiil yazgysy

Private Function Decrypt(infile As String) As Boolean
Dim filenol As Integer
Dim fileno2 As Integer
Dim outfile As String
Dim xpos As Long
Dim x As Byte
Dim t(3) As Byte

‘chage sagady gorkezyan belgini chykarmaly
MousePointer = vbHourglass

Xpos =4
outfile = "c:\temp.enc”
filenol = FreeFile
Open infile For Binary As filenol
fileno2 = FreeFile
Get #filenol, 1, t(0)
Get #fileno1, 2, t(1)
Get #filenol, 3, t(2)
Get #filenol, 4, t(3)
If (1(0) =0 And t(1) = 128 And t(2) = 0 And t(3) = 128) Then
Open outfile For Binary As fileno2
Do While Not EOF(fileno1l)
Xpos = xpos + 1
Get #filenol, xpos, x
Get #fileno2, xpos - 4, x + 128

Loop
Close fileno2
Decrypt = True
Else
Decrypt = False
End If
Close filenol

'deslapky fayly ayyrmaly, ony shifrlanan fayl bilen chalyshmaly
If Decrypt Then

Kill infile

FileCopy outfile, infile

Kill outfile
End If

'sychanyng gorkezijisini dikeltmeli
MousePointer = voNormal
End Function

Goriisiniz yaly desifrlamak programmasy hem edil sifrlamak yaly bolup goriinyér. Desifrlamak isi
fayldaky elektron golyn yagny 0, 128, 0, 128 baytlatyn yzygiderliginin bardygyny anyklamakdan
baslanyar.

Menyuyn degisli buyrygyndan Decrypt funksiyany saylap c¢agyrmak iicin hem asakdaky
progaramma bdlegini ona gosmaly:
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Private Sub mnuActDecrypt_Click()
Dim filename As String

filename = GetFile()
If flename <> " Then
If Decrypt(filename) = False Then
MsgBox "Fayl shifranylanda yalnyshlyk!"
End If
End If
End Sub

Programma tayyar ony ise giriziymeli.
Mazmuna ge¢cmek

8.5.Maglumatlaryn elementleri

Adatca maglumatlar islenip tayyarlanylanda maglumatlar tablisa gorniisinde yatda saklanylsa olar
bilen islemek yenil bolyar. Sonun {icin hem Visual Basic-de ol maglumatlary degisli formada yerlesdirip
bolar. Eger kompyuterde MS ACCESS kompyuter maksatnamasy bar bolsa ony hem ulansaii bolar. Yéne
ol maglumat goryny doretmek isinde yeke-tik miimkingilik déldir. K& halatlarda onuil bilen islemek
kynyragam bolmagy miimkin.

Visual Basic-de birndge gorniisli maglumat gorynyin dolandyrys ulgamlary bilen isldp bolar, olaryn
sanawy Bas menyuyn Add-Ins> Visual Data Manager buyrugy basmak bilen ¢ykan penjrinin
meyuyndan File basmak bilen bize belli maglumat gorlarynyn atlary, goérniisleri bilen ekrana geler:

@"H’isData
File Lty window  Help

Open DataBase.. » Microsoft Access...
Mew... k Dbaze 3

Close FoxPro

Paradox v 2B
Irnport/Ewport. . Excel . 25..
Workspace... Test Files... 20..
Errars...

abec..

Compact MDB...  »
Bepair MDE...

r..

Yokarky ¢ykan penjire bilen programma iigin tize maglumat goryny déredip, 6i doredilenini agyp
1sldp bolar.
Mazmuna ge¢mek

8.5.1.Maglumatlar elementini ulanmak

Maglumatlar elementi bilen islemegi asakdaky mysalda-tablisa seretmek {icin forma déretmekde
gorkezelin. Ol tablisa maglumat gorynyn diiziimine giryandir. Bu is ligin programmirlemek gerek bolmaz.
1.Ctrl+N diiwmeleri utgasdyryp basmak bilen téze taslama doretmeli.

2. New Project penjirede Standart EXE yazgyly belgijigi saylap OK basmaly.

3.Formanyn yokarky bdlegine iki sany yazgy meydanyny gosmaly.

4.0Ony formada yerlesdirmek {i¢in elementler panelindidki maglumatlar elementine iki sapar basmaly.
5.Déredilen elementi stiyrdp formadaky iki sany yazgy meydanynyn asagynda yerlesdirmeli.
6.Formada goyulanlary okap bolar yaly yagdayda ulaltmaly

5 Forml O] x|
ITe:-:H Text2

4| 4 |Data 4 | Hl
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7.Maglumatlar elementine seyle hasiyetler bermeli:

Caption: Authors tablisasy

Connect: Access

DatabaseName: C:\ProgramFiles\MicrosoftVisual Studio\VB98\biblio.mdb
(cykan ... belgini basyp bercefiem bolar)

RecordsetType:  1-Dynaset(¢ykyan sanawdan)

RecordSource: Authors(cykyan sanawdan)

8.Cepdiki yazgy meydanyna su hasiyetleri bermeli:

DataSource: Datal(¢cykyan sanawdan)
DataField: Author(¢ykyan sanawdan)

9.Sagdaky yazgy meydanyna su hésiyetleri bermeli:

DataSource: Datal(¢cykyan sanawdan)
DataField: Au_ID(¢ykyan sanawdan)

10.Programmany ise girizmeli hem-de seredilydn diiwme bilen tablisadaky her hili yazgylara seretmeli.
Yazgy meydanyna yazan islendik tiytgesmelerifi maglumat goryna yazylyar.
Run»Start bassak ¢agyran maglumat gorymyzdaky yazgyly su penjire peyda bolar. Onun 1(birinji)
yazgysynda Jacobs, Russell yazgy, » -bilen 12-nji yazga ge¢sek Wellin, Paul yazgy yazylandyr.

&9 Form1 0] x|
|Jacobs, Fussel [1

4| 4 | Tabliza Authaors AL
5 Form1 O] x|
[tellin, Paul [12

4| 4 | Tabliza Authars M

11.Formanyn yokarky sag bur¢yndaky x-belgini basyp amal edilisini saklap bolar.

12.Tablisa tize yazgyny gosjak bolsann formadaky Tablisa Authors  Yyazylan bdlegininn hésiyetlerinde
EOFAction hisiyete sagdaky ¢ykan sanawdan 2-Add New baha bermeli.

13. Run»>Start bilen programmany tizeden ise girizmeli. Yazgyny gosmak iicin tablisanyii sofiyna
belgini basyp geg¢meli, sora » basmaly.

14.Birinji yazgy meydanyna Yaz. Ash yazgyny yazmaly. Su yazgy maglumat goryna gosylar.

53 Forml =10 x|

fitaz. Ash {16100
4| 4 | Tabliza Authars » I Hl

15.Programmanyn isini formadaky x-begini basyp saklamaly.
16.Maglumat gordaky yazgyny ayyrmak islesek onda forma-da ol barada diiwme doretmeli. Doredilen
diilwmanin Name hésiyetinin bahasyna cmdDelete, Caption hésiyetine &Delete bermeli.
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. - 10| x| | &' Properties - ... _|0O| x|

cmdDelete CDmmandButb:uj

£ -0
I R, ° AT Alphabetic lCatEgDHZEd] .
[Tt Tesz 5
: | B : | = . :' Delete | (Marne] crdDelete i‘ |
| ] [ ] 1 1
- | M| 4 | Tabliza Authars MM Appearance 1 -30 |
: 2000 soooaac BackColor  [] &Ha00000
Zancel False
Caption  EEEE ;
Causestalidzti True |
1 | | ﬂ FiaF=lk Fala ﬂ |

17.Téze doredilen Delete-ditwmede is etmek ii¢in su prosedura bdlegini gosalyn

Private Sub cmdDelete_Click()
With Datal.Recordset
.Delete
.MovePrevious
End With
End Sub

cmdDelete j ICIick j

Private ZSub cmdDelete Click() (B
With Datal.Recordset [
JDelete
MovePrevious
End With
Fnd Sub 53 Form1 =10 x|
[Sha. Pal [16108 Delete |
4| A | Tabliza Authors }l}ll

Bu yerde 16099-a ¢enli maglumat goryn yazgysyny ayryp bolyan déldir. Dine tdze gosanlarymyzy
Delete diiwméni basyp ayryp bolar. Bagga maglumat gory bilen su isimizi gaytalamak {icin onun

maglumatlarynyn elementinifi hisiyetlerini, nima zerurlygyny bilmek zerurdyr.
Mazmuna gecmek

8.5.2.Maglumatlar elementinin hésiyetleri

Maglumatlar elementinin hédsiyetleri berilyan penjirediki sanawy asakdaky suratda getirilendir. Bu

yerdéki esasy berilmeli hisiyetler:

Connect maglumat gorynyn gorniisini beryér, hi¢ zat berilmese Access saylanyp alynyar;

DatabaseName maglumat gorynyn faylynyn adyny kesgitleyér;

RecordSet hisiyet maglumatlaryn nireden alynyandygyny gorkezyar: tablisadan(maglumatlar bir tablisada
bolsa onayly bolyar), dynaset-dinamiki yygyndydan(maglumatlar biri-birine bagly birnice
tablisada) ya-da snapshot-suratdan(maglumatlary difie okamak miimin bolsa).
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[Datal Data =l
Alphabetic | Categotized I
(Tarne) Dakal [
dlign 0 - None

Appearance |1 - 30
Backolor (] &HS00008
BiOFACkion 0 - Move Firs
apkion Tablisa authe
Conneck f -
DakabaseMarnda

DefaultCursor|{dEASE 1T

DefaulkType ggigg ISI"'IE_
Draglcan I

Excel 3.0;

Draghlode Excel 4.0;
Enabled Excel 5.0;
EOFAction  |=X8LE.0;
Exclusive False

Fonk M5 Sans Seril
Forecolor (] aHs00000
Height 375

Inde:x lI

Maglumat gorlary bilen islemek Visual Basic-de programmirlemegiin amatly miimkingiliklerinin
biridir.
Visual Basic-de maglumat gorlarynyn Microsoft Access(.MDB), SQL Server we Oracle formatlarynda
islemegin kop miimkingilikleri g6z 6niinde tutulandyr.
Access maglumat gory tablisany, indeksleri, soramany 6ziinde jemleyén fayldyr:
tablisa - setirlere we siitiinlere boliisdirilen maglumatlar toplumydyr; setirlere -yazgylar, siitiinlere -
meydanlar diyilyar.
indeks - tablisadaky yazgyny gorkezydn arabaglanysygyn sanawydyr; ol tablisadan maglumaty tiz
tapmaga yardam edyéar
sorama - SQL(Structured Query Language-Soramalaryri diizlenen dili)-ii operatorydyr, onufl bilen
tablisadan ona bagly yazgylar saylanyar.
Maglumat gory bolmak ii¢in ii bolmanda bir tablisa bolmalydyr. Sebdbi onda maglumatlar
saklanylmalydyr.
Sramalar tablisadaky maglumatlary saylamak ya-da iiytgetmek {i¢in hyzmat edyar. Eger soramany
dogry yazyp bilseniz bar bolan maglumat goryndan jogabynyzy alyp bilersiniz.
Mazmuna ge¢mek
8.5.3. Visual Data Manager-de maglumatlar goryny doretmek

Maglumatlar gory maglumatlary saklamak we saylamak ti¢in amatly serisdd eyedir. Ona yazgylary
gozlemegi tizlesdiryén tablisalar, soramalar we indeksler giyér.Visual Basic we Access maglumat goryny
tiz we ygtybarly doretmége zerur miimkingiliklere eyedir.
Maglumatlar goryny doretmek onun adyny saylamadan we bermekden bagslanyar. Maglumat
gorynyn ady bu yerde .MDB yazgy bilen gineldilen fayl gorniisinde yatda saklanylyar.Fayl doredilenden
son maglumat goryna girydn obyektleri-tablisalary, soramalary we s.m. doretmége girisilydr. Ol
obyektlerinl &hlisi MDB-faylyn i¢inde yatda saklanylyar.
Kitap diikany ti¢in dorediljek maglumat gorynyn yzygiderligi seylerdkdir:
1.Add-Ins>Visual Data Manager buyrugy bilen Visual Data Manager-i ise girizmeli.
2.Cykan penjirede File>New>Microsoft Access>Version 7.0 MDB buyruk bilen Select Microsoft Access
Database to Create penjireleri agmaly.

3.Maglumat gorynyn adyny girizmeli; onun ady biziii mysalymyzda House()fBooks(ada nidme belgi
berenin tapawudy yok) diyip at berildi..MDB gineldilme hdkman dédl ony Visual Basic-ii 6zi
kompyuterde beryar.

4.0K(Coxpanuts) diiwméni basmaly.
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Yokarysynda goryii ady bilen maglumat gorynyi penjiresi agylar. Kompyuterifi ekranynda birbada
iki penjire agylar. Birinjisi maglumat gorynyn penjiresi(DatabaseWindow); IKinjisi soramalar
penjiresi(SQL Statment). Maglumatlar gorynyn penjiresinde su déreden gorymyzyn hésiyetleriniii sanawy
getirilen, olar sagdaky penjirede.Onda entek yekeje tablisada ya-da soramada yok. Onun yokarky bas
menyuyn eteginddki gurallar panelinde gor bilen kébir amallary yerine yetirmek {i¢in

PR EBEE 8 W diiwmeler bardyr.

@VI:D.I.:E:\Prngum Filezs\Microzolt Vizual Studio\WVB98\H ouze()lBook:. mdb =1 |
Film  Llklity  Window Help

0 6 | | |0 6 | = 0 00

| T D atabas 10| x| | Gl S6L Statement =1k

= Eﬂ' Proparbins EaimeELjls I Clmar Save
Eﬁ" Marme=iZFrogram FllesiMicrosoft Vis.
B Conrmct= 2
[Eir" Transactionss=True
B Uplatabla=Triis
' Collatingorder=1033
[ ey Timeauk=a0
[ version=3.0
EE RecordsAfFactacd=0
Eif Replcalbe=
[f Lrmsigritaster] L=
Eﬁ' Connection=/ o

L | [T i
| 4 | | pl
[Ready | User: admin &

Gora bir tablisany gogsmazdan 611 ony yapmanyi we agmanyil amal edilisine seredelin:
1.File>Close buyrugy amal etmeli. Close buyruk agylan penjrani yapyar, Mysal ii¢in, su buyrugy amal
etsek yokarky penjire seyle bolar

@WSD ata =10 x|

File  Ltlity  “Window  Help

Bk EEE e

| Ready | Iser: admin 4

2.Yokarky penjireden Open Microsoft Access Database penjrini agmak iigin onda File»Open
Database>Microsoft Access buyrugy amal etmeli. Cykan penjireden House()fBooks.mdb fayly saylamaly
Open(OTkpbiTb) dilwméni basmaly. Sonda sol 6niki SQL-Statement bdlegi bos maglumat goryi penjiresi

acylar.
Mazmuna ge¢mek

8.5.3.1.Tablisa doretmek

Kitap diikany boyunca tablisa doretmek isiinin yzygiderligi seylerdkdir. Adaty kitaplaryn sanawy
seylerdk berilyar:

Kitaby ady Awtory

Ykdysady informatika Ashyr Yazgylyjow
Personal kompyuterde islemek Ashyr Yazgylyjow
Word yazgy redaktory Ashyr Yazgylyjow
MS EXCEL Ashyr Yazgylyjow
Maglumat biznesi Gurban Shukurow
Maglumat tehnologiyasy Bashim lwanow

Kompyuterde kitaplar ady bilenem, awtoryn familiyasy bilenem, awtoryil ady bilen tertiplesdirilydr.
Onyi licin Awtory meydany iki meydana bolmeli bolar, yokary tablisa asaky gorniise geler

Kitaby ady Familiyasy Ady
Ykdysady informatika Yazgylyjow Ashyr
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Personal kompyuterde islemek Yazgylyjow Ashyr
Word yazgy redaktory Yazgylyjow Ashyr
MS EXCEL Yazgylyjow Ashyr
Maglumat biznesi Shukurow Gurban
Maglumat tehnologiyasy lwanow Bashim

Maglumatlar tablisa girizmezden 6f onuii maketini konstruirlemeli. Bu isden 6n tablisa nihili
maglumatlaryn girizilydnini, atributyny(meydanyny) saylamaly, kesgitlemeli. Ondan son maglumatyn
gorniigini kesgitlemeli. Biziit mysalymyzda {i¢ sany adaty yazgy yazylyan meydan gerek.

Mazmuna gecmek

8.5.3.2.Tablisany konstruirlemek

Bizin tablisamyz House()fBooks maglumat goryna girydr, ol ekranda bolmalydyr, ol yok bolsa
File>Open Database buyruk bilen ony a¢maly. Tdze tablisa doredip baslamazdan 6n apisgn gurallar
panelinden Table-E& diiwmiini basmaly:
1.Sagdaky penjraninn is meydanyna sycanyn peykamyny eltip, sycanyn sag gulagyny basmaly, ¢ykan

gapdal menyudan New Table buyrugy saylamaly. Ekranda konstrirlemek diizgiinde tablisanyii bos
penjiresi ¢ykar, ondaky bos meydanlara meydanyn atributlary, maglumatlaryin gérniisleri berilmelidir,
maglumatlar basga diizgiinde girizilyandir.

Table Structure IIE
Table Mame: |
Field List: Mame: |
Tvpe: I— [T Fixedlength
Size:t I— [ variableLenath

CaollatingCrder: I [~ &utolncrement

[~ alowZerolength

OrdinalPosition: | ™ Required

YalidationText: I

ValidationRule: I

Add Field Remove Field Defaulthalue: |
Index List; Mame: |
[T Primary [ Unique [~ Foreion
[T Requied [~ Igroremull
Figlds:
Add Index | Remove Index | I
Build the Table | Close |

Bu yerde Table Structure penjraniii ¢ep bolegi bos meydandan ybaratdyr.Eger maglumat gory bar bolup
acylan bolsa, meydanlar kesgitlenen bolsa, ol yerde olaryi atlarynyn sanawy ¢ykardy. Sagda bolsa
cepdéki begilenen meydanyn hésiyetleri beyan edilyér. Penjranin asaky eteginde maglumat gora giryan
indeksler sanalandyr.
2.Tablisanyn ady in yokarky yazgy meydanynda berilyar. KitapSanaw yazgyny girizelin.
Mazmuna gecmek

8.5.3.3.Meydanlary doretmek
Tablisa ti¢ meydany asakdaky yzygiderlikde gosalyn:

1.Add Field diiwmani basyp tablisa birinji meydany gosalyn, sonda Add Field —ifi penjiresi agylar:
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Eil Add Field x|

Mame: OrdinalPosition:
[ |
Tvpe: YalidationTesxt:
IText j I
Size: Y alidationRule:
2 |

™ FixedField
% YariableField

Defaultyalue:

[T autolnceFied

oK

¥ allowZerolength

[T Required Close

2.Name meydana TITLE setri girizmeli, eger kursor bagga yerde bolsa ony ol yere eltmeli.

3.Klawiaturadaky Tab diiwmini basyp indiki meydana ge¢meli. Yazgynyn gorniisi kanagatlandyrsa
goymaly yogsamam ony gorkezmeli.

4.Size (maglumatyn mogberi)meydana ge¢cmek ii¢in yene klawiaturadaky Tab diiwméni basmaly.Ona 40
girizmeli.

5.0K basyp gora girizilen maglumaty iberyaris.

6.Ikinji medanyn adyny-LASTNAME girizmeli.

7.Klawiaturadaky Tab diiwmaéni iki sapar basmaly. Meydanyn uzynlygyny 20 edip girizmeli.

8.0K basyp gora girizilen maglumaty iberyéris.

9.Soniky meydanyn adyny-FIRSTNAME girizmeli.

10.Klawiaturadaky Tab diiwméni iki sapar basmaly. Meydanyn uzynlygyny 20 edip girizmeli.

11.Penjireddki Close diiwméni basmaly. Tablisany konstruirlemek tamamlandy.

12.Table Structure penjiredaki Build the Table diiwméni basmaly, sonda Data Manager tablisanyn maketini
maglumat goryna gosar.

@VisData: C:\Program Files\Microzoft Visual 5tudiohVB984Housze()iBook z. mdb -0l x|

File  Utility window Help
E=FIEEEITIETE:
=Ic=
| Esxecute Clear | Save
E5' Properties =
1] | M

[T Database Window o [m] B
|Ready | User: admin Y

Maglumat goryna birinji tablisa gosuldy. Indi tablisany agyp, onuil meydanlarynyil diiziimini tiytgedip,
tdze yazgylar gosup bolar. Ondan basgada tablisany ayryp ya-da onun diiziimini nusgalap bolar:

1.Maglumat gory penjiresindaki KitapSanaw tablisa sycanyn peykamyny eltip, sycanyn sag gulagyny
basyp ¢ykan sanawdan Open buyrugy bassak ofla maglumat girizmdge amatly, 61 yazylan
maglumatlara seretmek we redaktirlemek ii¢in penjire agylar:
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Table-KitapSanaw O] x|
f&dd | Edit | Celete | Seek | Filker | Close

Indezx: I j

Field Mame: Malue (F4=Zoom)

TITLE: |

LASTHAME: |

| | < I[BOF]I,I'I:I > | ozl

2. .Table Structure penjrini Close diiwmaéni basyp yapmaly.
Mazmuna gecmek

8.5.3.4. Tablisa maglumatlary girizmek

Tablisa maglumatlary girizmek {i¢in ony tdzeden agmaly:

1.Sagdaky sanawdan KitapSanaw tablisany saylamaly.

2.Saylan KitapSanaw tablisanyn iistliine sycanyn peykamyny eltip, sycanyn sag gulagyny basmaly, ¢ykan
sanawdan Open yazgyny basmaly.Sycanyn ¢ep gulagyny tiz-tiz iki sapar bassanam agylar.

Birinji yazgy seyle girizilyar:

1.Agylan penjirede Add diiwmaéni basyp tablisa tdze yazgy gosmaly.

2.TITLE meydana ykdysady informatika yazgyny yazmaly, sycanyn peykamyny LASTNAME meydana
gecirmeli.

3.LASTNAME meydana Yazgylyjow vyazgyny girizip, sycanyil peykamyny FRISTNAME meydana
gecirmeli.

4. FRISTNAME meydana Ashyr yazgyny girizmeli, sycanynl peykamyny indiki yazgynyn birinji
meydanyna eltmeli.

5.Girizilen iiytgesmeleri kompyuter yatda saklamagy teklip etse Yes diiwmini basmaly.

T able:KITAPSANAW =10 x|
add | Edit | Delete | Seek | Filker | Close

Index;: I j

Field Mame: Yalue (F4=Zoom)

TITLE: |i'|“kd':.fsau:|y infarmatika

LASTHAME: [irazgytyion

FIRSTNAME: fsshyr

ki | < Erows > | sl

Ikinji yazgyny Add diiwméd basyp doretmeli. Eger artykmag bir yazgy doredilse ya-da bos gegse ona
baryp menyudan Delete basyp ayryp bolar. Seylelikde asakdaky maglumaty KITAPSANAW-a girizeris.

TITLE LASTNAME FRISTNAME
Ykdysady informatika Yazgylyjow Ashyr
Personal kompyuterde islemek Yazgylyjow Ashyr

Word yazgy redaktory Yazgylyjow Ashyr

MS EXCEL Yazgylyjow Ashyr
Maglumat biznesi Shukurow Gurban
Maglumat tehnologiyasy lwanow Bashim

Maglumat gory bilen dhli isler su doreden tablisamyzyn esasynda amal edilyar.
Mazmuna gecmek

8.5.3.5. Soramalar doretmek

Sorama munyn 6zi SQL dilde yazylan ailatma bolup, berlen nysany kanagatlandyryan vyazgylary
tablisadan kesgitlemek {iicin niyetlenilendir. Sorama yerine yetirmezden 61 su isler kesgitlenmelidir:
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1.Maglumat gory dpisgd sycanyi peykamyny eltip, sycanyn sag gulagyny basmaly, ¢cykan sanawdan New
Query buyrugy basmaly. Bu isi Visual Data Manager menyudaky Utility>Query Builder buyruk bilen amal
edip bolar.

% Query Builder X
Figld Mame: Cperatar: Walue:
A | - [] | [~

and into Crikeria | Qr inko Criteria | List Possible Yalues |
Tables: Fields bo Show; Garoup By:
KITAPSAMAYW | j
Order By: ¢ fsc { Desc
| |

2.KITAPSANAW tablisany saylamaly, onufi sagyndaky penjirejikde tablisanyn dhli meydanlary yazylar.

Tables: Fields ko Shaow:

KITAPSANAY TITLE
KITAPSANAY, LASTHAME
KITAPSANAN  FIRSTMAME

Bu penjrianiii yokarsyndaky Field Name meydangada adatca tablisanyn birinji meydany gorkezilyir.
Ony [KITAPSANAW].LASTNAME yazgy bilen ¢ykan sanawdan calysmaly.

3.0perator meydanyny tiytgetmeli ddl. Biz awtorlaryn familiyasy gyzyklandyryar, sonufi tiginem = anyk
bolmaly.

4.value meydanyna Yazgylyjow girizmeli ya-da List Possible Values diiwméni basmaly hem-de sanawdan
Yazgylyjow saylamaly.

5.Fields to Show penjireddki sanawyn hemmesine basyp belgildp ¢ykmaly. Biz soramamyza ahli
meydanlar gosulan yagdayda amal etjekdiris.

6.Asakdaky Show diiwmaéni basyp SQL afllatmany gurarys, ekranda onuni gorniisi:

SAL Query J

Select KITAPSANAW TITLE KITAPSANAW LASTHAME KITAPSAMAW FIRSTHAME From
EITAPSANAW

Sorama doretméni, ony su nysana gosmany Add into Criteria ya-da Or into Criteria bilenem dowam etdirip
bolar.

7.Soramamyzy barlap gormek iicin asakdaky Run diiwméni basmaly. Sonda Data Manager siziii SQL-
soramanyz ge¢yanmi(passthrough) sorar:

VisData Eq

\?l) |z thiz a SOLPazsT hrough Querny?

No(Her) diiwmani basmaly. Eger sorama dogry yazylan bolsa biz gapdalynda Yazgylyjow yazylan
yazgylaryn seyle toplumyny goreris:
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@ SOL Statement 0] x|
add Edit Delete Close
Sort: Filter Mowve Eind
Field Mame: Yalue (F4=Foom)
TITLE: Iﬁ’kd';.-'sad';.-' informatilka
LASTHAME: firazgyhyiow
FIRSTHAME: fpshyr
< I r[1/6

Asakdaky sag we ¢ep peykany basyp gozleydn soramamyzy goriip bolar.

9.Netijéni goriip bolnymyzdan son Close diiwméni basyp isi tamamlamaly.

10.Query Builder penjirediki Save diiwmaéni basmaly. Sonda sorama girizmegi teklip eder, Yazgylyjow-atly
soramany girizmeli. Girizilen sorama maglumat goryna gosular.

11.Query Builder penjréni Close diiwméni basyp yapmaly.

Soramanyn netijesi dinamiki yygyndy diyip at bermini emele getiryar.Dinamiki yygyndydaky
maglumatlary redaktirldp bolar, ondaky iiytgesme KITAPSANAW tablisada gorkeziler. Her sapar sorama
doredilende maglumat goryna gosulan familiyany yazmak kén bir maksada layyk déldir, tdze sorama
yazmaly. Sonun ligin hem maglumat goryna girizilydn Soramalar umumyrak bolmaly. Umumy soramany
doretmek {i¢in Visual Data Manager —in hyzmatyndan peydalanyp bolar. Netije kanagatlandyrsa SQL-
anlatmany nusgalap Visual Basic-iii programma yazylyan yerine gegirmeli.Mysal {i¢in, SQL-soramany
seyle yazgy gorniisinde doredip bolar.

SQL= “Select*from[KITAPSANAW] Where[KITAPSANAW].LASTNAME ="
SQL = SQL & txtAuthorname & “”

Ondan son forma-da txtAuthorname at bilen yazgy meydany doredilyédr. Ulanyjy ona gerek familiyasyny
girizip biler, sorama ¢agyrylanda meydanyn mazmuny SQL operator setir hokmiinde
bolar we ondan soii soramanyn esasynda dinamoki yygyndy dorediler.

Mazmuna ge¢gmek

8.5.3.6.Deslapky adalga

Maglumat gorynyn tablisasyndaky haysam bolsa bir siitiinde ayratyn alynan, onufi her indiki
setirinde gaytalanmayan yazgy meydany bolsa maksada layykdyr. Ony bizin mysalymyzdaky siitiinlerde
gormeyaris. Kitap isine degisli her bir nesire yeke-tdk seyle yazgyny ISBN(International Standart Book
Number — ¢ap edilen her bir kitabyn diinyd standartynda nomeri) berip bolar, kitaplara seyle Halkara
derejesinde yeke-tik nomerleme XX-asyryn sonky 20-25 yyllarynda girizildi. Ondan 6nki kitaplarda
onun yaly nomerleme yokdyr. Sonui {iginem kitaplar iicin umumy deslapky adalga ii¢in ony almak hem
maksada layyk déldir, ol meydan bos bolmaly déldir. Bu yagdayda tablisada deslapky adalga tgin yorite
hasaplanyan-meydan doredilyar.

Mazmuna ge¢mek

8.5.3.7.Hasabaalyanlar

Deslapky adalga hasabaalyan-meydan gorniisinde bolanda tablisa yazgy girizenimizde onu sany 1
artyar. Yazga seyle siitiin girizilende, yazgylara yzygiderli san berip bolyar. Ol san bilen yazgylary tapyp,
tertipldp bolar.

Visual Data Manager— hasabaalyan meydan gosmak iicin ony ddretmeli, ony Long goOrniisli edip
saylamaly we Auto Increment yazylan yerde bellik etmeli.Ondan sofi indeks doretmeli, hasabaalyan iigin
Required yazgyda bellik etmeli hem-de hasabaalyan deslapky adalga Primary Key bellik etmeli. Bu
amallarymyzyn netijesinde tablisanyn her bir yazgysy ayratyn hasabaalyan meydan eye bolar.

KITAPSANAW tablisada hasabaalyan edil ISBN-in wezipesini amal eder. Hasabaalyan meydana
BOOK CODE at berelin. Ol meydan diikanyn satyjy sy ya-da alyjysy ii¢in hi¢ hili many bermez, yone
kompyuterde tablisadaky yazgylaryn istiinde amallary etmek tigin mohiimdir. Deslapky adalgany tablisa
konstuirlenyérki doretmelidir, maglumat nége kop toplansa onuil zerurlygy artar.
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Mazmuna gecmek

8.5.3.8. San meydanlary

KITAPSANAW tablisada {ic meydan hem yazgy gorniisdedir, olary sanlar yaly yatda saklamak
kynyrakdyr.olaryin ©zaralarynda arifmetik amallary yerine yetirmek miimkin déldir. Tablisada san
meydanlary bolanda olaryn {istiinde islendik amal edip bolar.

Bizinl tablisamyza iki san san meydanyny gosup bolar. Mysal ii¢in, sol bir atly kitabyn sanyny,
nyrhyny. Access-de nyrh tigin meydanyf pul gorniisi goz 6niinde tutulandyr. Adatca diikanda kitabyn sany
belli bir mukdara barsa onda nesiryatdan ony talap etmek meselesi 6z-0ziinden yiize ¢ykmalydyr.
Mydama-da kitap diikanda bar bolsa onunt mukdary 1-e dendir.

San meydanynyn birndge gorniisleri bardyr, ol meydanyn hésiyetleri Field Size setirden
saylanylyar.Ol setirddki miimkin bolan sanawlar Byte,Integer,Lohg, Single we Double gdrniislerden
ybaratdyr. Su sanawdan birini saylamak bilen meydandaky bolmaly miimkin aralygyny, onluk oturdan
son bolmaly sifrlaryn il uly mukdaryny we sany yatda saklamak ti¢in gerek baytyin mukdaryny kesgitlédp
bolar. San meydanlaryn gorniiglerini asakdaky tablisada getirelin:

Field Size Miimkin bolan bahalaryn aralygy Oturdan  son | Yadyi
hésiyet sifrint mukdary | mukdary
Byte 0-dan 255-¢e genli 0 1 bayt
Integer -32768-den 32767-a genli 0 2 bayt
Lohg Integer | -2147483648 den 2147483648- | 0 4 bayt
e genli
Single -3.4x103%-den 3.4x1038-¢ genli 7 4 bayt
Double -1.797x10%%-den 1.797x103%-e | 15 8 bayt
cenli

Eger san meydany drob ululyga eye bolsa onda onun gorniisini Single we Double aralykda
saylanylmaly. Miimkin bolsa tablisan basyndakylardan san meydanynyn gorniisi saylansa gowy bolar,
Mysal ii¢in, kitaby sany 255-den gegmese onun gérniisini Byte saylansa yatda saklamak ii¢in ujypsyzja
yer gerek bolar.Bu meydana QUANTITY diyilip atlandyrylyar. Uly san meydanlary {igin Integer ya-da Lohg
saylanyp alynmalydyr.

Mazmuna ge¢mek

8.5.3.9. Pul meydanlary

Pul meydany hem Double yaly yeri eyeleyir. Sebdbi oturdan soi iki sifr gerek bolyar. Her miiniden
sont bir bos yer goyulyar. Pul ululygy sag tarapdan dogurlanyar. Pulyn ululygynyn oniinden ya-da
soniundan pulyn belgilenisini goymaly Mysal {i¢in, $-dolaryn belgisi, MNT-tiirkmen manadynyn
belgisi.Seyle berlenilende ol yere difie sanyn 6zi girizilyér pulyn belgisini kompyuteriii 6z goyyar. Kitap
icin nyrhyna meydany PRICE diyip atlandyralyi. Nyrhyna seyle bersek onda —(minus)nyrh bolmaz.

Mazmuna ge¢mek

8.5.3.10. Logik meydanlary

Logik meydanlarda kopleng iki baha bolyar (Oa/Het, Wctuna/Moxs, Bkn,/Beikn,).Kitap diikany iki
gorniigli kitaplary kompyuterler barada hem-de romanlary satyar. Onda maglumat goryndaky yazgyda
ony tapawutlandyralyil. Onufi {igin logiki meydany yazga gosmaly. Meydanda yazgydaky kitap
romandygyny gorkezmeli. Su meydan bilen sorama-da iki sany ayratyn katalog diiziip bolar.Ol meydana
KITAP ROMANMY? at berelii.

Mazmuna gecmek

8.5.3.11. Memo meydany

Memo meydany erkin yazylan yazgylary saklamak tigin zerurdyr, Mysal tgin, her hili
diistindirigler.Adaty yazgy meydanynyn mdgberi 255 bayt(255 harp, sekil, olam 40 soz yerlesyir) bolyar,
Memo meydan 64000 bayt bolup biler. Memo meydanda kitap barada islendik maglumat yerlesdirip bolar.
Tablisada Memo meydana NOTES diyip at berelin.

Mazmuna gecmek
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8.5.3.12. Sene/Wagt meydany

Sene/Wagt meydany sene, wagt barada maglumatlary yatda saklamak ii¢in yorite islenip
tayyarlanylandyr. Kompyuterde, sol sanda Access-ifi icki san formatynda bardyr we hasaplanysda
ulanylyar. Seyle bolsa hem Visual Basic-de we Access-de ayratyn meydanda gorkezilyar hem-de haysy
formatda bolmalydygyny saylap bolyar. KITAPSANAW gorda onun iigin ACQUIRED at berelin.

Mazmuna gecmek

8.5.4. Tablisany iiytgetmek

Yokarda tablisa iigin gerek bolan meydanlara hisiyetnamalar beripdik, olary gosalyi.

Meydanyn ady Maglumatyn gorniisi

BOOK CODE Hasabaalyan (deslapky adalgadyr)
QUANTITY San(Byte)

PRICE Pul

KITAP ROMANMY? Logik

NOTES Memo

ACQUIRED Sene/Wagt

Tablisanynn maketine ilytgesmeler we degisli gosulmaly meydanlar asakdaky tertipde yerine

yetirilyar:

1.KITAPSANAW tablisany agmaly, onun iistiine sy¢anyn peykamyny eltip, sycanyii sag gulagyny basmaly,
¢ykan gapdal sanawdan Design buyrugy saylamaly.

2.Téze meydan gosmak ii¢in ¢ykan penjireden Add Fild diiwmaéni basmaly. Name 6yjige BOOK CODE
yvazgy yazmaly, klawiaturadan Tab diiwméni basyp Type 0yjige ge¢meli, ondaky sanawdan Long
saylamaly. Su meydan Hasabaalyan meydan bolmagy iicin AutolncrField we Required yazgylaryn
ontinde bellik etmeli. OK basmaly.

Bl Add Field x|

Mame: CrdinalPosition:
ook conE |

Twpe: YalidationText:

|L|:|ng ﬂ |
Size: YalidakionRule:
I—
|
~
~

Defaultyalue:

[+ AutolncrField
-

W Required: Close

oK

3.Indiki QUANTITY ady girizmeli, Tab basmaly. Ol san meydan bolmaly, Type sanawdan Byte saylanmaly.
Ok basmaly, indiki meydana gecmeli.

4. Indiki PRICE ady girizmeli, Tab basmaly. Ol pul meydan bolmaly, Type sanawdan Currency saylanmaly.
Ok basmaly, indiki meydana ge¢meli.

5.Indiki KITAP ROMANMY? ady girizmeli, Tab basmaly. Ol logik meydan bolmaly, Type sanawdan Currency
saylanmaly. Ok basmaly, indiki meydana ge¢meli.

6.Indi NOTES ady girizmeli, Tab basmaly. Ol Memo meydan bolmaly. Ok basmaly.

7.1 sonky ACQUIRED atly meydany girizmeli, Tab basmaly. Ol Date/Time meydan bolmaly, Ok basmaly.
Add Field penjrini Close diiwmaéni basyp yapmaly.
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%Add Index to KITAPSANAW x|

M arne:
| W PFrirnary

Indexed Fields:

[ Unigue

— [ lgnoreMulls
Avallable Fields:

ACQUIRED -
BOK CODE =
FIRSTHAME

KITAP ROMANMY?

L&S THAME _
NOTES

PRICE = Close

8.Table Structure penjirediki Add Index diiwmaéni basmaly, ¢ykan penjrinint Name meydanyna BOOK CODE

yazgy yazmaly. Available Fields —ddki sanaedan BOOK CODE setire baryp belgildp basyp, ony Indexed
Fields sanawa gosarys.

%Add Index to KITAPSANAW x|

M ame:
|BOCK CODE| W Primany

Indexed Fields:

W Unigue

— I lgnoreMullz
Available Fields:

ACQUIRED -
BOOK CODE =
FIRSTHAME

KITAP ROMANMY?

LAS THAME _
NOTES

PRICE hd| Close

Bu yerddki Primary we Unique yazgylaryn onilinde bellik edilmegi BOOK CODE meydanyn deslapky
adalga diyilip yglan edilmegidir.

%Add Index to KITAPSAMNAW x|
M arne:
[EOOK CODE] ¥ Frimary
Indexed Fields:
v Unique
-1
;I [~ lgnoreMulls

Available Fields:

ACOUIRED

BEOOK CODE
FIRSTHAME
EITAP BOMAMNMY?
LASTHAME

MOTES

FRICE

e L I»
=

Cloze

9.Indi bolsa maglumat goryny basga meydanlar boyunca indeksirldlin. Name meydana TITLE girizmeli,
Available Fields-déki sanawdan TITLE setre peykamy eltip basmaly. Primary we Unique yazgylaryn
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ontinden belligi ayyrmaly. Seyle etsek onuil meydanyna gaytalanyan yazgylary hem girizip bolar. Sol
bir at bilen kitaplary maglumat goryna girizip bolar. Indeksi OK diiwméni basyp yatda saklamaly.
10.Yokarky yaly edip LASTNAME meydanada indeks doretmeli. Ony ayratyn indeks etmekden #tiyacly
bolmaly.

11.Indeksleri doredip bolanymyzdan son Close diitwmani basyp penjrani yapmaly.

12.Field List sanawdaky QUANTITY setri basyp, ony hézirki meydan ederis. Bagda Defaultvalue dyjige 1
girizsek somra girizmesek hem ol yerde kitabyn sany sol hasaplanylyar.

13. Field List sanawdaky PRICE setri basyp, ony hédzirki meydan ederis. Bu sapar bahasyny bermini
barlagyn diizgiinini bereris.

14 .validationRule 6yjige >0 and <1000000 girizelin. Nyrh meydany pul gorniisli, kd halatda bilmezlikden
minus baha bolmaz yaly. Bu yerde diikan 1 mln manatdan az bolan nyrhdaky kitaplar satyar
diyildigidir.

15. validationText 0yjige bolup bilayjek nyrh 0-da 1000000 chenli yazgy girizmeli.

16.Tablisait maketini Close diiwméni basyp yapmaly.

Tablisa bilen islemek tamamlandy. Indi bolsa tize maglumat gory ulanylyan Visual Basic-ifl taslamasyny
doredelin. Visual Basic-de Add-Ins>Visual Data Manager girmeli, ¢ykan penjirede File>(Yoly gorkezilen
sanawdan)KITAPSANAW agmaly, ondan son ¢ykan penjirede Utility>Data Form Designer agmaly

@Uisﬂ ata:C:“\Program Filez'M
File | Utility ‘window Help

Guery Builder...
Data Form Desigrer. ..

Global Replace...

[
f Attachments..
Groups/Users. .
SYSTEM.MD?..

Preferences »

Sonda sol bada tablisanyn ya-da soramanyn esasynda forma doérediler. Cykan soraglara jogap yazaymak

yeterlikdir.
Mazmuna gecmek

8.6. ADO tilsimaty(ActiveX Data Objects)

ActiveX ya-da ADO maglumat obyektleri maglumatlara girmegin kdmil umumy tilsimatydyr. ADO-ny
maglumat gorlary bolan Access, Oracle, MS Exchange we beyleki maglumat ¢esmelerine birlesdirmek tigin
peydalanyp bolar. ADO-da maglumat gorlaryna birikmegin tize OLEDB mehanizmi peydalanylyar. Ol
her hili ¢esmelere has ¢ceye
girméni, tizlesdirmaéni {ipjin edydr. Onui sekillendirilisi asakda getirilendir.

ArCcess

SOL Server

YWisual % el
Basic ADO el e OLEDB
- Inernet
Taslama

Wil

Goriisiniz yaly ADO kompyuterin yerli tory ya-da INTERNET arkaly islendik maglumat ¢esmesine
birigip biler. Bu is “mUsder-serwer” ulgamda 6rdn peydalydyr. ADO-ny taslamada durmusa gegirmek {icin
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li¢ sany serisde bardyr. It yonekeyi: 1.Maglumatlar elementi - ADO(ADO Data Control). Yene ActiveX-ifi
iki diiziimi bardyr:
2.Birikdirilydn obyekt - ADO(ADO Connection Object).
3.Yazgylar yygymy obyekti - ADO(ADO Recordset Object).
Mazmuna gecmek

8.6.1.Maglumatlar elementi ADO peydalanmak.

Maglumatlar elementi - ADO in yonekeyidir. Visual Basic-de maglumatlar elementi — ADO bilen islemek
edil onun beyleki standart clementleri bilen islemek yalydyr. Onuini elementlerini forma bilen
baglanysdyrmagy bermek zerurdyr. Onun bilen islenisinin yzygiderligini mysalda seredelin:
1.Haysam bolsa maglumatlar elementi bilen déreden oiiki taslamamyzy acalyn.
2.Formadaky maglumatlar elementini belgildp klawiaturadan Delete diiwméni basmaly. Formadan element

ayrylar.
Maglumatlar elementi — ADO bilen islemezden 6n ony elementler paneline asakdaky yzygiderlikde
goymaly:
3. Visual Basic-ii elementler panelinii bos yerine syg¢anyn peykamyny eltip, sycanyn sag gulagyny
basmaly, ¢ykan gapdal menyudan Components buyrugy saylamaly.
4. Acgylan Components &pisgde Microsoft ADO Data Control 6.0(OLEDB) yazylan setrin basyndaky

dortburglyga bellik etmeli. Sonda onufi elementi-#*, adaty elementler panelindiki elementlerifi eteginde
peyda bolar.

5. Elementler panelindaki &%-elementi forma-nyfi asaky eteginde, 6fi adaty malumatlar elementi yerlesen
yerde yerlesdirmeli.

6.Yerlesdiren elementimizifi Caption hésiyetine Awtorlar baha bermeli.

7. ADO —daky maglumat goryna birikmek iicin Database hésiyetine derek birikdirilydn obyekt
peydalanylyar. ConnectionString setiri basmaly, onsoil, onun sagyndaky == basmaly, sonda su elementin
hésiyetinin sahypalary bilen asakdaky penjire agylar

Property Pages ﬂ

Source af Connection

" Usze Data Link File

" Usze ODBC Data Source Mame

_Browse.|
| E |
_buid. |

' Uze Connection String
| Bild...

Other Attributes: |

i faigis | | fissses |
Use Data Link File we Use ODBC Data Source Name meydanlar dasky maglumat ¢cesmelerine(Mysal iigin,

Serverlere) birikmek iicin ulanylyar. Biz Access-in tablisasyna birikjekdiris.
8.Birikmek setirini gurmak ti¢in bu penjirediki Build... diwméni basmaly, sonda su penjire ¢ykar.
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=
L=l CEOACTEA CEBASM C AaHHBIMMH pod
MocTaswHe yonyr I'Io.a.KnroqEHue] ,D.EII'IDJ'IHHTEJ'II:-HD] EBce ]

E blﬁE!pMTE NnogENYasrHele 0 aHHEIED

Mocraswwrk OLE DB

Ficrogaft 5S4k 1.1 OLE DB Provider
kicrozaoft Jet 3571 OLE DB Provider
bicrozaft Jet 4. 0 OLE DB Provider
Mdicrosaft OLE DB Prowider for Internet Publizhing
kicrogaft OLE DE Prowider for ODBC Drivers
kdicrogaft OLE DB Prowider for Oracle

bicrozoft OLE DE Prowider for SOL Server
Microzaft OLE DB Simple Provider

kS Femote

MSDataShape

OLE DB Prowvider for Microzoft Directary Services

Hanes 3> |
Ok, | Orrena | Crpaeka |

9.Yokarky Data Link Properties penjirede maglumat gotyna birikmek iigin onufi bu drayweri ni peydalanjak
bolsak Microsoft Jet 3.51 OLE DB Provider setiri belgilemeli, sonra Next(Qanee>>) diiwmaéni basmaly.

10.Bbibepute wnu BBeauTe uMMsa Gasbl AaHHbIX:(Select or Enter a Database Name) yazgyly meydanyil
sagyndaky = diiwméni basmaly, ¢ykan penjireddki papka, fayllardan Biblio.mdb maglumat gory
saylamaly, Open(OtkpbiTs) basmaly. Ekranda Connection gat agylar:

==l
L= CeoficTBa CBASH C AaHHBIMH ﬂ

MocTaewwe yonyr oAk ARYEHHE l .[I.u:unu:unHHTeanD] Bre ]

Hiamure cEaIEHMA 00A NOQKMOYEHHA K 4aHHEIM ACcess:

1. BeIfiepUTE MK BEEAMTE UMA B35kl LaHHB:

|E:'\F'ru:ugram Filezhhicrozaft Wizual StudiobWE 334Biblio,

2. Beeaure cEeqeHMA 00A EX00a B Gasy 4aHHEI:

NonezoEaTent: |.-’-'-.|:|min

¥ Muctodnapone [ Paspewwms coxpadeHMe napons

[MpOEEQUTE MoK MOYEHKE

k. OTraeHa Cnpaeka |
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11.Birlesyéan setri doretmek iigin OK diiwmaéni basmaly. Bu gatyil JononuutensHo(Advanced) We Bce(All)
menyulary has ¢ylsyrymly yagdaylarda ulanulyar.
12.Cykan penjirede OK basmaly. ConnectionString setiri hésiyeti berlen hasap edilyar.
13.Awtorlar elementin hésiyetlerinden RecordSource hésiyete barmaly sagyndaky == basmaly.
14.Cykan penjireddki Command Type meydanyi sanawyndan 2-adCmdTable saylamaly.

Property Pages x
RecordSaurce I

— RecordSource

Comrmand Type

2 - 5dCmdT able =]
8 - adCrndJ nknown
]

11 - adCrodT ext
i - adCmdT able
- adCrmdStaredProc

Cormmand Test [SHL]

i fsgis | resisesn | fhesses |

15. Asakdaky Table or Stored Procedure Name meydanyn penjiresine degisli sanawdan Authors setri
saylamaly.

T able ar Stored Procedure Hame

i uthors| =]
b Syl M EXColumms 9
kSl ExS pecs

kS pebd odules j

16.Penjrani OK basyp yapmaly.Authors maglumat gory bilen baglanysyk amal edildi. Indi maglumatlar
elementi ADO-ny basga elementler bilen baglasdyrmak zerurdyr.

17.Formadaky Textl elementi belgilemeli, onufi DataSource hésiyetinin bahsyna, sagyndan g¢ykan
sanawdan Adodcl bermeli, DataField hésiyetine, sagyndan ¢ykan sanawdan Author baha bermeli.

18.Indi Text2 elementi belgilélin, onun DataSource hésiyetinin bahsyna, sagyndan ¢ykan sanawdan Adodcl
bermeli, DataField hésiyetine, sagyndan ¢ykan sanawdan Au_ID baha bermeli.

19.Forma-dan cmdDelete diiwmani ayyermaly.

20.Taslamany yatda saklamaly we Run basyp ise girizmeli. Taslanyil esasynda seyle forma ¢ykar:

59 Forml -|0] x|

‘Yaz. Ash |1 B104

14| 4| 2wtorlar 2 |H|

Gorlisiniz yaly tdze element bilen taslanan is hem edil 6nrikki taslama yaly isleyar.

Mazmuna gecmek
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8.6.2.Birikdirme obyektleri we ADO yazgylar yygymyny peydalanmak

ADO bilen iglemegin esaslaryny dwrenenimizden soil. Ona is {igin programma yazmaga gegceliil.
Onun ii¢in yene sol Visual Basic-ddki Biblio.mdb maglumat goryna birikménin esaslaryny asakdaky
yzygiderlikde dwrenelin:
1.File>New Project buyruk bilen tdze taslama agalyn.¢cykan New Project penjirede Standart EXE belgijigi
saylamaly we OK basmaly.

2.Taslamanyn Name hédsiyetine ADORecordset baha bermeli.

3.Formal formanyn Name hisiyetine frmMain baha, Caption hdsiyetine ADO yazgy yygymy bilen ishlemek
baha bermeli.

4.frmMain formada sanaw elementini goymaly, goyulan sanaw elementin Name bahasyna IstAuthors baha
bermeli.

5.Visual Basic-ifi menyuyndan Project>References buyrugy amal etmeli, sonda References penjiresi agylar.

6.ADO gorniisli islere salgylanma doretmeli; onun penjiresinddki Microsoft ActiveX Data Objects 2.0 setirifi
ontinde bellik etmeli.

References - adorECORecordSET

X
fvailable References:
kBSerer 1.0 Type Library ﬂ Zancel
Mediadet 1.0 Tupe Libran
kediaPlayer 1.0 Tupe Libram
Microzoft Active Server Pages Object Library Browse. ..
Microsoft Activebd owvie Control
Microsoft Actives Data Objects [Mulli-dimensional 'I.L_I ﬂ
bt icrosoft Activer Data Obects 2.0 Libramy
Microzoft Active Data Objects 2.1 Libran Pricriky
Microsaft sctivel Data Objects Recordset 2.1 Library Help
Microzoft Actives Plugin ﬂ

Microzaft Add-n Deszigner
Microzoft AD0 Ext. 2.1 for DDL and Security

Microzoft Connection Dezsigner Instance 1.0
Microzoft Connection Desianer wB.0 | ﬁ
»

J

Microsoft Ackiver Data Objects 2,0 Library

Location:  CHPROGRAM FILESYCOMMOR FILESYSYSTEMYADO msadoz0.k
Language; Standard

7.Islere salgylanma doretmek hem-de Reference penjrini yapmak iigin OK basmaly. Indi programmada
gerek islerini ulansa bolar.
8. Formanyn (General)(Declarations) bdlegine su programma bolegini gosalyi:
Private cn As ADODB.Connection
Private rs As ADODB.Recordset

9.Form_Load is prosedurasyna su programma bolegi goyalyn

Private Sub Form_Load()
Dim cmd As String
Dim sql As String
Dim cn As ADODB.Connection
Dim rs As ADODB.Recordset

'Birlishdirilyan setri doretmeli
cmd = "Provider=Microsoft.jet. OLEDB.3.51“& "Data Source=" & "C:\Program Files\Microsoft Visual
Studio\VB98\Biblio.mdb"

‘Maglumat gory bilen birleshdirmeli
Set cn = New ADODB.Connection
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With cn

.ConnectionString = cmd
.Open
End With
'‘Sorama doretmek
sql = "select*from authors"

'Yazgy yygymyny achmaly
Set rs = New ADODB.Recordset
With rs
.Open sql, cn, adOpenForwardOnly, adLockReadOnly
Do While Not rs.EOF
'‘Awtory sanawa goshmaly
LstAuthors.Addltem rs("Author")

'Indiki yazga gechmeli
rs.MoveNext
Loop

‘Yazgy yygymyny yapmaly
.Close

End With
Set rs = Nothing

‘Birikmani yapmaly
cn.Close

‘Birikme obyekti ayyrmaly
Set cn = Nothing
End Sub

10.Taslamany yatda saklamaly we ise girizmeli.

Maglumat gory alnyp barylmalydyr, yagny ona yazgylar gosulmalydyr, yazgylar ayrylmalydyr.
Maglumat gora yazgylar gogsmagyn programma yazylysy:

rs.AddNew
rs("Author") = "Doe,John"
rs("Au_ID") = 123456
rs.Update

Maglumat goryndan yazgylary ayyrmak ticin kursory ayyrjak yazgyna eltmeli .Delete usulyeti cagyrmaly,
onuil programmasynyn yazylysyna mysal:

'Sorama doretmek
sql = "select * from authors where [Author]= 'Brown,Steve™"

'Yazgy yygymy achmaly
Set rs = New ADODB.Recordset
With rs
.Open sql, cn, adOpenForwardOnly, adLockReadOnly
If rs.RecordCount > 0 Then
rs.Delete
End If

‘Yazgy yygymyny yapmaly
.Close

End With

'Yazgy yygymyndaky obyekti ayyrmaly
Set rs = Noting

Mazmuna gecmek
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9.Visual Basic-de maglumatlary ekrana ¢ykarmak we printere capa ¢cykarmak

Visual Basic-de amal eden islerini, yazan programma yagyily, taslamanyn formalaryny ¢apa ¢ykaryp
gormek zerur isdir. Maglumatlary printerde gap isleri ii¢in Visual Basic-de Printers toplumlar Printer
obyektleri ulanylyar.

Visual Basic-de ¢ap etmegii asakda getirilen sanawdaky usullary bardyr:
Ekrandaky formany ¢ap etmek.
Formada ya-da printerde setirme-setir ¢cap etmek.
Goniiden goni hasaplamalar penjirede ¢ap etmek.
Crystal Repotts Pro-da déredilen hasabatlary ¢ap etmek.
DDE we OLE Automation serisdeler bilen basga taslalardan ¢ap etmek.

000 O0O0

Visual Basic-de cap etmek adatca Print operator bilen programma yazgysynda berilyir. Print usulyeti
maglumatlary forma hem-de printere ¢ykarar. Maglumatlary printere ¢ykarmak ti¢in Printer.Print usulyet
ulanylyar, forma ¢ykarmak ii¢in ¢ykaryljak obyekti oniinden gorkezip Print yazmak yeterlikdir, Mysal
ticin, frmForma.Print(Képiirdk Print bilen amallar etjek bolsan Cls usuly ulanmaly, sonda ekrana o6nki
¢ykarylanlar ayrylar).

Print usulyet c¢ap edilmeli maglumatlary yada goyberyir, yone ¢ap edyidn dildir. Cap isi EndDoc
usulyetden baslanyar, kdp setirli resminamalar iicin NewPage usulyet bardyr.Mysal {i¢in, programma
yvazgysynyn asakdaky yazylan bolegi birnice sahypadan ybarat bolan resminamany cap edyar:

Printer.Print "Birinji sahypa"
Printer.Print "Birinji sahypada ikinji setir"
Printer.NewPage

Printer.Print "Ikinji sahypa"
Printer.EndDoc

Programma diiziilende ep-esli wagt yalnyslyklary gozlemidge we diizetmige sarp edilydr. Kopleng
programmanyin méhiim yerlerine MsgBox operatory gosmak zerurdyr. Bu yagdayda programmany her
sapar Onki barlanan MsgBox ayryp tdzeden goybermeli bolyar. Goniliden-goni hasaplanyan &dpisgd
maglumaty Debug obyekt bilen ¢ykaryp bolar, onun {i¢in ol obyekte Print usulyeti cagyrmaly. Mysal iigin:

X=2*x+1
Debug.Print x
Mazmuna gecmek

9.1.Visual Basic-de goniiden-goni hasap penjirelerde yaliiyslyklara seretmek, olary
diizetmek

Bu isi yerine yetirmekligin yzygiderligini mysalda seredelin:

1.Taze taslamany forma bilen doredelin, onuil iicin File»New Project buyruk bilen tdze taslama agalyn,
¢ykan New Project penjirede Standart EXE belgijigi saylamaly we OK basmaly.

2.Formal yazgyly forma sycanyi peykamyny eltip iki sapar basmaly, sonda programma penjire agylar.

3. Formal-if Click is prosedurasyna su programma bolegini girizelin:

Private Sub Form_Click()
Dim x As Integer

'yalnyshlary yuze chykaryany bermeli
On Error GoTo looperr

'Sikl x=100000 chenli
Do While x < 100000
X=x+1
Loop
'yalnyshlary yuze chykaryandan gechmeli
Exit Sub
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looperr:
Debug.Print "Yalnysh!"
Debug.Print "x=" & Trim$(Str$(x))
End Sub

Su programma islande yaliyslyk ¢ykar.
4.Programmany ise girizelin, sonda su penjire ekrana geler:

Immediate x|
YTalnysh! -
®=IZ2TET

-

4 I I 3

Bu yalilyslygyn sebébi iiytgeydn ululyk x-a Integer gOrniis baha berip, onun alyp bildjek bahasyny
100000-¢ ¢enli artdyrdyk. x-yn bahasy 32768 bolanda yaliiyslyk yiize ¢ykdy, sebébi biitin iiytgeyéanler —
32768-den +32767 ¢enli baha alyp bilerler. Bu yerde yalilys yiize ¢ykmaz yaly x Lohg gdrniisli bolmaly.

Yalityslaryn diizedilis yzygiderligi:
1.Programmanyi igini tamamlamaly, onun ti¢in Run>End basmaly.
2.Programmada yalilys berlen

Dim x As Integer
setri
Dim x As Long

setir bilen ¢alysmaly.

3.Tédzeden Run Start bilen programmany ige girizmeli.
Mazmuna ge¢mek

9.2.Capda PrintForm usulyet

Hig hili buyruk gérkezilmese PrintForm usulyet ekrandaky formany printere ¢ykaryar.
Form_Click() prosedura Me.PrintForm operator gossak ekranda yaliiyslyk barada habar ¢ykmazdan 61
formanyn gorniisi printerde ¢ap ediler. Ekrandaky formanyi ornyna basga formalary cap etjek bolsan
frmReport.PrintForm

operatory ulanmaly. Sonda frmReport formanyn mazmuny cap ediler, onufi ornuna taslamadaky frmSplash,
frmMain, frmAbout ya-da bagga formalar bolup biler.
Mazmuna ge¢mek

9.3. Printers toplumy

Visual Basic-de ¢apa degisli Printers toplumy bardyr, onda kompyuter ulgamymyzda hasaba alynan
printer-obyektlerin sanawy yerlesdirilendir. Ona degisli sorama bilen yiiz tutyp printeri ¢alsyp, onda ¢ap
edip, yene-de onki standart printere gaydyp gelip bolyar.

Asakdaky yzygiderlik bilen Printers toplumda ndhili islemegi we Oziimizde haysy printerif
goyulandygyny bilip bolar.
1.Klawiaturadan Ctrl+N diiwmeleri utgasdyryp basyp tédze taslama doredelin.
2.New Project penjirede Standart EXE belgijigi saylamaly we OK basmaly.
3.Taslamanyn adyna PrintersCollection at berelif.
4.Formal formanyn Name hisiyetine frmMain, Caption hdsiyetine Printerler sanawy baha bermeli.
5.Sycanyi peykamyny elementler paneline eltip sycanyn sag gulagyny basmaly, ¢cykan gapdal menyudan

Components buyrugy saylamaly.
6.Components penjirede Microsoft Windows Common Controls 6.0 setirint 6niiinde bellik etmeli.Penjriani OK
diiwme basyp yapmaly.
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7.frmMain formada tablisa sanawy doretmeli, onunt Name hésiyetine lvwPrinters baha bermeli.
8.frmMain forma baryp peykamy iki sapar basyp, onun programma penjiresini agmaly.
9.Programma penjiresinde Resize is prosedurasyny seyle yazmaly:

Private Sub Form_Resize()
"Tablisa sanay chekmeli
IvwPrinters.Move 0, 0, ScaleWidth, ScaleHeight
End Sub

10. Programma penjiresinde Load is prosedurasyny seyle yazmaly

Private Sub Form_Load()
Dim p As Printer
Dim x As Listltem

‘Tablisa duzgunde tablisa sanawa gechmeli
With IvwPrinters
.View = IvwReport
.ColumnHeaders.Add , , "Printer"
.ColumnHeaders.Add 2, , "Draywer"
.ColumnHeaders.Add 3, , "Port"
End With

‘Ulgamdaky printerlerin sanawyny chykarmaly
For Each p In Printers

With p
Set x = lvwPrinters.Listltems.Add(, , .DeviceName)
x.Subltems(1) = .DriverName
x.Subltems(2) = .Port
End With
Next
End Sub

11.Taslamany yatda saklamaly we ise girizmeli, sonda isleyédn kompyuterinize haysam bolsa bir printer

birikdirilen bolsa onun sanawy ekrana ¢ykar.

Mazmuna gecmek

10.Visual Basic-de dialog penjireleri

Windowsda ulanyjy maglumat alys-calysygy iicin yorite formadan peydalanylyar, ona dialog

penjireleri diyilip at berilyér.

Visual Basic-de ulanyjy {i¢in habar berydn MsgBox, maglumat girizilydn InputBox standart dialog

penjireleri bardyr.

Mazmuna gecmek

10.1.Habar penjiresi

Habar penjiresini doretmek {igin operator seyle yazylyar:

MsgBox habar, atributy, ady

Bu yerde
habar - dialog penjirede aydylmaly yazgy;
ady - penjriniil ady yazylmaly setri;

atributy -parametr bolup, ol penjrénin ayratynlyklaryny, yagny her hili diiwmelerini we belgijiklerini
kesgitleydar. Asakda ol parametrin we hemiseliklerin bahasyny habar penjiresini kesgitlemekde

peydalanylyanlarynyi sanawyny getireris:

Hemiselik Bahasy Stili
vbOKOnly 0 Difie OK diwme bolar
vbOKCancel 1 OK we Cancel diwmeler bolar
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vbAbortRetorylgnore 2 Abort, Retory, Ignore diiwmeler bolar
vbYesNoCancel 3 Yes, No, Cancel diiwmeler bolar
vbYesNo 4 Yes, No diwmeler bolar
vbRetryCancel 5 Retory, Cancel diiwmeler bolar
vbCritical 16 Tankyt habar belgijigi bolar
vbQuestion 32 Sorag belgisi bolar(duydurys)
vbExclamation 48 Yiizlenme belgisi bolar(duydurys)
vbinformation 64 Habar beris belgisi bolar

......

Cancel diiwmeler bolar yaly yazjak bolsan, asakadky setirlerin birini yazmak yeterlikdir:

DlgDef = vbOKCancel

DigDef =1 + 64

Ondan son DIgDeg liytgeyénii bahasy MsgBox ¢agyrylanda ulanylyar.

Habar penjiresi funksiyanyn komegi bilen hem cagyrylyp bilner, gaytmanyn bahasy ulanyjynyn
haysy diiwmaini basanyna baglydyr. MsgBox funksiyanyn yazylysy, sol at bilen yazylyan operatorynky
yalydyr:

Dim rc As Integer 'Gaytma kody
rc = MsgBox( habar, atributy, ady)

Gaytma kodyn her hili bahasynyn sanawy sulardyr:

Hemigelik Bahasy Basylan diwme
vbOK 1 OK

vbCancel 2 Cancel

vbAbort 3 Abort

VbRetory 4 Retory
Vblgnore 5 Ignore

VbYes 6 Yes

vbNo 7 No

Mazmuna gecmek

10.2.Girizmek penjiresi

Girizmek penjiresi hem edil habar penjiresi yaly operator ya-da funksiya bilen berlip bilner.
Funksiya bolanda gysgarak yazylysynyn gorniisi seyledir:

Dim rc As String
rc = InputBox(habar, ady, dymma parametri)

Bu yerde dymma parametri-nde setri berip bolar, ol yazgy meydanynda bolar. Ulanyjy OK bassa bu
meydan iiytgeydne owrlilyir, biziit mysalymyzda rc. Eger ulanyjy Cancel diiwméni bassa nol uzynlykly
setire dolanyar. Indi InputBox funksiyanyi néhili ulanylysyny mysalda gorkezelin:

1.Téze taslamany File>New Project buyruk acalyi.

2.Cykan Project Wizard penjirede Standart EXE belgijigi saylamaly we OK basmaly.
3.Formal forma diiwme goymaly.

4.Diwmaénin Name hésiyetine cmdTryMe baha bermeli.

5.cmdTryMe diiwménin Caption hisiyetine &Meni bas baha bermeli.

6.cmdTryMe diiwma peykamy eltip iki sapar basyp programma penjiresini agmaly.
7. cmdTryMe diiwmaénin Click prosedura isine su programma bdlegi gosalyii:

Private Sub cmdTryMe_Click()
Dim rc As String

rc = InputBox("Meni giriz:")
MsgBox "Salam, " & rc & "!"
End Sub
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8.Run> Start bilen programmany ise girizmeli. Sonda su penjire ¢ykar

9.InputBox penjrani ¢gagyrmak ii¢in yokarky Meni bas dliwmaéni basarys we malumat girizeris

Projectl ﬂ
Meni giriz:
Cancel
|Bahard

10.Yazgyny girizip bolup OK basmaly, netije asakdaky bolar

Project1 B

Salam, B aharal

Mazmuna gecmek

10.3.Standart bolmadyk dialog penjiresi

1.01iki mysaldaky programma penjrini acalyi.
2.0nma su programma bdolegini gosalyii:

Private Sub LoginBox()
Dim rc As String
rc = InputBox("Meni giriz:")
If rc = "Bashlyk" Then
MsgBox "Hojayn, Salam!"
Else
MsgBox "Salam, " & rc & "!"
End If
End Sub

3. cmdTryMe diiwménin Click is prosedurasyny seylerdk iiytgedelin:
Private Sub cmdTryMe_Click()
LoginBox

End Sub

4.Taslamany ise girizelin.
5.Yazgy meydanyna Bashlyk yazalyn:
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5 =10] x|
Meni baz
Project] X|

beni giniz;
Cancel |

|E ashiyk

Ok diiwmani basmaly, netije seyle bolar:
Project] x|

Huojayn, Salaml

Mazmuna gecmek

10.4.Bir topar dialog penjiresini doretmek

Indiki doretjek taslamalarymyzda ulanylyp boljak dialog penjireleri bilen islemek tgin yonekeyje bir
topar doredelin.

Onun doredilis yzygiderligi seylerdkdir:

1.T4ze taslamany File>New Project buyruk bilen doredeli.

2.Cykan New Project penjirede ActiveX DLL yazgyly sekili saylamaly we OK basmaly.

3.Taslamada toparyn modulyny doredip, onuit Name hésiyetine modDialogs baha bermeli.

4.modDialogs programma modulynyn sgesini agyp, ona su prosedurany gosmaly:

Sub Main()

'‘Bu prosedurada programma azgysy(kody)
‘bolman DLL anyk ishlemek uchin zerur.
End Sub

5.Taslama penjranin Class1 toparyny iki sapar basyp, ony igjenlesdirelin.
6.Toparyil hdsiyetine sulary eye edelin:

Name: Instancing:
clsDialogs 5 - MultiUse

Programmanyn asaky bolegi logiki ululygy girizmek ti¢in niyetlenilendir:

Public Function YNBox(title As String, msg As String) As Integer
Dim rc As Integer
Dim DIgDef As Long

DlgDef = vbYesNo + vbQuestion
rc = MsgBox(msg, DIgDef, title)
YNBoX =rc
End Function
Indiki programma prosedurasy yaliiyslyklar bardadaky habar bilen baglanysyklydyr:

Public Sub ErrMsg(title As String, msg As String)
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Dim rc As Integer
Dim DlgDef As Long
DlgDef = vbOKCancel + vbCritical
rc = MsgBox(msg, DIgDef, title)
End Sub

Indiki programma bdlegi ulanyjylary hasaba almak ii¢in yazylan funksiyadyr:

Public Function LoginBox(title As String, msg As String, degault As String) As String
Dim rc As String
rc = InputBox(msg, title)
LoginBox = rc

End Function

7.Taslamany dialogs.vbp at bilen yatda saklamaly.

8.Bas menyudaky Project>Dialogs Properties... agyp, agylan penjrdnin Project Name meydanyna Dialogs,
Project Description meydanyna Dialog apishge bilen ishlemek uchin topar yazgyny girizmeli:

Dialogs - Project Properties ﬂ

General lMake ] Campile ] Zamponent ] Debugging ]

Project Type: Skartup Obiject:
fictives DL [(None) |

Project Mame:

|Dia|u:ugs
Project Help
Help File Mame: Conkexk ID:

| I

Project Description:

||:Iialu:u;| apishige bilen ishlemek uchin topar

Threading Model
[~ Unattended Execution reaang =ore
Apartment Threaded ﬂ
W Upgrade Actives Contrals ~
- - B
-
it i

9.Y okarky penjraniii Make gatyna ge¢meli Application Title meydanyna Dialogs yazgy yazmaly:

Dialogs - Project Properties X

General  Make lCu:umpiIe ] Cu:umpu:unent] Debugging ]

Mersion Mumber Application

Majar:  Minor:  Revision:

Title:  |Diglogs]
f oo

10.Déreden toparymyzy soiira ulanmak {i¢in kompilyasiya(kompyuterifi diline gecirmeli) edeliii, onun ii¢in
File>Make Dialogs.DIl buyrugy yazyp OK basmaly.

Kompyuteg az kem sdginenden son isimiz DLL programmahana geciriler.Ony basga taslamalarda hem

ulanyp bolar.

Mazmuna gecmek
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10.5.Dialog penjirelerinii toparyny peydalanmak

Topary barlamak iigin Kigirak taslama doredelin:

1.Téze taslamany forma bilen doredelini, onuil iicin File>New Project buyruk bilen téze taslama acalyn,
cykan New Project penjirede Standart EXE belgijigi saylamaly we OK basmaly.

2.Formal forma asakdaky hisiyeti bermeli:

Name: Caption:
frmDialogs Dialog apishgeleri doretmek

3.frmDialogs forma iki sany yazgy yerlesdirmeli, olaryn hisiyetleri:

Name: Caption:
IbITitle Ady:
IbIMsg Habar:

4.1k yazgy meydanyi hésiyetlerini seyle bermeli:

Name: Caption:
txtTitle Bos meydan
txtMsg Bos meydan

5.Forma ii¢ sany diiwme goymaly, su hésiyetler bermeli:

Name: Caption:
cmdYN &Hawa/Yok
cmdErr &Yalnysh
cmdLogin &Hasaba alysh

Doéreden formamyzyn gorniisi:

{5 Dialog apishgelen doretmek =10 ﬂ
Ady: |
Habar: |
|
Hawas ok Yalnpzh ‘ Hazaba alysh

6. Project>References buyrugy yerine yetirmeli.
7.Cykan penjirede dialog apishge bilen ishlemek uchin topar yazgynyn oOniine bellik etmeli, sofira OK
basmaly.
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References - Projectl

fvvailable References: QK

Control “izard 1.0 Type Library ﬂ Cancel

cryptext 1.0 Type Libram

C55Ed

CSSEd Utilities

CHZdda 1.0 Type Library

CACPr 1.0 Type Library ﬂ

Drata Object Wizard

DBMamespace 1.0 Type Library Priority

Deplay 1.0 Tupe Libram

Drewxter 1.0 Type Library ﬂ

DHTHL Edit Contral for IES

dialog apizhge bilen ishlemek uchin topar
bt dialon apizhae bilen ishlemek, uchin topar

Ciiataltizc 1.0 Tuoe Library -
1| | 3

dialog apishge bilen ishlemek uchin topar

Browse, ..

Help

i

Location:  C:\Pragram Files\Microsoft Yisual StudiolYB9& vaz13.11.dl

Language: Standard

8.Programma yazylyan penjrini a¢maly, ona su programma bdlegi (General)(Declarations) yere
girizmeli:

Option Explicit
Dim dlg As clsdialogs

9.Taslamada topar bilen islenilende ilikinji etmeli is, degisli obyektinn yene bir sanyny doretmeli. Onun
iicin formanyn bdlegini suny gosmaly:

Private Sub Form_Load()
Set dlg = New clsdialogs
End Sub

10.Programma obyektin yene bir nusgasyny doretse, onda onun beyleki esasy nusgasy gerek bolmasa ony
yok etmelidir. Bu topar bize isin biitin dowamynda gerek boljak, onda is gutaranson yok etsegem
boljak. Onun ligin prosedura su bolegi gosmaly:

Private Sub Form_Unload(Cancel As Integer)
Set dlg = Nothing
End Sub

11.Logik penjireleri(YNBox) barlamak {i¢in niyetlenilen su bolegi programma gosalyi

Private Sub cmdYN_Click()
Dim rc As Integer

rc = dlg. YNBox(txtTitle. Text, txtMsg.Text)
If rc = vbYes Then
MsgBox "Hawa duwme basylan"
Else
MsgBox "Yok duwme basylan”
End If
End Sub

12.Yalityslar penjrani(ErrMsg) barlamak ii¢in niyetlenilen programma bélegini gosmaly:

Private Sub cmdErr_Click()
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dlg.ErrMsg txtTitle. Text, txtMsg.Text
End Sub

13.Hasaba alyan penjréni(LoginBox) barlamak {i¢in programma bdlegi

Private Sub cmdLogin_Click()
Dim UserID As String

UserlID = dlg.LoginBox(txtTitle.Text, txtMsg.Text, ")
If UserID <>"" Then
MsgBox UserID & "Hasaba aldyk!"
End If
End Sub
14. Taslamany yatda saklamaly we ise girizmeli.
Mazmuna gecmek

11.Sycan bilen islemek

Adatca Windowsda obyektlerin yerini tliytgetmek Shift, Alt we Ctrl diiwmeleri ayratynlykda we
bilelikde basyp hem-de sycanyn gulagyny basyp amal edip bolyar. Visual Basic-de onun yaly isler

MouseDown, MouseUp We MouseMove proseduralarda yerine yetirilyin igdir.
Mazmuna gecmek

11.1.Click is

Elemente peykamy eltip basanmyzda Click is yerine yetyar.Ol kopleng formadaky diiwme {igin
peydalanylyar. Click diiwme ili¢cin yazylan programma sycanyn gulagyny basanymyzda yerine yetirilyar,
mysal ligin

Private Sub cmdOk_Click()
Unload Me
End Sub
Mazmuna gecmek

11.2.DbIClick is

DblIClick i3 sycanyn gulagyny yzly-yzyna ¢alt-caltdan iki sapar basanymyzda amal bolyar.Sycany iki sapar
calt-galtdan basmaklyk Windows-daky dolandyrys panelinden berilydr. Sanawda bu is hasiyetlere
seretmek tlicin hem-de belgilenen setirleri gogmak we ayyrmak ti¢in ulanylyar. Mysal {i¢in

Private Sub Istmembers_DbIClick()
Dim m As clsmember

Set m = New clsmember
m.MemberName = IstMembers.Text
m.ShowMeberProperties
Set m = Nothing
End Sub
Mazmuna gecmek

11.3.DragDrop is
DragDrop is obyekti sycanyn peykamy bilen siiyrdp zynanymyzda yerine yetyér, onun yazylysy:

Private Sub target_DragDrop(Source As Control, X As Single,_
Y As Single)

Bu yerde islendik is edilmezden Source, X, Y parametrlerini bahalary barlanyp bilner. Source parametr
obyekte zynylan elementin adydyr. X we Y DragDrop() 1isde sycanyn peykamynyn koordinatasyny
kesgitleyér.

Mazmuna gecmek
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11.4.DragOver is

DragOver isi obyekti listiinden siiyrdnimizde yerine yetyar.Onun yazylysy

Private Sub target _DragOver(Source As Control, X As Single,_
Y As Single, State As Integer)

Bu yerde Source parametr siiyrelydn obyektin ady. X, Y sycanyin peykamynyin koordinatasyny
kesgitleydr. Bitin State iliytgeydn siiyreydn obyektimizin kabul edyidn obyekte gord yagdayyny
kesgitleyar, onui alyp bilyan bahalary:

State parametr Niyetlenilisi

0 Obyekt gesmanin ¢agine giryar

1 Obyekt gesmanin ¢caginden ¢ykyar

2 Obyekt gesmanin ¢caginin iginde suyrelyar

Mazmuna gecmek

11.5.MouseDown is

MouseDown is sycanyn gulagyny basyp goybermesek yerine. yetydr. MouseDown is prosedurasynyi
yazylysy:

Private Sub target MouseDown(Button As Integer, Shift As Integer,
X As Single, Y As Single)
Bu yerde X, Y sycanyn peykamynyn koordinatasyny kesgitleyér. Bitin Button parametr asakdaky ti¢
bahanyi birine eye bolyar:

Button parametr Beyany

1 Syganyn ¢ep gulagy

2 Syganyn sag gulagy

3 Syganyn ortaky gulagy

Button parametrini bahasy bilen sycanyn haysy gulagynyn basylanyny bilip bolar. Bu is hacan gapdal
menyu agylmaly bolsa amatlydyr:

Private Sub IstMembers_MouseDown(Button As Integer, Shift As Integer,
X As Single, Y As Single)
If Button=2 Then
PopupMenu mnuMembers
End If
End Sub

Bitin shift parametr klawiaturadaky Shift, Ctrl we Alt basylan momentdéki yagdayyny beyan edyir,
onun alyp bilyén bahalary:

Shift parametr Beyany

1 Shift diwme
2 Ctrl diwme
4 Alt diwme

Bu ululyklaryn jemi diiwmelerin her hili utgasdyrylysyny kesgitleyar. Mysal ti¢in, 6 baha Ctrl bilen
Alt bile basylan, 7 bolanda iigiisem birbada basylan. Shift parametrbarlanylanda koplen¢ And adalga
ulanylyar. Biri-birinii icine goymak bilen If...Then her hili diiwmelere seredip bolar. Mysal iigin, su
programma bdlegi

If Shift=6 Then
MsgBox “Ctrl we Alt diwmeler basylan’
End If
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Seyle programma yazgysyna barabardyr

If Shift And 6 Then
MsgBox “Ctrl we Alt diwmeler basylan”
End If

Mazmuna gecmek

11.6.MouseMove is

Elementin iistiinden syg¢an bilen sliyrdnimizde MouseMove is yerine yetydr. Onun yazylysy:

Private Sub cmdExit_MouseMove(Button As Integer, Shift As Integer,
X As Single, Y As Single)

Indiki mysalda sy¢anyn peykamy Exit diiwmanin listiinden gegende formanyn ady iiytgeyar:

Private Sub cmdExit_MouseMove(Button As Integer, Shift As Integer,
X As Single, Y As Single)
Me.Caption = "Taslamany yapjak bolsan bas”
End Sub

Bagga elementler ligcin MouseMove is prosedurasyny programma girizip bolar.
Mazmuna gecmek

11.7.MouseUp is

Sycanyn gulagy basylan elementi siiyrdp goybersek MouseUp is amal bolar. Onun yazylysy:

Private Sub target_ MouseUp(Button As Integer, Shift As Integer,
X As Single, Y As Single)
Mazmuna ge¢mek

11.8.Siiyremek

Windows-daky obyektler, elementler kdpleng sycanyn peykamy bilen siiyrelydr, seyle edilse is
yonekey we ¢alt yerine yetirilyar:
Visual Basic-de hem isi seyle amal etmek ¢ylsyrymly déldir. Ol isi mysalda gorkezelin:

1.Standart EXE gorniisli taslamany doretmeli.

2.Formal formanyn Name hésiyetine frmMain baha, Caption hisiyete Suyremeli baha bermeli.

3.Forma iki sany sol bir mogberli sanawy goymaly. Biri formanyn yokarysynda beylekisi formanyn asaky
eteginde bolmaly.

4.Formadaky yokarky sanawayn Name hésiyetine IstA bermeli, Dragicon hisiyetine, onun sagyndaky ==
belgjigi basyp ¢ykan penjireden Draglpg.ico fayly tapyp Otkpsits basyp bermeli:

Load lcon =

Danka: Ia Dragdiop j QI

I Draglpg
! Drag2pg
| CH Drag3pg
@ Crragfidr
[ Droplpg
ﬁ'| Drropfidr

. HraA aiina: || OTEpEME

Tun daiinos: I lcons [#ico: cur] - | DrreqHa

i

LCnpaera
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Bu dpisgd \Common\Graphics\lcons\DragDrop\Draglpg.ico salgy bilen baryp bolar. Onun salgysyny gozlip

tapyp bolar.

5.Formadaky yokarky sanawayn Name hisiyetine IstB bermeli, Dragicon hésiyetine, onun sagyndaky ==
belgjigi basyp ¢ykan penjireden Draglpg.ico fayly tapyp yokardaky yaly Otkpbite basyp bermeli:
\Common\Graphics\lcons\DragDrop\Draglpg.ico: Netijede asakdaky formany alarys:

5 Suyremeli _|El|ﬂ
- [lstd,
:' S IR
l=tE
| [] n

6.Form_Load() is prosedurasyna su bdlegi gosmaly:

Private Sub Form_Load()
IstA.AddItem "Alma"
IstA.AddItem "Aywa"
IstA.AddItem "Garaly"

End Sub

7.IstA_MouseDown() is prosedurasyna su bolegi gosmaly:

Private Sub IstA_MouseDown(Button As Integer, Shift As Integer, X As Single, Y As Single)
If IstA.ListCount > 0 Then
IstA.Drag 1
End If
End Sub

8. IstA_DragDrop() is prosedurasyna su bolegi gosmaly:

Private Sub IstA_DragDrop(Sourse As Control, X As Single, Y As Single)
If Sourse = IstB Then
IstA.Addltem IstB.Text
IstB.Removeltem IstB.ListIndex
End If

9.IstB_MouseDown() is prosedurasyna su bolegi gosmaly:

Private Sub IstB_MouseDown(Button As Integer, Shift As Integer, X As Single, Y As Single)
If IstB.ListCount > 0 Then
IstB.Drag 1
End If
End Sub

10.1stB_DragDrop() i prosedurasyna su bolegi gosmaly:

Private Sub IstB_DragDrop(Sourse As Control, X As Single, Y As Single)
If Sourse = IstA Then
IstB.AddItem IstA.Text
IstA.Removeltem IstA.ListIndex
End If
End Sub

11.Taslamany yatda saklamaly we ise Run> Start basyp ise girizmeli.
Netijede asaky formany alarys, onun yokarky meydanynda miwelerii sanawy bolar:
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5 Suyremel |0 ﬂ

Sycanyn peykamyny miwédnin adynyn istiine eltip sycanyn ¢ep gulagyny basyp onuil adyny asaky
meydanga gegirip bolar:

5 Suyremeli -0 ﬂ
&lma
Garaly
Aywa
Mazmuna gecmek
11.9. OLE siiyremek

OLE (Object Linking and Embedding) diymek «obyektleri baglagsdyrmak we ornasdyrmak» diymekdir.
Sycan bilen bu gorniisli siiyremek yazgyny, fayly we obyektleri elementlerini 6z aralarynda stiyremekligi
tipjiin edyér. Mysal tigin, Windows-yn Mposognuk penjiresinde seyle siiyreme amal edilyar.

Mazmuna ge¢cmek

11.9.1.0LE siiyremekde OLEDrag usulyet

OLEDrag usulyet OLE siiyremek amalyny baslayar. Ol haganda iki obyektin arasynda
maglumatlary nusgalamak ya-da yerini iijtgetmekde ¢agyrylyar. Onuil programmasynyn yazylysy:

obyekt.OLEDrag

bu obyekt-OLE obyekt bolup, siiyremek {igin ¢esme bolup duryar.
Mazmuna gecmek

11.9.2.0LE siiyremekde OLEDragMode hasiyet

OLEDragMode hisiyet bilen OLE siiyremek ¢esmeden siiyremek 1sini yerine yetirip bolyanlygyny
bilip bolyar we ol gol bilenmi ya-da awtomatiki diizgiinde yerine yetirilisini hem bilip bolyar. Hésiyet
asakdaky bahalar alyp biler:

OLEDragManual - 0 Adaty yagday, gol bilen amal edilyar
OLEDragAutomatic - 1 ~ OLE siiyremek awtomatik yagdayda bolar.

Mazmuna gecmek

11.9.3.0LE siiyremekde OLEDropMode hiisiyet

OLEDrop hésiyet OLEDragMode hisiyete menzesdir.Ony bermek bilen taslamada OLE zyiimak isinin
gorniigini kesgitldp bolar. Hésiyet li¢ bahanyn birini alyp biler:

OLEDropMNone -0 Adaty yagday.OLE konteynere, OLE zyimak
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iicin isi kabul edijé rugsat bermeyéar
OLEDropManual -1 Taslamada OLE zytimagy doredyér
OLEDropAutomatic—2 Bu OLE zynmagyn in yonekey usulydyr, onda

zynmak awtomatik yagdayda guralyar.

Mazmuna gecmek

11.9.4.0LE siiyremekde OLEDropAllowed hisiyet

OLEDropAllowed hidsiyet kabul edija OLE zyiimagy yerine yetirip bolyanlygyny kesgitleyér, onun bahasy
logiki ululykdyr:

True Berlen yere OLE zytimak bolyar.
False Adaty yagday. OLE zynmak ona gadagan

Mazmuna gecmek

11.9.5.0LE siiyremekde OLEDragDrop() is

OLEDragDrop is OLE konteynere OLE zynmak bolanda yerine yetyir., onuil programmada yazylysy:
Private Sub obyekt OLEDragDrop(maglumatlar As DataObject, amal As Long, diwme As Integer,
klawiaturadaky diwme As Integer, x As Single, y As Single)

Bu yerde
maglumatlar- parametr OLE DataObject obyekte berilydr. Ol obyekte zynylan maglumatlar almak iigin
GetData usulyetini peydalanyp bolar;
amal -parametr kabul ediji maglumat bilen haysy amaly yerine yetirmelidigini habar beryér. Ol
parametr agakdaky bahalary alyp biler:

VbDropEffectNone — 0  Kabul ediji OLE maglumaty kabul etmyér
VbDropEffectCopy -1 Cesmeden kabul ediji maglumatlar nusgalanyar
VbDropEffectMove -2 Cesmeden kabul ediji maglumatlar yerlesdirilyar

VbDropEffectScroll - Maglumatlary  kabul  edijd  zyhanymyzda
2147483648 gapdaldaky dolanys bilen hereket gerekligini
gorkezyar

diwme —parametri OLE siiyreydn wagtymyz, sycanyil haysy diiwmesininn basylanyny kesgitleyar.Ol
asakdaky erkin utgagdyrmalar bolup biler:

1 Syganyn ¢ep gulagy basylgy
2 Syganyn sag gulagy basylgy
4 Sycganyn ortaky gulagy basylgy

klawiaturadaky diiwme —siiyrelydn wagty klawuaturadaky Ctrl, Shift we Alt diiwmelerinn basylanlygyny
bilip bolyar. Barlanan wagty AND operatordan peydalanyp bolar, onun alyp biljek bahalary:

1 Shift diwme basylgy
2 Ctrl daiwme basylgy
4 Alt diiwme basylgy

Parametr x we y sycanyn peykamynyii duran yerini kesgitleyir, olar hacanda zyiimaly yer anyk gorkezilse
zerurdyr.
Mazmuna ge¢mek

11.9.6.0LE siiyremekde OLEComleteDrag() is

OLEComleteDrag() is ¢esmeden maglumatlary zynanymyzda we nusgalamak ya-da yerini liytgetmek
amallar yerine yetirilende hem-de sol amallar goybolsun edilende yerine yetyir.Ol is OLE sliyremekde i
soiiky ¢agyrylyan amal hasap edilyir.
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Bu isde bir amal —parametr bardyr. Bu parametr OLEDragDrop isddki sol bir atly parametr yalydyr,
yone ol bu yerde vbDropEffectScroll baha alyp bilmez.
Mazmuna gecmek

11.9.7.0LE siiyremekde OLEStartDrag() is

Bu is cesme licin OLE siliyreme, sliyreme diizgiini gol bilen (OLEDragMode=vbOLEDragManual
hisiyete eyedir) saylananda yerine yetirilyar.

Ondan basgada ol cesme-diiziim OLE stiyremanin amalyny awtomatik
diizgiin(OLEDragMode=vbOLEDragAutomatic hésiyet) bilen amal etmek islese bolup biler.

maglumatlar- parametr OLE DataObject obyektde OLE maglumatlarda ya-da maglumatlar formatda
siiyremek ya-da nusgalamak bilen berilyar.

mumkin-amallar parametri berlen amalyn ¢esmesi {icin rugsat edilen siiyreme amalyny kesgitleyar. Ol
su li¢ bahanyn birisini alyp biler: vbDropEffectNone, vbDropEffectCopy, vbDropEffectMove.

Mazmuna gecmek

11.9.8.0LE siiyremekde OLEDragOver() is

Is OLE sliyremek amaly wagtynda sycanyn peykamy bilen obyektin yeri iiytgedilende yerine yetyér. Isin
parametrleriniii bahasy bilen sofira ndme is etmelidigini kesgitldp bolar. Ol isiii programmada yazylysy:

Private Sub obyekt OLEDragOver(maglumatlar As DataObject, amal As Long, diwme As Integer,
klawiaturadaky diwme As Integer, x As Single, y As Single, yagday As Integer)

Bu yerde birinji alty parametrler edil OLEDragDrop-daky yalydyr. yagday parametri siiyrelydan obyektin
kabul edyine gord yagdayyny kesgitleyir.
Mazmuna gecmek

11.9.9.0LE siiyremekde OLESetData() is

DataObject obyekt iicin kabul ediji GetData usulyeti cagyran wagty OLESetData() i§ yerine yetyir. Ol isin
programmada yazylysy:

Private Sub obyekt OLESetData(maglumatlar As DataObject, maglumatlar-formaty As Integer)

Bu yerde: maglumatlar —parametr zerur maglumatlary saklayan DataObject obyekti kesgitleyar;
maglumatlar-formaty —parametr, maglumatlar parametrinde saklanyan maglumatlaryn formatyny beyan
edyar.

Mazmuna ge¢gmek

11.9.10.0LE siiyremekde OLEGiveFeedback() is

OLEGiveFeedback() is her sapar OLEDragOver isden son yerine yetyar.
Ol obyekti siiyremek {igin haysy hereketler etmelidigini gorkezydn nysanlary doéretmek {igin
niyetlenilendir.

Mazmuna ge¢mek

11.10.0LE siiyremegi goldayan taslama

OLE siiyrema degisli programma diiziilisini asakdaky mysalda gorkezelin:

1.Tdze taslamany forma bilen doredelin, onuil iicin File>New Project buyruk bilen tdze taslama agalyn,
¢ykan New Project penjirede Standart EXE belgijigi saylamaly we OK basmaly.

2.Formal formanyi Name hésiyetine frmMain, Caption hésiyetine OLE siiyremek baha bermeli.

3.Formada iki sany yazgy meydanyny, formanyn dikligi yaly den edip yerlesdirmeli.

4.Cepki yazgy meydanyn Name hisiyetine txtl baha, Text hdsiyetini bos baha bermeli. OLDEragMode
hésiyete 1-Automatic, MultiLine hisiyete True baha, ScrollBars hisiyetine 2-Vertical baha bermeli.

5.Sagky yazgy meydanyn Name hisiyetine txt2 baha, Text hdsiyetini bos baha bermeli. OLDEragMode
hésiyete 1-Automatic, MultiLine hisiyete True baha, ScrollBars hisiyetine 2-Vertical baha bermeli.
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6.txt1 meydanyn OLEDragDrop is prosedurasyna seyle yazgy yazmaly:

Private Sub txt1_OLEDragDrop(Data As DataObject, Effect As Long, Button As Integer, Shift As Integer, X
As Single, Y As Single)
If Shift > 0 Then
Effect = vbDropEffectCopy

Else
Effect = vbDropEffectMove
End If
txtl.Text = Data.GetData(vbCFText)
End Sub

7.txt1 meydanyn OLEStartDrag is prosedurasyna seyle yazgy yazmaly:

Private Sub txt1_OLEStartDrag(Data As DataObject, AllowedEffects As Long)
Data.SetData txtl.Text, voCFText
End Sub

8.txt2 meydanyn OLEDragDrop is prosedurasyna seyle yazgy yazmaly:

Private Sub txt2_OLEDragDrop(Data As DataObject, Effect As Long, Button As Integer, Shift As Integer, X
As Single, Y As Single)
If Shift >0 Then
Effect = vbDropEffectCopy
Else
Effect = vbDropEffectMove
End If

txt2. Text = Data.GetData(vbCFText)
End Sub

9.txt2 meydanyi OLEStartDrag is prosedurasyna seyle yazgy yazmaly:
Private Sub txt2_OLEStartDrag(Data As DataObject, AllowedEffects As Long)

Data.SetData txt2.Text, vbCFText
End Sub

10.Taslamany yatda saklamaly.

Hemme yazgylary dogry we diirs etsek ¢epki meydana girizen yazgymyzy sagdaky meydana gecirip
bolar.
Mazmuna gecmek

12.Doredilen taslamalary diizetmek

Programmirleme bilen baglanysykly taslamalar doredilende, diiziilen programma yazgylaryn her
bir bolegi dhligorniisde doly barlanylmalydyr. Miimkin bolsa az yalilys goyberjek bolmaly, yalilys
bolayanda hem ony aradan ayyrmagyn usulyndan peydalanmaly.

Programma diiziilende goyberilen yaliiyslyklar seylerdk aradan ayrylyp bilner:

Programmany gursayan gusowa diizmek;

Yazylan her bir adalga, programma setire jikme-jik diisiindiris bermek bilen resminamalasdyrmak;
Programmany diizleyén serisdeler bilen islemek;

Barlag utilitlerini igldp tayyarlamak.

00O

Mazmuna gecmek

12.1.Programmany resminamalasdyrmak

Programma diiziilenda her bir proseduranyn, modulyn, setiriii edyén igini beyan gorniisinde yazmak
yerliklidir. Ol beyany programma setirinii basynda '-belgini «apostrof» goyup yazmaly. ‘-belgiden son
yazylan yazgylar programmada disindiris hokmiinde kabul edilydir we ekranda omia programma
adalgalayndan basga renk berilyédr. Adatca diisiindirislerde gok refk berilyér.
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Islendik programmany resminamalasdyrmak Ordn zerur we bu ugurdan kabul edilen standartyn

talabydyr. Mysal {igin, taslama derejesinde «miisder-serwer» diiziim ugin ii¢ drejeli ayratyn programma
modulyny su formatda yazyp bolar:

Taslamanyn ady:
' Gornlsi:

' Copyright:

' Haryt belgisi:
Awtory/gurama:
Niyetlenilisi:
Talap:

Her bir setirdéki iki nokatdan son diisiindiris yazylanda yokarky
programma seyle yazylar:

' Taslamanyri ady: Fayllar bilen islemegin programmasy

' Gornusi: 1.1

' Copyright: 2004-YAZ Software All Righta Reserved

' Haryt belgisi: Yok

' Awtory/gurama: Yaz Ash/ YAZ Software

" Niyetlenilisi: Programma serwerdaki agylan fayly sanawyna serdyir we seljeryar
' Talap:

Misderi: Windows 98 / Windows NT 4.0

Server: MS SQL Server 6.5
MS Transaction Server 2.0

Modul derejesinde programmany resminamalasdyrmak diymek taslama girydn @hli modullara

beyan bermekdir. Bu is esasanam programma bir topar programma yazyjylaryn gatnasmagynda Ordn
zerurdyr. Onda bolmaly yzgiderligii standart gorniisi seylerakdir:

' Faylyn ady:

" Awtory:

' Senesi:

' Beyany:

' Baglanysygy:
' Téazeleneni

Yokarky sanawyi diisiindirisli yazylysy seylerikdir:

' Faylyn ady: YazlS.cls

" Awtory: Yaz Ash

' Senesi: Sanjar 19 2004 y.

' Beyany: Maglumatlary toplamak we seljermek

' Baglanysygy: Yok

' Tazeleneni 19-11-04 Toplanan maglumatyi déredilen senesi

Prosedura derejesinde programma yazgylaryny resminamalagdyrmak isine &hli standart bolmadyk
we 0z-0ziinden anyk belli bolmadyk proseduralar we funksiyalar girizilmelidir.

' Prosedura: AddUser()
" Awtory: Yaz Ash
' Senesi: Sanjar 20 2004 y.

' Beyany: Ulanyjyny tora gosyar
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' Talap: Bu funksiya bilen islejek bolsan oniinden UserID we Password hisiyetlerifi bahasyny
bermeli.

Programma derejesinde diislindiris programma yazgysynyn her bir setri barada berilyédr. Onda has
kop dus gelyan, standartlasdyrylan gorniise ylalasylan belgilemeler bardyr:

Belgileme Beyany
' Umumy gorniisdaki diistindirigler
7? Programma yazgysynyn jedellirdk bdlegi

ticin. Uns berilmeli yeri.
11 Programma  yazgysynyn ayratyn iins
berilmeli bolegi iigin.

Ulanyan programmafiyz dziifliz tarapyndan yazylmasa, onufi yazgysynda '??2? we "!!! seyle belgili
boleklere orén iins berilmelidir.

Visual Basic-de taslamanyn diiziimine giryanlerin atlary barada gelesikleri bardyr. Hic hili at bermesen
Visual Basic—in 6z forma Formal, Forma2, Forma3 we s.m. yzly-yzyna at beryér. Elementlere hem atlar
seyle tertipde berilyar.

Visual Basic-de taslama we onufl boleklerine at berilende asakdaky maslahatlar gz oiilinde
tutulmalydyr:

o Uytgeyin ululyklaryii atlary uly we kici harplar seyle hem klawiaturadaky sekiller bolup bilerler.

Mysal ii¢in, UserName. Yéne at yazylanda adyri icinde bos yer bolmaly dildir.

O  Hemiseliklerinl atlary difie uly harplar bilen yazylmaly, bos yerii ornyna _ asagyny bellemek yaly

sekiller ulanylyar. Mysal ii¢cin, ACCESS, ACCESS , LEVEL ADMIN we s.m.

Visual Basic-ii elementleri {i¢in ulanylyan at bermelerininn 6niinden yazylyan standartlasdyrylan
gysgaltmalary, ol pefiks diyilibem atlandyrylyar:

Element Prefiks | Yazylysyna mysal
Forma frm frmMain

Duwme cmd cmdOK, cmdCancel
Yazgy bl IbIName

Yazgy meydany txt txtLastName
Utgasdyrylan meydan cho cboAccounts
Sanaw Ist IstGroups

Carguwa fra fraOptions

Gegiriji opt OptOn, optOff
Baydajyk chk chkTaxDeductible
Grafik meydan pic picWaterMark
Surat img imgSplasGraphic
Dolanys zolagy scr scrVolume

Taymer tmr tmrCountDown
Gurluglar sanawy drv drvDisk

Kataloglar sanawy dir dirDirectories
Fayllar sanawy fil filHiddenFiles
Cyzyk lin linSeperator
Figura sha shaCircle
Maglumatlar elementi dat datLogDatabase
OLE elementi ole oleWordDocument
Daragt tvw tvwGroups

Tablisa sanawy Ivw IvwUsers

Sekil sanawy iml| ImIGroups, imlUsers
Yagday setri sts stsAccountStatus

Mazmuna gecmek

12.2.Programma yazgysynyn diizlenilisi

Visual Basic-de programma YVazgylaryny ekranda we capda gowy gorliner yaly yazgyny
tertiplesdirmek bolar. Hig¢ hili gérkezme berilmese , yazgynyn 6niine kursory eltip klawiaturadaky Tab
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diiwmaéni bassak onda ol yazgy 4 sany bos yer yza siiyser. Ol bos yeriii sanyny azaldyp ya-da kopeldip
hem bolar. Onun iigin Visual Basic-in menyuwyndaky Tools>Options &dpisgd girip, onufi Editor gatyny
acmaly we ol yerdédki Tab Width meydanda bermeli:

O ptions

Editar | Editar Format ] izeneral ] Dacking ] Ervvironrment ] fdvanced

Code Settings

W Auto Syntax Check IV futo Indent

[ Require Variable Declaration
- Tab Wwidth: |4
W fuko Lisk Members -

[+ &uto Quick Info
W &uto Daka Tips

Window Settings

W Drag-and-Drop Text Editing
[+ Defaulk ko Full Module Yiew
W Procedure Separator

Mysal {igin, programma yazgysynyn bolegi

Select Case x

Casels=1

‘Wariant 1

Casels=1

‘Wariant 1

Casels=1

‘Wariant 1

Case Else

“ Yaltiyslar barada maglumatlary gykarmaly
End Select

asakdaky yaly toparlasdyrylsa gowy gorner we okalar:

Select Case x
Casels=1
‘Wariant 1
Casels=1
‘Wariant 1
Casels=1
‘Wariant 1
Case Else
“ Yalfiyslar barada maglumatlary gykarmaly
End Select

Programmanyi yagdayynyn iliytgemegini belgileydn her hili ¢ekilmeler berilip bilner. Mysal tigin,
fayl aganymyzda Open we Close buyruklaryil aralaryndayazgy yazmak ii¢in bos setirler goyar. Do buyruk
bilen baglanyan sikl iicin Do we Loop buyruklaryn arasynda gosmaga yza ¢ekilme goymaly, mysal ii¢in:

Open fileName For Input As fileno
Do While Not EOF(fileno)
Input #1, txt
Debug.Print txt

Loop
Close fileno

Mazmuna gecmek
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12.3.Visual Basic-de programmalaryn ygtybarlygyny yokarlandyrmak

Programmalaryn ygtybarlygyny yokarlandyrmak parametrler Tools>Options dpisgé girip, onun Editor
gatynda yerlesendir:

Options
Editor | Editor Format ] General ] Docking ] Environment ] Advanced ]

Code Setkings

v Auto Synkax Check Iv auto Indent

W Fequire Varisble Declaration: Tab width: ldi
I &suto List Members

v Auto Quick Info

IV Auto Data Tips

window Settings

W Drag-and-Drop Text Editing
Iv Defaulk bo Full Module Yiew
v Procedure Separator

Bu yerde Auto Syntax Check yazga bellik etsek bu redaktor yazan buyruk-adalgalarymyzyn diirs
vazylysyna gozeggilik eder.

Eger programmada her modulyn 6niinden Option Explicit buyrugy yazsak, onda Visual Basic dhli
Require Variable Declaration yazga bellik etmeli. Sonda her formanyin, modulyn, toparyn éniinde Option
Explicit awtomatik usulda yazylar.

Visual Basic—in yokarky penjiresinde Auto List Members yazgynyn oniinde bellik etsek obyekte
degisli hésiyetlerin we usulyetlerin sanawy c¢ykar. Mysal iicin, forma {igin programma bdlegini
yazanymyzda seyle sanaw ¢ykar:

IFurm j ILuad

Private Zuk Form Loadf(]
App |
End g8 Comments -
e CompanyMame
EH
B FileDescription
E& HelpFile
B hinstance
EH LegalCopyright - |

==+ | >

Visual Basic—ifi Options penjiresinde Auto Quick yazgynyn oniinde bellik etsek, programma bilen
girizmek isi amal edilende funksiyalar we parametrler barada maglumatlar ekrana geler. Seyle edilse
Visual Basic 1§ wagty goziikdirme ¢ykarar.

Visual Basic—ini Options penjiresinde Auto Data Tips yazgynyn oOniinde bellik etsek, sycanyn
peykamynyn duran yerinddki iytgeydn ululyklarynyn gorniislerini sekillendirmegi dolandyryar. Ol
programma diizlenen wagty 6rén zerurdyr.

Visual Basic—ifi Options penjiresinde Auto Indent yazgynyn oniinde bellik etsek, setirme-setir
diizlenen programma yazgysyny doretmige yardam eder. Ony goysak programma yazgysy awtomatiki
gerek bos yer goyar.

g

Mazmuna gecmek
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12.4.Visual Basic-de programmalary diizlemek serisdeleri

Gowy diizlenip yazylan programma yazgysynda yaliiyslaryn az bolmagy miimkindir. Visual Basic—
de yalnyslary diizetmegin serisdesi bardyr. Ol serisddni bas menyudaky ViewToolbars>Debug basyp,
programma yazgysyny diizlemeginl gurallarynyn panelini ekrana ¢agyryp bolar:

Cykmak hilen ddim Yerliy Oytgeyan
Girmek hilen Gdim ululyklar apiggesi

Arasyny kesmek Seredikrin dpigoe
nokady
Ciebug =
B re = @ — Gadyrylyan stek
Ige gitzmek———F T
Asryrmak Tiz seretmek
Diizleme pigtesi

Arasyny kesmek
Visual Basic—de taslamany ise girizmek Run»>Start ya-da yokardaky® basyp, ya-da F5 basyp ise
girizip bolar:

Asrlanyp gecmek
hilen adim

REun
Il Ereak Ckrl+Break.
m End
Reskart Shift+F5

Taslamany ise goybereneniiiden son, su menyudaky Break, yokardakyda-'lldiiwméni bassai
taslama bilen isi duruzyp bolar. Seyle edilse programmanyii yerine yetirilisinin duran yagdayyny
kesgitlap bolar.

Start diiwme basylandan son, programma yazgysynda yalilyslyklar bar bolsa, onda End,
yokardakyda-'® diiwméni basyp programma yazgysyna girip diizedisler girizip bolar.

Toggle Breakpoint diiwme, yokardakyda - I diiwme programmanyn hézirki setirinddki kesilme
nokadyn yagdayyna geciryér. Kesilme nokady programmanyn kébir yerine yetende programmanyi yerine
yetirilisini duruzyar.

Diizleme yerine yetirilenden soit programmadaky kesilme nokatlary ayyrmak zerurdyr.

Step Into-"= diiwme programmada bir setri yerine yetirydr., onui li¢in kd yagdaylarda F8 bassaiiam
bolar.

Step Overh= diiwme programmada her bir setri #dime-ddimsiz prosedurany ya-da funksiyany
cagyryar, onuf yerine Shift+F8 dilwmelerem basmak yeterlikdir.

Local Window-EJ diiwme programmada Yerli iiytgeyanleri penjirede, bahalary bilen awtomatiki
gorkezydr.

Immediate- & ya-da Ctrl+G diwme programmada goniden-goni hasaplary sol atly penjirede
gorkezyar.

Watch Window-&a diiwme programman yerine yetirilyarka kibir iytgeyanin ya-da obyektin
yagdayyna bolsy yaly wagtda seretmek {i¢in gerekdir.

Quick Watch-#%" diiwme basylsa programmanyii boliinen anilatmasyny sol wagtky bahasy bilen tiz
seretmek ti¢in dialog penjiresi cagyrylar. Debug-daky Add diiwme sofira hem programmanyn &mal
edilisine seretmek ii¢in girizilip bilner.

Call Stack- & diwme programmada su wagtda tamamlanmadyk, @hli agylan proseduralaryn
sanawyny dialog dpisgd cagyryar.

Debug menyuda Run To Cursor(onufi ornuna Ctrl+F8 diiwmnam bolar) diiwme-setri bardyr, ol
bassylsa taslama yerine yetirilende kursor programma yazgysynyi haysy yerinde duran bolsa sol yerde
saklanar.
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Mazmuna gecmek

13.Visual Basic-de anyklama fayllaryny(Elektron
kitaplary) doretmek we peydalanmak

Kompyuterde mesele ¢oziilende, yiimiislar amal edilende il bir zerur m&iim is ol hem bolsa, ulanyjy
mesele ¢ozyirkd, amaly yerine yetiryarka, isin yzygiderliginiii islendik yerinde zerurlyk yiize ¢yksa sol
wagta alyp bilmeginin hékmanlygydyr. Kompyuter taslamasynyn resminamalagdyrylysyna esasy
bildirilydn talaplarynn biri hem su isdir. Taslamanyi ulanylysy {i¢cin resminamalasdyrmagyn su isi iki
gorniisde doredilip bilner.

Birinjisi elektron anyklama ulgamy gorniisinde bolup onda her ddimde yiize ¢ykayjak soraglar
mesele ¢Oziilisiniii, amalyn yerine yetirilisinin yzygiderligine bagly bolup, ulanyjy islendik wagt sdginen
yerinde ona degisli anyklama alyp bilmelidir, Mysal ii¢in, MS WINDOWS-da, MS OFFICCE-de F1-ig
diiwméni basyp alnysy yaly.

Ikinjisi kompyuter taslamasyna degisli anyklama soraglaryi jogabyny gollanmalar, géziikdirmeler
gorniisinde adaty kagyza ¢ap etmek.

Mazmuna ge¢cmek

13.1.Visual Basic-de anyklama fayllaryny taslamalarda peydalanmak

Visual Basic-i tayyar taslamasynyn ayrylmaz bolegi hokmiinde elektron anyklama girmelidir.
Elektron anyklama doredilen taslamany ulanyjylar ii¢in, ulanys wagtynda diisliniksiz yerleri barada
deslapky komek isini yerine yetirmelidir. Elektron anyklama barada Anyklama fayly ony doretmek
baradaky her-hili programmalarda doredip bolap. Esasi mesele doredilen anyklama fayly ahli
kompyuterlerde okalyp bilinmelidir. Mysal iigin, MS WINDOWS, MS OFFICCE we s. l¢in anyklama
fayyllary WINDOWS-yn Bloknot, WordPad kompyuter maksatnamalarynda okalyp bilinyar.

Ol anyklama fayl islenik yazgy redaktorynda doredilende hem RTF(Rich Text-Format) formatda
vatda saklanylmalydyr. Visual Basic-de anyklama fayylyny(ofia HLP-fayly hem diyilydr) doretmek iicin
yoritelesdirilen Microsoft Help Workshop kompyuter maksatnamasy bardyr. Onun is ekrany asakdaky
sekilde getirilendir.

%Hicmsuft Help Workshop =0 ﬂ
File “iew Test Toolz Help

el ] x|

Ready LA
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13.2.Visual Basic-de anyklama fayly doretmek

Islendik taslamada anyklama faylyny doretmek {i¢in taslamanyn we onufi bolumleriniri
atlandyrylysyny, mazmunyny ayratyn fayllar gérniisinde tayyarlamalydyr.
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Taslamanyn mazmun fayly ASCII formatda yatda saklanyar hem-de Contents gatyn dasky gorniisini
we diiziimini kesgitleyir.

Bolumler fayly jemleyji resminamany emele getiryan yazgylary we grafikleri 6ziinde yerlesdiryar.

Taslama fayly taslamanyn mazmuny we bolimler faylyny, seyle hem taslama giryén beyleki
fayllary birlesdiryar. Ol fayl, anyklama ise girizilende anyklama penjiresiniii maketini, dasky goérniisini
we onun penjirelerinde jogaplaryn yerlesini kesgitleyar. Mysal ii¢in, Microsoft Word yazgy redaktoryn
anyklama faylynynn mazmuny asakda getirilendir:

Cnpaesounan cuctema: Microzoft Word 7| =]
CoaepskaHue l !:lKEISaTBJ‘Ib] HDHCK]

BeiSepure pazgen M HakmHTe kHoNkY 'Tlokasare'', nudo BeiSepTe gpurymw
Ekagky. Hanpuriep TpeokeTHEIR Yrasarens'".

@ AonyYeEHME CNpAaBo4YHeEx CESLEHMEA -
l@ WETAHOEHA W waaneHwe wWord
fMf=anyck NporpaMd W paboTa C dladnamMe

o CanyCH Nporpamy OffTice
@ HacTpoWka pabodero cTona Windows
@ FaboTa Cc dlafinamK KW nankKamm
@ MCNone30BaHWe nadHenw Microsoft office
I@I:!'rh:pbn’me, CO3A0AaHWME WM COMPpAHEHME AOHYWMEHTOE
l@ EEOQA, MEpPEMEIEHWE KM EbAEMNEHWE
l@ Mpaska W CoOpTHPOEHAa
l@ MpoEepra NpasonMcadHya
l@ POPMATHROEAHWE
l@ PasMeTEa CTPpaHKUbl

@ MMOOPT PWCYHHOE W CO3A0AaHWME FpafiM4ecKMs= 0BLEeHTOE -
4] | >

SakpeMe I MeuvaTe. .. | OTrieHa |
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13.2.1.Visual Basic-de anyklama faylynda mazmun fayly taslamak we doretmek

Islendik kitapda, gollanmalarda bolsy yaly, olaryit mazmuny oiilinde yerlesdirilydr. Seyle bolandan
sont iliki bilen anyklama ulgamyn mazmunynyii umumy goérniisini bermek maksada layykdyr. Kéa
halatlarda kitabyil mazmuny yzynda hem yerlesdirilip bilner. Ol is ulanyjynyn islegine baglydyr. Visual
Basic-dédki Help Workshop redaktorda mazmun fayl taslananda boliimlerin atlaryny we idenrifikatorlaryny
yvazmaly. Onunl yazylys yzgiderligi seyledir:

1. Help Workshop redaktor goyulmadyk bolsa goymaly.
2.Goyulan bolsa Patcw programmany a¢gmaly, Mysal ii¢in, meniii kompyuterimde PoHcw seyle yol bilen

acylyar:

_J;J D63o0p - Tools _|_|- O ﬂ
Falin Mpaeka Bug  [Mepewon  Mafpannoe  Cepewc  Cnpaeka n
s F =) i »
S @ | ¥ B B =W | X
Hazan Beeps Bripesare  Komvpoeare  Borasume | OTeeHume Hoanue
Aapec |_| C:WProgram FileshMicrosoft Visual StudiohCommon'Tools j
Maniku X
: : Tools
+1-_] Electonic Arts ﬂ
4] GLSehup Hia | Paamep| Tun j
#-_"] Hoean nanka — |.,|._] Hew 18KE  Help Contents File =
-1 InstallShield Irstallation Information W 483KE  Mpunosenue
-] Internet Explorer @ Hew EITKE Faincrpaeky ¥
#-(] KA3HA 99 RMIKl | »
489 KE g Moii komnsloTep

3.Cykan Help Workshop penjraniii menyuyndan File>New buyruk bilen tidze fayl doéretmeli. Cykan
sanawdaky Help Contents setri saylamaly we OK basmaly.
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Hew 7| %]

‘ HEIE Project

] | Cancel |

4.Ekrandaky penjranini Default Filename meydanyna Skill13.hlp yazmaly.
5.Ekrandaky penjréanin Default Title meydanyna Anyklama fayly doretmeli yazmaly.

Drefault filename [and Drefaulk bithe:

|5kill 3 hip |syklama faply doretmek]

6.Faylyn diiziimini doretmek atlarynyn sanawyny goslanyar, onuil {i¢in ekrandaky Add Above diiwmini
basmaly hem-de Heading gegirijini goymaly. Title meydana Anyklama faylyny doretmek yazgyny girizmeli.

7.Ekrandaky penjranin Add Below diiwmesini basmaly, boliimlerin atlaryny girizmeli: Heading gegirijini
goymaly we Title meydana Mazmun fayly doretmek yazgyny girizmeli, OK basmaly.

8.Basdan az-kem c¢ekilmek bermek ii¢in Move Right diiwméni basmaly. Sonda béliimlerini biri-birine
baglylygyny berip bolar.

9.Tédzeden ekrandaky penjrianiit Add Below diiwmesini basmaly, bu sapar Topic gecirijini goymaly.Title
meydana Mazmun fayly doretmeli setri girizmeli, Topic ID meydana IDH_CreateContentsFile yazgyny
girizmeli. Help File, Window Type meydanlary bos goymaly.

10.Seyle usul bilen su boliimleri gogmaly:

Boéldmin identifikatory Boldmin atlandyrylysy
IDH_AddHeadings Adyny goshmaly
IDH_AddTopics Bolumi goshmaly

11.Add Below diiwme bilen nobatdaky ady gosmaly. Title meydana Fayllary doretmek yazgyny girizip OK
diiwméni basmaly.
12.Fayllary doretmek bdliime ona tabyn su boliimleri gosmaly:

Bolumin identifikatory B&lUmin atlandyrylysy
IDH_WriteTopics Bolumlerin yazgysyny yazmaly
IDH_AddFootnotes Bellik goshmaly
IDH_SaveRTF Fayly yatda saklamaly

13.Title meydana in sonky tabyn boliim Taslama fayly doretmek yazgyny girizmeli, OK basmaly.
14 Taslama fayly doretmek bdliime asakdaky tabyn boliimleri gosmaly:

B&lumin identifikatory B&lUmin atlandyrylysy
IDH_CreateProjectFile Taslama fayly doretmeli
IDH_SetOptions Taslama parametri bermeli
IDH_SaveRTF Fayly yatda saklamaly
IDH_AddFiles Taslama fayl goshmaly
IDH_DefineWindow Apishga parametr kesgitlemeli
IDH_Comple Taslamany yatda saklamaly we
mashyn diline gechirmeli
IDH_Test Alnan anyklama fayly barlamaly

Yokarky yzgiderligiii netijesinde alnan mazmyn fayly redaktorda seyle gorner:



172

'@ﬁlﬂlicmsuft Help Workzhop - [Untitled1] - I:I|ﬂ
|.|_;] File Edt “iew “Window Test Toolz Help - 5’|ﬂ
=|@m| =| x[?
D efault filename [and windaow]: Drefauilt fitle:

|Skilll 3.Hip |sryklama fayly doretmek Edi..

Edit...

M Anyklama Fayly doretrek
7 Mazmun fayly doretmel

. Remove
7 Adyry goshmaly

7 Bolum goshmaly
|.,|.;] Bolurnler fayllany doretmek;, Add sbove...
7 Bolurnlenin pazgyayny vazmaly Add Belov..
7 Bellk goshmaly =
7 Fayly patda zaklamaly
|.,|.;] T azlama Fayly daretmek, kove Bight

" Tazlama fayly daretmel

R B i

. ' b o Left
T aslama parametri bermeli

" Fayly watda zaklamaly
" Tazlama fayl goshmaly
Apizhga parametr kezgitlemel

Taslamarny vatda zaklamaly we mashyn diine gechirmel

wa] wa) wa) ed) wal eal sl

" Alnan anyklama Fayly barlamaly
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13.2.2.Visual Basic-de anyklama faylynda boliimler fayly doretmek

Mazmun fayly doredilenden son, onun boliimlerini doretmége girismeli. Ol RTF(Rich Text-Format)
formatdaky resminama bolup, onda yazgylar, grafikler, salgylanmalar we makroslar bolmaly hem-de olar
anyklama faylyna cagyrylyp okalyp bilinmelidir. Boliimlerini islendik yazgy redaktorynda yazsaam
bolar. Mysal tigin, Microsoft Word yazgy redaktoryny ulanalyn:

1.Redaktory ise girizmeli we tdze resminama doretmeli.
2.Resminamanyi birinji setrine birinji boliiminl adyny girizmeli: Mazmun fayly doretmeli.
Resminamanyn adynyn asagyna su yazgyny girizmeli:

Isi mazmun fayldan baslamaly.Help Workshop redaktop bu is Ggin yorite niyetlenilendir. Onda biri-birine tabyn
shemalar déredip bolar.

Isi Help Workshop-a baryp File>New buyruk bermeli.

Help Contents setri saylamaly we OK diwmani basmaly.

3.Yazylan yazgyda bellik etmeli. Bellik boliimiii basynda bolmaly. Kursory yazylan yazgynyi Mazmun fayly
doretmeli 6iilinde goymaly.

4.Redaktoryn bas menyuyndaky Bcraska>CHocka buyrugy amal etmeli, ¢ykan penjireddki Hymepauus
topardan Opyras yazgyda bellik etmeli we Funtyi belgisini(#) girizmeli. OK basyp penjréni yapmaly.

5.Redaktorynl kursory bellige gecse, ol yere IDH_CreateContentsFile —boliimin identifikatoryny yazmaly.

6.Bo6iimin adyny berydn yazgyny girizmeli, ol boyunga anyklama fayldan ony gozlép tapar yaly. Kursory
# bellik bilen boliimin adynyn arasynda goymaly.

7.Yenede bas menyuyndaky Bcraeka>Crocka buyrugy amal etmeli, ¢ykan penjirediki Hymepauus
topardan [pyras yazgyda bellik etmeli we Dolaryn belgisini($) girizmeli.

8. Redaktoryn kursory bellik setre gegse, ol yere Mazmun fayly déretmeli yazmaly.

9.Boliimi yzygiderlikde seretmegi kesgitlemek {i¢in bellik doretmeli, onun tigin kursory $ bellik bilen
boliimint adynyn arasynda goymaly. Nobatdaky belligi bas menyuyndaky Bcraska>CHocka buyrugy
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amal etmeli, ¢gykan penjiredidki Hymepauus topardan Opyras yazgyda bellik etmeli we plyus(+) girizmeli.
OK basyp penjrani yapmaly.
10. Redaktoryn kursory bellik setire gecse, ol yere auto setri yazmaly. Sonda biz Windows Help buyruk
bilen berlen faylda seretmegiin awtomatiki yzygiderligini dorederis.
11.B6iimin adyny goyy garalasan has yerlikli bolar.

Bizinn MS Word-da amal eden faylymyzyn gorniisi

¥ Microsoft Word El" [
Fain [paska Bug Boraeka FPopmar Ceperic Tatmwua Okno 7 Wpwer
hE2E &Y B oo e HERESE & 601w -
friiiafie b&8ra fit - Arial 0 - KK UE =EE=EE=E I [-i= £+ A -
“ﬂﬂoxgmemZ

L[ gl'l'I'2'I'3'I'4'I'5'I'B'I'T'I'8'I'9'I'IU'I'll'I'12'I'13'I'14'I615'I':

#tiazmun fayly dirstmeli.
Isi mazmun fagldan baglamaly Help Workshop redakiop
bu is gin yérite nigetlenilendir. Onda biri-biting tabyn shemalar diredip bolar
|zl Help Workshop-a baryp File>HNew huyrik bermeli.
Help Contents setri sailamaly we OK diwmani basmaly.

#|IDH GreateContentsFile
3%&&@&&9@@@

*auta

E!E'_HIZE-|<|

CRI- - - R O B B B

Anyklama fayllary doredilende belliklerin begisini ulanmak sertlesilendir:
# - funtyn belgisi identifikatory yazmak ii¢in;
$ - dollaryn belgisi adyny bermek {igin;
+ - seretmegin yzygiderligini kesgitlemek {igin.
Boliime bellikleri girizmeginl esasy diizgilinlerinint sanawy asakdakylardyr:
o Bellik boliimin yazgysynyn basynda bolmaly.
o Oni bilen identifikatoryii(#)belligini girizmeli, sofira identifikatoryf 6ziini girizmeli.
o Sofira boliimin ady {igin ($)bellik girizmeli we ondan son boliimin adyny girizmeli. Ol bellik hokman
déldir, girizsen gowy.
o Yzygiderli seretmek {igin (+) bellik gosmaly. Ondan son auto sdzi girizsenem ya-da nomer
girizseiem bolar.

Doreden boliimler faylymyzy yazgy redaktorynda Skill13.rtf at bilen yatda saklamaly:

kA dakna: |5ki||13.rtF j

THn dakna: |TEKET & topraTe RTF j

Belligi ulanmagyn esaslaryny dwrenenimizden sofi anyklama faylyny déretmegi dowam etdirelin:
1.Boliimin sonyna kursory eltip Ctrl+Enter basyp sahypany bolmeli.
2 Kursoryn duran yerine su yazgyny yazmaly:

Adyny gosmaly
Ady gosma Ulgin Add Above we Add Below diwmeler ulanylyar. Ekrana Edit Contents Tab Entry penjire geler,
onda Heading gegirijide bellik etmeli, ondan son adyn beyanyny girizmeli.
At bilen anyklama faylyribolimlerini tertiplap bolar.
Bizin anyklamamyz lc bélimden ybarat.

3.Asakdaky bellikleri doretmeli:
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# IDH_AddHeadings

$ Adyny gosmaly

* auto
4.Indiki boliimin yazgysyny girizmeli:
Bolim gosmaly
Anyklama faylda her bir mowzuk Ugin 6z bolimi déredilyar. Su yazgy bolimdir. Bolim gosmak Ggin Add Above we
Add Below diwmeler ulanylyar. Ekrana Edit Contents Tab Entry penjire geler, onda Topic gecirijide bellik etmeli.
Her bir bélime i azyndan identifikator gorkezmeli.Help Workshop Ggin bélimin identifikatory IDH_ yazgydan sori
yazylyp baglanmaly. Seylede boluifi adyny bermeli. At Title meydanda berilyar. Beyleki meydanlar makroslar Ggin
niyetlenilendir.

5.Asakdaky bellikleri doretmeli:

IDH_AddTopics
Boliimi gogmaly
* auto

6.Indiki boliimin yazgysyny girizmeli

Bolimler yazgysyny yazmaly

Bolumler yazgysyny yazmak indiki edilmeli isdir. Onun Ggin RTF formatda yazgyny yatda saklayan yazgy redaktory
gerek.

Isi tdze resminama doretmekden baslamaly.

Her bir bélim ayratyn sahypadan baslanmaly.Birbada birndge boélumi yazsiyz, olaryd aralaryny doly
ayyralasdyrmaly, Mysal l¢gin, MS Word-da Ctrl+Enter bilen bolmeli.

Yazgyny yazyp bolanyfidan son bellikleri goymaly, olar béliimleri birlesdirmek (igin hyzmat eder.

7.Asakdaky bellikleri doretmeli:

# IDH_WriteTopics
Bolumler yazgysyny yazmaly
* auto

8.Indiki boliimin yazgysyny girizmeli:

Bellik gogmaly

Bolumleri déredenimizden sofi her bir bolimin sahypasynda bellikler déretmeli. Bolimin identifikatory Ggin bellik
hékmandyr. Identifikatory bermek bilen oria bellik hdkminde funtyh belligi-# saylanmalydyr.

Bolumin identifikatory Ggin bellik doretmek.

Kursory sahypanyri(s6zbasynyn) basynda goymaly. MS Word-da menyuyndaky BcraBka»CHocka buyrugy amal
etmeli, ¢ykan penjiredaki Hymepauusa topardan [Odpyraa yazgyda bellik etmeli we gerek bellik belgini saylap
girizmeli. OK basyp penjrani yapmaly.Bellik-daki yazgynyn ornyna, kursoryin duran yerine IDH_ yazgynyn yzyndan
identifikatory girizmeli.

9. Asakdaky bellikleri doretmeli:

# IDH_AddFootnotes
$ Bellik gogmaly
* auto

10.Indiki boliimin yazgysyny girizmeli:

Fayly yatda saklamaly
Ahli bélumleri we bellikleri tayyarlanyriyzdan sofi fayly RTF formatda yatda saklamaly. Ondan sof Help Workshop
redaktor bilen islem&ge dolanmaly we taslama fayly déretmeli.

11.Asakdaky bellikleri doretmeli:

IDH_SaveRTF
Fayly yatda saklamaly
* auto
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12.Indiki boliimin yazgysyny girizmeli:

Taslama fayly déretmeli

Anyklama faylyn sonky dizimi taslama faylyny déretmek bolup duryar. Taslama fayly anyklama faylyn her hili
hasiyetnamalaryny kesgitleyar, anyklama faylyny gurmak Ggin zerur bélim ler faylyna we mazmun faylyna seyle
hem beyleki maglumatlara bellikleri 6ziinde jemleyar.

Help Workshop-da File>»New buyrugy amal etmeli. Cykan penjirede Help Contents setri saylamaly we OK
diwmani basmaly.

Help File meydana anyklama faylyn adyny girizmeli. Bizii mysalymyzda Skill13.hlp diyip girizdik.

13.Asakdaky bellikleri doretmeli:

# IDH_CreateProjectFile
$ Taslama fayly déretmeli
* auto

14.Indiki boliimin yazgysyny girizmeli:
Taslama parametri bermeli

Taslamanyn her hili parametrini bermek iigcin Options diiwméni basmaly.

General gatda

Help Title meydana anyklama faylyr beyanyny girizmeli.

Compression gatda

Custom-da gegcrijini, HallCompression-da baydajygy goymaly. Bu belgilemeler anyklama faylda adalgalar
boyunca gézlegifi mumkingiligini Gpjin eder.

Files gaty

On déreden bélimler(RTF-de) faylymyzdan birinji sanawy saylamaly.

Contents File meydana mazmun faylyi adyny girizmeli.

15.Asakdaky bellikleri doretmeli:

# IDH_SetOptions
$ Taslama parametri bermeli
* auto

16.Indiki boliiminl yazgysyny girizmeli:

Taslama fayl gosmaly
Taslama parametr bermek bilen ona bolimler we mazmun fayly, grafikleri gosmaly

17.Asakdaky bellikleri doretmeli:

# IDH_AddFiles
3 Taslama fayl gogsmaly
* auto
18.Indiki boliimin yazgysyny girizmeli:

Penjranin parametr kesgitlemeli

Anyklama penjirede sereder yaly diwme bolmaly, onyn Ggin standart bolmadyk stil bermeli.

Window diwmani basmaly. Window Properties penjirede Add diwmani basmaly. Stilii adyny girizmeli we penijire
Procedure standart penjranifi esasynda déredilmelidir.

Ondan son Buttons gata gegmeli we anyklama penjirede seretmek (¢in diwme gosmaly bolsa Browse baydajyk
goymaly.

Agylan penjrani OK basyp yapmaly.

19.Asakdaky bellikleri doretmeli:
# IDH_DefineWindow

$ Penjranin parametr kesgitlemeli
* auto
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20.Indiki boliiminl yazgysyny girizmeli:

Taslamany masyn diline gegirmeli we yatda saklamaly.

Indiki isleri amal etmezden 6i taslamany we mazmun fayly yatda saklamaly. Onuni lgin taslama penjiresinin
asaky etegindaki Save and Compile diwmani basmaly.

Masyn diline gegiriji taslamanyn, mazmunyn we boélimlerin faylyny islap tayyarlap maglumat tayyarlayar. Masyn
diline gecirmek yalflyssyz gegse anyklama faylyny barlamaga baslamaly.

21.Asakdaky bellikleri doretmeli:

# IDH_Compile
$ Taslamany masyn diline gegirmeli we yatda saklamaly
* auto

22.Indiki boliiminl yazgysyny girizmeli:

Alnan anyklama fayly barlamaly

Ol in sonky 6ran mohim isdir. Anyklama faylyny barlap salgylar boyunca gegyanligini barlamaly. Minkin bolan
sawlikler we maketdaki yalnyslyklar barlanyar.Anyklama fayly edil adaty taslama yaly barlanmalydyr.

Anyklama faylyr dizimi isleyan bolsa ony programmirlenen taslama birikdirip bolar.

23.Asakdaky bellikleri doretmeli:

# IDH_Test
$ Alnan anyklama fayly barlamaly
* auto

Mazmuna gecmek

13.2.3.Visual Basic-de taslama fayly doretmek

Mazmun we boliimler faylyny birlesdirmek {i¢in taslama faylyny doéretmek zerurdyr, ol isin yzygiderligi

asakdaky yalydyr:

1.Help Workshop redaktory ise girizmeli.

2.Téze taslama faylyny doretmek ti¢in Help Workshop-da File>New buyrugy amal etmeli. A¢ylan penjirede
Help Project setri saylamaly OK basmaly.

3.Help Workshop-da taslamanyii adyny bermegi teklip eder, sonda Skill13 yazgy girizip Save diiwméni
basmaly. Onun penjiresi seyledir:

I'ffkl‘-'licn:lsn:ll‘t Help Workshop - [5kill1 3] — I:I|ﬂ
_}g‘. File  “iew “Window Test Toolz Help .= |ﬂ

=d 1=l I e vl

Help File: |Ski|l‘| 3 hlp

[OPTIONS]
LCID=0x209 0x0 0=0 ; AHradAckui [Bendeodpuradma)
REFPORT=Yesz

wiindowsg. ..

Bitmaps. ..
MMap
Alias. .

LConfig...

_windows.._|
_ Bimaps..__|
_ e |
__ Lorfig.. |
_DataFies...|

Drata Files...

Sawe and Compile

Ready LIk
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4.Cykan penjireden Options diiwméni basyp onun penjiresini agmaly.

5.Agylan Options penjirediki Help Title meydana Anyklama fayly déretmek yazgyny girizmeli.

6.Compression gata ge¢meli. Custom gegirijini goymaly, sofira Hall Compression yazgyda baydajyk
goymaly.

Options 7]
FTS ] M acros ] Build Tags ] Fontz
General Compression l Sorting ] Files

" Mone

" Maximurn [recommended)
* Custom

.........................................

[T Fark rormmrecsinn

7.Files gata gegcmeli we Help File setire Skill13.hlp yazgyny girizmeli.

8.RTF Files yazgyly meydanyn yanyndaky Change diiwmaini basmaly.

9.Topic Files penjire agylar, onda Add diiwméni basmaly. Cykan penjireden Skill13.rtf fayly tapmaly,
tapylanson ol boliimler fayly taslama gosular.

Topic files

. MCodelibh S kil 3. ot

10.Su yazgy édpisgéd ¢ykandan son penjrani OK basyp yapmaly.

11.Contents meydanyn yanyndaky Browse diiwmini basmaly. Cykan penjireden skill13.cnt fayly gozlap
saylamaly.On déreden faylymyz taslama gosular.

12.0ptions penjrani OK diiwme bilen yapmaly.

13.Windoe Properties penjrani ¢agyrmak tigin ekrandaky penjireden Window diiwméni basmaly.

14 Hisiyetler penjrini gormek {i¢cin ony ddretmeli. Add New Window Type penjriniii Create a Window
Named meydanyna Main yazmaly.

Based on this Standard Window Sanawda Procedure setri saylamaly. Parametrleri diizlemek gutarandan
soft OK dliiwméni basyp tamamlamaly.

Create a window 7| x|

Before pou can modify window
properties, vou must create at least
ane window.,

Create a window narmed:

| air

Bazed on thiz standard window:
|F'ru:u:eu:|ure ﬂ

| O, | Cancel |
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wWindow Properties 7 x|

General l F'u:usiti-:un] Buttnns] Calar ] Mau:ru:us]

window type: — (HETNRNNRR— - |

Add.. | Bemove | Ihchide. .. |

Title bar text: |

Comment: |

Wafindow attributes
B [ Mazimize window

W FKeepHelp window an top

| k. | OTtieHa

15.Buttons diiwméni basyp Browse yazgynyn 6niinde baydajyk goymaly, galan baydajyklara degmeli dal.
16.Windows Properties penjrini OK basyp yapmaly.Anyklama taslama asakdaky gorniise eye bolar:

'@ﬁlﬂlicmsuft Help Workzhop - [Skill13] - I:I|ﬂ
)ég_\?.: File “iew ‘Windmw Test Toolz Help - 5’|ﬂ
=|@m| o| x[?

Help File: |Skill1 3.hip

[OPTIOMS] Options...
COMPRESS=4 Hall

LCID=0=809 D40 D=0 ; AHrauickui [Benkodperadm9a]
REPORT=vez

TITLE=fnwklama fayly doretmek,

CHT=. \Program Filezhhicrozaft Vizual Studic Common' T oolzhS kil

Files...

| T

J

[FILES] Bitrmaps...
- MCodelibt S kil 3. tf
Map...
INDOWS
OMain="", pos=[E53, 102). size=[360, E00], auto-zize height, kee Alias...

Caonfig...

Data Files...

fu

Save and Compile

Ready M LI

17.Bu penjirede Map diiwméni basmaly, sonda biz bizin anyklama ulgamymyzy yazga bagly ederis.
18.Cykan penjiredéki her bir bolim ii¢in Add diiwméni basyp Topic ID meydana degisli boliimin
identifikatoryny, Mapped Numeric Value meydana identifikatoryn kontekstini sanlarda bermeli:

Boéliimin identifikatory Kontekstin identifikatory
IDH_CreateContentsFile 100
IDH_AddHeadings 200
IDH_AddTopics 300
IDH_WriateTopics 400
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IDH_AddFootnotes 500
IDH_SaveRTF 600
IDH_CreateProjectFile 700
IDH_SetOptions 800
IDH_AddFiles 900
IDH_DefineWindow 1000
IDH_Comple 1100
IDH_Test 1200

Netijede asakdaky penjrani alarys:

Map

Map tapic 1Dz to numenc values:

||:|H AddFil LIL]
|DH_AddFoothiotes=R00
IDH_AddHeadingz=200
IDH_Cample=1100 Remave
|IDH_CreateContentzFile=100
|IDH_CreatePraojectFile=700 |hclude. .
|DH_Definesindow=1000 -
IDH_SaweR TF=R00 '
IDH_SetOptions=a00 Edi..
IDH_Test=1200

IDH_Topicz=300

IDH_'wite T opice=400

P

Instead of IDH_, check thesze prefines:

k. | Cancel

19.Ahli bahalary girizip bolanymyzdan sofi penjrinifi OK diiwmesini basmaly.

20.Ekrandaky penjirede Save and Comple diiwméni basmaly. Ahli eden islerimizi Workshop masyn
diline gegirer we penjire az kem wagt yygnanar, sonra dikeldiler hem-de magyna gegiriligin netijesi
ekrana geler:

I%I‘-’Iicn:lscll‘t Help Workshop - [Compilationd] —10O] =]
"'—r.-'_] File  Edit “iew “indow Test Toolz Help =] =]

z|Ho| S 2|7

IDH_Compile Topic 11 of C:\Mou noxyrenTul. \Codelib\Skilll Zﬂ
HC1010: Note:
The following mapped Topic IDs were not used in any topic:
IDH_Comple
IDH_Topics
Resolving keywords...
Adding bitmaps...
12 Topics
0 Jumps
0 Keywords
0 Bitmaps

Created CAMoux noxymenTaiiSkill1 3.hip. 11,914 bytes
Hall compression decreased help file by 867 bytes.
Compile time: 0 minutes, 1 second

1 note. b warnings

4| =

Ready MM
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Alynan anyklama faylyn isleydnini bilmek {i¢in ony tizden-tiz barlap gormeli. Onun {i¢in asakdaky isleri
yerine yetirmeli:
1.Gurallar panelindiki sary sorag belgisini-Help diiwmaéni basmaly.

2.Ekranda agylan View Help File penjirede Skill13 faylyn ady oniinden yazylan bolmaly. Eger ol yok bolsa
ony Browse diiwmaéni basyp Skill13 saylamaly.

Yiew Help File el B
File: ||:: Wl ol gokyreHTEAS Il 3 hip ﬂ Browse. .
Topic 1D
Project file:

|I::"'.M oM gokyreHTENS kI 3 hp| ﬂ Browse...

tapped Topic [0

Chooze an [D fram this list Refresh

[ Automatically move b nest 1D after View Help iz clicked

Open Help file az if it were

+ |nvoked by a program ™ A double-clicked file icon
" A popup

Yiew Help | Cloze

3.Contents gatda anyklama faylymyz goreris, onuil ayratyn boliimlerine we tabyn boliimlerimize syganyi
peykamyny eltip anyklama soraglarymyzyi jogaplaryny sagdaky penjirede goriip bileris. Onun {igin
penjirede peykamy soragyn istiine eltip, asakdaky etekde
Anyklama faylynn yokardaky yonekeyje yzygiderligine esaslanyp Tiirkmen dilinde islendik
cylsyrymly, grafikaly, tablisaly, suratly anyklama faylyny doéredip boljak miimkingiligini gorkezdik.
Anyklama faylynyi doredilisiniii has kémil redaktory bilen tize maglumat tehnologiyasyna esaslanyan
ELEKTRON KITAPLARYNY TURKMEN DILINDE déredip boljagyny gorkezdik.

CnpasoyHan cucTema: Anyvklama Fayly doretmek 7=

CoaepskaHues ] Mok |

BLIGEpHTE EHMUMY M HasrHTE KHONKEY "OTEpEME", NHME0 BEIGEpIMTE ApYryi
BKNanky, Hanpurep T pegreTHEIN YykasaTens'.

|.|.;] Anyklama faply doretmek -
2] Mazrmun Faply doretmeli
|2 Advry goshmaly
2] Bolum goshmaly
|.|,;] E olurnler fayllary doretmek.
|2] Bolumlerin yazgysyny pazmaly
|2] Bellik goshmaly
|2?] Fayly yatda saklamaly
|.,|_;] T azlama faply doretmek
Tazlama fayly doretmel
Taszlama parametri bermeli

Fayly patda zaklamaly

T azlama fayl goshmaly

Apizhga parametr kezqgitlemeli

Tazlamary vatda zaklamaly we mazhyn diine gechirmel j

Nokaszsare | MNeyare... | OTraeHa |
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Yokarky anyklama penjirede biljek bslimiii belgilidp, sycany peykamyny ofia eltip calt-caltda iki sapar
basmaly ya-da asakdaky setirden Mokasate diiwméni basmaly, sonda sagda onun jogaby bar penjire
cykar:

@An}lklama fayply doretmek -0 ﬂ
FPaiin [lpaeka 3aknagka [lapamerpel
LCnpaera

LCogepaHue |

Meyare

Mazmun fayly daretmeli.
I5i mazmun fayldan baglamaly. Help
Workshop redaktop
bu ig Ggin ydrite niyetlenilendir. Onda
biri-birine tabyn shemalar déredip bolar.
Izi Help Workshop-a baryp FileNew
buyruk bermeli.
Help Contents setri saylamaly we O
diwrmani basrmaly,

Mazmuna gecmek

13.2.4.Visual Basic-de anyklama fayly taslama birikdirilisi

Tayyar HLP-fayllary taslama birikdirmeginl birndge gorniisleri bardyr:
o Anyklama faylyny tutus taslama ii¢in berip bolar;
O Ayratyn anyklama faylyny her bir Forma {i¢in kesgitlép bolar;
o Formalar we elementler iicin olara sycanyn peykamyny eltip sag gulagyny basanynda ¢ykmaly
jogaplar(ona kontekst anyklama hem diyilyér) gorniisinde.
Anyklama faylyny tutus taslama {i¢in berjek bolsan Project Properties penjrani agmaly, Help File meydana
anyklama faylyn adyny girizmeli ya-da programma amal edilydrkd App obyekt (taslama obyekti) licin
HelpFile hdsiyetin bahasyny bermeli.
Anyklama fayly taslama birikdirjek bolsan asakdaky yzygiderlikde yumuslary amal etmeli:
1.visual Basic-de Standart EXE gorniisli tize taslama doretmeli.
2.Formal-in Name hésiyetine frmMain baha, Caption hisiyetine Anyklama bilen taslama baha bermeli.
3.Sycanyin peykamyny Projectl taslama &dpisgd eltipsag gulagyny basmaly ¢ykan gapdal menyudan
Projectl Properties buyrugy saylamaly.
4.Projectl Properties penjranii Help File meydanyna anyklama faylyn adyny girizmeli, OK diiwmaéni
basmaly.
5.Formada menyu elementlerini goymaly we onla seyle hésiyetler gogsmaly

File menyuy
Caption: Name:
&File mnuFile

File menyuyn buyruklary

Caption: Name:
Eé&xit mnuExitFile
Help menyuy

Caption: Name:
&Help mnuHelp
Help menyuyn buyruklary

Caption: Name:

&Contens Files mnuHelpContensFiles
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&Topic Files mnuHelpTopicFiles
&Project Files mnuHelpProject

6.Menyu tayyar bolandan sofi Menu Redaktory OK basyp yapmaly.

7.Taslama standart penjire elementi gosmaly. Onufi Name hésiyetine digHelp baha bermeli. Ol element
anyklama fayly cagyrmak {i¢in peydalanylar.

8.Programma yazylyan penjrani agmaly mnuFileExit_Click() i$ prosedurasyna End operatory gosmaly.

9.Form_Load() is prosedurasyna agakdaky setiri yazmaly:

dlgHelp.HelpFile = App.HelpFile
10. mnuHelpContentsFile_Click() is prosedurasyna agakdaky setirleri yazmaly:

Private Sub mnuHelpContentsFile_Click()
dglHelp.HelpContext = “100”
dglHelp.HelpCommand = cdl HelpContext
dglHelp.ShowHelp

End Sub

11.mnuHelpTopicFiles_Click() is prosedurasyna su programma bolegini gosmaly:

Private Sub mnuHelpContentsFile_Click()
dglHelp.HelpContext = “400”
dglHelp.HelpCommand = cdl HelpContext
dglHelp.ShowHelp

End Sub

12.mnuHelpTopicFiles_Click() is prosedurasyna su programma bolegini gosmaly:

Private Sub mnuHelpProject_Click()
dglHelp.HelpContext = “700”
dglHelp.HelpCommand = cdl HelpContext
dglHelp.ShowHelp

End Sub

13.Programmany yatda saklamaly we ise girizmeli.

Yokarky programmasy dogry diiziilse menyuyi her biri iicin anyklama faylynyi bir boliimi ¢agyrylar.

Klawiaturadaky F1 diiwméni basanymyzda anyklama ¢agyrylmagy ii¢in asakdaky isleri amal etmeli:

1.frmMain formada yazgy meydanyny yerlesdirmeli. Onun Name hésiyetine txtHelp baha bermeli,
HelpContextID hédsiyetine 1200 baha bermeli. Text hésiyetin bahasyny arassalamaly.

2.Programmany yatda saklamaly we ige girizmeli.

3.Ekrana ¢ykan formanyi yazgy meydancasyna kursory eltip ony isjenilesdirmeli.Ondan soni anyklama
almak ticin F1 basmaly.

(5 Anyklama bilen tazlama -0 ﬂ
File Help

—

Mazmuna gecmek
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13.2.5.Visual Basic-de anyklama fayllaryny HTML formatda doretmek

Anyklama fayllaryny INTERNET-iit HTML formarynda bermek déwrebap isdir. HTML format Visual

Basic-de HTML Help Workshop redakory tarapyndan doéredilyér, 6n basga formatda doreden bolsan ona
cagyrylyp onuil formatyna gegirilyér.

HTML goyulmadyk bolsa ony htmlhelp.exe fayly tapyp goymaly, goyulan bolsa ise girizmeli.
2 ZHTML F

e <1 o HTML Help

Adaty formatda doredilen anyklama faylyily HTML formata gegirmegin yzygiderligi seylerdkdir:
1.HTML Help Workshop redaktory ige girizmeli.

2.HTML Help Workshop redaktorda File>>New buyrugy amal etmeli.
3.Cykan penjirediki sanawdan Project saylamaly OK basmaly.

New |

Specify what to create:

Froject
Test
HTHL File

Table of Contents
| e

ak. I Cancel

4.Ekranda New Project Wizard penjire peyda bolar, onda Convert WinHelp project yazgynyn oOniinde
baydajyk bolsun:

Mew Project

x|

wielcame to the new project wizard. Thiz wizard
will help you to create a new HTRL Help project

Thiz wizard can convert an existing »winHelp
project. It will convert the BTF files to HTRL
files, the .CHT file to a . HHC file, and the project
file to a . HHF file. Check the box belows if pou
are converting an exizting project.

IV iConwert "inHelp project

< Haz=an, I Hanee > I OTriena
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Bu yerde Oanee diiwmaini basmaly.
5.Indiki tapgyrda deslapky faylyn duran yerini we adyny, seyle hem netijeleyji faylyin bolmaly yerini
gorkezmeli. Onun papkalaryny Browse basyp, ondan fayly tapyp Otkpbits(Open) basyp bermeli:

Mew Project -- Source and Destination Project Files El

Specify where vour WinHelp project file iz located:

II::"'.M oM gokgreHTetS kil 3. hpj

Browze. . |

Specify the name of the HTML praject file and
where pou would like it to be created.

IEZ'\MDH aokyraeHTeM az, 200345File Mame

< Hazan, Danee > OTrieHa

6.Deslapky fayla Skill13.hpj taslama at beripdik, onun salgysy yokarda gorkezilendir.

7.Asaky setire kursory eltip, onun etegindédki Browse... diiwméni basyp gerek papkamyzy berip, ondaky
cykan penjirede HTMLHelp setire FileName yazmaly.

8.Iki taslamada gorkezileninden sof fanee>(Next...) basmaly.

9. Ekranda bu isi amal edijinini in soiiky penjiresi peyda bolar:

Mew Project - Finizsh |

The wizard will now create a new HTML Help
praject. [f you need o make any chanages, click
Back. Othemwize, click Finish to create your project.

< Hazag,

OTrieHa |

Bu penjirede goyberen sawliklerini yza gaydyp diizedip bolar, ondan sofira Motoso(Finish) basyp isi
tamamlap bolar.

Mazmuna gecmek




185
14.Visual Basic-de obyekte goniikdirilen programmirleme

Obyekte goniikdirilen programmirleme(ona gysgaga OGP diysegem bolar) munui 6zi obyektler bilen
derieme usulyeti, taslamasy we gosundylaryn yazylysydyr. Bu yerde obyekt bolup belli bir hisiyete we
usulyete eye bolan programmanyn bolegidir. Obyektler toparlara esalanyp doredilyir, onda maglumatlary
islép tayyarlamak diizgiinleri, her hili bolup bildyjek yagdaylar modelirlenip bilner.

Isgirler kopleng hadysalary obyektler gorniisinde pikir edyérler. Mysal iigin, yokary mekdep
talyplaryn, mugallymlaryn, okalyan jaylaryn, kompyuterlerin we beyleki obyektleriii toplumy hékmiinde
g6z Omniine getirilip bilner. OGP -de hakyky durmus modelirlenyar.

OGP programma isldp tayyarlamak isini yonekeylesdiryar. Obyektlerinn hésiyetleri we usiilyetleri
yonekeyje howpsuzlyk modeline eyedir. Ol model 611 programma yazanymyzda gorkezisimiz yaly Private,
Public we Friend adalgalary bilen kesgitlenydr. Tayyarlan programma gosyndymyz beyleki obyektlere
elyeter bolmagy ti¢in onyn parametrlerini Public bilen bermeli.

Visual Basic-de iil esasy obyekt Forma bolup duryar. On gérkezisimiz yaly Appearance, BorderStyle,
Caption, Name We WindowsState yaly ini esasy hésiyetleri bolup, olary 6z programmamyz bilen erkin
tiytgedip bolar. Forma seyle hem Load, Unload, Show we Hide yaly usulyetlere eyedir.

Taslama tdze forma gosmak bilen taslamadaky formanyn toparynyn “nesilini” dorederis. Onyn
hisiyetleri we usulyetleri esasy formanyil sol hésiyetleri we usulyetleri bilen gabat gelmelidir. Téze
formamyzy yuwas-yuwasdan iiytgetmek bilen ony 6zbasdak edip bolar.

Obyekte goniikdirilen programmirlemdni gerekligini kdbir uly edara kdrhananyi, kompaniyanyn
isinin  guralysynda, dolandyrylysynda diisiindirelin. Kompaniya AYAZ administrasiyadan, isgérler
boliiminden, maglumat tehnologiyasy bdliiminden we buhgalteriyadan ybarat.

Administrasiya galan boliimlerin ylalasykly islemegini gazanyar, onun iggéirleri esasanam beyleki
boliimleriit menejerleri bilen islesyarler. Administrasiyanyn isgérleri kompyuterde isldp bilyérler, yone 6z
meseleleri iigin taslama doretmége bilimleri yeterlik daldir.

Isgérler boliimi kompaniya isgérleri ise kabul etmek, isden ¢ykarmak we olaryi isine baha bermek
bilen is salysyarlar. Olar iggirlerinn sahsy maglumatlary bilen igleyarler, ol maglumatlar bagga boliimin
isgérleri licin gizlin bolmaly, yorite rugsat bolmasa olaryi ofia girmegi gadagandyr. Mysal ii¢in, haysam
bolsa bir bolimin menejeri 6z isgérinii sahsy maglumaty bilen tanysyp biler.

Maglumat tehnologiyasy boliim kompaniyadaky kompyuterlerin adaty islemegine seretmek bilen
AYAZ kompaniyadaky dhli boliimlerde yiize ¢ykyan tehniki miisgil isleri ¢ozmelidirler.

Buhgalteriya boliimi kompaniyanyi hasabyny alyp baryar, zatlarynyn hasabyny yoredyér we algy
bilen bergini jemleyir.Buhgalteriyanyi iistiinden ge¢ydn maglumatlaryn belli bir bolegi kompaniyanyn
maliye yagdayy baradadyr, olaryn gizlinligi hokmany suratda {ipjiin edilmelidir. Maliye maglumatlar
kompaniyanyn bésdeslerine elyeter bolmaly déldir.

Kompaniyanyn boliimleriniii bilelikdéki isi kesgitli diizgilinlere boyun egmelidir. Bir boliim beyleki
boliimin maglumatlary bilen islese kompaniyada isler bulasar, seyle bolsa kompaniyanyn batmagyna alyp
geler.

Seylelikde AYAZ kompaniyada gulluk maglumatlaryn elyeter bolmagynyn diizgiinleri kesgitlenen.
Menejerlere die 6z isgirlerinii sahsy maglumatlaryna seretmek rugsat berilyér, beyleki boliimlerin
isgirlerinin sahsy maglumatlary bilen tanysmak kompaniya ti¢in bahbitli déldir.

Su yokarky islerin dolandyrylysy yaly OGP hem seylerdk usula, ¢idklendirmi esaslanandyr. Her bir
obyekt 6z meselelerini ¢ozyir, beyleki obyektler bilen 6zara aragatnasyk zerur bolsa amal edilyir. OGP
programmirlenmeli meseleleriii amal edydn islerini ofa layyk modelirleydr. Eger OGP bilen edilen is
yerlikli taslanan bolsa diiziilen onia degisli programmany has kdp ulanyp bolar. Mysal ii¢in, kompaniyada
kabul edilen maglumatlary iglédp tayyarlamak algoritmi obyektde durmusa gegirilen bolsa ony beyleki
kompaniyalaryn meselelerinde, seyle hem basga gosundylarda ulanyp bolar.

Mazmuna ge¢mek

14.1. OGP-de obyektin atributy

Programmirlemekde obyektin 6zbasdak maznuna eye bolmagy anladyan atributlary bardyr.Visual
Basic-i1l islendik diiziijisi yaly obyektlernn hem hisiyeti, isi we usulyetleri bardyr. Seyle bolsa hem
obyektler proseduralardan su ii¢ sany tapawutlary bardyr:
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o Miraslyk;
o Inkasulyasiya;
o Polimorfizm.

Adatga Visual Basic —de miraslyk bilen inkapsulyasiya durmusa gegirilendir, polmorfizm onda
yokdyr, sebébi Visual Basic obyekte goniikdirilen programmirleme dili dildir. Seyle bolsa hem tehniki
nukday nazardan Visual Basic—de OGP-i esaslaryny d6wrenmek amatlydyr.

Mazmuna gecmek

14.1.1. OGP—de obyektin hésiyeti

Programmada doredilmeli ya-da peydalanylmaly her bir obyekt toparyin adyna eye bolmalydyr,
onun bilen bir obyekti beyleki obyektden tapawutlandyryp bolar. AYAZ kompaniyadaky isgirler
boliiminin beyany iigin hidsiyetlerden peydalanarys. Kompaniyanyn isgérlerinii hususy resminamalary
bilen dinie menejerler isldp bilerler. Onun programmada yazylysy:

Public IsManager As Boolean

Ondan baggada her bir menejer 6z boliiminin isgérleriniii hususy resminamalaryna seretmige haky
bardyr. Beyle yagdayda boliimin beyany ticin hisiyeti kesgitlemek zerurdyr:

Public Derartment As String

Isgérler boliimindki resmicd menejeri gyzyklandyryan isgéiri gérkezmeli, ony EmployeelD hisiyet
bilen doretmeli:

Public EmployeelD As Long

Indi bolsa Isgérler boliiminin sekilinin diiziimini gorkezelin

Isgiirler boliimi Topar

Ady: Bahar Hisiyet
Wezipesi: MMaglumat
tehnologiyasy  hiliimii
mengiar

Sorama:
Merdanyh hususy
resminamasyny almaly

“Isgérler bolumi” toparyn hisiyeti
Mazmuna gecmek

14.1.2. OGP-de obyektin usulyeti

Usulyet diyilip obyekt bilen yerine yetirilydn herekete aydylyar. Mysal ii¢in, obyekt-penjire ekranda
sekillendirilip ya-da gizlenip seyle hem 6z mogberini iiytgedip biler. “Isgarler bolimi” obyekt hem
isgérlerin hususy resminamalaryny okap biler. Obyekt degisli boliiminni menejerinden sorama gelende
isgdrin husuly resminamasyna yiizlenip biler, onda usulyet programmada seyle yazylar

Public Function GetFile() As String
If IsManager and Department = “Administrasiya” Then
GetFile = “Merdan”
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Else
GetFile =
End If
End Function

Bu usulyet ilki bilen maglumat sorayan talap edyidn isgérinin hususy resminamalaryny almaga
hukugynyn bardygyny barlayar. Biziii mysalymyzda ol administrasiyanyii menejeri bolmaly. Yonekey
bilesigeliji isgéarler iicin hususy maglumatlar elyeter déldirler. Onun sekili:

Isgiirler biliimi
Ady: Bahar

Wezipesi: MMaglumat
tehnologiyasy  hiliimii
manaier

Sorama:
MMerdanyh hususy
resminamasyny almaly

Usulyet

“Isgarler bolumi” toparyn usulyeti
Mazmuna gecmek

14.1.3. OGP-de miraslyk

OGP—de miraslyk munuii 6zi obyektin deslapky atalyk toparynyn atributlaryny saklanyp
galmagydyr. Mysal tigin, doreden Forma obyektimiz 6z atasynyn toparynyn hésiyetlerine we usulyetlerine
miraslyk edyédr. Ol Name, WindowState We BorderStyle hésiyetlere, Load, Unload We Hide usulyetlere eyedir.

Visual Basic-de obyektin bagga bir sanyny déretmek ti¢in onunl haysy topara degislidigini gérkezmeli
ondan soft New adalgadan peydalanmaly. Sonda tdze obyekt atanyn hidsiyetine we usulyetine miraslyk
edydr. Visual Basic-de obyektii basga bir sanyny doretmekde 10-njy boliimdédki maglumatlary cap
etmekddki we ekrana ¢ykarmakdaky cisDialogs toparda YNBox, ErrMsg We LoginBox usulyetler bardyr,
olardaky dialog penjirelerinn mysalynda miraslygy gorkezelin.

I1ki bilen obyekti yatda saklamak {i¢in husy boliip almaly:

Dim dlg As clsDialog
Ondan sonl obyektin 6zi New adalganyn komegi bilen doredilyér:
Set dlg = New clsDialog
Taze obyekt dig su ii¢ sany YNBox, ErrMsg We LoginBox usulyete eyedir. Olaryn dhlisi deslapky clsDialogs

toparda doredilendir.
Mazmuna gecmek

14.1.4. OGP—de inkapsulyasiya

Inkapsulyasia bilen obyektin maglumatlary we usulyetleri dasky diinydden gizlenyar. Bu yerde
programmist obyektin i¢ki ¢ylsyrymly durmusa gegirilisinden ayrylyar. Inkapsulyasiya OGP-nin giiycli
tarapydyr. Visual Basic-de inkapsulyasiyany Private adalga iipjiin edydr. Sonun iiginem Visual Basic-de
programma modullarynda koOp proseduralar Private adalga s6z bilen yglan edilydr. Sonda ofia basga
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formalardan we modullardan onia girmek gadagan edilyér. Eger kébir proseduralaryn beylekiler {i¢in agyk
bolmagy ii¢in onun Sub ya-da Function adalgalaryndan 61 Public adalga s6zi yazmaly, mysal {igin:

Public Function Format_Disk(Drive As String)

Miimkin  bolsa obyektler taslananda onun a¢yk hdsiyetleri  ¢dklendirilmelidir.  Ddsky
programmalaryn islemeli ddllerinin dhlisi yapylmalydyr. Seyle edilse basga programmistleriri
programma yalnyslyk girizilmeginin 6ni alynar.

Mazmuna gecmek

14.1.5. OGP-de polimorfizm

Polimorfizm munun 6zi obyektiil her-hili gorniisi kabul edip bilmegidir. Kdpleng obyekt beyleki
obyektlerin oniimi bolup bilerler.Tdze obyekt ata-enelerinin hésiyetlerini we usulyetlerini miraslyk
alyarlar. Polimorfizm tize alynan obyekte kébi hésiyetleri gosup, gorniisini iiytgedip ya-da ayryp
bolmaga miimkingilik beryar.

Mysal ligin, AYAZ kompaniyanyii maglumat tehnologiyasy boliimi 6ziinde isgérler boliminin
sahamcasyny acmak islese, onda ol saham¢a kompaniyanyn iggérler boliiminin diizglinine esaslamalydyr.
Sol bir wagtda sahamg¢ada maglumat tehnologiyasynyn miimkingilikleri ulanylmalydyr. Isgérler boliimi
maglumatlary kagyzda saklayan bolsa sahamg¢a maglumatlary kompyuterde saklamalydyr, seyle hem 6z
isgérleri licin gogsmaca maglumatlary girizip bilerler.

Maglumat tehnologiyasynynn boliimi isgirleri {icin sorag-jogap resminamasyny kompaniyanyn
isgirler boliiminin resminamasyna esaslanyp 0z seyle resminamasyny doéredip bilerler.

Isgiirler boliumi Maglumat tehnologijrasy'
boliimi
Ady: Bahar Ady: Bahar

Wezipesi: Maglumat Wezipesi: Maglumat
tehnologiyasy héliimih tehnologiyasy hélimin

menejer menejeri

Sorama: Sorama:

Merdanyi hususy Merdanyn hususy
resminamasyny almaly resminamasyny almaly

Polimrfizm

OGP -—nin esasy tapawudy olam bolsa bir sapar yazylan programma yazgylarynyn kop sapar
ulanylmagydyr.
Mazmuna gecmek

14.2. OGP-de toparyn doredilisi

Obyektleriil taslanysyny we doredilisini “Isgérler boliimi” toparyny kdmillesdirmeklik mysalynda
seredelin:
1.visual Basic-e girmeli, Standart EXE gorniisli tdze taslama doretmeli.
2. Toparyin modulyny gosmaly, onuil ligin Taslama &dpisgé baryp sycanyn sag gulagyny basmaly, ¢ykan
gapdal menyudan Add>»Class Module buyrugy saylamaly.
3.Hasiyetler penjiredéki Name hésiyete clsHR baha bermeli.
4. Programma yazylyan penjirede (General)(Declarations) bolege asakdakylary yglan etmeli:
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Option Explicit

Public Manager As Boolean
Public Dept As Integer

Public EmpID As Integer

Public EmpName As String

Public EmpDept As Integer

Public EmpPerformance As String
Public Reason As String

5. Toparmyz isgérlerin hususy resminamalaryny bermeli, onun ii¢in ofia agcyk usulyet gosmaly:

Public Function GetRecord() As Boolean
If Manager = True Then
If Dept = GetDept() Then
EmpName = GetEmpName()
EmpPerformance = GetPerfEval()
Reason ="
GetRecord = True
Else
Reason = "Ishgarlerin hususy resminamalaryna gurmek gadagan”
GetRecord = False
End If
Else
Reason = "Ishgarlerin hususy resminamalaryna gurmek dine menejerlere bolyar"
GetRecord = False
End If
End Function

6.Isgérin islydn boliimini kesgitlemek {i¢in usulyet gosmaly:

Public Function GetDept() As Integer
Select Case EmpID

Casels=1
GetDept =1
Casels=2
GetDept =1
Casels=3
GetDept =2
Case Else
GetDept=0
End Select

End Function
7 Isgérin adyny almak tigin usulyet gosalyn:

Public Function GetEmpName() As String
Select Case EmpID
Casels=1
GetEmpName = "Bahar"
Casels=2
GetEmpName = "Bagty"
Casels=3
GetEmpName = "Merdan"
Case Else
GetEmpName ="
End Select
End Function

8.Isgérlere baha bermek iicin usulyetem gosalyn

Public Function GetPerfEval() As String
Select Case EmpID
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Casels=1
GetPerfEval = "Has gowy"
Casels=2
GetPerfEval = "Gowyrak"
Casels=3
GetPerfEval = "Kanagatlanarly"
Case Else
GetPerfEval = "Belli dal"
End Select

End Function
9.Toparyn dogry atlandyrylysyna yzgiderli gozeggilik etmek iicin programma su bolegi gosalyn:

Private Sub Class_Initialize()
Manager = False
Dept=1
EmpID =0
EmpName =
EmpDept =0
EmpPerformance =
Reason ="

End Sub

Yokardaky isler bilen topar doretmek iicin zerurdyr, onda yedi sany Manager, Dept, EmplID,
EmpName, EmpDept, EmpPerformance We Reason hésiyet doretdik.
Bu yerde:
Manager -hdsiyet sorayanyn menejerdigini gorkezyar.

Dept -hésiyet isgirin isleydn boliimini kesgitleyér.

EmpID —hdsiyet maglumat almaly isgérin kodyny kesgitleyar.

EmpName—hésiyet, EmpID —hésiyet berilse isgarin ady girizilyar.

EmpDept —hdsiyet iggirin haysy bolimde isleyénini gorkezyar.

EmpPerformance —hésiyetde baha saklanyar.

Reason —hésiyetde bolsa sorama ret edilen yagdayda yaliiyslyk barada habar berer hem-de ret etme

esaslandyrylar.

HR toparda yokarky hisiyetlerden basgada dort sany usulyet bardyr. Bu yerde GetRecord() usulyet
acykdyr. Isgérin hususy resminamalaryna difie dogry Sorama-rugsatly yagdayda miimkingilik beryir.
Seylelik bilen topar dhli zerur miimkingiliklere eyedir, ony taslamalarda ulanyp bolar. Indi bolsa HR topar
bilen islemek ii¢in interfeys doredeliii.

Mazmuna gecmek

14.3. OGP-de toparyn ulanylysy

Visual Basic-de acan taslamamyzda interfeys doéretmek tigin asakdaky isleri amal edelin:
1.Formal formany igjen yagdaya getirelin, onuit Name hésiyetine frmHR baha, Caption hésiyetine Kadrlar
bolumi baha berelin.
2.Forma agakdaky hésiyetli ii¢ yazgy gosalyn:

Name: Text:
IbIDept Bolum
IbIManager Menejer?
IbIEmpID Ishgarin kod

3.Forma utgasdyrylan meydany goymaly, ony IblDept yazgynyn gapdalynda yerlesdirmeli, onun
hésiyetleri:

Name: Style:
IbIDept 2-Dropdown List

4.Forma iki sany gecirijini goymaly, olara su hésiyet bermeli:
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Name: Caption: Style:
optHawa &Hawa True
optYok &Yok

5.Indi bolsa isgirin kodyny girizmek barada elemen gosalyil. Forma yazgy meydanyny gosmaly, ofia su
hisiyet bermeli:

Name: Text:
IXtEmpID -

6.Forma baha ii¢in diiwme gosmaly, ofa su hésiyet bermeli

Name: Caption:
cmdGetPE &Baha almaly

Netijede taslanyan forma asakdaky gorniise eye bolar:

53 Izhgarler bolumi Y [m] B4

Sk

Menejer? Hawa = Yok

| ghaarin kody |

Baha almaly

Isgarler boliimi geplesik penjiresi

7.Formanyn programma yazylyan penjiresini agyp, onuil (General)(Declarations) bolegine suny yazmaly:

Option Explicit
Private hr As clsHR

8.Form_Load() is prosedurasyna su programma bolegini gosmaly:

Private Sub Form_Load()
'HR obyektin yene birini doretmeli
Set hr = New cIsHR
‘Bolumler kody sanawyna goshmaly
cboDept.AddItem "1"
cboDept.AddItem "2"
End Sub

9. Form_Unload() is prosedurasyna su programma bolegini gosmaly:

Private Sub Form_Unload(Cancel As Integer)
Set hr = Nothing
End Sub

10.cmdGetPE diiwméini basanymyzda igldp tayyarlamak {i¢in niyetlenen programma bolegini gosalyn:

Private Sub cmdGetPE_Click()
Dim rc As Boolean
Dim msg As String

hr.Dept = Val(cboDept.Text)
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hr.Manager = optYes.Value
hr.EmpID = Val(txtEmplID.Text)

If hr.GetRecord = True Then
msg = "Ishgarin kody:" & Trim$(Str$(hr.EmplID)) & vbCrLf
msg = msg & "Ishgarin ady:" & hr.EmpName & vbCrLf
msg = msg & "Baha:" & hr.EmpPerformance

MsgBox msg
Else
msg = "Maglumat alyp bolmady!" & vbCrLf
msg = msg & hr.Reason
End If
End Sub

Taslamany yatda saklamaly we ise girizmeli. Isgérlerin kodyny 1-den 3-e ¢enli almaly. Egerde olaryn isi
gyzyklandyrsa onda siziii menejerdiginizi gorkezmeli. Netije agakda getirilendir:

|emdGetPE =] feriex
Dim rc As Boolean
Dimw msg As Sm ;IQIEI
hr.Dept = Va Baum I1 j

hr . Hanager =

hr.EwmpID = W

: Projectl 11.12.04 |
Menejer? ™ Hawa Yok

|zhgarin kodw: 1

If hr.GetRec: shoainkedy i lasgﬁg;waasds&iihar
msg = "Ishos: £
msy = msSg & | {

msg = msg £

B aha almaly I

M=sgBox msg
Elze
msg = "Maglumat alyp bolmady!'"™ & wvhCrLf
= |
5 Ishgarler bolumi - |O] x|
Bolurn | j J
Mensjer? & Hawa " Yok lshgarin kady:0

|zhgarin ady:

[zhgarit kady I— Baha:Bell dal
[ e |

|
HR toparyn isleyisi

Baha almaly




